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Tina	O’Hailey	 brings	 her	 real	work	 experience	 from	Disney	 and	Electronic	Arts	 to	make	 this	 a	 solid	 reference	 for	 the
animator	or	producer	doing	hybrid	animation	for	the	first	 time	or	a	pro	double-checking	that	they	have	accounted	for
everything	 in	 the	 pipeline.	 The	 book	 combines	 the	 best	 how-to	 specifics	 with	 the	 creative	 theory	 behind	 the	 best
animation	today.	You	can	envision	the	creative	and	aesthetic	sacrifices	that	are	inevitable	without	the	knowledge	from
the	detailed	industry	examples	in	this	book.	Excellent	breakdown	of	the	challenges	of	integrating	2D	and	3D	animation
so	it	all	works	together	in	the	end.

—Craig	Caldwell,	Ph.D.	USTAR	Senior	Research	Professor,	Digital	Media	Cluster	Arts	Director,	Engineering	Arts	and
Entertainment	Film	&	Media	Arts	Dept.	&	School	of	Computing,	University	of	Utah

Tina’s	experience	and	confident,	professional	hand	is	well	represented	in	this	book.	It’s	hard	to	find	a	text	that	reads	like
friendly	and	informed	advice	rather	than	a	map	to	a	programmer’s	labyrinth.	This	is	a	great	mix	of	practical,	artful	and
anecdotal	events	 that	add	up	to	a	 truly	valuable	book.	Even	 if	you’re	only	vaguely	 interested	 in	creating	or	producing
hybrid	animation,	this	book	is	sure	to	stir	your	enthusiasm.

—Rob	Bekuhrs,	Animation	Director,	SuperGenius	Studio

Opening	with	the	question	of	why	one	would	use	hybrid	animation	techniques,	this	book	affords	the	reader	rare	insight
into	 the	 creative	 and	 technical	 processes	 of	 merging	 traditional	 drawn	 and	 CG	 animation.	 With	 Tina’s	 hands-on
experience	 working	 and	 teaching	 in	 animation,	 these	 concepts	 are	 now	 presented	 as	 a	 series	 of	 practical	 exercises,
supported	 by	 examples	 from	 world	 class	 animation	 studios	 where	 such	 techniques	 have	 been	 used.	 The	 film	 studio
examples	alone	are	a	visual	treat	undocumented	elsewhere.	Tina’s	book	will	surely	become	a	classic	animation	reference
for	many	years	to	come.

—Eric	Guaglione,	Supervising	Director	of	Rovio	Entertainment

The	first	edition	kept	its	eye	on	the	ball,	emphasizing	the	notion	that	no	matter	the	combination	of	tools	or	techniques
animation	is	always	about	the	performance!	This	new	edition	expands	on	that	tradition	by	bringing	updated	and	refined
examples	and	discussion	to	bear.	A	must-read	for	anyone	involved	with	hybrid	animation.

—Marty	Altman,	Professor,	Savannah	College	of	Art	and	Design	(SCAD)
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Dear	Reader,

Welcome	 to	 the	 second	 edition	 of	Hybrid	Animation.	 There	 are	 a	 lot	 of	 changes,	 so	my
apologies	if	you	were	using	this	for	a	textbook;	you’ll	have	to	update	your	reading	assignment
page	 numbers.	 The	 first	 edition	 of	 this	 book	 was	 based	 on	 a	 class	 I	 taught	 at	 SCAD,	 the
Savannah	College	of	Art	and	Design.	I’m	happy	to	say	that	class	is	no	longer	in	the	catalog.
Why	does	that	make	me	happy?	Because	hybrid	animation	as	a	concept	has	been	woven	into
our	complete	curriculum;	the	concepts	are	taught	from	day	one	and	not	pigeonholed	into	one
elective.	You’ll	note	a	similar	concept	throughout	the	industry,	I	hope.	It’s	all	animation.	It	just
doesn’t	matter	anymore	what	you	are	animating	with.	However,	there	is	a	trick	to	combining
mediums	and	that	is	ultimately	what	our	journey	together	is	to	discover.

Then	 the	 questions	 to	 ask	 are:	 what	 are	 the	 different	 ways	 those	 mediums	 are	 usually
combined?	What	techniques	do	you	use?	What	problems	do	you	need	to	overcome?	What	do
you	need	to	watch	out	for?	Why	do	it	at	all?

In	these	pages	we	will	answer	these	questions	and	more.	I	break	things	down	in	patterns,
repeatable	patterns.	We’ll	 explore	different	 software	 solutions	 for	each	pattern.	Then	with	a
little	practice,	you	can	mix	and	match	the	techniques	for	your	own	films.	Don’t	see	a	specific
software	in	these	pages?	That’s	OK.	I’ll	bet	you	can	find	a	pattern	or	technique	that	matches
your	workflow	and	then,	coupled	with	a	few	tutorials	on	how	to	use	your	specific	software,
you	can	come	up	with	the	answer.	Certainly,	problem	solving	is	our	biggest	quest.

I	can’t	wait	to	get	to	the	fun.

Warmly,
…	tina

Companion	data	can	be	found:	www.hybridanimation.com
Software	versions	used	in	this	book:
Tutorials	are	created	with	Maya	2014	(PC/MAC)	(in	most	cases	the	Maya	files	are	saved	in

2011)

http://www.thundercluck.com/
http://www.hybridanimation.com
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1

Hybrid	Animation

What	and	Why?

FIGURE	1.1	2D	character	interacting	with	a	3D	character,	The	Iron	Giant

The	Iron	Giant	©	Warner	Bros.,	a	division	of	Time	Warner	Entertainment	Company,	L.P.	All	Rights	Reserved

What	is	Hybrid	Animation?

Hybrid	 animation	 is	 the	 combination	 of	 2D	 and	 3D	 animation	 mediums.	 2D	 and	 3D
animation	mediums	can	be	used,	and	are	used,	 independently	of	one	another.	Pixar’s	B.O.O.:
Bureau	of	Other	worldly	Operations	or	Inside	Out	are	completely	3D	animated	films.	Disney’s
Little	Mermaid	 and	Miyazaki’s	 (Studio	Ghibli)	The	Wind	Rises	 are	 completely	 2D	animated
films.

Yet,	ever	since	the	first	appearance	of	a	3D	glowing	bauble	in	a	2D	animated	film,	Disney’s
The	 Black	 Cauldron,	 artists	 have	 been	 finding	 inventive	 ways	 to	 combine	 the	 animation



mediums.	The	use	of	2D/3D	at	Disney	predates	The	Black	Cauldron	and	can	be	seen	in	a	short
test	 done	 by	 John	Lassiter	 titled	Where	 the	Wild	 Things	Are	 (1983).	 In	 Japanese	 animation,
2D/3D	can	be	seen	as	early	as	Princess	Mononoke	(1997)	and	Ghost	in	the	Shell	(1995)	and	as
recently	as	Berserk	Golden	Age	Arc	3	Descent	(2013).

FIGURE	1.2	The	bauble	from	Disney’s	The	Black	Cauldron	(1985)	was	one	of	the	first	3D	elements	to	be	combined	with	2D

animation

©	1985	Disney

What	combinations	of	2D	and	3D	are	there?	Rendering	characters	in	different	mediums	is
the	 first	 type	 of	 combination.	 Some	of	 the	 earliest	 examples	 can	 be	 found	 in	 the	Academy
Award–	 nominated	 short	 Technological	 Threat	 (1998)	 and	 also	 in	 a	 wonderful	 short	 film
produced	at	Disney’s	Florida	Studio	called	Off	His	Rockers	 (1992).	 In	 feature	animated	 films,
probably	one	of	the	most	memorable	combinations	of	mediums	is	found	in	Warner	Bros.’	The
Iron	Giant	(1999),	in	which	a	young	boy	befriends	an	alien	robot;	the	robot	being	3D	in	a	2D
animated	film.	However,	characters	themselves	do	not	need	to	be	completely	rendered	in	one
medium	or	another,	as	was	the	case	with	the	character	John	Silver	in	Disney’s	Treasure	Planet
(2002),	or	the	bicyclists	 in	The	Triplets	of	Belleville	 (2003).	 In	 those	 films	2D	characters	were
drawn	with	 3D	 appendages	 rendered	 to	match	 the	 2D	 portions.	Most	 recently,	 the	 overall
characters	 themselves	 can	be	 a	 combination	 entirely	 of	 3D	and	 2D	as	was	 seen	 in	Disney’s
Oscar-winning	short	Paperman	 (2012),	where	 the	animation	was	created	 in	3D	and	then	2D
animation	was	done	overtop	of	the	3D.	Lastly,	the	most	common	use	of	combining	mediums	is
for	non-character	animation	elements.	This	combination	of	3D	elements	into	2D	animation	is
seen	in	almost	any	modern	2D	animation:	Mulan,	The	Simpsons,	Family	Guy,	and	Futurama,
to	name	a	few.



FIGURE	1.3	2D	character	with	3D	parts	riding	a	3D	bike	found	in	The	Triplets	of	Belleville

Now,	let’s	clarify	exactly	what	2D	and	3D	animation	assets	are	and	how	they	are	created,
just	 to	 make	 sure	 we	 are	 all	 clear.	 You	 might	 be	 proficient	 with	 a	 few	 of	 these	 creation
methods.	During	the	course	of	this	book,	hopefully,	you	will	find	yourself	experimenting	with
other	methods.	A	large,	looming	goal	of	this	book	is	to	show	you	the	path	to	fearlessness	and
flexibility	with	software,	because	at	the	end	of	the	day,	it	is	animation—that’s	all.

2D	animation	assets	are	 images	 that	exist	only	 in	 two	dimensions	during	creation;	a	very
academic	definition.	How	the	2D	images	are	created	is	the	interesting	part	that	must	be	dealt
with	 in	your	pipeline.	These	 images	can	be	created	 in	 the	birth	 tradition	of	animation	using
pencil	 and	 paper	 and	 then	 scanned	 into	 a	 computer	 for	 compositing.	 Traditional	 animation
artists	 have	 had	 great	 success	 in	 drawing	 their	 images	 digitally	 using	 software	 such	 as
Photoshop,	Flash,	or	Toon	Boom,	to	name	a	few.	Other	ways	of	creating	2D	animation	images
include	 painting	 on	 glass,	 drawing	 in	 sand,	 scratching	 on	 film,	 or	 other	 flat	 methods	 of
creation.	All	of	these	methods	fall	under	the	2D	animation	category.



FIGURE	1.4	2D	traditional	character	“M.E.,”	animation	(red)	by	Tina	O’Hailey,	cleanup	(graphite)	by	John	O’Hailey

FIGURE	1.5	Image	from	“How	to	Throw	a	Jellyfish	Party”	drawn	and	animated	in	Flash	by	Dan	Murdock,	2008,	Digital	Cel

I	Course,	SCAD

3D	animation	assets	exist	in	three	dimensions	during	the	creation	process.	More	academic-
speak,	but	look	at	the	key	phrase:	“during	the	creation	process.”	Live-action	film	would	come
under	this	category	if	we	were	not	limiting	ourselves	to	animation	assets.	3D	animation	assets
include	digital	 and	 stop-motion	animation.	Digital	 animation	 can	be	 created	 in	 3D	 software
packages	 such	 as	 XSI,	Maya,	Max,	 or	 a	multitude	 of	 other	 lower-budget	 software	 such	 as
Blender,	Wings,	and	the	like.	Stop-motion	is	the	process	of	animating	tangible	items	in	front	of



a	camera,	usually	poseable	puppets	made	of	clay,	 silicon,	or	other	materials.	There	 is	a	 sub-
category	of	stop-motion	called	pixilation,	which	uses	live	objects,	recorded	frame	by	frame,	to
create	an	animation.

FIGURE	1.6	3D	character	modeled	by	Erik	Minkin,	2014,	SCAD



FIGURE	1.7	Character	from	stop-motion	animation	“King	Russ”	by	M.	T.	Maloney

Since	we	are	focusing	on	animation	and	not	live	action,	combining	film	or	video	with	2D	or
3D	animation	is	beyond	the	scope	of	this	book.	However,	the	same	problem-solving	concepts
and	compositing	techniques	covered	in	this	book	can	be	applied	toward	combining	live	action
and	animation.

Why	Use	One	Medium	Over	the	Other?

Artists’	 imaginations	 continue	 to	 grow	 and	 stretch	 the	 boundaries	 of	 animation	 to	 tell
stories.	It	can	become	difficult	to	decide	which	medium	is	best	to	tell	the	story.	Sometimes,	fad
decisions	are	made	based	on	the	newness	of	a	medium.

To	 take	 an	 objective	 look	 at	 the	 decision,	 these	 following	 five	 reasons	 show	 why	 one
medium	might	be	preferred	over	another:

Visual	target	not	subject	matter
Line	mileage
Complexity
Team	skills	versus	production	schedule
Physical	assets	and	budget

Visual	Target	Not	 Subject	Matter.	 The	 visual	 target	 or	 visual	 style	 of	 a	 film	 is	 a	 large
factor	in	deciding	which	type	of	medium	will	be	chosen.	It	is	no	longer	the	subject	matter	that
is	the	deciding	factor.	The	division	between	what	medium	is	best	for	what	subject	matter	has
become	 so	 blurred	 as	 to	 be	 nonexistent.	 3D	 software	 techniques	 have	 advanced	 so	 that
humans,	 furry	 animals,	 and	 other	warm-looking	 creatures	 are	 no	 longer	 out	 of	 their	 grasp.
Which	medium	lends	itself	best	to	the	artists’	 final	vision	is	the	question	to	ask.	This	will	be
answered	with	strong	art	direction	and	experimenting	during	pre-production.



FIGURE	1.8	Visual	style	and	frame	of	final	2D/3D	animation	by	Claire	Almon,	2007,	SCAD

Line	Mileage.	 “Line	mileage”	 is	 a	 term	meaning	how	much	 line	you	have	 to	physically
draw.	If	you	were	to	take	a	traditional	drawing	and	stretch	out	the	lines	end	to	end	you	would
see	what	your	 “line	mileage”	 is.	Every	millimeter	more	of	pencil	 or	digital	 line	 takes	more
time	 to	 draw.	 Intricate	 character	 designs	may	 look	 good	 as	 still	 images,	 but	 the	 reality	 of
animating	 such	 a	 character	 is	 time	 consuming.	A	 character	with	 long,	 curly	hair,	wearing	 a
wrinkly	overcoat,	multiple	ammo	straps	over	his	shoulders,	and	a	striped	shirt	has	extra	line
mileage.	 It	 is	difficult	to	keep	so	many	lines	moving	well	without	seeming	to	crawl,	pop,	or
distract	from	the	animation.

FIGURE	1.9	Line	mileage	is	how	much	line	must	be	drawn,	shown	here	by	stretching	out	the	drawing	end	to	end

If	a	traditional	medium	is	chosen	and	the	animation	is	fully	animated,	line	mileage	is	looked
at	 very	 closely	 and	 characters	 are	 simplified	 in	 order	 to	 minimize	 the	 line	 mileage.	 An
example:	on	a	fully	animated	film,	such	as	Disney’s	Lilo	&	Stitch,	the	character	Nani’s	t-shirt
had	on	its	front	a	coffee	cup	design.	The	design	was	simplified	to	a	heart	in	order	to	lower	the
line	mileage.	This	may	not	seem	like	a	large	simplification.	Given	that	Nani	was	in	so	much	of
the	movie,	the	seemingly	small	simplification	along	with	many	others	added	up	to	less	time
spent	drawing.	Anime	characters	can	be	designed	with	more	detail	since	the	animation	style
dictates	minimal	inbetweening	of	the	characters.

A	 common	 multiplier	 of	 line	 mileage	 is	 crowds.	 If	 a	 traditional	 animated	 film	 calls	 for
crowds	of	people,	that	is	a	ton	of	line	mileage.	In	order	to	simplify	the	line	mileage,	many	3D
crowd	 techniques	 have	 been	 used.	 3D	 crowds	were	 rendered	 to	match	 the	 2D	 line	 style	 in
Disney’s	Hunchback	of	Notre	Dame	and	with	the	Hun	charge	in	Mulan.	Another	method	used
is	to	procedurally	populate	a	3D	world	with	2D	animated	sprites;	this	method	was	also	used	in
Mulan.	The	Simpsons	Movie	used	a	similar	technique	of	moving	a	3D	camera	move	through	a
2D	crowd.



FIGURE	1.10	Disney’s	Mulan.	The	palace	scene	used	2D	animation,	crowd	placement	in	Maya,	3D	fireworks,	and

compositing	software	to	create	this	hybrid	shot

©	1998	Disney

Complexity.	3D	has	successfully	been	used	to	animate	complex	elements	that	are	difficult
to	 animate	 believably	 using	 traditional	 methods.	 Objects	 shown	 in	 perspective	 or	 having
intricate	textures	and	details	can	become	distorted	when	drawn	in	2D.	An	early	example	is	the
magic	 carpet	 in	Aladdin.	 The	 carpet	was	 designed	with	 an	 intricate	 texture	 that	 needed	 to
bend	and	move	as	it	animated.	The	carpet,	needing	to	match	a	2D	style,	was	animated	in	2D
as	 a	 template	 and	 reanimated	 and	 rendered	 in	 3D	 so	 that	 its	 texture	moved	 believably.	 In
Disney’s	Brother	Bear,	 the	moose’s	 antlers	 proved	 to	 be	 difficult	 to	 draw	 in	 perspective.	 In
Figure	1.11	Broose	 Johnson	and	Tony	Stanley	animated	 the	antlers	 in	3D	 to	match	 their	2D
moose	animation.	The	3D	animation	was	then	used	as	a	template	and	redrawn	in	2D.

FIGURE	1.11	3D	antlers	were	animated	and	then	redrawn	in	2D	using	the	3D	as	reference.	Disney’s	Brother	Bear

©	2003	Disney



Team	 Skills	 versus	 Production	 Schedule.	 A	 reality	 is	 that	 you	 might	 have	 a	 team	 of
artists	 who	 are	 not	 comfortable	 with	 the	 medium	 you	 want	 to	 use.	 If	 you	 do	 not	 have	 a
production	 schedule	 that	 allows	 for	 training	 and	 retooling	 for	 different	 mediums,	 it	 will
ultimately	 sway	 the	 medium	 choice.	 Students	 can	 relate	 to	 this	 as	 well.	 Often	 they	 find
themselves	up	against	a	project	deadline	and	opt	for	the	medium	they	are	most	comfortable
with	instead	of	experimenting	with	new	mediums.	As	a	side	note,	this	is	a	cyclical	issue:	the
medium	an	artist	puts	on	his	reel	is	more	than	likely	the	medium	he	will	get	a	job	in.	Unless
the	 artist	 finds	 himself	 on	 a	 project	 that	 has	 the	 budget	 and	 time	 to	 allow	 training	 in	 a
different	medium,	he	may	find	jobs	scarce	should	a	fad	show	animation	studios	favoring	one
medium	over	another.

Physical	Assets	and	Budget.	Having	or	not	having	 the	budget	 to	purchase	 the	physical
assets	you	need	for	a	given	medium	will	certainly	sway	what	your	production	decisions	are.
What	is	the	cost	of	a	given	medium?	Is	one	less	costly	than	another?

Physical	 asset	 costs	 for	 the	 different	mediums,	when	 compared,	 are	 varying.	 The	 cost	 of
computer	animation	software	has	steadily	made	the	software	more	accessible	to	the	general
public;	 however,	 3D	 studios	 are	 costly	 to	 set	 up	 and	 even	 more	 costly	 to	 maintain.	 Stop-
motion	or	model	animation	costs	are	close	to	that	of	traditional	2D	animation,	and	traditional
animation’s	 costs	 can	 be	 kept	 low	with	 homemade	 light	 tables	 and	 self-punched	 paper.	 As
with	any	business,	physical	asset	costs	can	be	as	little	or	as	much	as	one	wants	to	spend.

Ultimately,	 the	 largest	 cost	 is	 that	of	 time	 spent	on	 the	project	 and	 the	number	of	 artists
needed	to	complete	 the	project.	Digital	processes	have	tried	to	answer	this	“time	 is	money”
issue.	3D	studios,	theoretically,	can	recoup	part	of	their	cost	by	having	smaller	crews.	Paperless
or	 digital	 2D	 animation	 is	 slightly	 cheaper	 than	 2D	 animation	 using	 paper	 since	 the	 digital
process	saves	time	by	allowing	easy	sharing	of	art	assets	and	bypasses	the	scanning	process.

Once	 a	 studio	 is	 set	 up	 and	 running	 in	 a	 given	medium,	 adding	 another	medium	 incurs
additional	 costs.	 For	 example,	 the	 small	 studio	 that	 creates	 The	 Simpsons	 television	 series
(writing,	story,	and	keys)	in	LA	has	small	budgets	and	extremely	quick	turnarounds.	However,
they	 also	 created	 the	 larger-budget	 The	 Simpsons	 Movie.	 In	 that	 movie	 there	 was	 a	 large
amount	of	2D/3D.	Naturally,	after	that	exposure	to	3D	the	crew	began	to	incorporate	3D	more
into	 the	 television	 show.	 A	 traditional	 pipeline	 that	 has	 a	 low	 budget	 may	 be	 extremely
hesitant	to	take	on	any	different	and	possibly	expensive	technique.	Such	requests	can	certainly
concern	the	accounting	department	due	to	the	extra	expense.

What	is	the	Main	Problem	of	Combining	the	Mediums?

Once	a	decision	has	been	made	to	use	multiple	mediums,	the	problems	of	how	to	produce



the	shots	loom	large.	It	is	very	important	to	work	out	the	following	pipeline	issues	so	that	the
production	can	be	successful:

Style	matching
Registration
Frame	rate	and	image	format
Timing
Image	sizes
Alpha	channel

FIGURE	1.12	Pipeline	test	of	2D	character	walk	cycle	with	3D	head	by	Claire	Almon,	2007,	2D/3D	course,	SCAD

Style	Matching.	 During	 the	 pre-visualization	 stage	 of	 production,	 experimentation	 will
need	 to	 take	place.	Multiple	 software,	drawing	methods,	 combinations	of	 the	mediums,	and
postprocessing	 effects	need	 to	be	 compared	 to	one	 another	 to	 see	which	pipeline	will	most
easily	achieve	the	visual	style	set	 forth	by	the	art	director.	Do	you	need	to	use	vector	 lines?
Can	you	get	away	with	raster?	Can	you	do	this	procedurally?

It	is	important	that	all	experiments	be	well	documented.	What	was	the	workflow	to	get	the
artwork	 from	 the	 concept	 to	 the	 final	 render?	 Did	 it	 achieve	 the	 visual	 style?	 At	 times	 a
different	visual	 style	will	be	achieved,	one	not	 correct	 for	 the	present	project	but	useful	 for
something	 in	 the	 future.	 Other	 times	 a	method	will	 not	 work—the	 technology	will	 not	 be
advanced	enough	yet.	Sometimes	it	only	takes	a	half	a	year	for	the	technology	to	catch	up	and
for	the	next	project	you	will	have	a	half-developed	technique	that	can	be	reapplied	and	tested.

Having	 a	 small	 team	 of	 enthusiastic	 risk	 takers	 who	 are	 unafraid	 to	 experiment	 with
technology	 and	 artistic	 techniques	 with	 an	 eye	 toward	 creating	 stunning	 visual	 results	 is
necessary.	The	techniques	found	in	this	book	will	help	you	become	one	of	those	enthusiastic
risk	takers.



FIGURE	1.13	Concept	art	for	Poison	Tree,	2D/3D	group	project,	2008,	SCAD

FIGURE	1.14	Final	image	from	Poison	Tree,	2D/3D	group	project,	2008,	SCAD

Registration.	 Registration	 refers	 to	 when	 one	 object	 touches	 another	 in	 the	 scene.	 For
example,	when	the	2D	character	Hogarth	climbs	into	the	3D	robot’s	hand	in	The	Iron	Giant;
where	they	make	contact	is	the	registration	line.	In	the	past,	having	a	3D	object	contact	a	2D
object	was	a	large	registration	issue	that	was	nearly	impossible	to	overcome.	3D	objects	had	to
be	printed	out	and	pegged	onto	animation	paper.	This	process	is	error	prone	the	moment	the
printer	 spits	out	 the	 first	page.	The	printer	 itself	does	not	print	a	well-registered	 image;	 the
pegging	process	cannot	be	perfect	enough.	The	2D	animator	must	register	his	2D	art	 to	this
wobbly	reference	image.	This	method	is	what	was	used	on	Mulan,	Lilo	&	Stitch,	and	countless
other	animated	films.	With	dedication	to	detail	it	is	possible	to	produce	well-registered	images
this	way,	though	this	method	is	very	difficult.	Technology	has	advanced	and	now	that	Wacom
tablets,	 Cintiq	 tablets,	 and	 paperless	 animation	 have	 arrived,	 the	 printing	 pipeline	 for
registration	is	no	longer	necessary	(unless	you	have	budgetary	issues).

However,	even	with	the	introduction	of	the	Cintiq	and	Wacom	tablets,	registration	is	still	an



issue	that	can	belittle	the	2D/3D	compositing	efforts.	If	the	artists	are	careless	in	regard	to	the
registration	lines,	in	other	words	if	the	artists	have	sloppy	draftsman-ship,	all	the	technology	in
the	world	cannot	save	the	shot.

Each	combination	of	elements	requires	a	different	pipeline	 to	obtain	 the	best	 registration.
Depending	on	which	element	“leads	the	movement”	in	each	shot,	the	3D	element	will	have	to
be	drawn	first	or	the	2D	element	will	have	to	be	drawn	first.	 In	the	coming	chapters,	as	we
cover	the	common	combinations	of	the	mediums,	we	will	also	highlight	the	pipeline	needed
for	proper	registration.

FIGURE	1.15	Example	of	2D	character	registering	with	3D	character	by	Candice	Ciesla,	2007,	2D/3D	course,	SCAD

Frame	Rate	and	Image	Format.	It	seems	like	a	small	issue,	and	it	is	often	overlooked	in	a
small	 studio	 or	 on	 student	 films.	 When	 combining	 different	 mediums,	 especially	 across
multiple	software	packages,	it	is	extremely	important	to	agree	on	the	frame	rate	that	will	be
used	 and	 in	 what	 format	 the	 images	 will	 go	 through	 the	 pipeline.	 For	 example:	 if	 a	 2D
character	 is	 drawn	 and	 pencil	 tests	 are	 done	 at	 24	 frames	 per	 second,	 the	 animation	 is
approved,	and	a	reference	.avi	file	is	made,	then	that	animation	is	brought	into	a	3D	software
package	for	the	3D	animator	to	create	the	octopus	arms	that	are	to	attach	to	the	2D	character,
then	 the	3D	animator	should,	obviously,	use	 the	same	frame	rate	as	 the	2D	animator.	 Is	 the
.avi	file	that	he	is	referencing	actually	24	frames	per	second?	Did	the	3D	animator	remember
to	set	his	playback	settings	to	24	fps	or	is	he	on	30	fps?	Pipeline	tests	need	to	check	that	image
formats	maintain	constant	frame	rate	and	image	size	throughout	the	production.	All	of	these
topics	 that	we	 cover	will	 save	 unnecessary	 redos	 of	 scenes	 due	 to	 animation	 not	matching
properly.



Timing.	Anyone	who	has	 ever	 animated	a	 character	holding	a	 coffee	 cup	 (or	 something
similar),	even	in	a	single	medium,	knows	that	 it	 is	difficult	 to	make	sure	that	the	coffee	cup
moves	in	sync	with	the	hand.	In	traditional	animation	the	cup	is	on	a	separate	piece	of	paper
and	the	animator	has	access	 to	the	timing	chart	or	x-sheet	and	knows	where	the	keyframes
are	and	what	type	of	timing	was	used.	She	can	match	similar	keyframes	and	timing	to	the	cup
level.	An	example	of	this	technique	is	depicted	in	Figure	1.16.	 If	 the	same	type	of	animation
were	to	be	done	in	3D,	then	constraints	could	be	used	to	help	simplify	the	issue.

FIGURE	1.16	Example	of	multiple	2D	elements	registering

Any	student	who	has	tried	to	animate	a	hand-held	object	 in	3D	without	using	constraints
should	instantly	cringe	at	how	difficult	 it	 is	to	match	the	timing.	This	is	what	happens	when
multiple	mediums	are	combined—the	timing	must	be	matched	frame	by	frame.

In	order	to	do	this,	it	is	easiest	to	know	where	the	keyframes	(extremes)	are	and	what	type
of	timing	is	being	used.	In	the	case	of	a	traditional	character	leading	a	digital	character,	are	the
2D	 character’s	 inbetweens	 on	halves?	Thirds?	Held?	This	 is	 not	 an	 issue	 if	 the	 animation	 is
completely	 done	 on	 ones	 (every	 frame	 is	 drawn);	 however,	 this	 is	 not	 commonly	 done.
Maintaining	an	x-sheet	and	some	style	of	timing	chart	is	the	solution	to	this	problem.

X-sheets	or	dope	sheets	can	be	found	in	countless	“how	to	animate”	books.	They	are	rarely
used	in	3D,	which	makes	the	inclusion	of	them	in	a	2D/3D	animation	process	alien	to	the	3D
animators.

Timing	 charts,	 the	 chart	 drawn	 on	 a	 traditional	 keyframe	 that	 communicates	 to	 the



inbetweener	how	to	space	the	inbetweens	he	must	draw,	is	another	traditional	technique	that
is	 not	 used	 by	 3D	 animators.	 This	 might	 be	 the	 hardest	 of	 all	 concepts	 to	 apply	 to	 your
pipeline.

It	 is	possible	to	combine	2D	and	3D	without	timing	charts	and	x-sheets.	The	use	of	them,
however,	will	make	it	less	painstaking.	As	with	all	of	the	previous	concepts,	we	will	take	care
to	answer	this	issue	and	its	different	variations	in	the	upcoming	chapters.
Image	Sizes.	The	next	to	last	concept	that	must	be	resolved	for	a	2D/3D	pipeline	is	that	of

image	 sizes.	 Because	 scanned	 images,	 rendered	 images,	 digitally	 drawn	 images,	 and	maybe
even	 still	 photography	 are	 to	 be	 combined,	 in	 order	 for	 them	 to	 register	 properly	 you	will
need	to	make	sure	that	you	are	using	the	same	pixel	ratio	and	have	agreed	on	resolution	and
image	sizes	for	your	pipeline.	Again,	this	issue	might	seem	obvious	to	a	solo	artist.	However,
on	 a	 group	 project	 nothing	 is	 too	 trivial	 to	 outline.	Often	 there	 are	 different	 file	 sizes	 used
throughout	 the	 production	 to	 speed	 up	 workflow.	 For	 example,	 in	 the	 rough	 stages	 of
animation,	 reference	 images	 need	 not	 be	 at	 full	 res	 size—	 that	 will	 only	 slow	 down	 the
software	 package	 being	 used	 and	 transfer	 of	 images	 between	 artists.	 Finding	 ways	 to	 use
smaller	 res	 sizes	 (all	 at	 the	 correct	 ratio	 so	 that	 registration	 stays	 consistent)	 will	 increase
productivity.	In	production	there	might	be	three	file	sizes	used;	depending	on	the	studio	there
may	be	more.
Final	Res:	The	final	render	of	animation	assets	that	are	then	composited	together.	(Example:

1280	X	720,	image	ratio	1:77,	pixel	ratio:	1)
Mid	Res:	Used	 for	 double-checking	 registration	 and	 getting	 animation	 approved.	 (Example:

960	X	540,	image	ratio	1:77,	pixel	ratio:	1)
Low	Res:	Used	for	initial	scans	and	rough	animation.	This	allows	for	memory	savings	and	ease

of	use	in	3D	animation	packages	as	reference.	(Example:	512	X	288,	image	ratio	1:77,	pixel
ratio:	1)

Alpha	 Channel:	 While	 considering	 how	 to	 send	 images	 back	 and	 forth	 to	 the	 different
software	 packages,	 a	 complete	 production-stopping	mistake	 is	 to	 fail	 to	 consider	 alpha
channels.	 Because	 you	 will	 be	 compositing	 elements	 from	 one	 software	 package	 over
elements	 in	 other	 software	 packages,	 at	 every	 step	 you	will	want	 auto-generated	 alpha
channels	 that	 are	 of	 good	 quality.	 An	 alpha	 channel	 is	 a	 grayscale	 image	 that	 tells	 the
computer	which	parts	of	the	picture	are	transparent	or	opaque.

To	 recap,	once	 the	pipeline	 for	 reaching	a	visual	 style	 is	achieved,	 then	 it	 is	decided	how
assets	will	go	 through	 the	pipeline	 to	accomplish	 the	best	 registration	based	on	which	asset
needs	 to	 be	 created	 first.	 Then	 a	 test	 is	 needed	 to	 make	 sure	 that	 the	 image	 sizes,	 alpha
channels,	as	well	as	frame	rate	and	image	format	all	flow	through	the	pipeline	and	end	up	into
a	final	image	that	is	successful.



Judging	the	Success	of	2D/3D	Integration

There	are	a	lot	of	things	to	consider	when	combining	2D	and	3D	animation.	After	working
through	the	chapters	in	this	book,	you	should	be	well	on	your	way	to	having	mastered	some
of	the	previous	considerations.	How	do	you	know	if	you’ve	done	it	successfully?

When	researching	for	this	book,	students	and	colleagues	brought	example	after	example	of
2D/3D	 combinations	 to	 add	 to	my	 growing	 list	 of	 films.	 Looking	 through	 all	 of	 them,	 one
might	 find	 that	 there	 is	 one	measure	 that	 determines	whether	 the	 2D/3D	 combination	was
successful	or	not.	As	all	hard-working	visual	entertainment	specialists	know	(be	they	editors,
VSFXs,	compositors,	animators,	texture	artists,	lighters—any	of	us),	our	work	is	successful	if	it
is	invisible.	If	our	visual	style	creates	a	homogeneous	image	that	conveys	the	emotion	of	the
story,	if	our	registration	is	executed	well	and	the	contact	points	don’t	wiggle,	if	our	animation
timing	is	accurate	and	our	media	move	well	together,	if	our	work	is	not	visible	and	if	the	story
is	told	without	interruption,	then	our	efforts	have	been	successful.

FIGURE	1.17	Stop-motion	test	with	digital	head	replacement	by	Chris	Ellis,	2006,	2D/3D	course,	SCAD

Need	to	know	More?

In	the	bonus	online	material	for	this	chapter	you	will	find	the	following:



1.	 Storybeats	and	bull’s-eyes,	which	includes:
Topic	Review	of	many	topics	that	are	often	referred	to	in	this	text

Hitting	the	emotional	target
Storybeats
Visual	storytelling.

Hands-On	Exercise	 that	creates	a	story	based	on	the	bull’s-eye	method	covered	 in
the	topic	overview	and	then	begins	to	assign	the	best	mediums	needed	to	support
the	story.

2.	 Chapter	 One	 Project,	 which	 contains	 a	 research	 project	 for	 students.	 (Insert	 evil
professor	laugh	here.)

3.	 Pipelines	 and	Moments—an	 extra	 chapter	 dedicated	 to	 research	 and	 development
methods	that	support	creating	a	worthwhile	story	with	a	strong	visual	aesthetic.	(This
is	found	with	Chapter	2’s	companion	data.)

Hybrid	animation	examples	(to	name	a	few):

Ghost	in	the	Shell	1995
Princess	Mononoke	1997
Prince	of	Egypt	1998
Mulan	1998
The	Iron	Giant	1999
Tarzan	1999
Cowboy	Bebop	1999
Titan	A.E.	2000
El	Dorado	2000
Spirit:	Stallion	of	the	Cimarron	2002
Lilo	&	Stitch	2002
Treasure	Planet	2002
Brother	Bear	2003
The	Triplets	of	Belleville	2003
Steamboy	2004
Mushishi	(episode	1)	2005
The	Simpsons	Movie	2007
Family	Guy:	Blue	Harvest	2007
Futurama	1999–2009
Waltz	with	Bashir	2009
Berserk	Golden	Age	Arc	2013
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3D	Character	Leads	2D	Character

FIGURE	2.1	2D/3D	compositing	example	by	Candice	Ciesla,	2008,	SCAD

Lecture	Notes

This	 chapter	 explores	 having	 a	 2D	 character	 and	 a	 3D	 character	 interacting	 with	 one
another.	We	examine	the	most	important	method	of	eliciting	an	emotional	response	from	the
audience,	which	is	by	including	touch	in	our	characters.	The	characters	must	touch	both	each
other	 and	 themselves.	 The	 issues	 that	 need	 to	 be	 resolved	 are	 registration,	 timing,	 and	 line
look.	How	do	we	make	characters	drawn	in	different	media	look	like	they	are	touching	and
make	the	line	quality	of	the	characters	look	like	they	match?



Industry	Examples

Let’s	take	a	look	at	some	memorable	scenes	that	have	shown	the	interaction	between	two
characters	who	happened	to	be	of	different	media.

Warner	Brothers’	The	 Iron	Giant	 is	one	of	my	 favorites.	 It	 is	one	of	 the	 first	 films	 in	my
memory	 to	 successfully	present	 two	 characters	 interacting	who	happened	 to	be	of	 different
mediums.	The	giant	was	a	natural	for	3D	given	its	rigid	nature	and	complexity.	Remember	the
ideas	of	 line	mileage	and	complexity	 from	Chapter	1?	The	 giant	has	 a	high	 amount	 of	 line
mileage	that	would	have	been	difficult	to	animate	in	2D	and	keep	the	rigid	nature	as	well.

Another	 example	 of	many	 2D/3D	 accomplishments	 is	 Disney’s	Treasure	 Planet.	We	 will
look	at	Treasure	Planet	more	in	this	book,	because	so	much	was	accomplished	technically	in
that	film.

These	might	seem	like	“old”	films.	There	are	plenty	of	other	film	examples	out	there.	The
industry	films	we	look	at	in	these	chapters	had	large	budgets,	lots	of	artists,	and	pulled	off	the
combining	of	 the	media.	We	can	 learn	a	 lot	 from	the	 techniques	 that	 the	animators	had	 the
time	and	money	 to	 come	up	with.	The	 challenges	 in	 the	pipeline	are	 still	 the	 same,	 though
some	tools	have	evolved	to	make	the	process	easier.

Emotion

I	spend	a	lot	of	time	driving	and	keep	a	portable	DVD	player	in	my	truck.	While	driving,	I
listen	to	movie	commentary	and	lectures	I	have	recorded	at	work.	(I	can	stand	no	time	being
wasted—	even	driving.)	One	day	I	found	myself	listening	to	a	lecture	by	Bob	Nicoll	(Dean	of
Blizzard	 University).	 His	 lecture	 was	 on	 “Emotions	 in	 Animation.”	 He	 would	 play	 for	 the
audience	a	clip	from	Dumbo,	where	Dumbo	goes	to	see	his	 jailed	mother.	 It	 is	a	bittersweet
meeting	 between	mother	 and	 son,	 underscored	 by	 a	mournful	 song.	When	 the	 clip	 ended,
Nicoll	 asked	 the	 audience	what	 they	 remembered	most	 from	 the	 clip.	Most	 often	 someone
would	comment	on	the	touching	between	the	two	characters.	To	see	two	characters	touch	stirs
strong	emotions	in	us.

I’ll	take	it	even	one	step	further.	Just	by	listening	to	the	clip	(I	was	not	even	watching	it—I
was	 driving;	 I	 keep	 the	 DVD	 player	 nearly	 closed	 to	 avoid	 temptation),	 I	 could	 mentally
visualize	the	sequence.	While	listening	to	the	clip,	I	found	myself	thinking	about	my	kids	and
wondering	 if	 I	 had	 been	 too	 harsh	 or	 too	 distracted	 with	 them	 the	 night	 before.	 I	 caught
myself	and	wondered	why	I	was	thinking	about	the	kids.	I	realized,	of	course,	that	Bob	Nicoll
was	 right.	The	clip	of	Dumbo	and	his	mom,	punctuated	by	 the	 touch,	had	connected	 in	my
brain	 to	 the	 strongest	 of	 emotions,	 which	 centers	 around	 my	 kids.	 Sure	 enough,	 I	 started



thinking	of	them,	which	in	turn	stirred	more	emotions.
Bingo.	That	is	the	way	we	get	audiences	to	feel	emotions—we	must	connect	to	a	memory

they	 have	 in	 their	 heads.	 (My	 students	 are	 cringing.	 They	 think	 I’m	 going	 to	 talk	 about
neuroscience.	 I	 promise,	 I’ll	 hold	myself	 back.)	You	might	have	heard	 that	 a	 large	memory
trigger	is	smell.	Well,	that	one	is	out	for	now.	With	Smell-O-Vision	aside,	we’ll	have	to	look	to
another	large	sense	that	we	use—touch.	We	touch	our	faces,	wring	our	hands,	hug	our	bodies;
we	do	all	sorts	of	self-touch	to	convey	to	others	how	we	feel.	We	also,	based	on	culture,	touch
others	to	convey	friendship,	intimidation,	love,	and	a	host	of	other	emotions.

This	 is	 our	 first	 task	 to	 undertake	 when	 combining	 2D	 and	 3D	 animation.	 We	 have	 to
master	how	to	have	our	characters	touch.

Dig	Deeper

You	can	indeed	dig	deeper	into	why	and	how	emotions	connect	in	our	brains.	My	favorite
book	on	this	subject	is	Joseph	LeDoux’s	Synaptic	Self.	This	 is	 the	only	 time	 I’ll	mention	 it;	 I
swear.

FIGURE	2.2	Touch	between	characters,	by	Claire	Almon,	2007,	2D/3D	compositing	course,	SCAD



Hands-On	Examples

The	 following	 section	 will	 finally	 let	 us	 get	 into	 putting	 together	 a	 scene.	 While	 going
through	this	hands-on	portion,	we	will	cover	some	of	the	pipeline	issues:	registration,	timing,
and	 line	 look.	We	 will	 also	 look	 at	 various	 ways	 to	 combine	 2D	 animation	 on	 top	 of	 3D
images.	From	these	methods	you	can	find	what	fits	your	pipeline	best	or	come	up	with	one	of
your	own.

Who	Leads?

In	the	first	scene	we	will	do,	a	small	character	climbs	into	the	hand	of	a	larger	character	and
is	lifted.	You	can	use	The	Iron	Giant	as	your	reference.	The	first	question	to	ask,	then,	is,	“Who
leads?”	 In	 other	 words,	 whose	 movement	 is	 moving	 the	 other?	 In	 this	 case,	 the	 larger
character	will	be	lifting	the	smaller	character;	therefore,	the	larger	character	leads.	Which	one
is	which	medium?	The	boy	character	will	be	2D	and	the	robot	character	will	be	3D.	So	in	this
case,	3D	will	lead	2D.



FIGURE	2.3	3D	leads	digital	2D	pipeline

This	 pipeline	 has	 2D	 animation	 being	 done	 digitally.	 This	means	 using	 Photoshop,	 Flash,
Toon	Boom,	and	so	on:	software.	You	can	draw	with	a	Wacom	tablet	or	use	a	Cintiq	tablet.	It
isn’t	 advisable	 to	 think	 about	 2D	 animating	 with	 a	 mouse.	 I’m	 sure	 it	 can	 be	 done,	 but	 I
wouldn’t	want	to	do	it.

What	if	you	do	not	have	a	fancy	Wacom	tablet	and	need	to	draw	the	2D	on	paper?	Then
you	would	 need	 to	 print	 the	 3D	 animation,	 peg	 it	 up,	 and	 use	 it	 as	 reference	 for	 your	 2D
animation.	It	is	a	cheap	pipeline,	but	it	instantly	causes	registration	issues	at	the	printing	stage.
The	3D	character	is	printed	onto	paper.	That	paper	is	hand-pegged,	meaning	someone	sits	at	a
light	table,	lines	up	crosshairs	that	were	printed	on	the	animation,	and	tapes	a	peg	strip	at	the
bottom	of	 the	page.	One	by	one	 each	page	 is	 pegged	up.	A	pencil	 test	 is	 shot	 to	 see	 if	 the
pegging	process	was	acceptable.	Then	the	animator	can	begin	to	animate	using	the	3D	images
as	 reference.	Once	 completed,	 the	 2D	 animation	 needs	 to	 be	 scanned	 back	 in	 to	 composite
with	the	3D	animation.



FIGURE	2.4	3D	leads	traditional	paper	2D	pipeline

Take	Note

Beware.	The	printing	and	scanning	process	adds	more	time	to	your	pipeline	and	most	likely
introduces	bad	registration	between	your	2D	and	3D	characters	unless	absolute	care	is	given
to	the	pegging	process.

You	might	ask,	“What	if	the	order	were	reversed?	What	if	the	boy	character	was	3D	and	the
robot	 character	was	 2D?”	 Then	we	would	 need	 to	 use	 a	 pipeline	where	 2D	 leads	 3D.	 I’ve
added	the	option	of	the	2D	being	traditional	paper	or	digital.	When	traditional	paper	2D	leads,
it	isn’t	as	problematic	unless	the	last	stage	of	tweaking	2D	to	3D	is	needed.	In	that	case,	there
would	be	a	printing	and	pegging	of	the	3D	assets	and	possible	registration	issues.



FIGURE	2.5	2D	leads	3D	pipeline

In	 scenes	where	one	character	 is	definitively	 leading	 the	other	one,	 it	 is	an	easy	pipeline.
However,	what	if	this	scene	was	a	dance	or	a	fight	between	characters?	What	if	they	had	to
tango?	That	would	take	more	coordination	between	animators.	More	than	likely	one	animator
would	 lead	 and	 rough	 in	where	 he	 or	 she	 expected	 the	 other	 character	 to	 be.	 The	 second
animator	would	then	take	over	and	match	where	the	first	animator	indicated	the	character	to
be.	 If	 there	were	 any	 discrepancies,	 there	would	 have	 to	 be	 a	 back-and-forth	 between	 the
animators.

Any	time	the	animation	goes	from	one	animator	back	to	the	other	for	tweaking,	it	can	be
considered	a	redo.	It	costs	extra	time	and	usually	worries	the	art	production	manager.	It	is	the
first	part	of	 the	pipeline	to	be	avoided.	That	does	mean	that	usually	each	animator	has	only
one	 shot	 to	 get	 the	 acting,	 registration,	 and	 timing	 correct	 and	 hope	 it	 matches	 to	 the
character’s	 animation.	However,	 if	 it	 is	 an	 “A”	 scene	 (a	 scene	 that	 is	 very	 important,	 like	 a
moment	 scene	 with	 high	 emotion	 and	 story	 importance)	 or	 a	 scene	 where	 no	 discernible
character	leads	the	other,	then	the	redos/tweaking	should	be	allowed	(within	reason)	to	make



sure	the	animation	is	acceptable.

Take	Note

Remember,	any	tweaking	between	media	means	much	more	time	will	be	needed	to	finish
the	scene.	Factor	that	in	when	you	are	budgeting	time	for	your	personal	films.

We’ll	take	a	look	at	some	different	software	usage.	What	if	you	don’t	have	the	software	we
use	in	this	book?	Here	are	the	steps	in	general	terms	so	that	you	can	apply	them	to	whatever
software	you	do	have	in	your	toolbox.

1.	 Animate	your	3D	character;	on	twos	is	best.
2.	 Create	a	3D	stand-in	that	will	serve	as	a	reference	for	the	2D	animator.
3.	 Render	the	3D	character	with	an	alpha	channel	as	an	image	series.
4.	 Render	the	3D	stand-in	character	with	an	alpha	channel	as	an	image	series.
5.	 Import	 the	 3D	 character	 and	 the	 stand-in	 layers	 into	 a	 drawing	 package	 of	 your

choice	or	print	and	peg.
6.	 Animate	 the	 2D	 character	 using	 the	 stand-in	 character	 as	 a	 guide.	 Note	 the

registration	points	between	the	2D	character	and	the	3D	character.
7.	 Render,	 export,	 or	 scan	 your	 2D	 animation	 as	 an	 image	 series	 or	 raw	 .mov	 to

maintain	alpha	channel.
8.	 Composite	the	characters	 together	and	create	the	final	movie	file	 in	the	package	of

your	choice.
9.	 Enjoy	your	success.

3D	Leads	2D:	Animating	a	3D	Character	with	a	3D	Stand-in
Using	Maya

This	hands-on	tutorial	will	walk	you	through	the	technical	steps	of	animating	our	robot	rig,
creating	a	 stand-in	3D	object	 for	our	2D	character,	 and	constraining	 it	 to	 follow	 the	 robot’s
hand.	 Then	 you	 will	 bring	 the	 levels	 into	 a	 2D	 raster	 paint	 program	 to	 animate	 the	 2D
character.



FIGURE	2.6	Our	goal	for	this	exercise	by	Chelsey	L.	Cline

1.	 Create	 a	 project.	 Start	Maya	 and	 create	 a	new	project	 for	 this	 lesson.	 Select	File	 >
Project	Window….	In	that	window,	click	New.	Give	it	a	name	and	a	location	where
you	will	 have	plenty	 of	 disk	 space.	Keep	 the	default	 folder	 settings,	 and	 then	 click
Accept.	 (Students,	do	not	save	directly	to	your	flash	drives.	Use	the	local	drive	and
back	up	to	your	network	folder	and	flash	drives	at	the	end	of	your	day.)

Take	Note

You	never	want	to	think	about	losing	data,	and	it	happens	to	the	best	of	us.	A	good	rule	that
I	use	 for	 important	projects	 is	 to	keep	 things	 local.	Back	up	 to	a	 flash	drive	daily.	Keep	 the
flash	 drive	 away	 from	 your	 computer.	 Back	 up	weekly	 to	 a	 network	 site	 (such	 as	 FTP	 or
Dropbox)	in	another	state/weather	pattern.



Take	Note

Maya	will	happily	save	your	file	even	if	your	computer	or	home	directory	has	run	out	of
disk	space.	 It	will	not	even	complain.	You	won’t	know	you	have	run	out	of	disk	space	 (and
have	corrupted	files)	until	the	next	time	you	open	your	scene.	No	amount	of	backups	will	save
you	from	that!

2.Open	 the	 file.	 Open	 our	 robot	 rig.	 File	 >	 Open	 Scene	 …	 locate	 the	 rig
Robby_3DLeads2D_1.ma,	and	click	Open.

3.Select	the	character	set	mode.	 In	the	bottom	right-hand	corner,	select	the	character	set
for	this	rig:	Robby.	This	allows	you	to	set	keyframes	and	not	worry	about	having	the
controls	selected.	If	you	are	familiar	with	animating	without	character	sets,	feel	free	to
do	so.	We	will	use	character	sets	in	this	book.	When	the	red	arrow	is	on,	you	are	using
character	sets	to	animate.

4.Animating	to	the	camera.	Because	we	have	a	camera	set	for	this	scene,	we	will	use	it	to
check	 our	 silhouettes.	 In	 the	 perspective	 window,	 click	 Panels	 >	 Perspective	 >
Render_Cam.	Do	not	move	this	camera.	It	is	important	to	keep	the	rendering	camera
still	during	the	animation	process.	Instead,	we	will	set	it	aside	so	that	we	can	animate
to	the	camera.	Animating	to	the	camera	means	animating	in	the	perspective,	top,	front,
and	side	window	with	the	ability	to	orbit	around	and	looking	at	the	Render_Cam	to
make	 sure	 the	 poses	 read	well.	 Choose	Panels	 >	Tear	Off	Copy.	 Now	 you	 have	 a
free-floating	panel	of	your	render	camera.	Resize	it	and	place	it	so	that	it	is	out	of	the
way	but	 still	 visible.	 (For	 those	 fortunate	 animators,	 place	 the	panel	 on	your	 second
monitor.)	In	the	Render_Cam	panel,	choose	the	following	items	so	that	you	can	get	a
clean	silhouette	view:

a.	 Under	 Show,	 hide	 everything	 but	 the	 geometry.	 Make	 sure	 to	 check	 off
Manipulators.

b.	 Press	the	7	key	on	the	keyboard.	That	puts	you	in	lighting	mode.	Because	we
have	no	lights,	your	scene	character	should	be	in	complete	silhouette.



FIGURE	2.7	A	torn-off	Render_Cam	panel,	which	we	will	use	to	check	our	silhouettes	as	we	animate	in	the

Perspective	view

5.Animate.	Now	you	are	ready	to	animate	the	hand	so	that	it	starts	at	the	bottom	of	the
frame	 and	 lifts	 up	 to	mid-chest	 level.	 Our	 animation	 lasts	 18	 frames.	 You	 can	 open
Robby_3DLeads2D_2.mb	for	an	already	animated	version	of	Robby.

6.Set	frame	rate.	What	frame	rate	will	you	animate	in?	You	need	to	make	sure	the	time	is
correct	 and	 stays	 constant	 throughout	 the	 production.	 In	 other	 words,	 right	 here	 is
where	 you	 can	 mess	 things	 up!	 Take	 a	 moment	 and	 set	 the	 frame	 rate	 in	 the
Animation	Preferences	window,	under	Settings	 >	Time	 Slider	 >	 Playback	 Speed.
Ours	is	set	to	Real-Time	[24	fps].	At	each	step	of	the	pipeline,	we	will	need	to	make
sure	this	is	our	frames	per	second.	(Use	the	Help	function	if	you	can’t	find	the	icon	for
the	animation	preferences	window.	Yes,	this	was	a	test.)



FIGURE	2.8	Keyframes	of	animated	Robby	hand

7.Import	2D’s	3D	stand-in.	Now,	 import	 in	 the	2D	character’s	3D	stand-in.	Click	File	 >
Import	…	and	find	the	file	Roy_3DLeads2D_Standin.ma.	Click	Import.	Roy	appears
at	the	origin,	beneath	the	robot.	In	the	Perspective	view,	orbit	around	to	see	him.

8.Constrain	stand-in	to	follow	the	hand.	The	stand-in	character	is	a	small	rig	itself,	able	to
be	animated	 in	a	 limited	 fashion	as	reference	 for	 the	2D	animator.	You’ll	notice	Roy
has	a	few	controls	to	move	his	arms,	legs,	head,	hips,	and	chest.	There	is	also	a	small
circle	at	his	bottom	titled	PLACE_ME.

a.	 Go	 to	 frame	one.	 Select	 Roy’s	 “Place_Me”	 controller.	 Translate	 and	 rotate
Roy	into	place	in	Rob	Robot’s	open	hand.

b.	 To	 make	 Roy	 follow	 Rob	 Robot’s	 animated	 hand,	 select	 Rob	 Robot’s
“Attach_Here”	control	(on	the	animated	hand),	hold	shift,	then	select	Roy’s
“Place_Me”	control.	Both	controllers	should	be	selected.	“Attach_Here”	will
be	white,	 and	 “Place_Me”	 should	 be	 green.	 This	 indicates	 that	 “Place_Me”
was	selected	last.



FIGURE	2.9	Roy	stand-in	put	in	Rob	Robot’s	hand	for	frame	1

Take	Note

FIGURE	2.10	Select	“Attach_Here”	and	“Place_Me”	(Driver—	Driven),	then	parent-constrain	the	objects	together

When	you	 constrain	 objects,	 the	 order	 in	which	 you	 select	 things	 is	 very	 important.	 You
select	them	as	Driver—Driven.	You	can	select	objects	to	be	constrained	to	other	objects.	In	this



case,	we	had	rigs	with	attaching	controls	that	we	used.	If	you	like	rigging,	check	out	my	other
book	Rig	It	Right!

c.In	the	Animation	menu,	select	Constrain	>	Parent	(option	box).
d.The	 default	 settings	 are	 just	 fine	 (you	 can	 click	 edit	 >	 rest	 settings	 to	 get	 default

settings).	It	is	important	that	Maintain	Offset	is	on.
e.Click	Add.

9.See	Roy	move	 in	Rob	Robot‘s	hand.	 Scrub	 through	 or	 play	 the	 animation	 to	 see	 that
Roy’s	3D	stand-in	does	indeed	sit	in	Rob	Robot’s	hand	throughout	the	animation.

10.To	aid	the	2D	animator,	add	a	few	keyframes	for	Roy.	Remember	to	not	overlap	the
robot	over-top	of	Roy	in	this	animation.	That	would	complicate	our	composite.	We’ll
get	to	that	technique	later.

11.Save	 your	 file.	 If	 you	 wish	 to	 see	 our	 completed	 file	 from	 this	 tutorial,	 view
Robby_3DLeads2D_3.mb.

FIGURE	2.11	Roy	now	moves	in	Rob	Robot’s	hand

Ones	or	Twos?

3D	 animators	 might	 not	 think	 of	 this	 at	 first.	 2D	 animators	 will	 ask	 this	 question
immediately.	 2D	 is	 normally	 drawn	 on	 twos.	 This	means	 that	 every	 frame	 is	 held	 for	 two
frames.	Why?	There	is	less	to	draw.	Drawing	something	on	ones,	or	a	drawing	for	every	single
frame	of	 film,	makes	 for	very	subtle	movement	and	 it	 is	difficult	 to	keep	 the	2D	animating
smoothly.	 It	 can	be	done.	Certainly	 there	 are	 those	who	have	used	 a	 style	 of	 animating	on
ones—Richard	 Williams,	 for	 example.	 There	 are	 also	 times	 when	 you	 need	 to	 put	 the
animation	on	ones,	such	as	when	the	movement	is	very	fast.	As	a	2D/3D	animator,	you	will
want	the	ability	to	at	least	be	able	to	put	everything	on	twos	and	at	most	be	able	to	control
when	things	are	on	twos	and	when	things	are	on	ones.

There	 are	many	methods	 to	 convert	 your	 animation	 in	 3D	 to	 be	 on	 twos.	 You	 can	 do	 it
manually	in	the	graph	editor	after	all	of	your	animation	is	done;	you	will	do	this	by	inserting



keys	on	every	other	frame	and	using	stepped	inbetweens	between	the	keys.	Although	that	is
fine,	it	can	make	it	difficult	to	go	back	and	adjust	your	animation.

Gregg	Azzopardi,	one	of	 the	 technical	 editors	of	 this	book,	 suggested	 this	method	 to	me.
There	is	a	script	that	can	be	found	on	Creative	Crash	called	twos.mel.	It	was	written	by	Jason
Schleifer.	Schleifer	 is	such	a	great	brain	in	the	rigging	for	animation	field.	Enclosed	with	the
companion	data	for	this	book,	you	will	find	a	modified	version	of	the	script	that	works	with
the	usage	in	this	chapter.

Install	the	Script

To	 use	 this	 script,	 you	 will	 want	 to	 copy	 the	 twos.mel	 script	 into	 your	 scripts	 folder.
Generally	this	is	in	your	home	directory,	maya/XXXX/scripts.	Substitute	the	version	of	Maya
you	are	using	for	XXXX.

Restart	 Maya,	 or	 if	 Maya	 is	 already	 open	 you	 can	 type	 rehash	 in	 the	 command	 line.
(Remember	to	hit	Enter	on	the	keyboard.)

Mac	users,	your	scripts	folder	is	in	the	Library	folder,	which	is	hidden	in	newer	versions	of
Mac	OS.	 In	the	finder,	Option	Click	on	the	Go	menu	to	open	the	 library	 folder.	The	scripts
folder	you	are	 looking	for	 is	here:	 /Users/YOU/Library/Preferences/Autodesk/maya/201X-
XX/scripts.

Use	the	Script	on	Character	Sets

If	you	are	using	character	sets	 to	animate,	 like	we	used	 in	the	example	files,	 follow	these
steps:

1.	 Select	the	character	set	in	the	outliner.
2.	 In	the	command	line,	type	twos	and	hit	enter	on	the	keyboard.

It	 will	 take	 a	 moment	 as	 the	 script	 goes	 through	 all	 of	 the	 animated	 attributes	 in	 your
character,	checks	them,	and	then	adds	a	node	that	controls	the	animation	curves	and	sets	them
to	run	only	on	twos.	The	script	will	then	prompt	you	to	add	the	following	line	on	your	shelf:
select-r	timeOnTwos.	If	you	middle-click	on	those	words	and	drag	them	to	a	shelf,	Maya	will
create	a	button.	When	you	click	on	that	button,	 it	selects	 the	node	that	Schleifer’s	script	has
created	for	you.



FIGURE	2.12	Jason	Schleifer’s	twos.mel	script	in	action

By	default,	 the	 “by”	attribute	 is	 set	 to	2.	You	can	 simply	key-frame	 that	 to	different	 step
rates	to	enjoy	your	animation	on	twos	and	on	ones	(or	other	increments)	as	needed.

When	you	play	back	your	animation	in	Maya	and	look	at	the	timeline	or	graph	editor,	you
will	notice	that	everything	still	looks	the	same.	This	script	does	not	interrupt	your	animation
process	 or	 the	 sweetening	 process	 at	 all.	 (Those	 wearing	 geek	 hats	 can	 check	 out	 the
Hypergraph	Connections	editor	to	see	the	node	and	math	expression	that	Schleifer	has	created
to	make	this	as	seamless	as	possible.)

If	you	wanted	to	go	back	and	animate	Roy	to	use	as	reference,	maybe	just	a	few	key	poses
of	how	he	would	react	to	being	hoisted	up	into	space,	you	will	want	to	also	put	his	animation
on	twos.	Currently,	he	is	following	along	with	the	robot,	so	you	do	not	need	to	do	anything
special	to	his	timing.	If	you	did	animate	him,	you	would	want	to	go	through	the	same	steps	as
outlined	earlier:	selecting	his	character	set	and	typing	twos	 into	the	channel	box.	He	will	be
hooked	to	the	same	timeOnTwos	node	and	By	attribute.	This	is	great.	That	means	that	your
reference	object	will	stay	with	the	same	timing	as	the	robot.	That	is	one	of	the	hardest	things
to	 have	 to	 worry	 about—making	 sure	 that	 the	 2D	 animation	 has	 the	 same	 keyframes	 and
timing	as	 the	 3D.	Why?	 If	 the	 2D	animates	on	 frames	when	 the	 3D	 is	holding	 still	 (or	vice
versa),	things	start	to	wiggle	and	you	give	away	the	illusion	of	registration.

Also,	if	you	are	not	using	character	sets,	you	can	select	all	of	the	animated	controls	and	use
the	script.	The	result	will	be	the	same.

3D	Animation	is	done—Now	What?

When	 do	 we	 put	 toon	 lines	 on	 our	 animated	 characters?	When	 do	 we	 do	 the	 final	 3D



render?	When	do	we	start	animating	our	2D	character?
Good	questions.	In	a	production	setting,	you	want	to	have	your	animation	completed	(and

approved)	 first	 before	 you	 begin	working	 on	 the	 final	 look.	 Iterations	 to	 a	 quick	 approval,
adjustment,	or	a	quick	removal	are	key	to	not	wasting	time	on	production.

Because	our	3D	animation	is	complete	and	is	to	be	handed	off	to	the	2D	department,	let’s
also	hand	it	off	to	the	rendering	department.

Note:	you	will	find	an	overview	to	Maya’s	Toon	Line	usage	in	the	companion	data	of	this
book:	ChapterTwo_MayasToonLine.pdf.

3D	Leads	2D:	Toon	Fill	Shading

Here	we	will	apply	toon	shading	to	our	3D	character,	Robby.	We	are	trying	to	get	flat	color
with	 a	 little	 shading	 for	 the	 paint	 fill	 and	 a	 thick	 and	 thin	 line	 to	 match	 a	 2D	 character’s
cleaned-up	line.	Our	tutorial	2D	character	is	pretty	basic	to	get	us	started.

FIGURE	2.13	2D	character

http://ChapterTwo_MayasToonLine.pdf


FIGURE	2.14	3D	character	with	toon	line

Open	 the	 file:	 open	 the	 animation	 file	 that	 you	 saved	 or	 our	 file
Robby_3DLeads2D_3_onTwos.mb.

Fill	Shader

First,	to	work	with	our	geometry	and	put	shading	on	it,	we	will	have	to	be	able	to	select	it.
Most	modern	rigs	have	the	geometry	locked	down	so	that	the	animators	cannot	touch	it	and
harm	it	in	any	way.	(If	the	rig	isn’t	locked	down	and	the	creator	is	in	my	class,	that	is	10	points
off.)

1.	 In	 the	 Layer	 panel,	 locate	 the	 GEO	 layer	 for	 the	 robot	 and	 make	 it	 editable	 by
clicking	 on	 the	R	 (R	 stands	 for	 reference;	 the	 object	 cannot	 be	 selected).	Once	 you
click	the	R,	 it	will	become	a	T	(T	 stands	 for	 template;	 the	object	cannot	be	selected
and	 it	 is	 displayed	 as	 a	 pink	 wire	 frame).	 Click	 again	 on	 the	T	 and	 the	 box	 will
become	empty.	Now	the	contents	of	that	layer	are	editable.

2.	 In	 the	 perspective	window,	 select	 the	 robot’s	 geometry	 and	press	 the	up	 arrow	on
your	 keyboard	 to	 select	 all	 of	 the	 geometry.	 (You	 can	 also	 locate	 the	GEO	 group
node	in	the	outliner	for	the	robot.)

3.	 In	the	Rendering	area,	select	Toon	>	Assign	Fill	Shader	>	Shaded	Brightness	Three
Tone.



4.	 Click	on	the	Render	icon	to	see	what	the	fill	shader	looks	like.

FIGURE	2.15	Render	icon	is	clicked	to	see	Toon	Fill	Shader	on	Robby

Take	Note

If	you	apply	toon	fill	to	an	object	and	it	turns	out	very	chunky,	there	is	an	easy	way	to	fix	it.
Toon	fill	shaders	will	show	faceting	of	 low-poly	objects	unless	they	have	soft	normals.	With
the	mesh	selected,	go	to	the	Polygons	area	and	select	Normals	>	Soften	Edge.	Re-render	the
frame	to	see	the	better	results.

Tweak	Fill	Shader

The	nice	thing	about	fill	shaders	is	that	you	can	adjust	them	using	IPR:

1.	 Click	on	the	IPR	button,	either	 in	 the	render	window	that	you	have	open	or	at	 the



top	status	line.
2.	 When	the	render	has	completed,	follow	the	directions	found	at	the	bottom:	“Select	a

region	to	begin	tuning.”

FIGURE	2.16	IPR	allows	you	to	select	a	region	to	interactively	render	while	you	adjust	parameters

3.	 Select	 any	 of	 the	 robot	 geometry;	 open	 the	 Attribute	 Editor	 (CTRL	 +	 A);	 scroll
through	the	tabs	until	you	find	the	three-ToneBrightnessShader	tab.

4.	 The	 three-tone	 brightness	 shader	 is	 a	 ramp	 shader.	 You	 can	 click	 and	 drag	 on	 the
small	circles	to	adjust	the	threshold	that	the	colors	show	up	in.	The	rightmost	color	is
the	color	that	shows	up	where	the	light	is	the	strongest.	The	leftmost	color	shows	up
where	the	light	is	the	weakest.

FIGURE	2.17	Use	the	IPR	render	view	to	quickly	tweak	your	fill	shader	using	the	threeToneBrightnessShader	tab

5.	 Create	a	dark	gray	for	the	left	color	and	a	light	gray	for	the	right	color.	Delete	the
middle	 color	 by	 clicking	 on	 the	X.	 Let’s	 find	 a	 midrange	 color	 using	 a	 different
method	you	might	not	be	aware	of.

FIGURE	2.18	Delete	the	middle	color

6.	 Double	Click	on	the	Selected	Color	chip	and	an	expanded	Color	Chooser	window



will	open.	In	that	window,	open	the	Blend	tab.
7.	 In	 the	Blend	 tab,	 click	 on	 any	 of	 the	 four	 rectangles,	 then	 click	 on	 the	 light	 color;

repeat	for	the	dark	color	until	you	have	created	a	nice	gradient.	See	Figure	2.19	as	an
example.

8.	 Click	on	the	ramp	between	the	two	colors	and	that	will	add	a	third	color	circle.
9.	 In	 the	Blend	Tab,	 select	 a	 color	 from	 the	 blend	 area.	 It	will	 load	 into	 the	 selected

ramp	color.	For	me,	this	saves	a	lot	of	time	by	allowing	me	to	use	the	blend	feature	to
get	something	closer	that	I	can	work	with.

10.	 Click	Accept	 or	Done	 (depending	 on	 your	 version	 of	 Maya)	 to	 close	 the	 Color
Chooser	window.

FIGURE	2.19	Add	colors	into	the	Blend	tab.	(Older	versions	of	Maya	auto	load	the	selected	color	chip.	Newer	versions	give

you	an	eyedropper	cursor	to	pick	the	color.)

FIGURE	2.20	Third	color	chosen	with	the	eyedropper	tool

This	 looks	 like	 a	 good	 place	 to	 save.	 Our	 completed	 file	 is	 saved	 at
Robby_3DLeads2D_4.mb.

Toon	Line



The	next	step	is	to	put	on	a	toon	line	that	matches	the	2D	character’s	cleaned-up	line.	For
this	next	section	use	the	animation	file	that	you	saved	or	our	file	Robby_3DLeads2D_4.mb.

Toon	Line	Shader

The	geometry	should	still	be	selectable	from	earlier	in	the	lesson	when	we	applied	the	toon
fill:

1.	 Select	the	robot’s	GEO	node	in	the	outliner,	or	click	on	the	geometry	and	click	the	up
arrow	key	on	the	keyboard.	(The	robot	should	be	highlighted	green.)

2.	 In	the	Rendering	area,	select	Toon	>	Assign	Outline	>	Add	New	Toon	Outline.	 In
the	attribute	editor,	change	Line	Width	=	0.058	or	something	smaller.	(Don’t	go	too
small;	we’re	about	to	adjust	this	line	some	more.)

3.	 Scroll	 down	 and	 open	 the	 section	 for	Curvature	 Based	Width	 Scaling;	 this	 will
allow	us	to	adjust	the	thickness	of	curved	lines	versus	straight	lines.

4.	 Turn	on	the	check	box	for	Curvature	Modulation.	(Where’s	the	little	green	Marvin
Martian?	Give	me	 the	Q-36	Explosive	Space	Modulator.)	You	might	have	 to	adjust
your	global	line	width	to	make	your	lines	visible	again.

5.	 I	 find	 it	 hard	 to	 see	 the	 toon	 lines	 in	 the	 perspective	 window	 when	 they	 are
highlighted	 in	 green.	 So	 in	 the	 camera	 view	 you	 can	 select	 Show	 >	 Selection
Highlighting	to	hide	the	highlighting.

Let’s	look	at	that	curvature	width	ramp.	What	happens	when	you	move	the	curve?	It	might
take	a	little	bit	of	thought	to	figure	it	out.	It	looks	like	the	documentation	has	the	explanation
backward	(I	might	be	reading	it	wrong).	Here	is	how	I	see	it	working:

1.	 [Left]	Moving	 the	curve	 to	 the	 left	 side	of	 the	 ramp	affects	 the	 toon	 lines	 that	are
curved.

2.	 [Right]	Moving	the	curve	to	the	right	side	of	the	ramp	affects	the	toon	lines	that	are
straight.

3.	 [Top]	Moving	the	curve	to	the	top	of	the	ramp	makes	the	toon	lines	thicker.
4.	 [Bottom]	Moving	the	curve	to	the	bottom	of	the	ramp	makes	the	toon	lines	thinner.

FIGURE	2.21	Curvature	width	ramp



It	takes	some	tweaking.	If	you	get	your	curve	to	look	like	the	one	shown	in	Figure	2.22,	you
can	get	a	little	thick	and	thin	depending	on	how	curved	the	object	is,	and	the	straight	lines	are
not	as	thick	as	the	thin	ones:

1.	 In	 the	 profile	 tab,	 bring	 the	Profile	Width	Modulation	 to	 .3	 to	 overall	 adjust	 the
taper.

2.	 Adjust	the	Profile	Width	as	necessary	to	get	a	line	thickness	that	you	like.
3.	 Test	Render.

FIGURE	2.22	Snapshot	of	the	robot’s	neck	and	the	curvature	width	ramp

Creases

The	crease	in	the	front	of	the	robot’s	chest	may	not	have	a	toon	line.	Or	perhaps	there	are
other	areas	where	you	want	to	add	a	toon	line.	Let’s	see	how	to	fix	that	problem:

1.	 Your	first	instinct	might	be	to	go	to	the	crease	lines	tab,	turn	off	Hard	creases,	and
adjust	the	Crease	Angle	Min	to	see	if	you	can	dial	in	that	specific	crease	in	the	robot.



However,	 you	 end	 up	 getting	 a	 lot	 more	 creases	 that	 way,	 more	 than	 you	 want.
(Keep	bringing	that	slider	down	and	you	can	do	a	nice	wire	frame	render.)

2.	 Instead,	keep	the	option	for	Hard	Creases	on.	Go	to	edge	selection	mode	and	select
a	line	of	edges	across	the	crease	in	the	bottom	of	the	rib	cage	(Figure	2.23).

3.	 In	the	Polygon	area,	select	Normals	>	Set	Normal	Angle	…
4.	 In	the	popup	window,	bring	the	value	to	0	and	click	Apply	and	Close.
5.	 Adjust	the	Crease	Width	and	Crease	Angle	Max	as	necessary.

Figure	 2.23	 shows	 the	 visible	 crease	 at	 the	 bottom	 of	 the	 chest.	 Using	 hard	 edges	 only
allows	you	a	little	more	control	of	exactly	what	creases	are	shown.

FIGURE	2.23	The	Hard	Crease	Lines	option	is	turned	on	and	edges	in	the	chest	are	given	hard	normals,	resulting	in	a	crease

line



FIGURE	2.23A	Robot	with	toon	fill	and	hard	creases

3D	Leads	2D:	Maya	Render	Layers	and	Photoshop

We	are	ready	to	export	our	levels	of	animation.	One	level	will	be	the	Robot	Robby	and	the
second	level	will	be	our	stand-in	character.	To	render	out	separate	levels	in	Maya,	you	can	use
Render	Layers.	Setting	them	up	is	much	like	setting	up	Display	Layers.	In	fact,	be	careful	to
note	when	you	are	in	the	Display	Layer	mode	versus	the	Render	Layer	mode.	The	following	is
how	to	use	Render	Layers	in	Maya	2008	or	older	versions.	We’ll	look	at	Maya	2009	as	well.

1.	 Create	render	layers:

a.	 At	the	bottom	of	the	Channels	box	in	the	layers	area,	click	the	Render	tab.
b.	 In	the	outliner,	select	RobbyRobot,	then	click	Layers	>	Create	Layer	from

Selected.



c.	 Double-click	on	the	new	layer	(layer1)	and	name	it	Robby_Anim.	Click	on
Save.	Note:	only	the	Robby	is	visible.

FIGURE	2.24	The	Robby_Anim	render	layer	has	only	the	robot	in	it.	Everything	else	hides	(will	not

render)

d.	 Click	back	on	the	Master	layer,	and	you	will	see	everything	again.
e.	 The	toon	lines	more	than	likely	were	not	added	to	your	Robby	Layer.	Select

Rob	Robot’s	 toon	 lines,	 then	right-click	on	 the	Robby_Anim	 render	 layer
and	choose	Add	Selected	Objects.

Repeat	b	through	c	for	Roy,	the	stand-in.

f.	You	should	have	the	following	render	layers:
i.	 Master	layer—shows	everything	when	clicked.
ii.	 Robby_Anim—shows	only	the	robot	when	clicked.
iii.	 Roy_Ref—shows	only	the	stand-in	character	when	clicked.

2.	Rendering	the	images:	The	next	thing	to	do	is	to	render	out	these	images.	You	can	set
the	background	color	to	be	something	other	than	black.	The	renders	shown	in	Figure



2.26	 have	 a	 white	 background	 color.	 Background	 colors	 can	 be	 set	 in	 the	 camera
attributes.	This	does	not	affect	the	alpha	channel.

a.	 In	the	Render	Layer	window,	choose	Options	>	Option	Box	for	Render	All
Layers.

b.	 In	the	options	box	choose	Keep	Layers.	Click	Apply	and	Close.
c.	 Double-check	that	the	Render	All	Layers	is	actually	checked	on.
d.	 Open	 your	 Render	 Settings	 window.	 (Window	 >	 Rendering	 Editors	 >

Render	Settings)

FIGURE	2.25	Roy_Ref	layer	with	stand-in	character

FIGURE	2.26	Render	all	layers

We	will	use	the	following	settings:

1.	 Set	the	name.
2.	 Naming	convention	is	name.#.ext.
3.	 Number	padding	to	4.
4.	 By	 Frame	 is	 set	 to	 1	 or	 2.	 (One,	 if	 you	 want	 to	 render	 every	 frame.	 Two,	 if	 the

animation	is	on	twos	and	you	want	to	render	every	other	frame	and	save	some	time.
No	sense	in	rendering	a	frame	twice	if	it	hasn’t	changed.)

5.	 We’ll	use	.tifs.



6.	 Choose	the	appropriate	frame	length;	ours	is	1	–	18.
7.	 Choose	the	RENDER_CAM	as	the	Renderable	Camera.
8.	 Watch	out!	Make	sure	alpha	channels	is	turned	on!
9.	 Resolution	should	be	your	final	resolution.

a.	 Now	you	can	click	Render	>	Batch	Render.	The	renders	for	each	layer	will	be	placed
in	named	folders.	Look	at	the	Script	Editor	to	see	the	progress.

FIGURE	2.27	Render	settings	and	expected	results

Why	did	we	go	through	the	trouble	of	setting	up	render	layers?	Now	we	have	a	sequence
of	 images	 for	both	 characters.	Each	has	 its	 own	alpha	 channel	 so	 that	 it	 can	be	 composited
overtop	of	a	background	or	other	levels	as	needed.	Now	we	can	take	our	robot’s	3D	render
and	 use	 Roy’s	 3D	 reference	 render	 to	 draw	 the	 2D	 animation	 and	 make	 sure	 that	 the
registration	is	correct.

Dig	Deeper!

A	quick	note	on	file	types.	Not	all	file	types	support	alpha	channels.	Tiff	does.	JPG	(which	is
also	compressed)	does	not.	Please	seek	help	with	an	intro	to	3D	book	if	you	are	unsure	of	file
types.

What	 could	 go	 wrong?	 I	 hit	 two	 possible	 bugs	 in	 this	 section	 both	 on	 PC	 and	 Mac
(versions	2011–2014).

1.	 The	twos	script	may	not	work	with	batch	rendering!	You	may	have	to	ditch	the	twos
node	 in	order	 to	 render.	Select	 that	 timing	node	 the	script	created	by	 typing	 in	 the



command	 line	 select-r	 timeOnTwos.	 This	 selects	 the	 node.	 Now,	 delete	 it.	 Batch
render	as	before.

2.	 During	 playback	 in	 Maya,	 it	 wouldn’t	 evaluate	 the	 timeline!	 I	 knew	 there	 was
animation	there,	but	it	would	not	show.	I	was	able	to	turn	it	on	again	by	clicking	on
Modify	 >	 Evaluate	Nodes	 >	 Evaluate	All.	 I	 think	 this	 was	more	 user	 error—the
accidental	hitting	of	a	hot	key.

3D	Leads	2D:	Animating	2D	on	Top	of	3D

What	software	do	you	use	to	draw	your	2D	animation	on	top	of	the	3D	animation?	In	class
we	 have	 been	 using	 many	 different	 software	 packages	 and	 find	 that	 each	 one	 lends	 itself
toward	different	final	looks.	You’ll	want	to	experiment	with	any	software	programs	you	think
might	work	to	see	how	well	you	can	animate	in	them.	We	will	cover	the	technical	aspects	of	a
few	of	them	here	in	this	chapter.

Maya	and	Photoshop

A	new	feature	that	was	put	into	Photoshop,	as	of	version	CS3,	is	the	ability	to	edit	and	work
on	sequences	of	images.

Open	Our	Renders

To	open	the	rendered	file	sequence	into	Photoshop,	click	File	>	Open,	 then	select	the	first
image	of	the	Robot	level.	Ours	is	in	the	folder	Robby_Anim	and	is	named	rb.00001.tif.	Click
on	the	Image	Sequence	option.

Oh,	look—a	window	opens	for	you	to	set	the	proper	frame	rate	(remember	what	we	said	in
Chapter	1—there	are	many,	many	places	to	mess	up	frame	rate);	select	24	fps.



FIGURE	2.28	Remember	to	set	the	correct	frame	rate

Notice	the	video	layer	in	the	layer	palette.	This	is	no	longer	a	normal	image	layer.	In	newer
versions	of	Photoshop	a	time-line	window	automatically	opens	up.	(In	earlier	versions,	open
the	timeline	by	clicking	on	Window	>	Timeline	or	Window	>	Animation.)

FIGURE	2.29	Robby	imported	as	video	layer

If	you	repeated	the	steps	presented	earlier	for	the	Roy	images,	you	would	have	a	separate
Photoshop	file.	In	newer	versions	of	Photoshop	the	video	of	Robby	is	in	a	Video	Group.	If	you
do	the	next	step	with	Robby’s	Layer	1	selected,	Photoshop	will	load	the	video	clip	of	Roy	after
Robby.

Instead,	 click	 on	 the	 main	 canvas	 so	 that	 the	 Robby	 Layer	 1	 layer	 is	 deselected.	 Now,
continue	to	the	next	step.	Select	Layer	>	Video	Layers	>	New	Video	Layer	from	File,	 then
select	the	first	image	of	Roy.

You	can’t	see	both	layers	now,	can	you?	There	is	a	difficulty	here.	Photoshop	doesn’t	know
what	alpha	channel	to	use,	so	it	does	not	use	any.	We	can	get	around	this.	Select	Roy’s	layer,
then	change	the	layer	blend	to	multiply.	Now	you	can	see	both	layers.



Later	 in	another	chapter,	we	will	 learn	how	to	work	around	Photoshop’s	video	layers	not
seeing	 individual	 image	alphas.	For	now,	we	are	only	using	 the	 layers	as	 reference,	 so	 their
alpha	channel	is	not	absolutely	needed	right	now.

FIGURE	2.30	Multiply	blend	node	allows	you	to	see	both	layers

To	Animate



FIGURE	2.31	Blank	video	layer	to	draw	on.	Timeline	shows	Robby	and	Roy	reference	layers	and	the	empty	video	layer	you

will	draw	on

To	draw	frame	by	frame	in	Photoshop,	you	will	need	a	blank	video	layer	on	which	to	draw:

1.	 Click	 on	 the	 canvas	 to	make	 sure	 no	 video	 layer	 is	 selected.	Click	Layer	 >	 Video
Layers	 >	 New	 Blank	 Video	 Layer.	 Note	 the	 new	 blank	 video	 layer	 in	 the	 layer
palette.

2.	 To	see	different	frames,	scrub	through	the	timeline	frames	by	clicking	and	dragging
on	the	blue	arrow.

3.	 You	can	do	 straight-ahead	animation	easily	or	do	pose-to-pose	animation.	You	will
want	 to	 turn	onion-skinning	on	so	 that	you	can	see	keyframes	before	and	after	 the
breakdown.	 Click	 on	 the	 arrow	 at	 the	 top	 right	 of	 the	 timeline	 window.	 Turn	 on
Enable	Onion	Skins.	Then	choose	Onion	Skin	Settings.	Set	 the	Frame	Before	and
Frame	After,	and	Frame	Spacing	options	to	8.	You	should	see	ghosting	appear	in	your
animation.

4.	 Now	you	are	ready	to	draw.	Set	brush	size	and	style	to	your	liking.



FIGURE	2.32	Onion-skinning

Dig	Deeper

If	you	want	to	know	a	lot	more	about	how	to	control	the	line	look	in	Photoshop,	check	out
Creative	Photoshop:	Digital	Illustration	and	Art	Techniques	Covering	Photoshop	CS3	by	Derek
Lea.

5.Make	sure	the	blank	video	layer	is	selected.	Animate	by	drawing	on	each	frame.	Move
the	blue	arrow	to	the	next	frame.	Continue	to	draw.	If	you	have	keyframes	with	the
3D	 reference	 character	 posed,	 it	 helps	 the	 2D	 animator	 tie	 down	 the	 contact	 points
more	clearly.

A	note	on	animating	 in	Photoshop:	 this	 chapter	 is	using	 time-line	keyframes.	 The	 other
method	of	using	Photoshop	to	animate	is	frame	animation.	Frame	animation	is	 the	original
implementation	 of	 animation;	 timeline	 was	 developed	 later.	 If	 you	 wish	 to	 use	 the	 older
version	of	animation,	take	a	look	at	the	Photoshop	documentation.

If	you	are	using	CS4	or	later,	you	can	use	hot	keys	to	advance	to	the	next	frame	or	go	back
to	the	previous	frame	(super	handy	when	animating).	The	hot	keys	are	the	arrow	keys,	and
you	will	need	to	turn	on	timeline	hot	keys	by	clicking	on	the	option	arrow	in	the	upper	right
corner	of	the	animation	window	and	turning	on	Enable	Timeline	Short-Cut	Keys.



Rendering

When	you	are	done	animating,	 you	will	want	 to	 save	out	your	 file	 as	 individual	 images.
These	 images	 can	 then	 be	 composited	 together	 with	 the	 other	 levels	 in	 the	 compositing
package	 of	 your	 choice.	 The	 most	 important	 thing	 here	 is	 to	 get	 an	 alpha	 channel.	 These
directions	will	help	you	get	that.	It’s	tricky	in	Photoshop.

1.	 First,	HIDE	BOTH	 reference	 layers.	 (Otherwise	 they	will	 render	with	 your	 drawn
images.	OOPS!)

2.	 Save	the	PSD	file	to	retain	the	video	layers	for	future	changes.
3.	 Select	File	>	Export	>	Render	Video	…

Use	the	following	settings:

1.	 Set	name	and	folder.
2.	 You	 can	 render	 out	 to	quick	 time	or	 individual	 frames.	The	only	way	 to	 get	 alpha

channels	is	to	use	QuickTime	Movie.
3.	 To	 keep	 from	 losing	 render	 quality:	 Format	 =	 QuickTime	 Settings.	 Preset	 =

Uncompressed	 (I	would	prefer	 to	use	 .tifs,	 but	 at	 the	moment	Adobe	packages	do
not	seem	to	support	.tif	rgba.)

4.	 Set	the	Alpha	Channel	to	be	Premultiplied	with	White.
5.	 Warning!	Watch	out	for	the	frame	rate	option	at	the	bottom	of	the	menu!
6.	 Click	Render.

This	will	 save	a	movie	 file	 of	your	 animation	with	alpha	 channels.	Note	 that	you	do	not
have	an	image	for	each	frame.	Instead,	you	have	a	movie	file	and	that	file	can	get	quite	large.
It	is	uncompressed,	which	is	sometimes	referred	to	as	“Animation”	format	in	QuickTime.	It	is
the	same	difference—100	 individual	 frames	or	one	big	file.	 It	 is	 lossless,	meaning	there	 is	no
compression	that	can	cause	visual	artifacts.



FIGURE	2.33	Rendering	options

Maya	and	Corel	Painter

I	want	to	make	a	point	here.	Don’t	get	all	snobbish	about	software.	(This	is	a	reminder	to
myself	as	well.)	What	other	software	is	out	there?	What	can	it	do?	What	do	we	need	it	to	do
for	our	2D/3D	needs?	Most	importantly,	our	2D	package	needs	to	bring	in	a	series	of	images
or	a	movie	file	so	we	can	animate;	needs	to	save	out	alpha	channels;	and	needs	to	be	able	to
handle	 the	 resolution	 of	 images	 and	 color	 depth	 you	want.	What	 if	 you	want	 to	 use	Corel
Painter	 to	 animate	 in?	 It	 takes	 a	 few	more	 button	 clicks,	 but	 you	 get	 the	 added	 bonus	 of
animating	 in	 Painter.	 The	 paintbrushes	 and	 paper	 textures	 can	 add	 a	 great	 look	 to	 your
animated	film.

There	 are	 some	 issues	with	Corel	Painter.	Unlike	Photoshop,	you	 cannot	have	more	 than
one	 reference	 video	 reference.	 (If	 you	 find	 a	way	 to	 do	 so,	 contact	me	 via	 the	 publisher’s
website.)	 Second,	 older	 versions	 of	 Painter	 crash	 when	 reading	 in	 .tifs.	 There	 are	 some
concerns	with	bit	depth	in	the	newer	versions.	To	avoid	all	of	that,	you	may	want	to	create	a



render	from	Maya	that	is	a	JPG	and	is	not	using	render	layers.

Re-Render

You	can	use	Photoshop	to	composite	the	Robby	and	Roy	reference	images	together	or	re-
render	in	Maya.	It	is	up	to	you.	In	this	chapter,	we’ll	use	Maya	very	quickly	to	re-render.

1.	 Open	 the	 Maya	 file	 of	 your	 completed	 animation	 or	 our	 file
Robby_3DLeads2D_5.mb.

2.	 Freak	out	because	you	only	see	Roy	and	not	 the	Robot.	 (I	did.	 I	 thought	 I	had	 lost
something.	One	shouldn’t	work	so	late	at	night.	It	makes	one	jumpy.)

3.	 Go	to	the	Render	Layer	area	and	click	masterLayer	so	that	everything	shows.
4.	 Turn	off	Options	>	Render	All	Layers.
5.	 In	 the	 render	 layers,	make	sure	 that	an	R	 is	only	on	 the	master-Layer	 or	you	will

wonder	why	you	don’t	have	the	masterLayer	rendered.
6.	 Change	the	render	settings	so	that	you	output	a	JPG	image.
7.	 Batch	Render.

Animating	in	Corel	Painter

Corel	 Painter	 12	 has	 changed	 how	 you	 sketch	 over	 a	 movie	 source.	 Note:	 the	 online
documentation	 for	 it	 is	 not	 accurate	 (at	 least	 when	 I	 was	 reading	 it).	 Here’s	 how	 it	 really
works:

1.	 Create	a	movie	file	for	your	2D	character	by	clicking	on	Movie	>	New	Movie.	Name
it	“my2D.frm”.	My	file	size	is	very	small:	320	×	240.	Yours	will	be	the	final	size	that
you	are	working	at.	Watch	out—you	could	run	out	of	memory	here.	Set	the	number
of	images	=	18,	Onion	Skin	=	2.	 (Onion-skinning	refers	 to	how	many	frames	are	 in
front	and	behind	of	the	movie	you	get	to	see.)

2.	 Open	the	clone	source	window	by	clicking	Window	>	Clone	Source.
3.	 At	the	bottom	left	of	the	clone	source	window,	click	the	icon	for	Open	Source	Image

>	Open	Source	…
4.	 Locate	 the	Robby_Roy_together	 images.	 Because	 this	 is	 a	 sequence	 of	 images	 you

will	need	to:

a.	 Select	the	first	numbered	file,	then	click	open.



b.	 Select	the	last	numbered	file,	then	click	open.
c.	 Name	the	file	that	Painter	will	save:	myRef.FMP.
d.	 Select	 the	 proper	 level	 of	 onion-skinning	 and	 bit	 depth	 (we’ll	 use	 the

defaults),	and	click	OK.

5.	 Select	the	my2D	window	so	that	it	is	the	active	window.
6.	 In	the	Clone	Source	window	click	on	Open	Source	Image	and	choose	the	reference

image.	 It	 will	 only	 have	 the	 name	 of	 the	 first	 image	 listed—for	 example,
rr_together.0001.tif.

7.	 To	see	the	reference	movie,	click	on	Canvas	>	Tracing	Paper.	Tracing	paper	lets	you
see	the	clone	source	layer	under	your	drawing	layers.

8.	 The	Frame	Stack	window	should	already	be	open.	You	can	draw	on	each	frame	and
advance	forward	to	continue	to	animate.

FIGURE	2.34	Settings	to	create	new	movie	document	in	Corel	Painter

What	about	onion-skinning?	That	was	set	 in	 the	dialog	box	when	you	 first	created	 the
document.	You	can	close	the	document	and	reopen	it	to	set	a	new	number	of	images	to
show	for	onion	skinning.	Why?	I	don’t	know.	Let’s	assume	it	has	to	do	with	how	the
program	allocates	memory.	The	pointer	to	the	reference	file	does	not	get	saved	with
your	animation	file.

Oops—bug	 alert:	 The	 frame	 stack	 window	 in	 my	 version	 is	 not	 advancing	 the	 clone
source	frames.	It	should.	Well,	that’s	a	bummer.	To	work	around	it,	you	can	go	to	the
reference	movie,	frame	advance,	and	in	the	clone	window	add	the	same	file	again.	It
will	continue	to	stack	multiple	images.	Click	on	the	correct	image	as	reference.	Wow—



that	 can	 go	 wrong	 very	 quickly.	 You	 have	 to	 be	 super	 careful	 to	 make	 sure	 the
reference	image	is	the	same	frame	as	the	one	you	are	drawing	on.

FIGURE	2.35	Animating	using	Movie	Clone	Source	as	tracing	paper

Rendering	in	Corel	Painter

When	you	have	completed	your	animation,	it	is	time	to	render	out	the	images:

1.	 Select	File	>	Save	As	…
2.	 Choose	Save	Movie	as	Movie	File.
3.	 Use	 the	 same	 settings	 that	 we	 used	 in	 Photoshop:	 Animation	 Compression	 and

Millions	of	Colors.	Watch	out	for	frame	rate!



FIGURE	2.36	Rendering	animation	in	Corel	Painter

Bug:	older	versions	of	Corel	Painter	crashed	when	trying	to	export	movie	files.	In	version
12	it	 is	working.	When	you	are	saving	your	 images	as	a	QuickTime	file	and	you	experience
crashes,	 it	might	 be	 the	 version	 of	QuickTime	 you	 are	 using	 that	 is	 causing	 issues	 and	 not
necessarily	 the	piece	of	 software.	Try	a	different	QuickTime	version,	possibly	even	an	older
one.	If	you	are	on	a	school’s	computer	where	you	are	unable	to	install	files,	you	may	have	to
find	an	alternative	method	for	saving	your	images.

Let’s	consider	what	we	just	went	through.	There’s	a	lot	of	button	clicking	and	some	things
that	 just	 aren’t	 functional.	 In	 your	 personal	 pipeline,	 you	may	want	 to	 evaluate	 your	 time
versus	money.	 If	you	are	using	cheaper	 software	because	 that	 is	 all	your	budget	will	 allow,
consider	 how	 much	 time	 and	 effort	 each	 extra	 button	 click,	 bug,	 issue,	 crash,	 or	 bad
documentation	cost	you.	To	counterbalance	 the	 time,	you	may	 find	 that	you	can	only	get	a
certain	 look	 out	 of	 a	 given	 piece	 of	 software.	 Corel	 does	 have	 extremely	 nice	 painting
functionality.	It’s	your	decision.

Maya	and	Other	Software



Of	course,	there	are	other	software	packages	that	you	can	use	to	animate	in	2D.	Flash	might
be	your	 first	choice,	as	 it	was	designed	as	an	animation	package.	The	 thing	 to	watch	 is	 that
your	line	looks	like	a	hand-drawn	2D	line	and	not	like	a	Flash	redrawn	line.	To	do	this	you	will
have	 to	 hand-massage	 every	 line	 that	 you	 draw	 by	 turning	 the	 lines	 into	 brushstrokes	 (or
drawing	with	the	brush	to	begin	with)	and	adjusting	the	vector	points	to	smooth	out	the	line.
Figure	2.37	shows	a	drawing	in	Flash	with	the	points	selected	for	adjustment.	To	see	an	online
example	of	Flash	animation,	take	a	look	at	Home	Star	Runner	at	www.homestarrunner.com.
All	 animations	 are	 created	 in	Flash,	 and	 each	drawn	 line	 is	massaged	 (or	 cleaned	up)	 to	be
exactly	what	the	artists	intended.

FIGURE	2.37	Drawing	in	Flash	creates	vector	lines

A	great	package,	and	one	that	 is	a	2D	digital	animation	industry	standard,	 is	Toon	Boom.
We’ll	take	a	look	at	drawing	in	Toon	Boom	later	on	in	this	book.

http://www.homestarrunner.com


FIGURE	2.38	Drawing	in	Toon	Boom	also	creates	a	vector	image	and	can	be	used	to	create	inbetweens

Test	each	software	package	and	decide	which	one	best	gives	you	the	style	you	are	looking
for.	 Remember	 what	 we	 covered	 in	 Chapter	 1?	 Give	 yourself	 time	 to	 test	 other	 software
programs	 to	 come	 up	 with	 other	 looks.	 Otherwise	 you	 risk	 only	 knowing	 one
pipeline/technique	and	coming	up	with	a	limited	number	of	visual	looks.

Putting	it	together

You	 should	 have	 two	 levels	 ready	 to	 be	 composited	 together.	 We’re	 going	 to	 look	 at
timeline-based	compositing	very	quickly,	just	enough	to	get	you	started.

There	are	two	types	of	compositing	software:	timeline	based	and	node	based.	After	Effects,
Premiere,	 Combustion,	 and	 other	 products	 of	 that	 price	 point	 are	 generally	 timeline	 based.
They	 are	 good	 for	 quick	workings	 and	 let	 those	 with	 smaller	 budgets	 achieve	 some	 great
results.	 Node-based	 compositing	 systems	 such	 as	Nuke,	Autodesk	 Smoke,	 and	Avid	 have	 a
different	way	of	approaching	compositing.	For	some,	they	are	more	robust	at	putting	together
complicated	shots.	They	are	considered	the	high-end	compositing	packages,	can	handle	larger
images,	and	handle	bit	depth—oh,	my,	I’m	starting	to	sound	like	a	software	demo	jock;	no,	not
that.	Use	what	you	have	or	what	gets	the	job	done.	For	animation,	you	do	not	need	a	super-
duper	compositing	system;	this	 isn’t	a	visual	effects	movie	we’re	putting	together.	However,
there	 are	 a	 few	 things	 you	will	want	 out	 of	 your	 compositing	 system	 for	 putting	 together
animations:

1.	 The	ability	to	composite	one	image	with	alpha	channels	over	another	image:	A	over
B.	(If	your	compositing	software	doesn’t	have	this,	I	hope	it	was	free.)



2.	 The	ability	to	create	traveling	masks	to	help	register	two	images	together.
3.	 The	ability	to	use	masks	to	color	correct.
4.	 The	ability	to	reuse	artwork	easily.
5.	 The	ability	to	quickly	render	out	the	final	product	at	different	resolutions,	for	quick

testing	of	the	final	results.

For	this	chapter,	we	will	use	After	Effects.	You	will	want	to	bring	in	your	two	levels,	Robby
and	Roy,	and	composite	them	together	to	create	the	final	output	movie.

Take	Note

Watch	out	for	frame	rate	(again).	We’re	working	at	24	frames	per	second.	After	Effects	(and
most	compositing	software	programs)	default	to	30	frames	per	second.

Set	the	Frame	Rate

Go	to	the	menu	Preferences	>	Import	…	(under	Edit	on	a	PC)	and	set	the	following:

1.	 Select	Sequence	Footage	>	24	Frames	per	Second.
2.	 Interpret	Unlabeled	Alpha	As	Premultipled	(Matted	with	White).

FIGURE	2.39	Settings	to	ensure	a	proper	import	of	animation	into	After	Effects

Import	Images



1.	 Select	File	 >	 Import	 File,	 and	 choose	 the	 robot’s	 images.	Make	 sure	 to	 select	 .tif
Sequence	and	Force	Alphabetical	Order.

Take	Note

What	 can	go	wrong	here?	 If	 you	do	not	have	 zero	padding	 in	your	numbers—image-.tif,
image-2.tif,	 image-10.tif—your	 images	 will	 come	 in	 out	 of	 sequence.	 Eeek!	 Don’t	 do	 that,
Batman!	Instead,	use	zero	padding	in	your	image	names:	image-00001.tif,	image-00002.tif,	and
so	on.

2.Repeat	step	1	for	your	2D	Roy	images.	 If	 the	files	are	a	Quick-Time	movie,	you	only
have	to	select	the	file.	After	Effects	will	bring	it	in	as	you	expect	it	to.

3.Drag	 the	 two	 image	 sequences	 into	 the	 composition	 area	 of	After	 Effects.	Drag	 and
drop	them	with	the	Robot	images	on	the	bottom	level.

FIGURE	2.40	Drag	levels	of	animation	into	the	composition	area	of	After	Effects.	(Apparently	my	Roy	is	only	red	feet	and

no	body.)

Because	of	the	way	this	project	is	set	up,	you	should	not	have	any	overlap	between	the	two
characters.	 This	means	 the	 fingers	 should	 not	 come	 in	 front	 of	 Roy.	Well,	 they	 could.	 You
might	have	animated	Roy	hanging	on	for	dear	life.	I	would.	If	that	is	the	case,	you	need	to	do
some	matting	out	of	Roy.	There	are	a	couple	of	ways	to	do	that.	We	will	cover	the	matting
process	in	the	next	chapter.



Render	Your	Final	Movie!

Render	 a	 low-resolution	 pass	 first	 for	 a	 quick	 check,	 then	 do	 a	 high-res	 composite.	 You
probably	guessed	where	to	go	to	export	out	your	final	2D/3D	movie.	In	the	Project	tab,	select
the	composition.	Then	select	File	>	Export	>	Add	to	Render	Queue.	Click	on	the	small	arrow
next	to	Output	Module.	This	gives	a	 list	of	quick	rendering	selections.	What	do	you	render
your	movie	 in?	That	 is	up	to	you.	For	animation	classes	we	 like	 to	render	 in	QuickTime,	so
that	we	can	scrub	through	the	movie	frame	by	frame	in	Quick-Time.	Also,	a	codec	that	has	a
good	compression	rate	that	doesn’t	degrade	the	image	too	much	is	useful.	There	are	plenty	of
texts	 or	 websites	 dedicated	 to	 exhaustive	 comparison	 of	 codecs.	 I	 like	 Sorenson	 3;	 still,	 it
renders	quickly	and	lets	me	double-check	all	is	well	before	completing	a	lossless	render.	You
may	like	H.264;	it	expects	a	certain	image	size.

Once	you	are	satisfied	that	all	is	well,	repeat	the	steps	again	to	get	the	final	render	with	a
lossless	 compression.	 If	 you	 chose	 the	 quick	 setting	 of	 “lossless	with	Alpha,”	 a	 peek	 at	 the
custom	settings	will	show	that	you	are	using	an	animation	codec	that	saves	raw	images	in	a
QuickTime	file	with	a	premultiplied	alpha	matte.	These	images	you	can	use	to	put	into	your
final	edit,	add	sound	effects,	and	so	on.

One	other	note:	the	frame	rate	will	now	be	changed	to	29.97	frames	per	second,	since	only
film	actually	plays	at	24	fps.	You’ll	note	a	warning	notice	in	the	custom	rendering	settings.

FIGURE	2.41	Compression	settings	for	final	composite



FIGURE	2.42	Keyframes	from	final	composite

Further	Reading
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2D	Characters	with	3D	Parts	(2D	Leads)

FIGURE	3.1	John-Michael	Kirkconnell,	2009,	2D/3D	course,	SCAD

Lecture	Notes

This	chapter	explores	a	true	hybrid	character	that	is	2D	and	3D.	In	Chapter	2,	we	looked	at
two	 characters	 of	 different	 media	 interacting.	 The	 contact	 point	 could	 have	 been	 skillfully
hidden	to	avoid	the	issue	of	touch.	We	chose	to	show	the	touch/contact	point	because	we	were
discussing	how	important	touch	between	characters	can	be.	However,	in	this	chapter,	we	will
look	 at	 one	 character	 in	 which	 we	 want	 the	 media	 to	 be	 seamless.	 We	 do	 not	 want	 the



differences	 in	 the	 character’s	 media	 to	 divert	 the	 viewer’s	 attention	 from	 the	 character’s
acting.

As	with	everything	we	have	encountered,	there	are	questions	that	must	be	answered.	How
do	we	make	the	two	media	look	like	each	other?	What	should	we	look	out	for?	What	pipeline
is	best	to	ensure	registration?	What	method	will	allow	for	the	best	animation?	What	method
will	get	in	the	way	of	the	animator	the	least?

How	do	We	Make	the	Two	Media	Look	Like	Each	Other?

A	good	answer	might	be	that	we	draw	everything	in	2D:	animate	the	leading	portion	in	2D
and	then	animate	the	3D	section.	Then	we	would	take	the	3D	render	and	draw	overtop	of	it	in
3D.	This	doesn’t	help	our	line	mileage	any,	but	can	certainly	make	for	a	uniform	look.

Figure	3.2	 shows	 an	 example	 of	 an	 animation	 that	was	 done	 in	Maya	 and	 then	 redrawn
frame	by	frame	in	Photoshop.	In	this	case,	the	animation	was	of	a	camera	moving	around	the
three	characters.	Doing	the	animation	in	3D	helped	the	animator	to	work	out	the	perspective
changes	and	drawing	overtop	in	2D	gave	it	a	nice	organic	feel.

FIGURE	3.2	3D	animation	redrawn	in	2D	to	create	an	organic	feel.

Image	from	3	Magicians	by	Claire	Almon



There	are	many	examples	of	 this	 type	of	 line	 look.	The	Pearce	Sisters	by	Luis	Cook	 is	an
example	 of	 a	 hybrid	 animation	 created	 in	 3D	 but	 drawn	 over	 in	 2D
(www.pearcesisters.co.uk/production.html).	 The	 resulting	 look	 is	 very	 stylized	 and	 was
definitely	influential	to	3	Magicians.

Now	 that	 toon	 line	 rendering	 has	 come	 so	 far	 (though	 it	 cannot	 completely	 emulate	 the
beauty	 of	 a	nice	 cleanup	 line),	we	 can	put	 3D	and	 2D	 together	 to	 create	hybrid	 characters.
Later	in	this	chapter,	we	will	look	at	some	industry	examples	of	2D/3D	characters.	Figure	3.3
shows	a	2D/3D	character	from	a	group	project	class.	The	cast	itself	was	modeled	and	toon	line
rendered	in	Maya.	The	organic	parts	of	the	character	were	drawn	in	2D	using	Flash.

FIGURE	3.3	3D	body	cast	with	2D	character	from	Jaguar	McGuire	by	Clint	Donaldson,	2009,	SCAD	group	project

To	form	a	cohesive	hybrid	character,	you	will	need	 to	keep	 in	mind	 the	camera,	 lighting,
shading,	and	movement.

http://www.pearcesisters.co.uk/production.html


Camera

The	artist	will	want	to	flatten	out	the	3D	as	much	as	possible	by	using	a	telephoto	lens	(if
feasible)	 to	minimize	 the	perspective	 shift	of	objects.	This	 step	 is	often	overlooked	as	many
new	animators	are	not	comfortable	enough	working	with	the	camera	in	the	3D	software;	they
tend	to	leave	it	at	the	default	lens	and	focal	distance.

Lighting	and	Shading

When	putting	the	2D	and	3D	portions	of	the	character	together,	we	will	want	to	minimize
how	rounded	the	3D	character	 looks	by	using	 flat	 toon	shading;	or,	 if	we	choose	a	rounded
look,	the	2D	character	portion	will	have	to	have	tones	on	it	to	make	it	seem	rounded	as	well.

Movement

We’ve	gotten	away	with	timing	things	out	in	3D	and	basically	rotoscoping	the	2D	on	top	of
reference	contact	points.	With	a	character	led	by	2D,	the	3D	animator	will	need	to	have	access
to	the	timing	chart	and	x-sheet	for	the	animation	in	order	to	see	where	the	3D	keys	should	be
placed	and	what	type	of	spacing	should	be	used.	It	is	possible	to	proceed	without	x-sheets	and
timing	charts,	but	doing	so	can	cause	a	disjointed	feel	in	the	animation.	Also	keep	in	mind	that
the	2D	will	more	than	likely	be	on	twos.

What	should	We	Look	Out	for?

When	animating	a	2D	character	that	will	have	a	3D	limb	or	some	type	of	3D	appendage,
make	 sure	 to	 draw	 in	 the	 placement	 for	 the	 limb.	 It	will	 be	 erased	 at	 compositing	 time.	A
beginner’s	mistake	is	to	forget	to	sketch	in	where	the	missing	limb	is	and	thus	forget	to	put
weight	on	 it	and	 the	 like.	The	more	 information	you	put	 into	your	2D	animation,	 the	more
you	have	to	follow	when	placing	the	3D	portion.

What	Pipeline	is	Best	to	Ensure	Registration?



When	2D	leads,	it	doesn’t	affect	registration	if	you	use	2D	paper	or	digital	2D.	There	will	be
some	 time	 spent	 on	 scanning	 in	 the	 2D	 paper	 animation,	 but	 this	 should	 not	 add	 any
registration	issues.	Remember,	we	have	registration	issues	the	second	we	print,	not	when	we
scan.	In	short,	2D	leading	is	easier	on	the	pipeline	than	anything	else.	If	there	have	to	be	any
2D	 animation	 fixes	 after	 3D	 appendage	 animation	 is	 done,	 I	 would	 suggest	 doing	 them
digitally.	 If	you	don’t,	 then	you	will	have	 to	go	 through	a	printing	and	pegging	process	 for
your	 3D	 appendage	 and	 then	 you	 will	 have	 to	 rescan.	 Art	 production	 managers	 will	 be
looking	at	their	schedules	and	grimacing.

What	Method	will	get	in	the	Way	of	the	Animator	the	Least?

When	 it	 comes	 to	digital	 2D	animation,	 I	 have	kept	my	eye	out	 for	different	 techniques.
Recently,	on	a	group	project,	we	had	a	handful	of	animators	working	in	Photoshop,	Flash,	and
Toon	Boom.	We	 compared	notes	 and	debated	 on	which	method	we	 liked	 best.	We’ll	 cover
different	software	and	animation	techniques	in	this	book.	You	can	choose	which	one	fits	your
preferred	method	of	animation.

What	Method	will	Allow	for	the	Best	Animation?

Button	pushing	aside,	there	are	other	factors	that	are	important	to	consider	when	choosing
your	pipeline	for	digital	2D	animation:

1.	 Timing.	You	want	the	easiest	method	that	allows	you	to	work	out	your	animation’s
timing.

2.	 Playback.	You	need	to	be	able	to	play	back	your	animation	easily,	often,	and	at	the
proper	frame	rate.

3.	 Use	of	reference.	You	want	 to	be	able	 to	easily	use	 reference	 images	 to	 see	 contact
points.	These	can	be	from	your	3D	assets,	sketches,	and	so	on.

4.	 Onion-skinning.	 It	 is	 important	 that	 the	 methods	 you	 use	 allow	 for	 pose-to-pose
animation	so	that	you	can	see	your	previous	and	next	key	while	working	on	the	pose
in	between.	The	method	must	not	be	 cumbersome	 (uh-oh,	 I’m	slipping	 into	white-
paper,	software-architecture	language—“must	not,”	“shall	have”).

5.	 Line	quality.	Can	you	draw	in	it?	Does	it	slow	your	drawing	process	down?	The	hope
is	 that	 it	 does	 not.	 This	 is	 the	 one	 main	 deciding	 factor	 in	 many	 of	 our	 group
project/student	 project	 discussions.	 If	 the	 package	 you	 animate	 in	 doesn’t	 give	 you



the	final	line	quality	you	want,	that	is	okay.	You	may	have	to	add	another	software
package	to	do	the	cleaned-up	line	overtop	the	animation.

In	 fact,	 given	 the	 specifications	 listed	 earlier	 of	 what	 an	 animator	 wants	 out	 of	 the
production	 pipeline,	 it	 is	 not	 uncommon	 to	 have	multiple	 software	 packages.	 For	 example,
you	might	use	Flash	for	the	timing	portion	because	of	the	ease	of	the	timeline,	Photoshop	for
the	second	pass	at	the	animation	and	inbetweens,	Toon	Boom	for	the	final	cleaned-up	line,	and
After	Effects	for	the	final	composite.	Now,	the	software	I	just	mentioned	is	just	an	example;	it
is	 more	 from	 a	 student’s	 vantage	 point	 of	 the	 software	 he	 or	 she	 might	 have	 available.
Students	might	have	to	stay	in	Photoshop	for	the	cleaned-up	line	if	they	do	not	have	access	to
non-Adobe	 products.	 Other	 software	 programs	 that	 could	 be	 used	 include	 US	 Animation’s
Opus,	Plastic	Animation	Paper,	and	CTP	Pro,	to	name	a	few.

Is	it	Hard	to	Animate	a	Hybrid	Character?

Creating	 a	 hybrid	 character	 does	 add	 some	 technical	 challenge.	 You	will	want	 to	 have	 a
good	reason	to	do	it.	What	reasons?	Those	that	we	spoke	about	in	Chapter	1:	visual	target,	line
mileage,	 and	 complexity.	 If	 it	 supports	 the	 story	 by	 supporting	 your	 visual	 target	 and
minimizes	either	your	line	mileage	(how	much	the	animator	has	to	draw)	or	the	complexity
(perspective,	lots	of	parts,	and	so	forth),	then	you	have	a	candidate	for	a	2D/3D	character.

The	second	you	decide	to	do	one	character	as	multiple	media	you	might	find	that	your	crew
of	animators	cannot	handle	or	prefers	not	to	do	both	2D	and	3D.	Some	do,	and	those	that	do
will	 be	 able	 to	 handle	 their	 shots	 alone.	 Some	 prefer	 only	 one	medium,	 therefore	 you	will
have	to	assign	two	animators	for	one	character.	Did	you	hear	an	accountant	just	open	a	bottle?
That	does	make	for	an	expensive	character.	While	one	animator	is	working	on	the	2D	portion,
the	other	animator	might	have	no	work	at	his	or	her	desk.	Not	an	optimal	situation	for	tight
budgets.

Industry	Examples

Using	 2D	 for	 the	 character	 (be	 it	 traditional	 paper	 or	 digital)	 allows	 an	 artist	 to	 draw
keyframes	using	those	traditional	skills	that	give	so	much	personality	to	the	character.	On	top
of	that	personality,	the	artist	is	able	to	use	3D	tools	to	push	the	character	further	by	allowing
more	complex	parts	to	be	animated.

The	most	amazing	mainstream	industry	examples	can	be	found	in	Glen	Kean’s	animation	of



John	Silver	in	the	animated	film	Treasure	Planet,	and	another	more	subtle	example	is	shown
in	The	Triplets	of	Belleville,	where	the	2D/3D	integration	is	invisible.

I	encourage	you	to	take	a	look	at	the	bonus	features	on	the	Treasure	Planet	DVD.	There	is
so	much	information	on	there	that	you	will	have	to	watch	it	many	times.	In	fact,	it	is	one	of
the	best	examples	of	a	visual	commentary	on	a	DVD.	You	can	set	it	up	so	that	you	watch	the
film	 and,	 like	 a	 built-in	 lecture,	 the	 film	will	 pause	 at	 the	 appropriate	 places,	 play	 a	 bonus
video	clip	on	how	things	were	made,	and	so	on,	and	then	resume	playback	of	the	movie.	It	is	a
classroom	on	a	DVD.

FIGURE	3.4	Pipeline	test	of	3D	arm	with	Captain	Hook	animation

©	2002	Disney

If	you	look	at	the	bonus	features	on	the	DVD,	you	will	find	a	pencil	test	of	Captain	Hook
that	 has	 his	 arm	 replaced	with	 a	 3D	 arm.	According	 to	Glenn	Keane	 in	 his	 interview,	 they
chose	 that	 scene	 because	 it	 had	 such	 strong	 acting	 and	 vibrancy.	 If	 you	 watch,	 it	 should
become	evident	that	the	2D	character	leads.	The	idea	of	2D	leading	is	the	same	with	the	John
Silver	 character.	This	makes	 sense	because	he	 is	 the	 character	moving	around	and	 the	 arm,
eyepiece,	and	peg	leg	(which	are	3D)	follow	the	2D’s	movement.	The	character	design	allows
for	 an	 easy	 fit	 of	 the	 pieces	 together.	 I	 don’t	mean	 to	 say	 it	 is	 easy,	 just	 that	 the	 character
design	does	not	get	in	the	way.	The	arm	seam,	where	it	fits	the	body,	is	a	logical	seam	in	the
drawing.	If	and	when	the	2D	sleeve	comes	over	the	3D	arm,	special	care	must	be	taken	when
compositing	these	together,	because	the	3D	would	be	both	in	front	of	the	2D	chest	and	behind
the	2D	sleeve.	This	would	require	a	matte	to	hold	out	(or	not	show)	some	of	the	3D	arm.



FIGURE	3.5	Close	up	of	John	Silver’s	arm	shows	a	clean	joining	line	between	the	two	elements

2002	Disney

However,	you	might	have	not	noticed	the	most	invisible	examples	of	hybrid	animation.	In
The	Triplets	 of	Belleville,	 you	might	have	missed	 the	 2D/3D	portions.	You	probably	noticed
some	distinct	3D	elements	like	the	bicycle	wheel,	but	did	you	see	the	2D/3D	character?	Any
time	a	character	is	riding	a	bicycle,	the	character’s	contact	limbs	are	actually	3D.	The	rest	of
the	body	is	sometimes	animated	in	3D	as	well	to	use	as	reference.	You	can	take	a	look	at	the
bonus	features	on	the	DVD	to	see	examples.	The	3D	line	was	dirtied	up	to	make	it	less	perfect
in	order	to	match	the	2D	line.



FIGURE	3.6The	Triplets	of	Belleville	shows	a	2D/3D	character	with	a	3D	bicycle

In	Dreamworks’	Spirit,	Stallion	of	the	Cimarron,	you	may	not	have	noticed	that	the	main
horse	is	sometimes	2D,	sometimes	3D.	The	same	goes	for	many	foreground	and	background
characters	in	the	film.	It	could	be	categorized	as	a	2D	with	a	3D	part	or	a	3D	with	a	2D	part
because	 it	 is	 so	 interchanged.	 Buy	 that	 film	 and	 look	 at	 the	 extras	 on	 the	 DVD.	 From	 the
beginning,	Dreamworks	had	computers	at	 the	desks	of	 the	2D	artists.	 It	was	always	 treated
just	like	any	other	tool.	This	showed	in	their	films	where	they	combined	2D	and	3D	seemingly
effortlessly.	Dreamworks	eventually	did	transition	completely	to	3D	for	most	of	its	films.

Students	in	my	class,	your	homework	is	to	go	watch	these	three	movies	once	for	the	story
and	once	more	frame-by-frame	to	see	the	2D	and	3D	animation.

One	 last	example	 that	you	probably	are	not	aware	of	 (there	was	no	mention	of	 it	on	the
DVD)	is	the	moose	from	Brother	Bear.	It	might	have	been	mentioned	in	the	commentary.	The
moose	were	animated	 in	 2D,	 and	 then	 the	animators	brought	 their	 2D	drawings	 into	Maya
and	animated	the	antlers	in	3D	to	match	the	2D	drawings.	The	drawings	were	printed	out	and
pegged	up,	and	the	cleanup	drawings	were	done	traditionally	on	paper.	I	wish	I	had	a	picture
of	 the	 antler	 rig	 that	was	made	 for	 the	 animators,	 Tony	 Stanley	 and	Broose	 Johnson.	They
came	 to	 the	 training	 room	 one	 day	 and	 showed	 me	 the	 “make	 funny”	 button,	 which	 put
Groucho	Marx’s	glasses	 and	mustache	on	 the	3D	version	of	 the	moose’s	head.	You	have	 to
keep	a	sense	of	humor.

Hands-On	Examples



Now	let’s	go	through	the	process	of	making	an	animation	of	a	2D	character	who	has	a	3D
arm.	Our	main	 concerns	will	 be	 registration	and	 line	 look.	As	discussed	previously,	 the	 line
look	 of	 the	 two	 elements	 will	 need	 to	 match.	 To	 do	 this,	 you	 must	 master	 the	 rendering
process	and	render	the	3D	line	look	or	use	the	3D	part	as	a	template	and	draw	over	it	in	the
software	package	of	your	 choosing.	Unfortunately,	 the	 latter	 choice	does	not	decrease	one’s
line	mileage.

We	will	take	sequence	1,	scene	10,	from	the	storyboard	at	the	beginning	of	this	section.	This
is	 a	 sequence	 from	 SCAD	 student	 Dianna	 Bedell’s	 senior	 project.	 The	 character	 was	 not
designed	to	be	2D/3D.	We	will	retrofit	the	Hoodoo	priestess	with	a	3D	arm.

FIGURE	3.7	Finished	2D	character	design	by	Dianna	Bedell,	cleanup	by	Amanda	Powell,	2009,	SCAD

FIGURE	3.8	3D	arm	by	Danny	Tiesling,	2009,	SCAD

FIGURE	3.9	3D	arm	added	to	a	2D	character

All	images	for	this	hands-on	section	can	be	found	in	the	companion	data	for	this	book.

Timing

When	working	out	your	animation	timing,	there	are	many	software	and	analog	options	for



you.	 I	 encourage	my	 students	 to	work	 in	whatever	method	 is	 fast	 and	 cheap.	 I	 don’t	mean
cheap	as	in	how	much	it	costs.	Instead,	I	mean	cheap	as	in	how	dear	it	is	to	you.	If	you	have	to
work	very	hard	to	create	just	one	image,	you	will	be	less	inclined	to	part	with	it	if	it	needs	to
be	changed	or	discarded.	However,	if	you	utilize	a	method	that	easily	allows	you	to	change	an
image	that	is	not	as	dear	to	you,	you	are	more	likely	to	tweak.	You	will	also	want	something
that	allows	you	 to	adjust	your	 timing	easily	and	go	back	 to	previous	versions	 just	as	easily.
This	will	 allow	 you	 to	 be	 bold	 and	 experiment	with	 new	 timing.	Who	 knows	what	 happy
accidents	might	turn	up?

Hopefully,	 you	 have	 already	 begun	 working	 in	 2D	 and	 in	 this	 you	 have	 already	 begun
working	on	the	2D	animation	pipeline	that	best	suits	you.	In	this	chapter	we’re	going	to	push
for	digital	animation	methods.	Feel	free	to	modify	to	fit	the	pipeline	that	best	supports	your
creative	process.

This	chapter	will	not	help	you	on	your	animation	and	acting.	You’ll	have	to	bring	that	to	the
table	 yourself.	 To	 further	 push	 your	 animations,	 you	 can	 always	 refer	 to	 Action!	 Acting
Lessons	for	CG	Animators	by	John	Kundert-Gibbs.

To	 begin	work	 on	your	 sketches,	 stay	 loose	 and	work	 in	 your	 sketchbook	 and	 then	 scan
those	in.	Or	you	can	use	your	favorite	software	to	draw	in.	Film	Roman,	the	studio	that	brings
us	The	Simpsons,	has	recently	gone	through	a	transition	from	paper	to	digital	drawing.	Film
Roman’s	 animators	 use	 both	 methods	 depending	 on	 the	 scene	 and	 need.	 They	 use	 Toon
Boom’s	Sketchbook	Pro	to	create	their	key	sketches.

Once	 your	 main	 ideas	 are	 worked	 out,	 you	 will	 want	 to	 work	 on	 the	 timing	 of	 your
keyframes.	This	can	be	referred	to	as	a	pencil	test.	I	have	a	few	students	who	use	Photoshop	to
do	their	timing.	I	find	it	gets	in	my	way	because	I	think	in	x-sheets	and	timelines.	To	use	x-
sheets	we	could	use	Flash	or	Toon	Boom.

Timing	in	Flash

For	this	example,	we	have	scanned	in	our	images	using	a	flatbed	scanner.	Figure	3.10	shows
an	animation	that	has	been	scanned	in	with	keyframes	placed	into	Flash’s	timeline.	Additional
poses	can	be	drawn	easily	 in	Flash.	Keyframes	can	be	moved.	Held	frames	can	be	added	or
removed	to	adjust	the	timing.	Playback	is	done	easily	as	well.



FIGURE	3.10	Keyframes	placed	in	Flash	and	timing	adjusted

Take	Note

Remember	to	check	your	frame	rate	settings!	We	are	working	at	24	fps	for	this	example.

Timing	in	Toon	Boom’s	Pencil	Check	Pro

Another	 software	 program	 that	 you	 can	 use	 is	 Toon	 Boom’s	 Pencil	 Check	 Pro.	 Here	 I’ll
show	 an	 example	 of	 using	 Pencil	 Check	 Pro	 and	 a	multifeed	 scanner.	 (You	will	 be	 spoiled
rotten	if	you	use	one	of	these	scanners.)

In	Pencil	Check	Pro,	click	File	>	Capture	to	scan	in	the	pegged-up	images.	You’ll	note	that
there	 are	 advanced	 settings	 for	 adjusting	 peg	 position	 and	 field	 size	 for	 scanning	 in	 this
software.	You	can	also	import	drawings	that	have	already	been	scanned.	Whatever	software
you	use,	 the	object	 is	 to	adjust	 the	 timing	of	 the	key-frames.	 In	 the	x-sheet	window,	Pencil
Check	Pro	has	some	features	you	might	find	handy.



FIGURE	3.11	Keyframes	scanned	into	Pencil	Check	Pro	with	adjusted	timing

1.	 Holding	keyframes.	Once	you	have	brought	your	drawings	into	the	x-sheet,	select	the
first	keyframe	and	click	on	the	EX	+	icon.	This	extends	the	exposure.	In	Figure	3.11
you	see	that	the	first	keyframe	was	held	for	three	more	frames.

2.	 Onion-skinning.	 This	 one	 is	 very	 easy	 to	 find.	 There	 is	 an	 icon	 for	 “Show	Onion
Skin.”	 Figure	 3.12	 has	 onion	 skin	 showing.	 Settings	 can	 be	 found	 under	 View	 >
Drawing	>	Onion	Skin.

3.	 Adding	drawings.	To	add	a	keyframe	or	breakdown	in	Pencil	Check	Pro,	simply	click
on	an	empty	cell	in	the	x-sheet.	Draw.	Doesn’t	get	much	easier	than	that.	You’ll	note
that	Pencil	Check	Pro	draws	in	vector	lines,	which	is	resolution	independent.

4.	 Playback	and	adjusting.	Press	the	play	arrow	at	the	top	of	the	canvas,	and	you	will
see	your	animation.	Add	and	decrease	exposure	in	the	x-sheet	as	needed	for	proper
timing.



FIGURE	3.12	Seeing	keyframes	in	onion	skin

Director	Approved

Once	your	timing	is	done	and	director	approved,	you’ll	want	to	save	your	images	for	the
next	step.	 If	you	are	 the	director	and	 if	you	are	satisfied	with	your	animation,	 then	you	are
director	approved.	Move	on	to	the	next	step.

In	Flash,	you	will	want	 to	go	 to	File	>	Export	>	Export	Movie….	Because	 this	 is	 a	 low-
resolution	 reference,	we	 should	 neither	 be	 concerned	with	 compression	 nor	 alpha	 channels.
You	can	choose	JPG	sequence.	This	will	save	your	animation	as	a	series	of	JPG	images	with
the	 base	 name	 plus	 the	 frame	 number	 in	 the	 old	 format	 of	 name#.ext.	 If	 you	 want	 a	 “.”
between	 the	name	and	 the	 frame	number,	add	 that	 in	 the	base	name	you	set.	For	example,
you	would	use	the	base	name	“jam.”	to	get	the	final	name	of	“jam.001.jpg.”

In	Pencil	 Check	 Pro	 you	would	 also	 go	 to	File	 >	 Export	 >	 Export	 Images.	 You	 might
prefer	movie	or	 .avi	 files.	 For	production,	 I’d	 rather	have	 individual	 images.	 It	 is	 easier	and
faster	to	touch	up/replace	one	image	instead	of	reexporting	a	whole	.avi	file.	Again,	since	this
is	 reference	 and	 we	 aren’t	 concerned	 about	 alpha	 channels	 just	 yet,	 .jpg	 will	 work	 for	 us.
Pencil	Check	does	not	pad	the	frame	number	with	zeros.



FIGURE	3.13	Pose	test	from	Pencil	Check	Pro.	Images	by	Dianna	Bedell,	2009,	Senior	Project	II,	SCAD

3D	Arm	in	Maya

Before	cleaning	up	the	2D	animation,	you’ll	want	to	get	the	character	completely	animated
and	 have	 that	 approved.	We’ll	 add	 the	 arm	 appendage.	 Depending	 on	 which	 3D	 software
program	you	are	using,	the	buttons	used	will	be	different,	but	the	process	will	be	mostly	the
same.	Your	goal	is	to	bring	the	2D	images	in,	set	up	a	render	camera	to	match	the	2D	image,
work	with	the	 lens	of	 the	camera	so	that	 it	 flattens	out	perspective	as	much	as	you	need	to
match	your	2D,	animate	your	3D	arm	to	that	camera	so	that	the	image	you	create	looks	like	it
registers	to	the	2D	image,	and	then	render.	Simple,	right?	Really,	it	is.	Let’s	go	through	it,	shall
we?



Import	2D

Inside	 Maya,	 there	 are	 many	 ways	 to	 bring	 in	 an	 image	 plane.	 To	 make	 sure	 we	 are
animating	to	the	same	camera	as	the	2D	image,	we	absolutely	need	to	attach	the	image	plane
to	 the	 camera.	 Other	 techniques	 of	 bringing	 in	 the	 image	 and	 texture-mapping	 it	 onto	 a
polygon	will	not	ensure	that	our	3D	camera	is	accurate.

1.	 Create	a	new	camera:	Create	>	Cameras	>	Camera.	Because	this	is	a	locked-off	shot
(the	camera	is	not	moving),	we’ll	use	a	plain	camera	with	no	aim	or	up.	Rename	the
camera	Render_Cam,	and	give	it	a	Focal	Length	of	150.

2.	 Make	sure	this	camera	is	the	current	camera	(Panels	>	Perspective	>	Render_Cam).
In	 the	 top	 of	 the	 camera	 window,	 click	View	 >	 Image	 Plane	 >	 Import	 Image….
Select	the	first	image	of	your	2D	sequence.

3.	 But	you	have	more	than	one	image,	don’t	you?	You’ll	have	to	tell	Maya	that.	Perhaps
in	a	future	version	they	will	have	a	“Use	Image	Sequence”	button	right	there	in	the
open	dialog	box.	Instead,	at	the	top	of	the	camera	window	click	View	>	Image	Plane
>	Image	Plane	Attributes	>	 imagePlane1.	 In	 the	attribute	editor,	 click	on	 the	Use
Image	Sequence	option.

Now	 in	your	camera	view,	you	 should	 see	your	animation.	 If	you	use	movie	 files	or	 .avi
files,	 those	 will	 read	 in	 as	 well	 (if	 you	 have	 the	 QuickTime	 driver	 installed).	 If	 you	 scrub
through	the	Maya	timeline,	you	should	see	your	animation	in	the	Render_Cam	window.



FIGURE	3.14	2D	images	imported	into	Maya

What	 could	 go	wrong	 here?	 If	 your	 naming	 convention	 is	 not	Name.number.extension,
Maya	will	not	be	able	to	figure	out	that	you	have	an	image	sequence.	If	you	have	a	number	in
the	name,	Maya	gets	confused.	For	example,	kitty10001.tif,	kitty10002.tif	might	have	issues.	It
should	work	if	you	instead	name	it	kitty1.0001.	tif,	kitty1.0002.tif.

Take	Note

Make	sure	that	your	Maya	Render	settings	are	the	output	resolution	that	you	want!	This	is	a
locked-off	shot,	so	the	camera	(canvas	size)	should	match	the	2D	images	that	we	created.	A
way	to	see	 immediately	 if	your	resolution	 is	set	correctly	 is	 to	go	to	 the	Render_Cam	view
and	click	View	>	Camera	Settings	>	Resolution	Gate.	The	resolution	gate	(or	rectangle)	 is
hard	to	see	because	it	exactly	matches	the	2D	image	that	was	brought	in	as	an	image	plane.	In
the	upper	right	corner	of	Figure	3.14,	the	resolution	gate	is	being	shown.	As	you	can	see,	the
resolution	size	is	barely	visible	over	the	image	plane.	You	do	not	see	the	rectangle	resolution
gate,	because	 it	 is	white	and	 the	 image	plane	 is	white.	 If	 the	render	settings	were	 incorrect,
you	would	see	the	resolution	gate	as	a	different	size	from	the	image	plane.

Here’s	 a	 good	question:	Do	 they	need	 to	match?	No.	Actually,	 your	 2D	 images	 can	be	 a



separate	size	and	you	can	adjust	during	compositing	 time.	You	would	only	need	 to	globally
resize	your	3D	image	to	match.	But	why	go	through	that?	Remember	that	bad	habit	we	talked
about—the	“we’ll	fix	it	in	post”	terror,	which	is	shorthand	for	“I	don’t	want	to	think	about	it
right	now.	Let	someone	else	fix	the	problem.”

Hold	on	a	moment.	I	need	to	stop	and	look	at	this.	All	these	button	clicks;	all	these	things
that	 could	 potentially	 go	wrong.	 And	 in	 a	 group	 project	 we’ll	 have	multiple	 people	 doing
these	things?	Golly.	Animation	that	goes	beyond	a	single	actor	doing	a	vaudeville	act	in	front
of	the	audience	is	not	easy.	But	we	love	it,	so,	okay.	That	was	our	reality	check.	Back	to	work.

Our	file	was	saved	as	2D_Leads_3D_v1.mb	inside	the	3D_Arm	folder.

Animate

The	 odd	 thing	 to	 get	 over	when	 animating	 3D	 on	 top	 of	 2D	 is	 that	 you	 can	move	 your
camera	all	around	to	get	the	object	looking	like	it	is	in	the	correct	spot.	The	thing	that	matters
is	how	the	final	image	is	going	to	render	out.	So	you	can	do	some	unconventional	movement
in	the	camera	placement	to	cheat	perspective	or	use	it	to	your	advantage.	Beware:	overuse	of
this	power	can	make	for	some	odd-looking	animation.

FIGURE	3.15	Keyframes	set	in	Maya

Because	we	have	the	knowledge	of	what	frames	are	keyframes	via	the	x-sheet	and	we	have
an	understanding	of	what	 timing	was	used	via	 the	 timing	charts,	we	have	an	easier	 time	of



matching	the	3D	animation	to	the	2D	animation:

1.	 Import	in	the	3D	arm	rig.	Click	File	>	Import	and	locate	the	ArmRig_v1.mb	file.	This
will	bring	in	the	arm	at	the	origin.

2.	 Use	the	Perspective	and	orthogonal	views	to	position	the	arm	so	that	it	looks	like	it
is	in	the	correct	spot	in	the	Render_Cam	view.

3.	 Find	the	keyframes	on	the	x-sheet	and	pose	your	arm	for	those	main	keyframes.	Our
x-sheet	 for	 this	example	 is	on	a	 simple	Excel	 spreadsheet:	x-sheet.xls.	You	can	 see
the	spreadsheet	on	the	left	side	of	Figure	3.15.

To	help	pose	the	3D	arm	better,	the	Render_Cam	has	been	torn	off	(much	as	we
did	in	Chapter	2).	Also,	Shading	>	Xray	has	been	chosen	so	that	the	animator
can	see	through	the	3D	object	to	the	2D	arm.	If	you	have	the	2D	roughed-in
arm,	 that	 will	 help	 you	 pose	 your	 limb.	 Of	 course,	 the	 perspective	 hand-
drawn	will	 not	match.	 Look	 to	match	 the	 contact	 points,	 the	 shoulder	 and
wrist,	more	than	the	elbow.

To	 set	 keyframes	 easily,	 this	 3D	 arm	 has	 a	 character	 set:	 Arm1.	 Select	 the
character	set	for	the	arm	and	hit	s	for	each	key-frame.	As	Figure	3.15	shows,
keyframes	set	 in	the	timeline	correspond	to	the	x-sheet.	You’ll	note	that	 the
perspective	camera	is	used	to	pose	the	arm	in	3D	space	so	that	it	looks	correct
in	the	Render_Cam	view.

4.	 Next,	 look	for	breakdowns	and	the	spacing	they	should	have,	and	create	keyframes
for	your	arm.	Again,	if	you	have	a	timing	chart	from	the	2D	animation,	you	should	be
able	to	match	the	same	spacing	and	achieve	better	registration	with	the	2D	character.
If	you	do	not	have	a	timing	chart,	you’ll	have	to	guess	where	the	breakdown	is	and
know	that	the	next	step	is	going	to	take	much	longer.	In	Figure	3.16	the	breakdown
28	is	halfway	between	the	keyframe	for	16	and	35.	(For	those	truly	following	along
with	the	enclosed	data,	frame	16	is	held	from	frame	14,	and	in	the	enclosed	example,
frame	28	was	moved	to	29.)

5.	 Remember	to	roll	through	your	drawings	often	to	make	sure	that	the	arm	registers	in
its	 socket.	 Look	 for	 jiggling	 at	 the	 contact	 point	 and	 adjust	 your	 keyframes	 to
eliminate	the	jiggling.

6.	 Now,	 add	 your	 inbetweens.	Use	 the	 graph	 editor	 to	 adjust	 the	 final	 spacing	 of	 the
drawings	to	match	the	2D.



FIGURE	3.16	Breakdowns	set	in	Maya

Take	Note

A	note	on	 following	 the	 timing	chart.	With	 the	 timing	chart	 showing	where	breakdowns
are	on	halves,	or	halfway	between	the	keyframes,	you	can	speed	up	your	workflow	and	use
Maya	to	your	benefit.	For	instance,	the	timing	chart	between	frames	16	and	28	calls	for	frame
22	to	be	halfway	between	the	keyframes.	Set	the	tangents	on	frame	16	to	be	linear.	Frame	22
will	then	be	mathematically	halfway	between	the	two	keyframes.	Go	to	frame	22,	take	a	look
at	the	drawing,	and	adjust	as	necessary	to	put	things	on	arcs	or	add	overlapping	action	and	so
forth,	then	hit	s	to	set	a	keyframe.



FIGURE	3.17	Using	Maya’s	inbetweens	but	moving	them	to	the	correct	time	to	match	the	timing	chart

The	next	half	on	the	timing	chart	is	for	frame	22.	That	drawing	is	supposed	to	be	halfway
between	frames	16	and	22.	Let	Maya	do	the	work	for	you.	Locate	the	inbetween	that	Maya
has	made	 that	 is	visually	halfway	between	 frame	16	and	 frame	22.	 In	our	example,	 it	 is	on
frame	19.	Go	to	frame	19	and	hit	s	on	the	keyboard	to	make	that	a	keyframe	in	Maya.	Then
simply	use	 the	dope	 sheet	 to	move	 the	keyframe	 to	 frame	20	as	 the	 timing	chart	 indicates.
Now	you	 can	more	 easily	 go	 into	 the	 graph	 editor	 and	 adjust	 your	 spacing	by	moving	 the
tangents.	 Your	 timing,	 where	 the	 keyframes	 and	 breakdowns	 are,	 is	 already	 in	 place.	 This
method	 speeds	 up	 your	 work-flow	 tremendously.	 Use	 Maya	 to	 do	 the	 work	 for	 you,	 but
control	it	so	that	you	don’t	end	up	with	Maya	inbetweens.	(The	horror!)



FIGURE	3.18	Completed	animation	in	Maya

7.We’ll	use	your	twos.mel	script	to	put	this	animation	on	twos:

a.	 In	the	outliner,	select	the	character	set.
b.	 Type	twos	in	the	command	line.
c.	 You	will	 receive	 the	 feedback.	 Put	 this	 command	on	 a	 shelf	 to	 animate	 the

timing:	select—r	timeOnTwos.
d.	 Highlight	the	command	select—r	timeOnTwos	and	middle-mouse-drag	it	to

a	custom	shelf	so	that	you	can	use	it	later	on.
e.	 Scrub	through	your	animation	to	see	that	your	work	is	now	on	twos.

What?	 Oh.	 Your	 animation	 isn’t	 always	 on	 twos?	 That	 is	 the	 case
sometimes,	 isn’t	 it?	 Let’s	 look	 again	 at	 our	 animation.	 If	 you	 have
timing	that	is	on	ones	at	some	points	and	on	twos	(or	fours,	whatever
it	 may	 be)	 at	 others,	 you	 can	 animate	 what	 the	 script	 has	 set	 your
timing	 to	be.	 It	 isn’t	 too	hard,	 either.	 I	 like	 this	method	much	better
than	 setting	 every	 key	 on	 stepped	 and	 manually	 making	 every
keyframe	on	twos.

f.	 If	 you	 haven’t	 clicked	 anything	 since	 running	 the	 script,	 the	 timeOnTwos
node	is	still	selected	and	you	can	see	it	in	the	channel	box.	If	not,	you’ll	need
to	 click	 on	 the	 button	 you	 made	 or	 type	 into	 the	 script	 editor:	 select—	 r
timeOnTwos.

g.	 You	can	animate	this	attribute	as	needed	to	adjust	your	timing.	With	the	time
set	 to	 frame	1,	 right-click	on	 the	attribute	and	keyframe	selected.	This	will
set	a	keyframe	for	timing	on	twos.



h.	 Advance	to	a	frame	where	you	need	the	timing	to	change	to	ones	and	change
the	By	attribute	to	1.	Set	the	keyframe	on	that	attribute.

i.	 This	way	 you	 can	 adjust	 your	 ones	 and	 twos	 but	 still	 use	 the	 graph	 editor
without	creating	a	large	mess.

FIGURE	3.19	Using	twos	script	to	put	3D	animation	on	twos

8.Render	the	animation.	There	is	already	a	toon	shader	and	ink	line	on	the	arm	for	you.
You	need	only	 to	 render	 the	arm	 level.	This	means	 that	you	do	not	want	 the	 image
plane	to	render.	How	do	you	get	rid	of	that?	You	can	either	delete	the	image	plane	at
this	point	or	adjust	the	alpha	gain	for	the	image	plane	to	be	0.	Then	render	as	follows:

a.	 Set	the	render	settings.	See	Figure	3.20.

i.	 Name	the	level
ii.	 Name.#	extension
iii.	 .tif	(or	something	that	keeps	alpha	channels)
iv.	 Start	and	end	frames
v.	 Frame	padding
vi.	 Select	the	correct	camera
vii.	 Make	sure	to	include	alpha	channels
viii.	 Make	sure	your	size	is	correct.

b.	 Click	Render	>	Batch	Render.



FIGURE	3.20	Render	settings	and	example	of	final	renders

Our	arm	level	file	names	are	arm.#.tif.
How	did	you	do?	Things	should	start	to	seem	a	lot	easier	now.	If	you	did	not	have	a	good

grasp	 on	 the	 graph	 editor	 to	 begin	with,	 this	might	 be	 a	 little	 tricky	 for	 you.	 Please,	 avoid
keyitis.	This	is	a	horrible	disease	in	which	the	animator	who	does	not	feel	comfortable	in	the
graph	editor	begins	to	compensate	by	setting	key-frames	on	every	frame.	Yes,	you	can	do	this,
but	 you	 start	 to	 get	 into	 stop-motion	 animation	 at	 that	 point,	 where	 everything	 is	 being
moved	manually	 and	 no	matter	 how	 hard	 you	 try,	 there	will	 be	 pops	 and	 jumps	 between
images.	Of	course,	if	you	are	going	for	a	stop-motion	feel,	don’t	do	it	that	way	either.	There
are	procedural	ways	to	adjust	your	timing	to	get	the	same	type	of	feel.	I	can’t	stop	you.	If	you
have	to	go	through	your	keyitis	phase,	go	ahead,	get	it	out	of	your	system.	If	you	start	to	miss
your	quotas,	come	back	and	conquer	your	fear	of	the	graph	editor.	Kudos	to	my	students	who
I	have	seen	work	hard	on	getting	over	their	graph	editor	fear.

Take	Note

Remember,	if	you	render	out	.tif	images,	they	do	not	read	into	Photoshop	with	their	alpha
channel.	For	every	compositor	that	exists,	.tifs	are	fine—just	not	Photoshop.

Rim	Light



Something	 to	consider	when	you	have	a	2D	object	and	a	3D	object	 together	 in	 the	same
scene	is	whether	you	want	them	to	look	very	flat	or	whether	you	want	them	to	have	some
dimension.	Usually	 this	 boils	 down	 to	 the	 question	 of	whether	 you	 have	 time,	money,	 and
human	resources	to	make	rim	lights,	tones,	and	shadows	for	all	of	your	characters.	These	types
of	elements	are	usually	produced	by	the	Special	Effects	EFX	department.	I’ll	talk	more	about
this	odd	brand	of	artists	later	on	in	the	EFX	chapter.	(I	mean	odd	in	a	great	way.)	For	our	solo
project,	we	will	include	rim	lights	(or	highlights)	on	our	3D	arm,	as	it	is	made	of	metal.

We	will	make	 the	 rim	 light	 as	 a	 separate	 pass	 from	 the	 rendered	 arm.	This	way	we	 can
adjust	 it	 at	 composite	 time	 to	match	 everything	 else.	 Our	 goal	 is	 to	 create	 a	 rim	matte:	 a
black-and-white	image	representing	the	area	that	will	be	a	highlight.

This	is	a	different	way	to	think.	As	you	create	this	image,	you	are	not	thinking	of	anything
but	 a	 black-and-white	 image	 that	 represents	where	 the	 highlight	will	 be.	 So	 do	 not	worry
about	 the	 main	 color	 of	 the	 arm.	 I’m	 starting	 with	 my	 last	 saved	 Maya	 file:
2D_Leads_3D_v5.mb.

1.	 To	start,	I	have	to	hide	my	image	plane.	The	bright	white	gets	in	my	way.	I’ll	toggle
off	cameras	by	clicking	in	the	Render_Cam	window:	Show	>	Cameras.	In	my	sample
file,	I	have	deleted	the	image	plane.

2.	 Now,	let’s	assign	a	special	toon	shader	to	the	arm:

a.	 Unlock	the	GEO_Layer	by	clicking	the	R.
b.	 Select	any	part	of	the	arm	and	hit	the	up	arrow	key	or	select	the	GEO	group

node	in	the	outliner.
c.	 Assign	 a	 Dark	 Profile	 Toon	 shader	 to	 the	 arm	 under	Animation:	Toon	 >

Assign	Fill	Shader	>	Dark	Profile.
d.	 Create	the	color	ramp	so	that	its	first	chip	is	white	and	the	second	is	black	as

shown	in	Figure	3.21.	This	will	create	a	white	area	where	we	want	to	have	a
highlight	and	all	else	is	black.	Perfect.

e.	 In	the	outliner,	delete	the	Toon	Line	Shader.	We	do	not	need	it	for	this	pass.

3.	 Render	the	rim	light	pass.

a.	 Go	to	your	Render	Settings	and	prepare	your	render.	See	Settings	in	Figure
3.22	and	then	Batch	Render.



FIGURE	3.21	Dark	profile	added	to	the	robot	arm.	This	will	be	used	as	a	rim/highlight	matte

FIGURE	3.22	Render	Settings	and	an	example	of	final	renders

Take	Note

Even	though	we	have	set	up	the	rim	light	as	an	RGB	image	that	will	be	used	as	a	mask,	we
still	need	the	alpha	channel	for	the	arm.	Make	sure	to	use	.tif	or	some	format	that	keeps	alpha



channels.
Our	Rim	Light	file	names	are	arm_RL.#.tif.

Cleanup	in	Photoshop

To	do	proper	cleanup	 in	Photoshop,	you	will	want	 to	use	a	brush	 that	gives	 the	best	 line
quality.	Well,	how	do	you	accomplish	 that?	Those	of	us	who	grew	up	with	Photoshop	have
seen	it	change	from	a	tool	that	you	would	never	dream	of	drawing	with	to	a	tool	that	has	lots
of	potential.	In	fact,	it	has	too	much	potential—it	can	be	a	thick	forest	to	traverse	through	to
get	a	brush	that	you	like	and	fits	what	you	need.	(Those	are	two	separate	requirements.	You
can	like	a	brush	but	it	isn’t	what	you	need.)

The	choices	seem	to	boil	down	to	these:

1.	 Use	a	built-in	brush	in	Photoshop.
2.	 Create	a	custom	brush.
3.	 Download	one.

You	might	jump	to	the	third	option	automatically.	It	sounds	like	the	easy	choice.	Not	any	of
the	 choices	 are	 easy,	 actually.	 You	 are	 forced	 to	 pick	 out	 one	 piece	 of	 candy	 in	 a	 nearly
infinitely	 sized	candy	store.	How	can	you	do	 that?	There	could	be	a	better-looking	piece	of
candy	in	the	next	parameter	that	you	tweak	or	in	the	next	brush	that	you	download!

I	have	watched	various	students	go	through	this	process	as	they	work	on	the	senior	projects
or	on	a	group	project.	I	have	also	gone	through	this	same	process	myself.	Just	when	I	think	I
get	a	brush	 that	 I	 like,	 I	 try	 to	draw	very	 tightly	and	 find	 that	 the	brush	doesn’t	work	well
enough	for	my	purposes	or	does	not	draw	smoothly	enough	for	me.	Once	I	get	a	brush	that	I
like,	however,	I	can	draw	my	heart	out.	It	is	the	process	of	getting	that	brush	that	I	imagine	is
enough;	when	an	artist	finds	a	brush,	she	or	he	might	not	try	any	others.

What	 limitations	 are	 we	 taking	 on	with	 Photoshop?	 This	 is	 drawing	 in	 rasters,	 which	 is
resolution	dependent.	You	are	probably	already	familiar	with	the	limitations	of	raster	images.
If	 you	 zoom	 in	 too	 far,	 the	 image	will	 pixelate.	 This	 is	 avoidable	 if	 you	 keep	drawing	 at	 a
higher	resolution.	What	do	you	gain?	A	different	look	than	vector	drawing	(such	as	we	found
in	Toon	Boom	and	Flash).

Built-in	Photoshop	Brush



Let’s	start	with	built-in	Photoshop	brushes.	Can	you	do	cleanup	with	those	basic	brushes?
Yes.	For	those	who	love	a	thick-thin	cleanup	line,	you	might	not	be	satisfied	with	the	results	if
you	do	not	dig	deeper.

I	 interviewed	a	 student	who	had	 spent	weeks	doing	cleanup	on	a	 senior	project	piece.	A
note	to	the	concept	of	cleanup:	we	don’t	have	an	actual	class	on	cleanup	in	the	curriculum.	We
tend	to	focus	on	animation,	acting,	storyboarding,	and	the	like.	So	students	who	take	on	the
task	of	 cleaning	up,	 inking	and	painting,	 or	otherwise	 completing	a	 2D	 film	are	 learning	as
they	go.

FIGURE	3.23	Cleanup	using	Photoshop’s	standard	brush

You	might	have	 taken	a	 look	at	 the	basic	 brushes	 in	Photoshop	and	 scrolled	 through	 the
presets.	But	did	you	ever	load	the	other	presets?	I’ll	admit	I	hadn’t	for	quite	a	while,	until	one
day	I	went	poking	around	to	see	what	else	was	there.	If	you	open	the	options	for	the	brushes
palette,	you	will	see	at	the	bottom	various	brush	sets	that	you	can	load	in.	Figure	3.24	shows	a
few	brushes	that	come	with	Photoshop.



FIGURE	3.24	Preset	brushes	in	Photoshop

When	your	cleanup	and	painting	are	done,	you	will	export	an	uncompressed	movie	file	to
keep	your	alpha	channels.	That	catches	some	students—and	professors.



FIGURE	3.25	Exporting	the	final	level	of	Jam,	saving	as	raw	QuickTime	in	order	to	have	alpha	channels

The	cleanup	file	name	in	the	companion	data	is	Jam_Lvl_12fps.mov.

Custom	Brushes

You	can	push	further	than	the	stock	brushes	and	create	your	own.	There	is	a	lot	you	can	do
when	you	modify	the	attributes	of	the	stock	brushes,	and	you	can	come	up	with	an	amazing
assortment	of	looks	that	are	much	more	painterly	or	at	least	non-round.	It	takes	a	lot	of	time
to	experiment,	so	make	sure	to	set	someone	on	this	task	early	on	in	your	group	project.	If	you
are	doing	a	solo	project,	that	someone	is	you.

When	 you	 create	 custom	 brushes,	 the	 brush	 shape	 is	 based	 on	 a	 grayscale	 image.
Completely	black	areas	will	fully	deliver	paint	to	the	canvas,	gray	areas	will	deliver	a	varying
degree	of	paint,	 and	white	areas	will	not	paint.	The	brush	attributes	can	be	applied	 to	your
custom	brush	tip.

How	do	you	make	that	black-and-white	image?	You	can	paint	it	 in	Photoshop,	scan	in	an
image,	or	create	it	in	Illustrator	or	a	similar	program.

Here’s	an	example	of	creating	a	custom	brush:

1.	 Create	the	desired	brush	tip	shape	in	Illustrator	and	save.
2.	 Open	that	file	in	Photoshop.



3.	 Click	Edit	>	Define	Brush	Preset….	This	creates	a	brush	from	that	image.
4.	 Tweak	the	parameters	until	you	get	the	desired	results.

FIGURE	3.26	Using	an	Illustrator	file	to	create	a	custom	Photoshop	brush

Dig	Deeper

Learn	how	to	harness	Photoshop’s	brushes	with	Creative	Photoshop	Digital	Illustration	and
Art	 Techniques	 by	 Derek	 Lea.	 Just	 reading	 the	 first	 chapter	 sent	 me	 off	 painting	 with
Photoshop	like	never	before.

Downloading	Brushes

Of	course,	why	reinvent	the	wheel?	There	are	an	amazing	number	of	brushes	waiting	for
you	to	download.	In	just	doing	a	quick	search	for	the	group	project,	I	found	more	brushes	than
I	 could	 ever	 test	 in	 one	 session.	 For	 example,	 I	 ran	 across	 a	 brush	 web-site:
myphotoshopbrushes.com.	Though	there	were	many	sets	of	brushes	that	I	could	have	looked

http://myphotoshopbrushes.com


at,	I	focused	more	on	traditional	media	brushes	and	ran	across	this	set	called	Dukal’s	Artistic
Brushes	 by	 Alex	 Dukal.	 You	 can	 find	 these	 brushes	 at
http://myphotoshopbrushes.com/brushes/id/248.

I	downloaded	these	brushes	and	found	that	 they	were	at	a	very	high	resolution,	meaning
the	brushes	were	huge	and	contained	a	 lot	of	detail.	You	can	 scale	 the	brushes	down	 to	do
detailed	work	and,	of	course,	use	them	as	large	sweeping	brushes	as	well.	I	then	took	a	look	at
Alex	 Dukal’s	 website	 to	 see	 what	 type	 of	 work	 he	 does	 with	 these	 brushes
(www.circografico.com.ar).	 Lovely	 work.	 Figure	 3.27	 shows	 the	 Dukal	 brushes	 loaded	 into
Photoshop	and	one	quick	use	of	brush,	“Splat	2.”

FIGURE	3.27	Dukal’s	artistic	brushes

What	can	you	do	with	brushes	like	these?	Figure	3.28	is	an	illustration	by	Dukal	using	his
Photoshop	brushes.	This	originated	as	a	doodle	on	a	Post-it	note.	The	background	is	scanned-in
mag	paper.	The	brushes	he	used	were	his	collection	of	Artistic	Brushes	#2.

http://myphotoshopbrushes.com/brushes/id/248
http://www.circografico.com.ar


FIGURE	3.28	Alex	Dukal’s	Chick	of	the	Year

I	didn’t	search	for	it,	but	I	would	bet	there	is	a	downloadable	brush	set	of	coffee	stains	or
stains	in	general.	I’ll	have	to	put	that	onto	my	to-do	list	for	looking	up	or	creating.	Can	you
imagine	it?	I	could	put	coffee	stains	on	all	of	my	lecture	notes	or	PowerPoint	slides.

Or	Clean	Up	in	Toon	Boom

Another	package	that	you	might	use	to	do	cleanup	in	is	Toon	Boom.	This	company	offers
different	product	solutions.	Each	one	has	a	different	tool	set.	For	frame	by	frame	animation,
we’ll	use	Toon	Boom	Animate	3.	(Not	the	Pro	version—which	is	more	for	the	cut-out	style	of
animation	according	to	the	documentation.)

In	Figure	3.29	you	see	the	timeline	at	the	bottom	of	the	screen.	The	x-sheet	can	be	found
under	the	x-sheet	tab.	The	keyframes	that	were	drawn	in	Photoshop	have	been	brought	into
one	level	by	importing	the	drawings	and	a	drawing	level	has	been	placed	above	the	keys.



FIGURE	3.29	Animation	brought	into	Toon	Boom	for	inbetweens	and	cleanup

To	get	a	tapered	line	in	Toon	Boom,	you	will	need	to	adjust	the	settings	for	the	brush	tool.
See	 Figure	 3.30	 for	 an	 example.	 A	 range	 between	 a	 minimum	 of	 0	 and	 maximum	 of
something	of	your	choice	will	vary	the	thickness	of	the	line.	The	attribute	smoothing	will	 try
to	auto	adjust	your	line.	The	higher	the	number,	the	more	it	believes	you	cannot	draw	and	will
try	to	draw	for	you.	For	some	this	 is	a	bonus,	for	others	 it	 is	a	major	annoyance.	Bring	that
setting	down	as	low	as	you	need	to	for	sanity.	Another	thing	you	might	notice	directly	off	the
bat	is	that	the	line	seems	jagged	when	you	draw.	This	is	a	vector	line	and	you	are	only	seeing
a	 quick	 screen	 representation.	 You	 will	 have	 to	 select	 Play	 >	 Render	 and	 Play.	 In	 older
versions	the	hot	key	CTRL	+	ENTER	will	open	the	playback	window.	In	the	playback	window
you	can	see	the	real	line	as	shown	in	Figure	3.30.	Note	that	the	fine	art	of	creating	wonderful
cleanup	lines	lies	in	you—not	the	software.	Take	care	to	draw	your	lines	with	appropriate	thick
and	thin	weights,	which	software	does	not	automatically	take	into	account	as	it	renders.



FIGURE	3.30	Cleanup	line	in	the	jagged	preview	and	in	the	final	render	view

Final	Render

In	 this	 book	 we’ll	 use	 many	 different	 compositing	 softwares.	 For	 this	 chapter,	 we’ll	 use
After	Effects	to	composite	the	different	levels	together.	Later	on	in	this	book,	we’ll	use	a	node-
based	compositor	to	see	the	difference	in	how	you	approach	a	scene.

Let’s	 review	 the	 levels	 that	we	have	 starting	 from	 the	back	 to	 the	 front.	Refer	 to	 Figure
3.31.	The	bottom	level	is	a	background,	which	was	painted	in	Photoshop.	The	next	level	up	is
the	character	level,	which	is	composed	of	both	the	ink	and	the	paint	level.	These	levels	could
be	separated	into	two	levels.	With	them	separate,	there	are	more	compositing	tricks	that	you
can	do	with	 the	 ink	 lines.	Next,	 there	 is	 the	3D	arm	 level,	which	also	has	both	 the	 ink	and
paint	 together.	 Above	 those	 is	 the	 RGB	 version	 of	 the	Rim	 Light	 level.	 It	 is	 important	 to
remember	that	we	are	seeing	an	RGB	image	of	a	matte	and	not	looking	at	an	alpha	channel.
(One	 is	 inverted	 from	 the	 other.)	 Lastly,	 we	 have	 a	 table	 level,	 which	 is	 titled
underlay/overlay.	 It	has	this	 title	because	 it	 lies	over	most	everything	but	also	“lies”	under
Jam’s	elbows.



FIGURE	3.31	Levels	that	need	to	be	composited	together	and	a	final	composited	image

Setting	Up	the	Composition

Bring	the	art	assets	into	After	Effects.	Remember	to	check	your	import	preferences	so	that
they	match	the	frame	rate	that	your	project	is	in.	See	Figure	3.32	for	an	example.

FIGURE	3.32	Import	preferences	should	match	the	frame	rate	of	the	project

On	 newer	 versions	 of	 After	 Effects	 on	 a	 Macintosh,	 the	 images	 come	 in	 automatically
packaged	into	a	nice	image	sequence.	Lovely.	See	Figure	3.33	as	an	example.



FIGURE	3.33	CS6	of	After	Effects	on	a	Mac	packages	image	sequences	neatly	for	you.	No	precomp	necessary

In	 older	 versions,	 you’ll	 want	 to	 follow	 the	 next	 steps	 to	 keep	 things	 neat	 and	 orderly:
create	a	folder	for	the	levels	that	are	individual	.tif	images.	For	example,	the	arm	and	the	arm
rim	light	levels	would	have	their	own	folder.	Then	you’ll	want	to	make	a	“precomp”	of	each
of	those	levels.	First,	make	a	composition	of	the	arm	level	by	selecting	arm.0001.tif	 through
arm.0050.tif	and	dragging	them	onto	the	Create	a	New	Composition	button.	This	will	open
a	dialog	box.	To	get	the	images	to	show	up	one	after	the	other,	you	need	to	select	Sequence
Layers	 and	make	 sure	 that	 the	Still	Duration	 is	one	 frame:	0:00:00:01.	 See	 Figure	3.34	 and
Figure	3.35	for	examples.

FIGURE	3.34	Creating	a	precomp	of	the	arm	level



FIGURE	3.35	Arm	composition

Create	a	new	composition	and	drag	 in	 the	 levels	 in	 the	 following	order	starting	from	the
bottom	level	to	the	top:	background,	olul,	Jam.	Do	not	drag	in	the	arm	and	arm	rim	light	just
yet.	See	Figure	3.36	for	an	example	of	how	the	composition	should	look	at	this	point.	You’ll
note	 that	 Jam	 is	overtop	of	 the	 table.	That	 is	great	 for	her	hands,	but	her	body	needs	 to	be
behind	the	table.	We’ll	have	to	matte	that	out.	We’ll	tackle	mattes	later	on	in	this	chapter.



FIGURE	3.36	Levels	in	After	Effects

3D	Arm	with	Rim	Light

The	3D	arm	is	going	to	take	just	a	little	bit	of	working	with	to	get	the	rim	light	on	it.	The
great	thing	about	using	mattes	to	adjust	lighting	is	that	in	this	comping	stage,	you	can	see	the
arm	level	in	relationship	with	all	of	the	other	levels.

1.	 Create	a	new	composition	by	clicking	the	Create	New	Composition	icon.
2.	 Give	 the	 composition	 the	 name	 3DArm.	 Make	 sure	 that	 the	 composition	 is	 the

correct	size,	and	watch	out	for	frame	rate!
3.	 Drag	the	Arm	composition	that	we	made	earlier	into	this	new	composition.
4.	 Right-click	in	the	timeline	and	add	a	New	>	Adjustment	Layer	above	the	3D	arm.
5.	 Drag	in	the	Arm	Rim	Light	composition	and	place	it	above	the	Adjustment	Layer.



FIGURE	3.37	Arm	and	Arm	Rim	Light	put	into	their	own	composition

6.	 Select	 the	Adjustment	 Layer	 and	 from	 the	 top	menu	 click	Layer	 >Track	Matte	 >
Luma	Matte.	You	will	be	able	to	see	the	arm	level	again.	You’ll	notice	a	matte	icon
next	to	the	Adjustment	Layer	and	the	Arm	Rim	Light	level.

7.	 Right-click	on	the	Adjustment	Layer	and	add	EFFECT	>	Color	Correction	>	Color
Balance	(HLS).

8.	 Bring	Lightness	up	to	the	desired	level.

Another	great	thing	about	having	this	rim	light	matte	is	that	you	can	adjust	the	color	of
the	 painted	 object.	 Some	 tutorials	 might	 have	 you	 make	 a	 black-and-white	 matte,
adjust	the	opacity,	and	just	lay	it	overtop	of	the	arm	level.	That	is	a	valid	method	but
does	not	give	the	most	color	correction	capability.

Let’s	work	with	that	matte	just	a	little	bit	more.



FIGURE	3.38	Rim	Light	matte	level	used	to	adjust	the	color	of	the	arm

1.	 Select	 the	 Arm	 Rim	 Light	 Layer	 and	 click	Effect	 >	Blur	 &	 Sharpen	 >	Gaussian
Blur.

2.	 Blur	 the	matte	by	changing	blurriness	 to	a	desired	number.	Ours	 is	 set	 to	3.	 (Make
sure	the	visibility	of	the	layer	is	off.)

Back	in	the	main	composition,	drag	in	the	3D	Arm	composition	that	we	just	completed.
You	should	now	have	a	3D	arm	with	rim	light	on	top	of	your	2D	character.



FIGURE	3.39	3D	arm	with	rim	lighting	added	to	main	composition

Masking	Out	Body

One	last	thing	to	do	with	the	body	is	to	add	a	matte	to	mask	out	where	the	table	is	so	that
the	arms	stay	on	top	of	the	table	but	the	body	is	not	visible.	The	easiest	steps	to	create	a	mask
are	to	select	the	layer	you	want	to	mask	out	and	then	click	on	the	pen	tool	and	draw	the	mask.
There	are	other	ways	to	do	it,	but	this	way	requires	the	fewest	number	of	clicks.

1.	 Select	the	Jam	level.
2.	 Near	the	top	of	the	application,	choose	the	pen	tool	(or	hit	G).
3.	 Draw	a	mask	along	the	edge	of	the	table.	Take	care	to	draw	around	the	2D	elbow	on

the	 table.	 Click	 on	 the	 beginning	 point	 when	 you	 are	 done,	 and	 the	 mask	 will
complete.

4.	 And	 it	will	mask	 out	 everything	 else	 but	 the	 bottom	 of	 the	 body.	 In	 the	 timeline,
open	up	the	Mask	attribute	that	has	been	added	onto	the	Jam	level.	Click	Inverted.
Your	mask	should	now	be	masking	out	the	bottom	of	the	body	as	you	want.



Random	Note

The	words	are	bugging	me	here,	 in	case	you	couldn’t	 tell.	 In	my	vocabulary,	a	matte	 is	a
noun;	it	 is	what	you	draw.	The	verb	is	“mask.”	Using	these	terms,	a	matte	masks	out	things.
However,	After	Effects	calls	the	mattes	masks.	Oh,	bother.

FIGURE	3.40	Body	masked	out	so	that	it	is	not	visible	overtop	of	the	table

You	might	 have	 noticed	 that	 the	 3D	 arm	 is	 overtop	 of	 the	 hair	 at	 the	 beginning	 of	 the
animation.	Repeat	the	same	steps	above	for	the	3D	arm	level	to	make	it	look	like	the	hair	is
on	 top	of	 the	arm.	Something	different	you	will	have	 to	do	 is	make	 it	a	 traveling	matte;	 in
other	words,	animate	it	moving	along	with	the	hair.	Simply	use	the	Selection	Tool	 (or	press
v)	to	move	the	points	around.	After	Effects	will	auto-keyframe	for	you.



FIGURE	3.41	Traveling	matte	created	to	hold	out	the	arm	where	the	hair	should	appear	on	top

At	every	stage	that	we	have	gone	through,	there	is	room	for	being	meticulous.	To	not	be	so
is	to	create	errors	that	will	show	up	in	the	final	stage.	You	can	imagine	in	a	large	production,
or	even	in	your	small	group	project,	many	of	these	steps	are	carried	out	by	different	people
with	no	 idea	what	 the	other	people	are	going	 to	do	with	 their	 images	when	 they	are	done
with	them	and	no	idea	of	how	the	whole	pipeline	fits	together.	At	every	stage,	you	want	to
look	for	areas	where	you	can	“plus	the	image”	and	understand	how	those	before	and	after	you
are	going	to	work	with	the	asset	you	create	so	that	you	can	help	and	not	hinder	them	with
your	work.	 You’ll	 have	 to	make	mistakes	 to	 figure	 that	 out.	My	 suggestion	 is	 to	 do	 group
projects	often.	This	will	help	you	see	those	costly	mistakes	before	your	paycheck	is	riding	on
it.

FIGURE	3.42	Final	comp

Interview

Name:	Todd	Redner



Title:	Animation	Director	at	Floyd	County	Productions
http://www.imdb.com/name/nm2400789/

Let’s	face	it,	we	have	limits	in	the	real	world	and	they	are	called	“budgets.”	The	only
way	we	were	able	to	make	a	3D	pilot	and	keep	it	under	budget	was	to	use	2D	animation
on	3D	models.	The	characters	were	sculpted	as	generic	people.	We	simply	unwrapped
the	models	and	drew	all	the	facial	features,	colors,	clothing,	and	so	on	in	Flash.	The	3D
animators	only	had	to	worry	about	body	movements,	while	the	2D	animators	did	all	of
the	eye	movements	and	 lipsync	 in	Flash.	 It	worked	really	well	and	had	a	very	unique
look.	It	saved	us	time	and	money	in	multiple	areas:	we	didn’t	have	to	purchase	multiple
workstations,	render	times	did	not	kill	us,	and	by	separating	the	facial	movements	from
the	body	animation	we	were	able	to	animate	faster.

The	biggest	help	in	using	3D	and	2D	together	for	us	has	been	with	backgrounds	and
objects.	You	can	spend	some	crazy	hours	on	building	realistic	backgrounds	for	your	3D
show.	One	of	our	projects	was	taking	way	too	long	to	draw	and	paint	the	backgrounds,
so	our	solution	was	to	take	rough	sketches	and	build	a	simple	3D	background.	That	way
we	could	have	the	model	done	for	all	angles	in	one	shot,	get	the	shading	done	faster,	and
the	perspective	was	already	done	before	the	next	shot	was	laid	out!	After	we	pick	the

http://www.imdb.com/name/nm2400789/


shot,	we	just	render	and	add	any	texture	or	effects.	Another	show	we	did	called	for	the
reverse.	The	characters	were	entirely	created	in	3D,	but	we	painted	the	backgrounds	in
2D.	There	were	just	so	many	shots	that	required	crazy	amounts	of	objects	and	sets	that
would	just	not	work	for	our	budget	to	do	in	3D.	So	we	creatively	blended	2D	and	3D
into	the	backgrounds.	No	matter	what	the	media	 is—2D,	3D,	or	4D	(fingers	crossed!)—
whatever	it	takes	to	get	the	right	look	and	also	keep	the	project	under	budget	is	what
we	have	to	do.	Otherwise,	we	are	either	losing	money,	losing	work,	or	both.

Further	Reading

Kundert-Gibbs,	J.	Action!	Acting	Lessons	for	CG	Animators.	Indianapolis:	Sybex,	2002.
Lea,	Derek.	Creative	Photoshop	Digital	Illustration	and	Art	Techniques.	Amsterdam;	Boston:

Focal	Press,	2007.
Schroeppel,	 Tom.	 The	 Bare	 Bones	 Camera	 Course	 for	 Film	 and	 Video.	 Coral	 Gables,	 FL:

Schroeppel,	1980.

Student	Contributors

Contributing	students	for	this	chapter,	in	order	of	contribution:

John-Michael	Kirkconnell
Claire	Almon
Clint	Donaldson
Dianna	Bedell
Amanda	Powell
Daniel	Tiesling



4

3D	Characters	with	2D	Parts	(3D	Leads)

FIGURE	4.1	Bouncing	2D/3D	balls,	by	Jessica	Toedt,	2009,	2D/3D	compositing	course,	SCAD

Lecture	Notes

How	are	you	doing	so	far?	I	hope	that	you	are	getting	used	to	the	process	and	thinking	up



ways	to	combine	the	media	and	reasons	why	you	should.	Once	you	have	everything	broken
down	into	the	basic	patterns	of	problems—2D	leads,	3D	leads,	using	cameras	and	textures	to
flatten	3D	or	using	tones	and	shadows	to	round	2D	(we’ll	cover	that	soon),	rendering	in	layers,
compositing,	and	using	masks—then	it’s	just	a	matter	of	finding	the	best	ways	to	achieve	your
look	with	whatever	techniques	you	need.

By	now	you	have	probably	lost	a	little	fear	and	do	not	believe	that	you	need	to	stay	in	one
package	for	your	scenes;	heavens,	no.	By	now	you	should	be	thinking	in	layers	of	images.	You
should	be	 thinking	 that	 the	output	of	any	given	software	package	 is	 just	an	 image	and	 that
your	character	is	made	up	of	multiple	passes	of	images.	Good,	you	have	come	far.

Often	 in	 class	 (or	 even	 the	 industry)	 I	 see	 those	 who	 become	mesmerized	 with	 the	 3D
package.	They	get	stuck	in	that	3D	Cartesian	world	and	think	that	everything	has	to	be	done
there.	 Students	 get	 stuck	 thinking	 that	 they	need	 to	 render	 the	whole	 frame	 in	one	go	 and
overlook	 the	 concept	 of	 breaking	 things	 into	 levels.	 Breaking	 things	 into	 levels	 allows
animators	to	use	mattes	in	a	compositing	package	to	adjust	colors	and	to	isolate	elements	into
levels	so	that	if	something	needs	to	be	tweaked	or	adjusted,	they	do	not	have	to	re-render	the
whole	frame,	just	the	one	level.	Ah,	the	time	savings	that	process	gives;	it	makes	me	happy.

The	same	thing	goes	for	our	characters,	as	we	have	found.	They	do	not	have	to	be	stuck	in
one	medium	or	software	package.	For	many	reasons,	we	have	discovered	you	might	want	to
use	3D	to	help	along	your	2D	animation,	whether	 it	be	 to	reduce	 line	mileage	or	help	with
perspective	and	complexity	of	the	character.	We	have	focused	on	why	one	would	use	3D.	But
why	would	one	use	2D?	Can’t	everything	be	done	 in	3D	nowadays?	If	 I	were	standing	 in	a
classroom	in	front	of	you,	I	would	have	a	perplexed	look	on	my	face	and	would	be	trying	hard
not	to	let	my	sarcasm	show.	Yes,	many	things	can	be	done	in	3D.	But	should	they	be?

In	my	classrooms,	the	students	have	to	produce	a	senior	film	(with	a	passing	grade)	or	they
do	not	graduate.	I’m	sure	this	is	the	case	on	many	campuses:	the	films	tend	to	be	monomedia.
It	is	a	monochromatic	sea	of	3D-ishness,	and	it	all	looks	the	same.	Of	course,	if	it	were	all	2D
films	 it	 might	 look	 the	 same	 too	 because	 of	 similar	 animation	 style	 emulation	 in	 the
curriculum.	However,	more	than	likely,	it	will	not	all	be	similar	simply	because	of	the	different
artists’	hands.	I	am	generalizing,	of	course.	The	3D	work	doesn’t	all	look	exactly	the	same,	but
there	is	a	trap	that	young	artists	can	fall	into.	When	they	create	something	using	the	3D	tools,
the	same	3D	tools	that	the	next	500	artists	are	using,	they	become	satisfied	with	what	they	see
on	screen	and	think	that	it	is	the	vision	they	were	after,	when	in	actuality,	it	is	the	easiest	thing
that	the	tool	has	offered	them	and	the	other	500	to	1,000	artists.	Only	the	few,	who	know	what
their	artistic	vision	is	and	push	to	make	the	software	do	their	bidding,	produce	images	that	are
not	in	that	monochromatic	3D	sea.	Because	the	tools	produce	something	that	can	be	labeled	as
the	 3D	 package	 programmers’	 artistic	 vision,	 those	 without	 their	 own	 clear	 artistic	 vision
settle	for	the	programmers’	vision.	Even	if	you	do	not	use	2D/3D	in	your	independent	films,	at
least	push	beyond	the	programmers’	artistic	vision.	I	will	now	put	away	my	soapbox.



On	our	campus,	only	in	the	past	few	years	after	 introducing	this	2D/3D	class,	 I	have	seen
the	 nonmono	 films	 created.	 It	 is	 nice	 to	 see	 this	 transition.	 We	 must	 break	 free	 from	 the
monochromatic	sea.	(How	did	I	get	back	up	on	this	soapbox?)

We	have	done	a	2D	character	with	3D	parts,	where	 the	2D	character	 leads.	Now	we	will
turn	our	attention	to	a	3D	character	with	2D	parts,	where	the	3D	character	leads.	The	question
to	ask,	then,	is,	why	use	2D	parts?

Why	 indeed	 should	we	use	 2D?	With	 enough	 time	 for	 research	and	development,	nearly
anything	can	be	done	in	3D	that	can	be	done	in	2D.	Back	in	Chapter	1,	we	discussed	how	it	is
no	 longer	 the	 subject	matter	 that	decides.	Human	characters	do	not	have	 to	 be	done	 in	 2D,
because	they	can	be	accomplished	in	3D.	Fuzzy	characters	do	not	have	to	be	done	in	2D.	3D
has	come	a	long	way.	So	it	isn’t	exactly	the	subject	matter	that	decides	the	medium.	What	was
that?	 The	 student	 in	 the	 back	 row,	 you	 had	 an	 answer?	 Yes.	 You	 are	 correct.	 The	 look,
supporting	the	artistic	vision,	is	a	great	reason	to	choose	2D	over	3D.	You	have	been	listening.
Very	good.	This	 is	my	point:	once	 the	student	or	young	filmmaker	gets	beyond	the	 thought
process	that	the	programmers’	artistic	vision	is	a	good	one,	simply	because	it	is	easier	to	push
a	button,	then	that	filmmaker	can	grow	into	seeing	which	method	will	best	support	his	or	her
own	personal	artistic	vision.

Then	you	can	start	to	see	that	sometimes	2D	can	be	the	answer.	We’ll	look	at	some	industry
and	student	examples	further	on	in	this	chapter.	First,	let’s	categorize	some	reasons	you	might
decide	to	use	2D	over	3D.

Line	Look

What	 if	you	 truly	needed	 to	have	a	certain	 style	of	 line	 that	currently	can’t	be	 replicated
with	3D	toon	lines?	Perhaps	you	need	a	lovely	cleanup	thick	and	thin	line.	Perhaps	you	want	a
scratchy	hand-painted	line?	Possibly	you	could	create	it	with	3D,	but	that	brings	us	to	the	next
reason.	Read	on.

Time

Sometimes	 it	 takes	 less	 time	 to	 draw	 it	 than	 it	 does	 to	 do	 all	 of	 the	 research	 and
development	to	figure	out	how	to	do	a	given	thing	in	3D.	We’ll	examine	the	element	of	time
in	the	industry	examples	section.



Animation	Style

Another	 reason	 that	 might	 tip	 the	 scales	 toward	 2D	 instead	 of	 3D	 is	 to	 match	 a	 given
animation	style.	It	might	be	easier	to	animate	in	2D.

Whatever	the	reason,	it	sometimes	is	the	hardest	decision	to	make,	to	add	in	2D.	We	love
our	3D	shiny	buttons	and	widgets.	 It	 is	hard	 to	 stop	and	wonder	 if	 it	would	be	easier,	 look
better,	 or	 possibly	 take	 less	 time	 than	 it	 would	 take	 for	 the	 research	 and	 development
department	to	draw	the	assets.	Did	I	just	say	2D	could	cost	less	than	3D?	If	you	consider	how
much	time	it	can	take	to	test,	develop,	and	render	3D	assets	to	look	like	what	you	want,	then
yes,	2D	can	cost	less.	I’m	referring	to	more	risky	3D	assets,	which	possibly	you	have	not	done
before	or	that	are	highly	technical	like	water,	goo,	dynamics,	and	so	on.

Industry	Examples

The	hydra	from	Disney’s	Hercules	(1997)	is	a	good	example	of	when	2D	was	used	to	get	it
right.	When	 the	hydra’s	heads	grow	 from	 the	 stump	where	 the	previous	head	was	 severed,
there	is	an	eruption	of	goo.	The	hydra	was	a	3D	element	in	a	2D	film.	The	animators	used	flat
shading	 on	 it,	 with	 tones	 and	 highlights.	 There	 were	 rendered	 toon	 lines	 done	 with
Renderman.	(In	that	day,	you	had	to	work	hard	to	have	toon	lines.)	For	the	goo	that	was	to
erupt	from	the	stump,	they	investigated	3D	particle	systems.	They	spent	a	long	time	trying	to
get	the	particles	to	look	right.	It	wasn’t	working.	Finally	the	look	development	supervisor	had
a	wonderful	idea.	She	asked,	“Can	we	do	it	in	2D	instead?”	It	looked	great.	The	animators	did
a	simple	2D	EFX	element	of	goo	and	composited	it	into	the	shot.

Now	that	you	are	getting	used	to	the	idea	of	2D/3D	animation,	it	may	not	seem	that	odd	to
you	to	consider	drawing	a	2D	element	on	top	of	a	3D	element.	Three	chapters	ago	you	might
not	have	so	easily	come	to	the	idea	of	putting	2D	goo	on	top	of	3D.	There’s	no	turning	back
now.	It	is	just	an	image.	Anything	goes	to	get	that	animation	on	the	screen.

Recently	I	wandered	through	a	room	where	Dreamworks’	Spirit,	Stallion	of	the	Cimarron
was	being	played.	It	had	been	a	while	since	I	had	looked	at	that	film.	It	is	a	great	example	of
2D/3D	mixtures.	The	sequence	playing	was	one	in	which	the	lead	horse	falls	into	a	river.	(Why
animal	movies,	both	animated	and	live	action,	always	have	to	douse	animals	in	raging	rivers,	I
do	not	know.)	As	the	horse	struggled	in	the	3D	water,	his	splashes	were	2D.	It	worked	pretty
well	to	have	the	2D	splashes	at	the	contact	point	of	the	2D	horse	and	the	3D	water.	To	have
3D	perfect	water	around	a	flat	2D	horse	would	have	drawn	attention	to	the	contact	point	and
drawn	attention	away	from	the	action	of	the	scene.

I	 have	 another	Disney	 example	 that	 I	 lived	 through.	 For	 Fantasia	 2000’s	 Pines	 of	 Rome



sequence,	 the	animators	worked	hard	 to	develop	3D	whales.	They	were	 lovely	whales;	you
can	check	out	 the	DVD	to	see	 them.	 It’s	a	cute	 tale	about	a	baby	whale	and	his	adventures
while	trying	to	fly	with	his	parents.	There	were	a	few	elements	in	that	sequence	that	could	not
be	executed	very	well	in	3D	at	the	time.	During	production,	in	1995,	3D	was	not	the	best	at	a
few	things.	The	first	element	that	was	not	convincing	in	3D	was	the	eyes	for	the	whales,	and
the	second	element	was	the	water	splashes.	Both	elements	were	done	in	2D.	The	3D	whales
were	printed,	pegged	up	on	paper,	and	used	by	the	2D	artist	as	reference.	I’ll	assume	that	there
was	some	hand-adjusting	of	the	2D	eyes	in	the	compositing	software	at	the	end	of	the	process
if	there	were	any	registration	issues.	The	eyes	were	drawn	in	2D,	and	the	water	splashes	were
not	only	drawn	in	2D,	they	were	drawn	in	an	older	style	of	EFX	animation	with	the	side	of	the
pencil	 instead	 of	 drawing	 outlines.	 A	 similar	 style	 was	 used	 in	 the	 Sorcerer’s	 Apprentice
sequence	in	the	original	Fantasia	(1940).

For	months	I	watched	these	sequences	as	they	went	through	animation.	I	didn’t	even	work
at	 Disney	 at	 the	 time.	 I	 worked	 at	 Dreamworks.	 After	 getting	 off	 work	 I	 would	 drive	 to
Flower	Street	 to	 take	dinner	 to	my	spouse,	who	worked	as	a	cleanup	artist	 in	 the	character
department	by	day	and	did	overtime	 in	EFX	at	night.	He	was	 in	crunch	 time	 then	and	was
working	overtime	drawing	those	whale	eyes	and	water	splashes.	 It	was	a	huge	undertaking
and	turned	out	very	well.	I	marveled	at	the	roto	prints	of	the	3D	whales.	For	some	shots	they
were	 printed	 out	 on	 24	 field	 paper,	 and	 the	 artists	 had	 to	 draw	 eyes	 on	 that	 large	 24	 field
paper.	 I	wish	 I	 knew	 for	 sure,	 but	 I’m	 confident	 that	 animating	on	 24	 field	 paper	 (which	 is
incredibly	huge)	had	to	have	caused	some	slight	registration	issues.	Imagine	these	huge	pieces
of	paper	that	were	twice	the	size	of	normal	animation	paper	and	the	only	things	on	them	were
a	couple	of	small	whale	eyes.	I’m	not	sure	why	they	were	using	24	field	paper.	Usually	when
you	are	drawing	a	small	 image	on	a	 large	background,	you	can	draw	on	smaller	paper	and
composite	the	drawing	into	the	correct	place.	I’m	sure	there	was	a	reason.

Hands-On	Examples

I	 run	 a	 group	 project	 class	 at	 least	 once	 a	 year.	 In	 2008,	 the	 group	 project	 was	 very
successful	for	such	a	small	team.	I’m	proud	to	say	we	placed	in	the	Daytona	Film	Festival,	the
Savannah	Film	Festival,	 and	 the	Atlanta	Film	Festival.	The	group	project	 for	 2009	was	of	 a
slightly	 larger	 scope,	 and	 our	 team	 size	 doubled.	 At	 the	 start	 of	 the	 project	 I	 knew	 that	 I
wanted	it	to	line	up	to	produce	artwork	for	this	book.	So	I	put	onto	the	group	one	restriction:
the	character	had	to	be	a	2D/3D	character.	At	first	I	worried	that	forcing	a	restriction	like	that
would	hamper	the	creative	process	or	it	would	be	forced	onto	the	story	with	no	reason.	The
rule	the	team	came	up	with	for	the	use	of	2D	and	3D	was	this:	organic	=	2D,	nonorganic	=	3D.



I	 thought	 this	was	 an	 interesting	 concept.	We’ll	 take	 a	 look	 at	 a	 sequence	 that	 exemplifies
those	rules	and	the	2D/3D	process.

Jaguar	McGuire:	Cape	on	Fire	Sequence

The	short	group	project	film	that	we	came	up	with	for	2009	is	titled	Jaguar	McGuire.	It	is	a
story	about	a	conflict	between	a	cat	and	his	owner.	The	cat	owner	is	none	other	than	Jaguar
McGuire,	who,	 the	 audience	 finds	 out	 in	 the	 opening	 shot,	 is	 a	 daredevil.	 They	 also	 realize
quickly	that	he	must	have	had	bad	fortune	in	his	career	as	he	is	in	a	body	cast.	The	second	shot
shows	Jaguar	looking	longingly	at	his	cape	and	seemingly	reminiscing	over	his	career,	which,
as	a	newspaper	headline	reminds	him,	is	definitely	over.	Just	as	we	are	feeling	sorry	for	poor
Jaguar	McGuire,	we	realize	 that	his	 troubles	are	 far	 from	over	as	we	hear	 the	 first	of	many
hundreds	 of	meows	 that	 come	 from	his	 cat.	 This	 troubled	 cat	 owner’s	 cat	 still	 requires	 the
things	that	cats	need.	How	will	Jaguar	quell	the	meowing?	What	ensues	is	a	physical	comedy
that	is	sure	to	have	you	laughing.

During	the	struggles,	there	is	a	sequence	where	the	cat	climbs	on	top	of	Jaguar’s	body	cast.
Jaguar	has	one	free	leg	and	tries	to	kick	the	cat	off.	Unfortunately,	the	cat	jumps	off	just	before
the	 leg	 connects	 and	 instead	of	 kicking	 the	 cat,	 Jaguar	 kicks	his	 own	 injured	 leg	 out	 of	 the
sling.	The	momentum	propels	his	leg	off	the	side	of	the	bed	and	knocks	over	his	table,	which
launches	a	vase	of	water	(in	slow	motion)	through	the	air.	The	vase	crashes	and	short-circuits
an	 electrical	 outlet.	 The	 sparks,	 sadly,	 catch	 the	 hem	of	 the	 cape	 on	 fire.	 Jaguar	watches	 in
helpless	 horror	 as	 the	 flames	 burst	 up	 the	 length	 of	 the	 cape.	 Being	 a	 daredevil,	 Jaguar
believes	he	can	stop	the	fire	and	uses	his	only	free	foot	to	try	to	stomp	the	flames.

We’ll	take	a	look	at	how	the	characters	came	to	be	in	the	2D/3D	process	for	this	sequence.
Many	individuals	were	involved	in	the	creation	of	this	short	animated	film.	We	started	with	a
team	of	14	that	met	weekly	in	the	classroom	for	10	weeks	and	then	worked	with	many	more
artists	outside	of	the	classroom	as	we	continued	through	production	and	post-production.

Jaguar

Many	designs	by	students	were	turned	in	for	the	main	character,	Jaguar	McGuire.	Our	art
director,	 Jason	Walling,	 compiled	 different	 ideas	 and	 ultimately	 came	 up	 with	 the	 page	 of
design	ideas	you	see	in	Figure	4.2.	The	character	design	allowed	for	a	2D	leg,	2D	head,	and	2D
wiggling	toes	and	thumbs;	all	else	on	Jaguar,	being	in	a	cast,	is	3D.	You’ll	note	that	the	face	and
leg	are	completely	encased	in	bandages.	It	took	some	convincing,	but	we	finally	came	to	the



agreement	that	at	least	the	leg	would	not	be	covered	in	bandages.	The	reason	for	minimizing
the	bandages	 is	 that	2D	bandages	are	 incredibly	hard	to	keep	up	with	when	animating,	and
the	cleanup	on	them	would	make	it	difficult	to	manage	quality	control.	Anyone	who	has	gone
through	2D	animation	classes	has	probably	heard	the	evils	of	stripes,	long	flowing	hair,	prints
on	clothing,	complicated	ribbon	work,	and	the	like.	All	of	these	items	can	contribute	to	a	more
complex	 cleanup	 line,	 which	 if	 not	 managed	 well	 can	 cause	 strobing,	 jiggle,	 or	 otherwise
distract	from	the	animation.	The	bandages	on	the	face	stayed,	because	those	were	important
to	keep	up	the	high	level	of	frustration	needed	throughout	the	film.

FIGURE	4.2	Jaguar	McGuire	character	design	by	Jason	Walling

Our	director,	Clint	Donaldson,	took	the	concept	and	began	working	on	ideas	of	how	the	2D
and	3D	would	work	together.	In	Figure	4.3,	you	see	a	visual	target	created	by	Clint	that	is	our
first	depiction	of	a	2D	Jaguar	body	inside	of	a	3D	cast.	From	the	very	beginning,	the	idea	of	a
3D	cast	that	was	simply	immovable	backed	our	story	of	this	trapped	stuntman.	It	fit	the	story
and	 I	 was	 pleased	 that	 the	 restriction	 I	 originally	 gave	 did	 not	 end	 up	 feeling	 like	 it	 was
retrofitted	into	the	story.



FIGURE	4.3	Jaguar	McGuire’s	2D/3D	visual	target	by	Clint	Donaldson

For	 the	 first	 10	weeks	of	production	we	had	a	 class	of	 14	 individuals.	Many	were	 tasked
with	modeling	and	texturing.	The	3D	cast	rig	was	created	along	with	a	3D	version	of	the	head
and	 leg	 to	be	used	as	reference	 for	 the	2D	animation.	Figure	4.4	 is	a	 shot	of	 the	 room	with
Jaguar’s	supine	body	on	the	bed.	Because	this	was	a	production	pipeline	with	many	individuals
involved,	we	utilized	the	reference	concept	for	everything.	The	model	and	the	rig	file	were	all
referenced	into	the	main	blocked	Maya	scenes.	This	way	the	scenes	could	be	pushed	through
the	pipeline	before	the	models	or	rigs	were	completed.	As	the	modelers	finished	the	higher-
resolution	versions	of	the	models,	they	updated	the	reference	files.	Then	as	the	riggers	finished
rigging	 the	 files,	 those	were	 updated.	 From	 the	 animator’s	 point	 of	 view,	 they	 animated	 a
block	version	of	the	character	in	a	block	room	one	day,	and	as	the	production	went	along	the
room	they	referenced	in	became	more	high	resolution	and	filled	out	until	it	was	a	completed
room	ready	to	render.



FIGURE	4.4	Jaguar	McGuire	3D	model.	Head	and	leg	are	2D	reference	stand-ins

The	animation	was	completed	 in	Maya.	The	animators	chose	 to	animate	 the	3D	stand-ins
completely	to	better	visualize	the	animation.	Figure	4.5	shows	keyframes	of	the	3D	animation
including	the	stand-in	leg.	The	stand-in	for	the	head	is	a	low-res	version.	This	was	the	rig	that
was	pushed	through	earlier	in	production.	Later	in	the	production,	a	higher-res	3D	head	was
developed	to	allow	more	perspective	help	for	the	2D	animators	(Figure	4.6).	This	higher-res
head	 was	 necessary	 for	 other	 shots	 where	 we	 did	 a	 crazy	 zolly	 shot	 (a	 rite	 of	 passage,
according	 to	 the	 artists).	 A	 zolly	 shot	 on	 a	 2D/3D	 character,	 though,	 is	 very	 challenging.
Another	thing	that	 the	higher-res	head	gave	us	was	the	ability	to	cast	shadows	on	the	head
and	pull	those	shadows	to	composite	overtop	of	our	2D	character.	We’ll	look	at	that	technique
in	the	chapter	on	EFX.



FIGURE	4.5	Jaguar	McGuire’s	3D	low-res	head	referenced	into	the	animator’s	scene

FIGURE	4.6	Jaguar	McGuire’s	3D	high-res	head	referenced	into	the	animator’s	scene

The	animation	was	done	normally	in	Maya,	creating	a	character	set	and	setting	keyframes



as	you	are	used	to.	Also,	the	twos.mel	script	was	used	to	make	sure	that	the	animation	was	on
twos.	 You	 can	 see	 a	 playblast	 of	 the	 animation	 of	 the	 3D	 character	 in	 the	 file
3DLeads2D_3Danim.avi.	This	playblast	from	Maya	shows	the	controls	from	the	rig	as	well.	It
was	a	simple	rig,	as	no	deformations	were	on	the	cast	itself.	We	debated	whether	or	not	to	add
them.	In	the	end	we	decided	that	for	comic	effect	we	would	try	it	without	any	deformations.

Upon	completion	of	the	3D	animation,	Clint	brought	the	animation	into	Flash	to	rough	out
the	2D	animation.	Clint	and	Jason,	the	two	directors	of	the	group	project,	preferred	creating
their	rough	2D	animation	in	Flash	because	it	is	easier	to	set	up	key-frames	in	the	timeline	and
adjust	timing.	They	were	not	familiar	with	animating	in	Photoshop.	They	also	liked	working
with	the	timelines	and	being	able	to	adjust	the	timing	of	their	2D	easily	by	moving	keyframes
in	 Flash.	 You	 can	 open	 the	 Flash	 file	 to	 see	 the	 layering	 used	 and	 the	 rough	 2D	 animation
drawn	overtop	of	the	3D	in	the	file	Shot41	–	43_2DRough.fla,	found	in	the	companion	data.

FIGURE	4.7	2D	rough	animation	drawn	in	Flash

Not	all	animators	in	the	group	project	were	able	to	do	both	the	2D	and	the	3D	animation.
Clint	and	Jason	both	were	able	to,	and	they	handled	the	total	animation	of	each	of	their	shots.
The	cleanup,	originally,	was	to	be	handed	off	to	our	team	of	volunteer	cleanup	artists.	Using
the	 standard	 round	 brush	 inside	 Photoshop,	 they	were	 to	 complete	 the	 cleanup	 pass	 of	 the
character.	 However,	 we	 found	 that	 the	 animators	 had	 fairly	 clean	 lines	 in	 their	 animation.
Most	of	the	cleanup	was	completed	in	Flash	with	a	very	small	brush.

Jaguar’s	Neck	Brace



There	was	much	 discussion	 early	 on	 about	 whether	 or	 not	 we	would	 break	 our	 rule	 of
“organic	is	2D”	with	the	neck	brace.	Clint	and	I	pushed	for	a	2D	neck	brace,	thinking	it	would
be	easier	to	animate	that	way.	I	also	believed	that	it	might	make	for	an	easier	contact	point
between	the	2D	and	the	3D.	To	our	art	director’s	credit,	Jason	did	not	think	we	were	correct
and	did	a	test	to	show	us	that	a	3D	neck	brace	would	work	just	fine.	He	animated	shot	9	with
a	3D	neck	brace.	The	neck	brace	had	a	simple	lattice	deformer	on	it,	and	it	worked	just	fine.	In
fact,	since	we	rarely	see	the	neck	of	the	character,	the	2D	head	can	mostly	be	composited	on
top	of	the	character	with	few	registration	issues.	We	all	had	to	agree	that	Jason	was	correct.
The	test	proved	it.

Figure	 4.8	 shows	 how	 the	 3D	 neck	 brace	 moves	 along	 with	 the	 high-res	 3D	 head.	 A
playblast	of	scene	9’s	3D	is	in	the	companion	data:	3DLeads2D_3Danim_shot9.avi.

FIGURE	4.8	Shot	9	of	Jaguar	McGuire	and	his	3D	neck	brace	animated	by	Jason	Walling,	our	art	director

The	3D	animation	was	 then	brought	 into	Flash	where	 the	 rough	2D	animation	head	was
placed.	The	high-res	version	of	the	head	in	Maya	helped	the	animator	with	perspective	on	the
face	 and	 ears.	When	 combining	 2D	with	 a	 3D	 shot,	 it	 is	 extremely	 important	 that	 the	 2D
follow	 perspective	 as	 much	 as	 possible.	 Otherwise	 there	 would	 be	 a	 visual	 mismatch	 that
would	detract	from	the	animation.



FIGURE	4.9	Shot	9	of	Jaguar	McGuire’s	2D	head,	animated	in	Flash	by	Jason	Walling,	our	art	director

The	 Flash	 file	 for	 this	 rough	 animation	 scene	 is	 in	 the	 companion	 data	 for	 you	 to	 view:
3DLeads2D_2DAnim_shot9.fla.

The	scene	was	cleaned	up	in	Flash	using	a	very	small	brush.	Then	the	scene	was	ready	for
final	composite.

FIGURE	4.10	Cleanup	draw	in	Flash,	by	Jason	Walling,	2009,	SCAD	group	project

Your	Shot	4



Now	it	is	your	turn	to	take	a	shot	from	the	project.	You	have	been	issued	shot	4.	This	is	a
reaction	shot	of	Jaguar.	He	has	been	looking	at	his	cape	and	cards	and	the	newspaper	headline
that	pronounces	his	career	over.	Just	as	he	sighs,	a	deep	sad	groan,	his	nostalgic	lamenting	is
interrupted	by	his	cat’s	meow.

3D	Animation	Leads

Start	 by	 opening	 the	Maya	 file	Shot4_Blocked.mb.	 If	 your	 project	 is	 not	 set,	Maya	will
automatically	call	in	the	referenced	rig	file	jaguar_bodyCast_v2.mb.	 If	Maya	cannot	find	it,
you	will	be	prompted	to	browse	for	the	file.	Once	the	file	is	loaded	into	Maya,	you	can	switch
views	to	display	the	animated	camera	for	this	scene,	camera1.	To	do	this,	in	the	panel	window
click	Panels	>	Perspective	>	Camera	1.

FIGURE	4.11	Blocked	in	Maya,	this	file	was	opened	and	viewed	through	an	animated	camera

The	animation	for	the	head	has	been	blocked	in	already	for	you.	The	scene	is	100	frames
long.	The	frame	rate	is	24	frames	per	second	(fps).	Our	camera	rendering	settings	are	HD720.
You	will	note	that	the	blocked-in	animation	was	not	placed	on	the	rig	controls	but	on	the	head
itself.	Select	the	head	so	that	it	turns	green,	and	you	will	be	able	to	see	the	keyframes	in	the
timeline.	This	is	normally	naughty	rigging.	In	rigging	classes,	I	teach	the	students	to	lock	down
all	geometry	so	 that	 the	controls	are	 the	only	 thing	 that	can	be	animated.	Rigging	 this	way
keeps	novice	animators	from	breaking	the	rig	easily.	However,	 in	a	small	group	project	 like
this	one,	where	most	of	us	were	familiar	with	the	outliner,	we	broke	convention	and	animated



the	geometry.	In	larger	group	projects	or	when	the	team	issues	scenes	to	animators	who	are
not	 familiar	with	 the	 rig	 (like	 you),	 this	 convention	 could	 cause	 confusion.	 In	many	 scenes
throughout	the	film,	we	had	to	break	the	rig	to	get	the	posing	we	needed.	This	is	entirely	to	be
expected	 in	 settings	outside	a	 sterile	 classroom.	Do	what	you	need	 to	do	 to	ensure	 that	 the
shot	is	completed	on	time,	but	do	not	cause	more	issues	for	others	down	pipeline	from	you.
Because	you	are	being	issued	this	scene,	please	note	that	there	is	no	character	set	on	Jaguar,
and	the	head	geometry	has	been	animated.

FIGURE	4.12	Animation	is	on	the	geometry—naughty	rigging.	(Read	Rig	It	Right!	for	more	information	on	the	rules	of

rigging.)

The	camera	has	been	animated,	which	will	likely	be	the	case	in	a	production	environment.
You	are	to	animate	the	3D	character.	Those	who	have	worked	in	production	know	this	to	be
the	case;	for	students,	this	might	be	a	new	concept.

The	neck	brace	 is	not	 rigged.	You	can	select	on	 it	directly	and	rotate	 it	as	you	see	 fit	 for
your	animation.	Those	who	take	my	rigging	courses	know	that	this	bothers	me	to	the	core	of
my	being.	Make	a	note:	 these	students	did	not	take	my	rigging	class	and	we’ll	 live	with	the
unclean	implications.	In	a	perfect	world,	we	would	have	a	completely	locked-down	rig	with
controls	in	place.	Breaking	the	rig	on	a	shot-by-shot	basis	is	one	thing,	but	having	a	part	of	the
rig	that	should	have	controls	to	be	animated	in	every	shot	is	another.	It	is	simple	animation	for
the	brace,	so	we	can	animate	the	geometry.



FIGURE	4.13	The	neck	brace	can	be	animated	directly	by	moving	geometry

When	 you	 have	 completed	 your	 animation,	 do	 not	 forget	 to	 run	 the	 twos.mel	 script	 by
typing	twos	 in	the	command	line.	This	will	put	your	animation	on	twos	for	you,	and	in	this
scene	 there	 shouldn’t	be	 a	need	 to	 change	 it	 to	ones	unless	you	 feel	you	need	 to	when	 the
character	quickly	turns	to	find	the	source	of	the	meow.

Render	3D	Reference	Images

Save	your	project	and	render	out	a	sequence	of	images	to	bring	it	into	the	2D	package	of
your	choice.	There	is	no	need	to	render	out	render	passes	in	this	scene	because	the	head	only
needs	to	be	composited	right	on	top	of	the	body.	This	is	an	easy	registration	scene.	However,	if
it	will	make	your	registration	a	little	bit	easier,	we	can	render	out	the	head	on	a	separate	level
so	 that	when	you	are	drawing	 in	your	2D	package	you	can	hide	 the	head	and	see	only	 the
body	level.	This	will	allow	you	to	see	if	you	truly	have	proper	registration.

Create	render	layers	as	we	did	in	Chapter	3	for	the	head	and	the	body:

1.	 Click	on	the	body;	it	should	turn	green.
2.	 In	the	Render	Layer	window,	select	Layers	>	Create	Layers	from	Selected.
3.	 Label	the	layer	RLBody.
4.	 Repeat	for	the	head.



FIGURE	4.14	Render	layers	for	the	body	and	head

Remember	the	settings	that	you	need	to	have	in	order	to	render	layers:

1.	 You	have	to	tell	Maya	to	render	all	of	the	layers	in	the	Render	Layer	area	by	clicking
Options	>	Render	All	Layers.

2.	 Make	sure	that	your	render	settings	have	the	following:

a.	 Correct	naming	and	file	extension
b.	 Correct	frame	range	and	padding
c.	 Camera1	selected	and	alpha	channel
d.	 HD720	resolution

3.	 Then	click	Render	>	Batch	Render.
4.	 Your	 images	will	 be	 placed	 inside	 folders	with	 names	matching	 your	 render	 layer

names.

Take	Note

Watch	out.	What	if	your	compositing	software	of	choice	doesn’t	read	in	alpha	channels	with
.tif	 image	 sequences?	You	have	 two	options:	 create	a	 raw	QuickTime	movie	 file	with	alpha
channels	or	an	FLV	file.

Creating	a	raw	QuickTime	movie	file	with	alpha:

1.	 In	the	package	of	your	choice,	convert	those	.tif	or	tga	images	to	a	QuickTime	movie
file.	I	will	use	After	Effects.	As	we	have	done	before,	import	your	images	into	After
Effects	and	create	a	composition	with	the	proper	frame	rate.	To	check	if	your	alpha
channel	 is	 there	 (please	 check,	 this	will	 save	 you	 the	 headache	 of	 having	 to	 come
back	and	redo	this),	click	on	the	Show	Channel	 icon	and	select	Alpha.	You	should
see	a	black-and-white	 image	that	matches	the	shape	of	the	object	 in	your	image.	 If



you	only	see	white,	you	have	no	alpha	channel.	Go	back	to	step	2	and	make	sure	you
are	not	using	JPGs	or	some	other	image	format	that	does	not	support	alpha	channels.
I’ll	wait	for	you	right	here	until	you	get	back.

2.	 Once	you	are	sure	that	you	have	alpha	channels,	export	the	images	as	a	QuickTime
movie	with	the	compression	set	at	Animation.	This	will	basically	be	a	movie	of	full-
res	images	that	contain	alpha.

3.	 Repeat	for	the	head	layer.

Creating	FLV	or	SWF	files:
Here,	 we’ll	 use	 a	 new	 piece	 of	 software	 found	 in	 the	 creative	 suite.	 In	 Adobe	 Media

Encoder	choose:

1.	 File	>	Add	Source	…	and	select	your	.tif	sequence.	Make	sure	to	select	TIFF	 image
file	sequence.

2.	 Set	the	output	to	FLV.
3.	 Click	 on	 FLV	 to	 open	 the	 options.	 Make	 sure	 the	 video	 tab	 has	 Encode	 Alpha

Channel	checked	on.	All	else	should	automatically	match	the	size	of	your	.tif	images.
4.	 Click	on	the	green	play	arrow	in	the	upper	right	of	 the	program	to	start	 the	queue

and	render	the	FLV	file.

When	this	FLV	file	is	brought	into	Flash,	the	alpha	channels	will	be	respected.

FIGURE	4.15	Using	Media	Encoder	to	convert	.tif	sequence	(with	alpha)	to	FLV	file	(with	alpha).	Teach	Flash	to	respect	your



alpha	channels

2D	Animation	Follows

Next	we	will	do	our	2D	rough	animation	in	Flash.	Create	a	new	document	(ActionScript	3.0
document)	with	 the	 following	 dimensions:	 1280	 ×	 720,	 24	 fps.	We	will	 bring	 the	 reference
images	into	the	timeline.

1.	 Go	to	File	>	Import	>	Import	Video	…	and	select	the	body	level	movie	file.
2.	 Turn	on	Embed	video	in	SWF	and	play	in	timeline.
3.	 Click	 on	next	 and	make	 sure	 the	 symbol	 type	 is	embedded	video.	 Click	 on	next,

then	finish.
4.	 Repeat	for	the	head	reference	layer.

A	Note	on	Flash	and	Importing	Video

Flash	was	never	 really	optimized	 to	use	video.	 It	was	basically	making	a	vector	 for	 each
pixel—super	memory	bog.	CS6	and	newer	versions	of	Flash	expect	FLV	or	SWF	files.	Older
versions	of	 Flash	will	 bring	 in	 a	 raw	QuickTime	 file.	What	would	 happen	 if	we	 used	 a	 .tif
image	sequence?	Glad	you	asked,	because	I	did	use	.tif	images	and	when	I	brought	them	into
Flash	they	read	in	as	an	astronomically	huge	file	that	I	could	not	see.	If	you	try	to	use	a	tga,	it
will	open	correctly	but	without	 the	alpha	channel.	Adobe	products	will	 read	alpha	channels
with	FLV	files.	After	Effects	will	also	read	the	QuickTime	file	and	its	alpha.	Of	course,	by	the
time	 this	 prints	 it	 could	 change—so	 always	 check	 your	 alpha	 channels	 and	 image	 types	 for
your	pipeline.

Drawing	in	Flash

Insert	a	new	layer	above	your	video	layers	and	choose	the	pencil	or	brush	tool	to	draw	in.
The	 shots	with	 rough	 animation	 shown	 in	 Figure	 4.16	were	 drawn	 using	 the	 brush	 tool	 in
Flash.	You	can	see	that	using	the	brush	tool	still	creates	a	vector	line;	the	outline	of	the	brush	is
vector.	The	brush	tool	works	with	tablet	pressure	sensitivity	as	well.



FIGURE	4.16	Rough	animation	using	brush	tool	in	Flash

For	those	new	to	drawing	in	Flash	and	the	concepts	of	key-frames,	here	are	a	few	tips:	lock
all	layers	that	you	are	not	currently	drawing	on.	If	you	don’t,	you	might	accidentally	draw	on
layers	 that	you	do	not	wish	to.	Also,	you	can	drag	and	drop	keyframes	on	the	timeline;	but
beware,	you	can	accidentally	duplicate	key-frames	and	cause	a	messy	timeline.	Refer	to	Figure
4.17	for	the	following	explanations:

1.	 The	current	time	is	indicated	by	a	red	bar.
2.	 A	 blank	 keyframe,	where	 nothing	 is	 drawn,	 is	 indicated	 by	 a	white	 block	with	 an

empty	circle.	You	can	right-click	on	the	timeline	to	insert	a	blank	keyframe	or	use	the
hot	 key	F7.	 Once	 you	 have	 a	 blank	 keyframe,	 or	 a	 blank	 piece	 of	 paper,	 you	 can
begin	to	draw	your	key;	the	circle	will	fill	in	and	the	keyframe	will	turn	gray.

3.	 To	create	a	keyframe	that	also	has	a	copy	of	the	previous	drawing	on	it,	use	the	hot
key	F6.

4.	 To	extend	a	keyframe	by	holding	it	longer,	use	the	hot	key	F5.	The	end	of	a	hold	is
indicated	by	a	gray	rectangle	on	the	timeline.



FIGURE	4.17	Using	the	timeline	in	Flash

When	you	have	completed	your	rough	animation,	you	will	want	to	export	those	images	so
that	they	can	be	brought	into	the	cleanup	package	of	your	choice.	For	our	production	Jaguar
McGuire,	we	debated	using	Toon	Boom	or	Photoshop.	In	the	end,	because	of	its	familiarity	and
to	enable	students	to	work	on	projects	at	home,	we	chose	Flash	for	most	scenes.	By	now	you
should	already	be	 thinking	of	 the	next	 step.	 If	we	need	 the	alpha	channel,	 can	we	output	a
series	of	.tifs	or	tgas?	Yes,	or	we’ll	export	a	Quick-Time	file:

1.	 Delete	 all	 but	 the	 rough	 head	 animation	 levels.	 Even	 if	 you	 hide	 layers,	 they	will
export.

2.	 Choose	File	>	Export	>	Export	Movie.
3.	 Give	it	a	name,	choose	QuickTime	Movie,	and	click	Save.
4.	 In	the	export	settings,	make	sure	that	the	image	size	is	correct.
5.	 If	 you	want	 an	 alpha	 channel,	make	 sure	 that	 Ignore	 stage	 color	 (generate	 alpha

channel)	is	clicked	on.
6.	 Click	QuickTime	Settings	…
7.	 Make	sure	that	the	compression	settings	are	for	animation,	and	that	the	frame	rate	is

correct.
8.	 Then	click	Export.



FIGURE	4.18	Exporting	rough	animation	from	Flash

It	is	always	good	to	be	paranoid	when	exporting	images	and	always	double-check	that	they
exported	what	you	wanted	them	to.	All	too	often	you	get	five	steps	down	the	pipeline	only	to
realize	you	have	exported	completely	blank	images	or	 images	from	the	wrong	camera.	 It	 is
also	good	to	check	whether	alpha	channels	are	present	and	if	the	images	are	the	correct	size.
While	testing	this	chapter,	I	was	happily	following	along	until	I	realized	that	my	images	were
not	exporting	out	at	the	correct	size	from	Flash.	This	is	very	sad.	Then	I	remembered	that	the
same	thing	happened	during	a	24-hour	art	challenge	where	I	did	a	2D/3D	shot,	and	at	five	in
the	morning	my	brain	could	not	process	why	my	2D	image	(which	was	drawn	in	Flash)	was
not	lining	up	with	the	3D	image.	Now	I	see	why.	When	you	export	a	simple	line	drawing	from
Flash,	 even	 though	 your	 export	 settings	 are	 the	 correct	 size,	 it	 will	 crop	 to	 the	 smallest
rectangle	that	will	encompass	your	image.	That	can	be	quite	a	shock.	A	way	around	this	is	to
place	a	bounding	rectangle	around	your	canvas	that	is	just	at	the	cutoff	size.	If	you	make	it	a
guide	layer,	it	will	not	render.	This	will	ensure	a	proper	export.	Warning:	If	the	box	is	bigger
than	 the	 output	 file	 size	 should	 be,	 you	 may	 have	 registration	 issues	 in	 your	 compositing
software.



FIGURE	4.19	Placing	an	outline	in	Flash	to	ensure	an	export	of	the	proper	canvas	size

Cleanup	in	Photoshop

The	easiest	way	to	open	a	QuickTime	or	FLV	movie	into	a	video	layer	and	make	sure	that
the	file	size	is	the	correct	dimension	is	to	simply	go	to	File	>	Open	and	open	the	movie	file
you	exported	out	of	Flash.	This	will	open	the	file	into	a	video	layer	and	give	you	a	document
that	 is	 the	 correct	 size	 and	 bit	 depth.	 Watch	 out	 for	 your	 document’s	 playback	 settings,
however.	During	testing,	our	frame	rate	had	to	be	changed	manually.	You	can	see	 in	Figure
4.20	where	the	frame	rate	is	incorrect.



FIGURE	4.20	Using	rough	animation	in	Photoshop	for	cleanup

Add	an	extra	video	layer	and	use	the	brush	that	you	wish	to	draw	in	your	cleanup	line,	as
we	 have	 in	 previous	 chapters.	 When	 you	 are	 done,	 export	 your	 video	 layer	 for	 final
compositing.



FIGURE	4.21	Cleaned-up	animation	in	Photoshop

More	on	Toon	Lines

We	haven’t	looked	at	toon	lines	in	a	while,	and	you	were	promised	more.	Let’s	take	a	look
at	some	more	features	of	toon	lines.	What	if	you	wanted	a	scratchy,	non-pencil-like	line?	Let’s
use	our	shot	4	scene	and	test	out	some	paint	effects	toon	lines.

Open	the	Shot4_Blocked.mb	 file	or	 the	 file	you	have	 just	animated.	Select	 the	body	cast
and	neck	brace	and	apply	a	new	toon	shader	by	clicking	on	Toon	>	Assign	Outline	>	Add
New	Toon	Outline.	Now	a	 toon	 line	 is	applied	 to	your	character	and	you	can	 see	 it	 in	 the
main	viewport.	Next	we	want	to	work	with	the	paint	effects	brushes	and	apply	them	to	the
toon	outline.	Some	of	these	become	heavy	to	render	in	the	viewport;	you	might	have	to	turn
off	Display	in	Viewport	in	the	attribute	editor.	Other	paint	effects	brushes	do	not	display	well
and	are	only	appreciated	when	rendered.	To	begin	with,	open	the	visor	window	by	clicking
Paint	Effects	>	Get	Brush:

1.	 Select	the	pfxToon1	toon	line	node	in	the	outliner.
2.	 Select	 a	brush	 in	 the	visor	window	>	Paint	 effects	 tab.	 In	 Figure	4.22	 the	Toon	 >

ThickOilLine	brush	has	been	selected.
3.	 To	apply	the	brush	to	the	toon	line,	click	Toon	>	Assign	Paint	Effects	Brush	to	Toon

Lines.

You	can	see	in	the	viewport	shown	in	Figure	4.22	that	the	paint	effects	toon	line	is	visible.
Figure	4.23	is	a	render	of	the	toon	line	composited	with	the	rough	animation.



FIGURE	4.22	Assigning	the	paint	effects	brush	to	toon	line

FIGURE	4.23	Composite	of	3D	with	a	2D	head

You	can	use	the	brushes	with	the	default	settings	such	as	you	see	in	Figure	4.24.	Here	 the
Oils	>	dryOilRed	has	been	applied	to	the	toon	line.



FIGURE	4.24	DryOilRed	Paint	Effects	brush

Or	you	can	select	the	brush	in	the	Attribute	Editor	and	adjust	the	settings	for	more	control.
In	Figure	4.25	the	paint	effects	brush	Oils	>	thickOilRed	was	applied	to	the	toon	line.	As	you
can	 see	 in	 the	 image,	 the	 brush	 type	was	 set	 to	 Thin	 Line,	MultiStreaks	was	 set	 to	 2,	 and
Streak	Spreads	was	adjusted.	Give	yourself	time	to	work	with	these	attributes,	as	it	takes	time
to	become	familiar	with	them.	When	you	first	begin	to	work	with	paint	effects	and	toon	lines,
take	screen	grabs	of	the	settings	you	have	adjusted	and	the	renders	you	come	up	with.	These
can	help	you	navigate	through	good	and	bad	adjustments.

FIGURE	4.25	ThickOilRed	Paint	Effects	brush



Don’t	overlook	nontraditional-sounding	paint	effects	brushes.	You	will	be	surprised	by	what
you	can	use.	In	Figure	4.26	I	took	a	chance	and	used	an	intestinal	flow	paint	effects	brush.

FIGURE	4.26	Intestinal	f low	paint	effects	brush

Putting	it	all	together

Now	you	have	some	images	ready	to	be	placed	together.	What	assets	do	you	have?

1.	 3D	animated	body	and	neck	brace
2.	 2D	animated	head

This	should	be	a	simple	composite	in	your	favorite	compositor:	After	Effects,	Smoke,	Nuke,
or	 Final	 Cut.	 Simply	 place	 the	 asset	 clips	 overtop	 of	 one	 another	 in	 separate	 layers	 and
complete	a	final	composite.	What	could	go	wrong?	Alpha	channels,	image	size,	frame	rate.	If
you	do	not	have	 alpha	 channels	 in	 any	of	 the	 layers,	 then	you	will	 need	 to	 go	back	 to	 the
originating	 software	 package	 and	 re-render	 with	 alpha	 channels	 that	 your	 compositing
software	will	read.	If	you	rendered	a	layer	at	the	wrong	size—then	you	will	need	to	re-render.
Lastly,	watch	in	your	compositing	software	that	all	image	sequences	for	the	layers	come	in	at
the	same	frame	rate	that	they	were	drawn	in.	There	was	no	background	supplied	to	you	for
this	shot.	You	can	create	an	art	card	(color	card)	for	your	final	composite.

Let’s	try	it	in	Autodesk	Smoke.	After	opening	Smoke	and	setting	a	project	and	user	name,
click	on	the	MediaHub	tab	at	the	bottom	of	the	interface.	Navigate	to	the	folders	with	your
image	sequences.	The	first	thing	you	want	to	look	for	is	your	images	with	alpha	channels.	You
can	see	straight	away	if	the	alpha	channels	are	being	respected	or	not.	In	Figure	4.27	you	can
see	 two	 versions	 of	 the	 body	 layer.	 One	 is	 a	 movie	 file	 with	 no	 alpha	 and	 the	 other	 is	 a



sequence	of	.tif	images	with	alpha.	The	alpha	is	indicated	by	the	word	“MULTI,”	which	is	at
the	bottom	right	hand	of	the	image’s	icon.	Double	click	on	MULTI	and	the	RGB	and	Alpha
channel	will	display.	You	can	even	scrub	through	the	clips	by	clicking	and	dragging	on	them.
Control	click	on	the	clip	with	the	alpha	and	choose	Import.	Repeat	for	the	head	layer	as	well.
These	clips	will	load	into	the	Media	Library	at	the	left	side	of	the	interface.

FIGURE	4.27	Importing	images	with	alpha	channels	into	Autodesk	Smoke

There	many	ways	to	deal	with	alpha	channels	in	Smoke	and	they	have	a	dedicated	YouTube
channel	 to	help	you	figure	out	 the	ways.	Look	up	“Dealing	with	Alpha	Video	Series”	 in	the
Smoke	Learning	Channel	on	YouTube.

Go	to	the	Timeline	tab	in	Smoke	and	create	a	new	sequence	by	clicking	on	File	>	New	>
Sequence.	Double	click	on	the	sequence	 in	 the	Media	Library.	This	makes	 it	active	 in	 the
viewing	area.	Drag	and	drop	the	body	layer	into	the	empty	video	channel.	Create	a	new	video
track	by	clicking	on	Sequence	>	New	>	Video	Track.	Drag	and	drop	the	head	layer	into	the
new	empty	video	channel.	(You	could	have	set	the	sequence	to	have	two	video	channels	in	the
option	box	when	you	created	it.	Did	you?	Good	job.	You	saved	a	click.)

But	the	composited	image	isn’t	showing?	Well,	Smoke	is	more	than	a	timeline	editor.	It	uses
the	timeline	to	sequence	the	video	clips,	but	you	can	do	more	under	the	hood	with	them.	If
you	compare	this	thought	process	to	Maya,	in	a	way,	it	is	similar.	Smoke	isn’t	a	simple	node-
based	compositor	either.	(We’ll	learn	about	those	later.)

Select	 the	 head	 layer,	 then	 locate	 the	 small	 FX	 button	 at	 the	 left	 of	 the	 screen	 in	 the



timeline	pane.	Click	that,	then	click	on	Axis.	This	will	tell	the	two	layers	to	composite.

FIGURE	4.28	Using	Axis	FX	to	composite	the	two	clips	over	one	another

In	a	way	that	is	similar	to	most	packages,	make	sure	that	you	have	the	sequence	selected	in
the	media	library	and	select	File	>	Export.	Give	the	file	a	name	and	the	desired	format,	then
click	on	Export.

You’ll	note	that	in	the	example	above,	I	used	the	3D	head	reference	to	show	the	pipeline.
You’ll	use	your	2D	animation	completed	in	Flash,	Toon	Boom,	Photoshop,	Gimp,	or	whatever
you	chose	to	animate	in.

By	now,	you	should	really	be	getting	a	 feel	 for	moving	around	 in	 the	different	packages.
You	 don’t	 have	 to	 use	 a	 compositing	 software	 if	 your	 animation/cleanup	 software	 does
compositing	 as	 well.	 For	 example,	 Toon	 Boom	 Animate	 Pro	 would	 allow	 you	 to	 do	 the
cleanup	animation	and	composite	all	 in	one	package.	See	Figure	4.29	 for	an	example.	 (Note:
this	 is	 what	 drawing	with	 a	mouse	 looks	 like!)	 The	 default	 import	 settings	 brought	 in	 the
correct	alpha	channel	information.



FIGURE	4.29	Body	and	head	layer	brought	into	Toon	Boom	Animate	Pro.	Cleanup	and	compositing	can	take	place	in	that

same	package	without	having	to	use	After	Effects	or	Smoke

Congratulations!	We’re	moving	along	at	a	steady	pace	now.	Are	you	using	these	pipelines
with	 multiple	 software	 packages?	 Do	 you	 know	 where	 your	 alpha	 channels	 are	 now?
Excellent.	I	wonder	what	is	next.

Interview

Marty	Altman

Former	CGI	Technical	Director,	Walt	Disney	Feature	Animation

The	convergence	of	all	things	“digital	media,”	the	ever-growing	demand	for	content,
and	 in	particular	 shrinking	budgets	 and	 time	 frames,	means	 the	mixing	of	 approaches
and	techniques	is	becoming	more	prevalent.	Progressively	more	examples	appear	almost
every	 day	 now,	 but	 this	 trend	 started	 years	 ago.	 Some	 specific	 examples	 of	 hybrid
approaches	from	the	not-too-distant	past	help	tell	this	story.

The	palace	crowd	element	in	Disney’s	animated	feature	film	Mulan	was	an	interesting
mix	of	2D	and	3D	approaches.	We	utilized	a	slightly	modified	version	of	the	proprietary



crowd	simulation,	which	was	used	for	the	wildebeest	stampede	in	Lion	King,	the	crowds
in	Hunchback	of	Notre	Dame,	the	whales	in	Pines	of	Rome	in	Fantasia	2000,	as	well	as
the	Hun	charge	in	Mulan.	We	also	used	a	modified	version	of	the	editor	written	for	the
Hun	charge.	The	simulation	placed	the	characters	in	3D,	and	behaviors	were	simulated
as	before.	The	editor	was	a	3D	application	with	certain	2D	capabilities.

The	2D	approach	really	came	in	with	the	palace	crowd	characters	themselves.	All	the
crowd	 behaviors,	 both	 cycles	 and	 transitions,	 were	 traditionally	 animated	 characters
converted	 to	 an	 interesting	 system	 of	 animated	 textures	 and	mapped	 onto	 individual
polygons.	Colors	for	some	portions	of	the	textures,	in	this	case	skin	tone	and	hair	color,
were	 locked.	 Other	 portions	 of	 the	 textures,	 such	 as	 clothing,	 used	 a	 false-color
technique	and	art-directed	color	palettes	to	increase	perceived	variety.

This	hybrid	approach	not	only	matched	the	traditional	style	of	the	film	but	provided	a
wide	range	of	usefulness	for	the	characters—they	could	appear	full	screen	as	could	any
other	animated	character	in	the	film,	and	the	same	system	could	place	30,000	characters
in	 a	 single	 scene.	 While	 still	 a	 good	 bit	 of	 work	 to	 traditionally	 animate	 the	 crowd
characters,	 a	 pure	 3D	approach	would	have	 taken	 significantly	more	 calendar	 time	 to
meet	 those	 same	 requirements.	 If	pure	3D	had	been	 the	only	option,	we	 likely	would
have	lost	the	palace	crowd	element	due	to	budget	and	time	constraints.

The	 Pooh’s	 Hunny	 Hut	 attraction	 at	 Tokyo	 Disneyland	 provides	 examples	 of
integration	issues	going	beyond	just	2D	and	3D,	because	of	the	practical	aspects	needed
for	 a	 theme	 park	 attraction.	 One	 involves	 traditional	 painted	 backgrounds,	 a	 2D
character	 (Tigger)	 bouncing	 across	 three	 large	 screens,	 and	 a	 swarm	 of	 3D	 characters
(bees).	 It	 also	 has	 a	 big	 multiplane	 camera	 move	 incorporating	 both	 the	 projected
artwork	 and	 several	 levels	 of	 practical	 elements	 placed	 between	 the	 viewers	 and	 the
screens.	For	the	multiplane	shot	to	succeed,	all	these	levels	have	to	work	together.

Another	Hunny	Hut	example	makes	use	of	projection	onto	a	half-silvered	mirror,	so
viewers	 see	 themselves	 with	 a	 3D	 character.	 Several	 issues	 made	 this	 challenging.	 A
special	projector	was	shipped	straight	 from	the	factory	to	Tokyo,	so	we	never	had	the
chance	to	test	our	imagery	directly	and	instead	had	to	make	adjustments	based	on	phone
conversations	with	 the	 Imagineers	 in	Tokyo	 looking	 at	 the	 screen.	The	heffalump	 is	 a
semitransparent	 3D	 character	 that	 fills	 up	 with	 semitransparent	 honey,	 and	 since	 the
projector	was	fed	with	an	NTSC	source,	we	had	to	anticipate	color	issues.	Of	course,	the
heffalump’s	primary	color	was	red	(arguably	NTSC’s	least	favorite	color).

The	 short	 time	 frame	 and	 increased	 logistical	 issues	 required	 a	 different	 thought
process.	 The	 heffalump	 element	was	 broken	 down	 into	 several	more	 rendered	 levels
than	would	ordinarily	be	used	to	provide	maximum	flexibility	for	controlling	the	final
look	 in	 the	 composite.	 We	 also	 borrowed	 a	 bracketing	 technique	 from	 traditional
photography	to	further	cut	down	the	need	to	go	back	and	forth	between	Orlando	and



Tokyo	to	resolve	the	final	version.	A	comment	like	“a	third	of	the	way	between	number
2	 and	 number	 3”	meant	 one	 tweak	 of	 the	 parameters	 in	 the	 composite	 and	we	were
done.

The	 convergence	 of	 animation,	 film,	 visual	 effects,	 broadcast,	 games,	 web	 and
interactive,	 and	other	 related	 industries	 is	 leading	us	 to	 a	place	where	 the	 true	power
user	not	only	prefers	to	have	many	tools	in	his	toolbox	but	also	has	an	insatiable	need	to
learn	more.	The	rationale	is	straightforward.	The	more	tools	and	techniques	you	have	at
your	disposal,	the	better	your	chances	of	seeing	connections	that	lead	to	higher	aesthetic
quality,	greater	efficiencies,	or	both.	Better	quality	gets	you	noticed	and	is	always	good.
Efficiency,	as	 in	getting	the	 job	done	on	time	and	within	budget,	helps	ensure	you	get
the	next	call.

Further	Readings

OHailey,	Tina.	Rig	it	Right!.	London;	Boston:	Focal	Press,	2013.
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EFX

FIGURE	5.1	Melting	Man,	by	Troy	Gustafson

Lecture	Notes

In	the	previous	chapter,	we	discussed	3D	characters	with	2D	parts.	One	of	the	examples	we
talked	about	was	goo	on	a	three-headed	hydra.	For	this	chapter,	let’s	take	a	look	at	the	art	of
special	 effects	 (EFX).	 It	 is	 a	 worthy	 topic	 that	 is	 more	 than	 often	 left	 out	 of	 animation
discussions.



When	training	the	different	departments	in	feature	animation	studios,	I	found	that	the	EFX
team	was	 composed	 of	 odd,	 quirky	 individuals,	 more	 so	 than	 the	 other	 departments.	 In	 a
building	 of	 more	 than	 150	 artists,	 who	 are	 normally	 slightly	 odd	 and	 fun	 loving,	 these
individuals	 looked	 at	 things	 completely	 differently	 than	 the	 character	 animators.	 Where
character	 animators	 look	 at	 the	 body	mechanics	 and	 acting	 as	 a	whole	 large	 unit,	 the	 EFX
animators	 look	 at	 the	 subcomponents	 of	 the	 character.	 EFX	 animators	 look	 at	 the	 self-cast
shadows	on	the	body,	 the	highlights	 from	a	key	 light,	water	dripping	down	the	hair,	goo	(if
any),	incidental	props,	and	the	like.	In	other	words,	they	see	the	world	completely	differently
than	 do	 character	 animators,	 and	 in	 my	 opinion	 they	 are	 underappreciated	 and	 lack
appropriate	representation	in	animation	tomes.	Of	course,	that	is	understandable,	as	few	EFX
animators	have	written	anything,	although	a	few	books	have	been	published	on	the	subject.
We	will	not	be	able	to	do	the	topic	justice	here.	We	will	only	be	able	to	gain	an	overview	and
apply	it	toward	our	2D/3D	adventure.

Dig	Deeper

If	 you	 want	 to	 dig	 deeper	 into	 the	 topic	 of	 traditional	 EFX,	 read	 Joe	 Gilland’s	 book
Elemental	Magic:	The	Art	of	Special	Effects	Animation.



FIGURE	5.2	EFX	example	by	Joe	Gilland	in	his	book	Elemental	Magic,	The	Art	of	Special	Effects	Animation

Let’s	 try	 to	 categorize	 the	 types	 of	 EFX	 elements	 to	 give	 you	 a	 better	 understanding	 of
what	to	look	for	in	your	scenes.	The	constant	rule	throughout	all	EFX	elements	is	that	usually
these	are	nonacting,	or	noncharacter,	elements	in	the	story.	However,	there	are	exceptions	to
that	rule,	which	we	will	discuss	later	on	in	this	chapter.	When	discussing	this	topic	with	many
individuals,	we	have	come	up	with	the	following	categories	for	EFX	animation	and	example
elements:

1.	 Solid	shapes

a.	 Props	with	contact	points:	leading	the	character	or	led	by	the	character
b.	 Moving	manmade	objects	without	contact	points	to	a	character
c.	 Moving	organics:	trees,	flowers,	rocks

2.	 Abstract	shapes

a.	 Liquid:	flowing,	contained,	drops,	or	streams
b.	 Fire:	small,	large,	linear,	billowing



c.	 Smoke/vapors:	linear,	billowing,	wispy
d.	 Wind/weather:	rain,	snow	(while	in	the	air)
e.	 Earth	particulates:	dust
f.	 Magic/sparkles

3.	 Light

a.	 Highlights
b.	 Shadows
c.	 Tones

No	matter	how	you	dissect	 the	subparts	of	EFX	elements,	 there	are	at	 least	 two	separate
groupings:	a	solid	shape	group	and	an	abstract	shape	group.	Solid	shapes	are,	if	you	remember
your	science	class,	solids.	They	have	definite	form	and	shape	and	can	usually	be	broken	down
into	smaller	shapes.	The	abstract	category	includes	liquids,	gases,	and	plasmas.	We	define	them
as	abstract	because	the	shapes	they	form,	when	drawn,	include	a	certain	level	of	design	that	is
inspired	by	nature	but	does	not	mimic	it	exactly.	There	are	those	who	prefer	to	animate	the
solid	 shapes	 and	 those	 who	 prefer	 to	 animate	 the	 abstract	 shapes.	 For	 either	 category,	 3D
tools,	particle	systems,	fluid	simulators,	and	procedural	shaders	have	been	designed	to	aid	in
the	creation	of	these	EFX.	The	third	category,	light,	could	arguably	be	placed	under	either	the
solid	or	abstract	category	based	on	the	property	of	light	being	observed.	The	thing	to	note	is
that	 in	 EFX,	we	 are	 thinking	 of	 the	 shape	 of	 visible	 light	 or	 the	 absence	 of	 it.	We	 are	 not
looking	at	light	as	in	3D	lighting	and	rendering.	We’ll	look	at	each	of	these	categories	more	in
depth.

Solid	Shapes



FIGURE	5.3	3D	BMX	bicycle	modeled	by	Jeff	Dutton	and	Michael	Spokas

In	our	listing	of	solid	shapes,	our	first	item	is	props	with	contact	points.	These	are	things	that
the	character	moves	(coffee	cups,	cigars,	pipes,	forks,	newspapers,	etc.)	or	things	that	move	the
character	(bicycles,	cars,	spaceships,	etc.).	The	second	listing	is	objects	that	move	but	have	no
contact	point	to	the	character.	This	can	include	just	about	anything	you	see	in	an	environment
that	is	man	made:	trash,	road	signs,	garden	gnomes,	and	wind	wheels,	for	instance.	The	next
category	is	moving	organic	objects	such	as	trees,	flowers,	and	grass.	Depending	on	animation
style,	the	amount	of	movement	to	these	items	may	be	kept	at	a	minimum	because	it	can	be
extremely	 time	 consuming	 to	 create	 this	 movement,	 even	 when	 done	 in	 3D.	 Rocks	 and
boulders	are	in	this	category	because	they	are	solid	shapes	that	can	fall	and	react	to	gravity.	If
we	must	continue	to	categorize,	you	would	want	to	include	ice	and	glaciers	into	this	category
as	well,	because	they	are	solid	in	shape.

Abstract	Shapes



FIGURE	5.4	Fire	and	smoke	example,	by	Troy	Gustafson

In	calling	these	elements	abstract,	we	do	not	mean	that	their	shape	or	movement	is	abstract,
because	there	is	reason	for	their	form	and	path	of	movement.	However,	as	stated	earlier,	these
elements	are	more	able	to	be	designed	and	are	actually	a	designed	form	abstracted	from	their
observance	in	nature.	Each	element—	liquid,	fire,	smoke,	wind,	earth,	magic,	and	so	on—has	its
own	 law	 of	 movement,	 reaction	 to	 gravity,	 loss	 of	 energy,	 entropy,	 and	 volume	 that	 the
animator	must	adequately	study	in	order	to	reproduce.

Light



FIGURE	5.5	Tones	and	shadows	on	a	character,	by	Troy	Gustafson

In	2D	EFX,	 light	must	be	drawn.	 It	 is	usually	drawn	as	animated	mattes	 that	are	used	at
compositing	time	to	affect	 the	coloring	of	 the	character	and	environment.	An	artist	can	also
pull	animated	mattes	from	a	3D	render	and	use	them	when	compositing	to	achieve	different
lighting	 and	 shading	 effects.	 There	 are	 three	 visible	 elements	 to	 lights	when	 drawn	 in	 this
manner.	Highlights	 are	 the	bright	areas	on	a	character.	They	are	usually	caused	by	a	kicker
light,	or	rim	light.	Tones	are	the	darker	areas	on	a	character	where	the	light	is	not	illuminating
the	character.	Tones	add	great	depth	to	a	character,	especially	when	combining	a	2D	character
with	a	3D	character.	However,	beware:	drawing	tones	on	every	character	in	every	shot	takes	a
lot	of	time.	During	a	time	crunch,	this	is	usually	the	first	element	to	be	removed.	Shadows	are,
obviously,	 the	 shadows	 that	 a	 character	 or	 object	 casts	 upon	 the	 environment.	 All	 three
elements	are	usually	blurred	and	minimized	in	movement	so	that	they	do	not	distract	from	the
main	action	of	the	story.

Exceptions



FIGURE	5.6	Melting	character	with	rough	character	level,	rough	EFX	level,	and	final	cleanup	EFX	level,	by	Troy	Gustafson

There	can	be	a	blurry	line	between	character	animation	and	EFX	animation	in	certain	cases.
What	if	the	shadow	is	telling	the	story?	In	that	case,	it	is	a	character	and	may	be	taken	over	by
the	 character	 animators.	 What	 if	 the	 character	 is	 made	 of	 wind	 or	 fire?	 (Think	 about	 the
element	characters	in	Disney’s	feature	animation	Hercules.)	What	do	you	do	with	a	character
who	 is	 basically	 composed	 of	 an	 EFX	 element?	 Something	 like	 that	 might	 be	 roughly
animated	by	the	character	animator,	and	then	the	EFX	animator	adds	his	or	her	expertise	of
fire/wind/ice	 to	 the	 animator’s	 expertise	 of	 character	movement.	What	 if	 the	 prop	 that	 the
character	is	holding	is	intricate	to	the	acting?	Depending	on	the	character	animator,	he	or	she
may	 rough	 in	 the	 placement	 of	 the	 prop	 or	 even	 animate	 the	 complete	 prop.	 The	 EFX
animators	would	do	what	was	needed	to	finish	the	prop’s	animation.

Trench	Note

All	 of	 these	 examples	 are	 based	 on	 studio	 culture	 and	 the	 artists	 found	 therein.	 This
information	is	based	on	the	general	pattern	that	I	witnessed	in	the	two	studios	where	I	have
worked.	 Both	 studios	were	 large.	 In	 smaller	 studios	where	 individuals	 have	 to	wear	many



hats,	of	course,	these	ideas	can	be	very	different	based	on	the	talent	found	there.

Contact	Points	and	Pipeline

The	questions,	 as	 always,	 are	 these:	Which	 element	 leads?	Where	 are	 the	 contact	 points?
What	media	will	be	used?

Usually	the	prop	animation	is	the	first	one	to	be	considered.	Props	either	lead	the	character
or	 are	 led	 by	 the	 character.	 As	 in	 our	 earlier	 discussions,	 props	 themselves	 can	 become
complicated	in	line	mileage	and	perspective.	So	using	3D	props	has	become	popular.

After	considering	props,	the	next	factors	to	consider	are	the	environment	and	the	elements.
Most	 elemental	 items	 react	 to	 the	 character;	 therefore,	 they	 follow	 after	 the	 character
animation.	Even	when	the	environment	and	elements	to	do	not	react	to	the	character,	they	are
still	 usually	done	after	 the	 character	 animation	 so	 that	 they	do	not	 accidentally	obscure	 the
important	story	points	we	are	trying	to	convey	in	the	scene.

The	 last	 element	 that	 is	 usually	 drawn	 is	 light.	 This	 is	 the	 light	 that	 is	 cast	 upon	 the
characters,	props,	water,	goo,	and	so	on.

Trench	Note

You	can	imagine	that	after	 the	character	animators	are	done	and	having	their	celebratory
“animation	 is	done”	parties,	EFX	artists	 are	 still	 bent	over	 their	desks	working	on	 the	 light,
props,	and	abstract	shapes	that	are	 in	the	very	scenes	whose	“doneness”	 is	being	celebrated.
The	 same	 can	 be	 said	 for	 the	 other	 departments	 that	 follow	 EFX.	 These	 departments	 are
referred	 to	 as	 the	 “back	 end”	 of	 production.	At	 the	Disney	 studio,	 these	 departments	were
called	scene	planning,	scanning,	color	models,	ink	and	paint,	compositing,	and	final	check.	The
departments	and	the	breakdown	of	tasks	vary	from	studio	to	studio.	The	takeaway	here	is	that
the	waterfall	of	“doneness”	is	never	complete	until	the	wrap	party.

Industry	Examples

You	 do	 not	 have	 to	 look	 very	 hard	 to	 find	 plenty	 of	 examples	 of	 props	 leading	 2D
animation	 :	 Futurama,	 Family	 Guy,	 The	 Simpsons,	 Lilo	 &	 Stitch,	 The	 Triplets	 of	 Belleville,
Mulan,	Atlantis,	Treasure	Planet,	Sinbad,	The	Road	to	El	Dorado,	Pokemon	movies,	Macross



Zero,	and	the	list	goes	on	and	on.
You	might	have	noticed	the	heavy	use	of	3D	spaceships	and	environments	in	Futurama.	I’ve

had	students	comment	that	they	did	not	notice	it	until	taking	my	class,	where	they	were	told
to	go	 look.	The	 flat	 shading	and	 toon	 shading	did	not	 cause	 the	3D	 to	 stand	out	 too	much,
which	 we	 know	 from	 Chapter	 1	 is	 a	 sign	 of	 success.	 Other	 examples	 that	 students	 have
commented	on	include	the	obvious	use	of	3D	in	the	Family	Guy	movie,	Clone	Wars.

Other	films	have	used	3D	and	you	might	not	have	even	noticed.	Mulan,	for	instance,	used	a
large	amount	of	3D	for	both	character	and	EFX.	One	complicated	shot	comes	to	mind	where
Mushu	is	looking	for	Mulan	while	riding	a	shield	down	a	2D	avalanche.	The	background	was	a
traditional	painting.	The	snow	avalanche	was	done	in	2D.	In	this	case,	the	2D	EFX	avalanche
was	 leading,	 so	 an	 animated	 grid	was	 created	 to	 help	with	 the	 perspective	 of	 the	 sloshing
snow.	A	3D	shield	holding	a	3D	reference	Mushu	was	also	created.	The	3D	shield	was	the	only
3D	 element	 that	was	 to	 be	 used	 in	 the	 final	 composite;	 all	 else	was	 reference.	 The	Mushu
character	was	 so	 small	 for	 some	of	 the	 shot	 that	 they	kept	 the	3D	stand-in	 for	 that	 section,
much	 to	 the	 happiness	 of	 the	 3D	 animator.	 The	 2D	 avalanche	was	 added	 along	with	 snow
chunks,	 snow	particulates,	 tones,	 shadows,	 and	a	Hun	head.	This	 scene	 itself	was	 extremely
challenging	because	it	contained	a	traveling	pan	across	so	much	2D	snow,	and	this	was	done
before	 we	 had	 Cintiq	 tablets.	 Lacking	 a	 way	 to	 do	 digital	 2D	 animation	 meant	 that	 a
printing/pegging	process	had	 to	occur	 so	 that	 the	2D	animators	 could	use	 the	3D	reference.
Because	 this	was	 a	 large	 camera	 pan,	 the	 paper	 that	was	 used	 for	 printing	was	 extremely
large:	24	fields,	the	printing/pegging	days.	Come	to	think	of	it,	wouldn’t	that	be	a	great	shot	to
recreate	 as	 a	 homework	 assignment?	Note	 to	 self:	maybe	 for	 the	 advanced	 version	 of	 this
class.



FIGURE	5.7	Drawing	on	24	field	paper

Using	 3D	 for	 props	 and	 environments,	 if	 not	 having	 contact	 with	 the	 2D	 character,	 is
relatively	easy,	and	therefore	the	use	of	3D	props	is	widespread.	As	we	have	found,	once	the
different	 elements	 begin	 interacting,	 things	 take	 on	 a	 bit	more	 complexity.	 The	 trick	when
combining	 the	 3D	 prop	 with	 the	 2D	 character	 is	 making	 sure	 that	 their	 dimensionality
matches.	Either	the	3D	prop	needs	to	be	flattened	visually	to	match	the	2D,	or	the	2D	needs	to
be	made	more	rounded	by	using	tones	and	highlights	to	match	the	3D.	If	the	2D	appears	to	be
very	 flat	 and	 the	 3D	 appears	 very	 highly	 rendered	 and	 round,	 the	 styles	 may	 clash
considerably.	In	the	last	chapter’s	assignment	you	may	have	already	found	some	of	your	own
examples	of	good	and	bad	2D/3D	that	might	show	this	style	mishmash.

Using	2D	animated	EFX	on	top	of	3D	usually	would	not	seem	cohesive	if	the	style	were	a
highly	rendered	3D	look.	However,	if	the	visual	style	is	flat	or	toonish,	then	2D	EFX	elements
can	be	used.	We	examined	the	goo	used	on	the	hydra’s	head	in	the	previous	chapter.	We	also
took	 a	 look	 at	 shots	 from	 the	 group	project	 Jaguar	McGuire.	Next	we	will	 examine	 a	 few
shots	that	have	3D	props,	2D	EFX	elements,	and	some	interaction	between	both.



Hands-On	Examples

We	will	now	examine	five	EFX	issues	that	might	need	to	be	resolved	in	a	2D/3D	film:

1.	 3D	props	leading	2D
2.	 2D	leading	3D
3.	 Tones
4.	 Shadows
5.	 Compositing	tricks	with	ink	lines

3D	Props	Leading	2D

In	 previous	 shots,	 Jaguar	 McGuire	 has	 tried	 to	 kick	 the	 cat	 as	 it	 sat	 on	 his	 broken	 leg.
Instead	of	connecting	with	the	cat,	Jaguar	instead	kicks	his	own	broken	leg,	which	propels	it
out	of	its	sling	and	causes	it	to	hit	a	nearby	table,	sending	a	vase	filled	with	flowers	through
the	 air	 (in	 slow	motion).	 Please	 see	 the	 companion	 data	 for	 the	 storyboard	 displaying	 the
following	sequence.	Our	shot,	39,	shows	the	vase	of	flowers	hitting	the	floor.	Upon	hitting	the
floor,	 the	 flowers	and	water	 splash	out.	The	water,	unfortunately,	 splashes	 into	an	electrical
outlet.	The	outlet	short-circuits	and	shoots	a	fiery	spark	to	land	on	Jaguar	McGuire’s	cape.	The
cape	must	 be	old	 and	dry,	 or	 soaked	 in	kerosene,	 for	 it	 instantly	bursts	 into	 flames.	 Jaguar,
being	a	super	daredevil	and	still	believing	himself	inhuman,	tries	to	stamp	out	the	fire	with	his
free	foot.

The	elements	 in	shots	38	and	39	are	 listed	here,	along	with	the	software	that	was	used	to
create	them:



FIGURE	5.8	Elements	from	shot	38:	temporary	3D	background,	3D	vase	reference,	2D	water,	and	2D	flowers

The	 pipeline	 for	 3D	 prop	 leading	 2D	 is	 the	 same	 as	 a	 3D	 character	 with	 2D	 parts.	 This
should	be	getting	familiar	now.

Begin	by	setting	up	your	camera	in	the	3D	package	of	your	choice	and	animating	the	3D
prop.	In	the	example	shown	in	Figure	5.9,	you	see	the	camera	placed	in	the	3D	room	and	the
key-frames	of	a	3D	vase.	This	is	the	shot	we	were	discussing	earlier	in	the	industry	section	of
the	lecture	notes.	Clint	Donaldson,	the	director	of	Jaguar	McGuire,	did	 the	animation	of	 the
3D	vase.

In	this	example,	 the	render	size	 is	HD720,	which	has	a	pixel	size	of	1280	×	720	 in	Maya’s
render	settings.	Because	we	are	only	rendering	out	a	reference	image	for	the	2D	animator,	we
can	 simplify	 things	 by	 rendering	 out	 the	 vase	 layer	 only.	 Also,	 the	 alpha	 channel	 is	 not
necessarily	needed	here.	We	can	add	a	gray	background	to	the	camera’s	environment	setting
so	that	we	do	not	get	a	black	background.

To	set	the	background	to	be	gray	for	this	reference	render,	follow	these	steps:

1.	 In	the	rendering	camera’s	viewport,	click	View	>	Camera	Attribute	Editor….	This



opens	the	Attribute	Editor	for	the	camera.
2.	 Open	the	Environment	tab	and	change	the	Background	Color	to	the	desired	color.
3.	 Render	a	series	of	images	as	usual.	Remember	to	select	the	rendering	camera.	If	you

need	the	alpha	channel,	then	remember	to	select	it,	and	as	we	have	learned,	to	keep
that	alpha	channel	you	will	need	to	create	a	QuickTime	animation	compression	file.
For	this	example,	we	do	not	need	the	alpha	channel,	so	we	will	stay	with	a	series	of
.tif	files.

A	quick	check	in	Adobe	Bridge	shows	us	that	the	images	are	rendered	correctly:	from	the
right	 camera,	 named	 with	 frame	 padding	 (leading	 zeros),	 correct	 background	 color,	 and
correct	version	of	animation.	We’ve	already	talked	about	it	before,	but	I	cannot	stress	enough
that	it	is	a	great	timesaver	to	check	your	renders	before	proceeding.	It	is	an	even	better	work
habit	to	do	a	spot	check	on	one	frame	before	kicking	off	a	render	that	might	take	a	long	time.
Once	you	lose	a	couple	of	hours’	worth	of	time	to	a	silly	oversight	and	almost	miss	a	director
drive	by	approval	time,	you’ll	start	developing	“rules	you	should	live	by”	too.

The	render	mentioned	previously	has	been	included	in	the	chapter	companion	for	this	book.
Look	inside	the	folder	Chapter	Five	>	3D	leads	2D	>	vase.

2D	Animation	in	Photoshop

Open	 your	 .tif	 series	 of	 images	 in	 Photoshop	 by	 clicking	 File	 >	Open….	 Select	 the	 first
image	of	the	sequence	and	click	on	image	sequence.	Don’t	forget	to	set	the	correct	frame	rate.

This	 will	 automatically	 create	 a	 canvas	 with	 the	 correct	 image	 size	 and	 load	 the	 image
sequence	 into	 a	 video	 layer.	Note:	 in	 newer	 versions	 of	 Photoshop,	 the	 video	 layer	will	 be
inside	a	video	group	as	seen	in	Figure	5.9.



FIGURE	5.9	A	reference	loaded	in	as	a	video	layer	in	Photoshop

As	we	have	done	before,	you	will	want	to	create	a	video	layer	to	draw	your	EFX	layers	in.
In	 newer	 versions	 of	 Photoshop,	 if	 you	 have	 a	 video	 group,	 click	 in	 the	 layers	window	 to
deselect	that	group	before	creating	a	new	video	layer.	We	have	many	EFX	elements	to	draw
in	this	shot:	water,	flowers,	sparks,	and	flying	copper	bits.	We’ll	start	with	the	flowers.	If	you
remember	back	to	our	lecture	at	the	beginning	of	the	chapter,	flowers	would	come	under	our
solid	shapes	category.

In	Figure	5.10	the	vase	reference	layer	is	in	the	bottom	layer	position.	A	flower	animation
layer	is	also	visible.	As	a	note	to	my	students,	notice	that	the	flowers	are	extremely	roughed
in.	This	is	a	great	way	to	animate	through	your	shot	quickly	so	that	you	can	test	out	various
versions	or,	as	was	 the	case	with	 this	example,	get	 the	animation	supervisor’s	 feedback	and
approval.	A	great	guideline	is	to	work	rough	and	fast;	show	early;	show	often.



FIGURE	5.10	Rough	pass	of	a	f lower	animation

All	of	the	flowers	were	created	on	one	video	layer.	Was	this	a	great	idea?	Remember	that
the	video	layers	will	be	exported	out	for	ink	and	paint	and	compositing.	If	all	of	the	flowers
are	 on	one	 layer,	 that	makes	 for	 one	 sequence	of	 images	 that	will	 be	 inked	 and	painted.	 It
might	make	inking	and	painting	easier	to	have	the	flowers	all	on	one	layer,	but	that	makes	it
more	 difficult	 for	 the	 animator	 to	 keep	 track	 of	 the	 stems.	 Animating	 using	 video	 layers
sometimes	 causes	 bad	 habits	 of	 putting	 elements	 all	 in	 one	 layer.	 It	 is	 quite	 common	 for
elements	 to	 appear	 on	one	 layer	 and	 then	move	 to	 another	 layer	 so	 that	 they	have	proper
leveling.	Ultimately,	do	what	is	right	to	get	the	proper	animation,	but	keep	in	mind	how	the
leveling	is	going	to	happen	during	compositing.	Keep	those	x-sheets	handy.	As	you	gain	more
experience	with	creating	shots,	you’ll	start	to	see	how	to	break	apart	the	levels.

Once	the	flowers’	rough	animation	was	approved,	a	more	polished	version	of	the	animation
was	completed.



FIGURE	5.11	Final	animation	of	f lowers

A	special	note	on	animating	in	Photoshop:	in	shot	39,	the	timing	of	the	vase	movement	was
worked	 out	 in	 Maya,	 and	 that	 dictated	 the	 main	 movement	 of	 the	 2D	 flower	 and	 water
elements.	The	water	element	was	easy	enough	to	animate	in	Photoshop	because	it	was	mostly
animated	straight	ahead.	Animating	pose	 to	pose	 in	Photoshop	 is	difficult	when	using	video
layers.	 It	 can	be	done,	or	 the	animator	 can	choose	 to	use	 the	older	method	of	animating	 in
Photoshop:	using	 the	 frame	method	versus	using	video	 layers.	Why	 is	 it	difficult	 to	animate
using	video	 layers?	When	 there	 is	 a	keyframe	on	 frames	1	and	7	and	you	want	 to	 create	a
breakdown	on	 frame	 5,	 all	 of	 the	 other	 blank	 frames	 on	 the	 video	 layer	 get	 in	 the	way	of
rolling	through	your	animation	(see	Figure	5.12).	For	animators	who	like	to	flip	back	and	forth
between	the	drawings	instead	of	using	the	onion-skinning,	the	blank	frames	can	cause	the	eye
to	lose	where	the	previous	drawing	was.	It	is	still	possible,	with	some	duplicating	of	layers,	to
use	a	familiar	flipping	or	rolling	method.

The	 following	method	 can	 be	 employed	when	 doing	 cleanup	 in	 Photoshop	 or	 animating
pose	to	pose:

1.	 Draw	 the	 first	 and	 second	 keyframes	 in	 a	 video	 layer,	 as	 we	 learned	 in	 previous
chapters.

2.	 Duplicate	the	layer.
3.	 In	 the	 timeline,	open	 the	 layer	and	notice	 the	blue	boxes	on	 the	altered	video	 line.

You	cannot	move	these	keyframes	(drawings),	but	you	can	move	the	duplicate	layer
itself	so	that	the	keyframes	line	up	where	you	want	them	visible.



4.	 Repeat	as	needed	so	that	you	can	see	your	keys	in	the	correct	order	to	roll	or	flip	the
images	as	desired	while	you	draw	the	needed	breakdown	drawing.

5.	 When	you	are	done,	delete	the	duplicate	layer(s).

In	Figure	5.12	three	flower	keyframes	have	been	drawn.	The	layer	has	been	duplicated	and
moved	so	that	the	two	keyframes	show	up	at	the	same	time.	In	order	to	roll	the	drawings,	the
duplicate	would	be	moved	back	one	frame	in	time.

FIGURE	5.12	Using	duplicate	layers	to	roll	through	keyframes	without	blank	inbetweens

To	flip	or	roll	 images	has	a	different	definition	based	on	what	studio/country	one	is	 in.	 In
some	U.S.	studios,	to	flip	images	means	the	animators	stack	their	papers	in	such	a	way	as	to
look	at	the	first	key,	look	at	the	breakdown	that	they	are	currently	drawing	on,	and	then	flip
back	 a	 page	 to	 the	 second	 key.	 It	 is	 called	 “flip”	 because	 you	 end	up	 flipping	 forward	 and
backward	to	see	the	motion.	To	roll,	in	the	United	States,	is	to	stack	the	papers	in	order	and	to
roll	through	the	frames	with	the	first	key	on	the	bottom,	the	breakdown	on	top	of	that,	and
the	second	key	on	top.	Depending	on	one’s	dexterity,	one	can	roll	up	to	five	drawings	at	once.
These	terms	have	to	do	with	paper	and	what	one	has	to	do	in	order	to	keep	the	drawing	one	is
currently	adjusting	on	top	for	drawing.	In	our	digital	animation	pipeline,	you	will	mostly	be
rolling	 or	 you	 might	 hear	 the	 term	 “scrub”	 (which	 comes	 from	 the	 digital	 editing	 field).
However	you	manage	it	or	whatever	you	call	it,	it	is	imperative	for	the	pose-to-pose	animator
and	 the	 cleanup	 artist	 to	 have	 the	 ability	 to	 roll	 through	 their	 drawings	without	 seeing	 the
blank	inbetweens.

Another	type	of	EFX	element	that	we	discussed	was	abstract	elements.	Water	can	fall	into



this	category	because	it	is	purely	drawn	in	as	an	abstraction	of	its	natural	form.	Liquid,	water,
and	 smoke	 are	 all	 abstract	 elements.	 Our	 shot	 39	 depicts	 a	 vase	 filled	 with	 water	 flying
through	the	air.	The	vase	hits	the	ground	and	the	water	splashes	out	onto	an	electrical	outlet	in
the	wall.	The	same	method	of	roughing	in	the	animation	with	video	layers	was	used.	You	can
see	an	example	of	the	rough	and	final	animation	in	Figures	5.13	and	5.14.	You’ll	note	that	the
rough	 animation	 is	 extremely	 rough,	 with	 nothing	 more	 than	 bouncing	 balls	 to	 indicate
direction	and	volume.

FIGURE	5.13	Rough	animation	of	the	water	in	the	vase

FIGURE	5.14	Final	animation	of	the	water	EFX	element



Ink	Lines

Once	the	animation	and	cleanup	are	completed,	you	will	want	to	add	color	to	your	artwork.
There	are	many	ways	to	do	it	and	many	different	software	solutions.	Let’s	look	at	the	things
you	 might	 want	 to	 do	 with	 your	 ink	 lines	 before	 we	 deal	 with	 the	 button	 clicking	 and
different	software	programs.

The	first	thing	we	will	do	is	make	sure	that	the	ink	line	stays	separate	from	the	paint.	Why
would	we	want	to	have	the	ink	line	separate	from	the	paint?	We	can	reuse	the	ink	line	in	our
compositing	software	to	create	various	visual	compositing	techniques.

With	 the	 ink	 line	 separate,	 you	 can	 easily	 change	 the	 color	 of	 the	 ink	 line	 if	 your	 paint
package	 lets	 you	 fill	 in	 color	 and	 keep	 alpha	 channels.	 In	 Photoshop	 this	 can	 be	 done	 by
selecting	Edit	>	Fill	and	making	sure	that	the	Preserve	Transparency	option	is	turned	on.

FIGURE	5.15	Using	Fill	to	color	ink	lines	easily

A	simple	example	of	how	ink	lines	can	be	finessed	is	shown	in	Figure	5.16.	The	ink	line	has
been	duplicated	and	blurred.	This	blurred	 ink	 line	was	clipped	 (or	masked	out)	by	 the	paint
layer.	This	way	the	blurring	did	not	extend	on	the	outside	of	the	water,	giving	the	water	an
unwanted	halo.	The	harsh	edges	of	the	blurred	ink	line	are	never	visible	because	the	original
ink	line	is	layered	on	top	of	it,	as	you	see	in	the	top	portion	of	Figure	5.16.	The	paint	layer	is
also	transparent,	though	that	is	not	visible	in	this	image.



FIGURE	5.16	Ink	line	sample

Figure	5.17	 is	similar	to	the	previous	example,	except	that	there	 is	not	the	addition	of	the
original	ink	line	on	top.	The	blurred	ink	line	is	also	colored	to	be	similar	to	that	of	the	paint.
This	 is	a	useful	 technique	when	combining	2D	elements	with	3D	elements	 that	do	not	have
strong	toon	lines.	Just	because	there	is	a	drawn	line	for	the	2D	element	does	not	mean	that	it
has	to	stay	visible	in	the	final	composite.

FIGURE	5.17	Ink	line	sample

If	 you	 use	 Photoshop	 or	 any	 painting	 package	 in	which	 you	 use	 something	 like	 a	 paint



bucket	tool,	a	good	technique	to	use	for	painting	is	the	following:

1.	 Place	the	ink	line	on	one	layer.
2.	 Create	the	paint	fill	on	a	second	layer.
3.	 Paint	using	the	paint	bucket	and	brush	tools.	Don’t	worry	about	coloring	outside	of

the	lines	too	much.
4.	 Using	a	magic	wand	tool,	select	the	paint	that	is	outside	the	lines.	In	Photoshop,	make

sure	to	have	Sample	All	Layers	turned	on.
5.	 Delete	the	extra	paint.	Touch	up	any	missed	areas.

FIGURE	5.18	Creating	paint	fills	on	a	separate	layer	in	Photoshop

Node-Based	Compositors

Nuke

My	favorite	compositing	method	is	node	compositing.	I	first	learned	node	compositing	on
Eddie,	an	old	system,	and	Flame/Flint.	(I	used	Flame	for	barely	more	than	a	week,	so	don’t	be
too	 impressed.)	 I	 used	Shake	quite	 a	bit	 and	 then	 it	was	 replaced	with	Nuke.	As	we	 stated
earlier,	 there	 are	 two	main	 types	 of	 compositing	 systems:	 node	 and	 layer	 (timeline)	 based.
Smoke,	as	we	have	seen,	is	something	in	between:	a	timeline	editor	with	a	node	compositor
under	 the	 hood.	 Once	 you	 know	 a	 node-based	 system,	 it	 is	 fairly	 easy	 to	 pick	 up	 another
node-based	compositor.	 I’ll	admit,	 I	prefer	node	systems.	They	seem	more	organic	and	fluid
for	how	I	work/think.	I	would	encourage	you	to	become	familiar	with	both	types	of	systems.
Were	you	to	find	yourself	in	a	visual	effects	(VSFX)	house	as	a	compositor,	you	would	have	to
learn	 proprietary	 compositing	 systems;	 knowing	 both	 types	 will	 give	 you	 a	 head	 start	 on
learning	how	the	pros	do	it.

If	 you	have	 ever	worked	 in	Maya’s	Hypershade	or	Hypergraph	Connections	Editor,	 then
you	have	worked	with	node	networks.

We’ll	do	 this	water	composite	 in	Nuke.	 I	won’t	go	 through	 the	Nuke	 interface	 too	much;
you	 can	 read	 the	 documentation	 for	 that.	 As	with	most	 software,	 the	 install	 comes	with	 a



manual	and	plenty	of	tutorials.	Students,	please	familiarize	yourselves	with	finding	answers	in
the	documentation.	This	is	a	skill	I	see	lacking	in	students.	(I’m	putting	the	soapbox	away.)

If	you	want	to	follow	along,	images	can	be	found	in	the	companion	data	in	Chapter	Five	>
Ink.

1.	 Locate	the	image	icon	and	click	on	the	Read	button.	Select	the	water.####.tif	image
sequence	and	click	open.	This	will	load	your	images	and	it	will	create	an	Image	Read
node	in	the	node	graph	window.

2.	 To	 see	 the	 image	you	have	 to	 connect	 it	 to	 a	 viewer.	Connect	 the	 arrow	 from	 the
Viewer1	node	to	the	image	sequence	that	was	loaded	in.	You’ll	be	able	to	play	the
sequence.

3.	 Select	the	image	node;	locate	the	Properties	tab;	rename	the	node	to	WaterInk.
4.	 Select	the	Filter	icon	and	click	on	Blur.	This	will	add	a	Blur	node	to	the	output	of	the

WaterInk	node.
5.	 In	the	Properties	tab,	you	can	adjust	the	amount	of	blur	to	be	used.
6.	 Deselect	 all	 nodes.	 Select	 the	Merge	 icon	 and	 click	 on	Merge.	 This	 will	 create	 a

merge	over	the	node	with	two	yellow	arrows	yearning	to	be	connected	to	something.
Connect	the	A	arrow	to	WaterInk.	Connect	the	B	arrow	to	the	Blur	node.

7.	 To	see	the	result,	connect	the	viewer’s	yellow	arrow	to	 the	bottom	of	 the	Merge1
(Over)	node.



FIGURE	5.19	Ink	line	over	blurred	ink	line	in	Nuke

The	preview	image	now	shows	a	blurred	ink	line	underneath	a	nonblurred	ink	line.	There
are	two	things	 left	 to	do:	 (1)	add	the	paint,	and	(2)	cut	off	 the	blurred	 line	so	that	 it	doesn’t
extend	outside	of	the	edges	of	the	ink	line.

1.	 From	the	Image	tab,	click	on	the	Read	button	and	load	a	series	of	the	paint	level.	(For
this	example,	the	ink	and	paint	lines	were	done	as	separate	layers	in	Photoshop	and
exported	out	as	separate	file	sequences.)

2.	 Select	the	Merge1	(Over)	node	and	the	Water_Paint	node.	The	first	node	you	select
will	be	layered	on	top	in	the	next	step.	We	want	the	paint	to	be	on	the	bottom,	“B.”
(We	 didn’t	 do	 this	 earlier	 with	 the	 blur	 node,	 because	 it	 would	 not	 have	 acted
correctly.	It	would	have	disconnected	the	Blur	node,	or	at	least	in	my	version	of	Nuke
it	did.)

3.	 Create	a	Merge	node	by	clicking	on	Merge	>	Merge.	It	will	be	called	Merge2	(over)
and	the	viewer	should	update	to	show	an	ink	layer	on	top	of	a	blurred	ink	layer	on
top	of	a	paint	layer.

4.	 This	is	the	extra	fancy	step.	Click	and	drag	from	the	right	side	of	the	Blur	node	 to
the	paint	 layer.	 This	will	 read	 the	 paint	 layer	 as	 a	mask	 and	will	 only	 show	 the
blurred	ink	line	wherever	there	is	paint.	This	way	the	ink	line	does	not	blur	outside	of
the	lines!

FIGURE	5.20	Adding	the	paint	and	containing	the	blurred	line.	Image	shown	with	alpha	channel	to	better	illustrate	the	blur.

(Fuzzy	blocks	are	artifacts	from	learning	edition	of	Nuke.)

Now	you	 have	 gone	 through	 a	 crash	 course	 in	 node	 compositing.	 The	 great	 thing	 about
using	node	systems	is	that	you	can	reuse	series	of	images	easily	and	hook	everything	together,
if	you	are	prone	to	thinking	this	way.	In	fact,	if	you	compare	this	page	to	the	page	from	the



previous	 edition	 of	 this	 book	 you	will	 note	 that	 it	 is	 almost	 the	 same	 steps	 with	 only	 the
names	 of	 the	 nodes	 changed.	 Those	who	 have	 not	 adopted	 the	 usage	 of	 node	 compositing
should	challenge	themselves	and	step	up	to	a	higher-end	compositing	method,	even	if	using	a
learning	edition	of	software.	You’ll	be	glad	you	did.

Toon	Boom

Toon	Boom	has	a	wonderful	assortment	of	 softwares.	The	 type	of	pipeline	you	are	using
determines	which	software	you	use.	Luckily,	most	of	the	Toon	Boom	products	have	a	learning
edition	so	you	can	test	out	your	pipeline	before	purchasing.	The	newest	version,	Toon	Boom
Harmony,	allows	for	3D	models	to	be	brought	into	the	scene	directly,	much	like	you	can	with
Photoshop.	There	 is	no	 learner’s	edition	of	 that	version	of	 the	software,	 though.	There	 is	an
educational	discount	 for	Harmony.	One	other	 thing	 to	note	 is	 that	 scenes	animated	 in	Toon
Boom	Animate	or	Animate	Pro	are	not	able	to	be	brought	into	Harmony.	Harmony	is	utilized
by	larger	companies,	more	for	its	database	structure	for	asset	management.

Lately,	 the	 industry	 has	 been	 switching	 from	 Flash	 to	 Toon	 Boom	 Animate	 Pro	 and
Harmony.	We	added	it	to	our	classrooms	so	that	the	students	could	gain	exposure	to	it.	We	do
not	use	the	auto	lipsync	functionality	of	the	software.	However,	that	feature	is	probably	useful
for	those	in	a	short	turnaround,	small-budget	situation.	You’ll	find	ample	training	material	out
there	if	you	want	to	learn	more	about	the	software.

Here	are	two	websites	that	can	help	you	get	started	with	the	package:
www.toonboomtutorials.com
http://toonboomcartooning.wetpaint.com

http://www.toonboomtutorials.com
http://toonboomcartooning.wetpaint.com


FIGURE	5.21	2D	characters	drawn	in	Toon	Boom	Animate	over	a	3D	train	animated	and	rendered	in	Maya.	By	Jessica

Huang,	2009,	2D/3D	compositing	course,	SCAD

The	bottom	of	it	all	is	getting	comfortable	moving	between	the	different	packages.	Render
3D	in	Maya,	animate	2D	in	Photoshop,	composite	in	Toon	Boom.	Or,	based	on	artists’	talents,
render	3D	in	whatever	3D	package	you	use,	rough	animate	2D	in	Photoshop,	cleanup	animate
in	Toon	Boom,	composite	it	all	in	Nuke	or	After	Effects.

Let’s	 cover	 the	 basics	 of	 bringing	 some	 images	 into	Toon	Boom.	 For	 this	we’ll	 use	Toon
Boom	Animate	 Pro.	 First,	 we’ll	 export	 out	 of	 Photoshop;	 things	 should	 be	 getting	 familiar
now.	However,	each	software	package	you	use	brings	a	different	set	of	button	clicks,	and	with
each	version	those	button	clicks	will	change.	All	is	based	on	how	the	software	reads	the	alpha
channels	and	what	 file	 formats	 the	software	works	with.	The	more	back-and-forth	between
multiple	 software	 packages	 that	 you	 gain	 exposure	 to,	 the	 easier	 time	 you	 will	 have	 at
problem	solving	these	pipeline	issues.

Here’s	how	to	export	from	Photoshop	to	Toon	Boom:

1.	 Hide	 all	 but	 the	 layer	 that	 you	want	 exported	 out	 of	 Photoshop	 and	 select	File	 >
Render	Video.

2.	 Newer	versions	of	Photoshop	can	export	sequences	of	 images,	 including	 .tif	 images,
with	transparency.	Else	you	can	export	an	uncompressed	movie	file.

Use	 these	 settings	 for	 a	 series	 of	 .tif	 images:	 Photoshop	 Render	 Sequence.



Format:	TIFF.	Make	 sure	 to	 set	Settings	 >	 Save	 transparency	 (else	 it	will
not!).	Alpha	Channel:	Straight	unmatted.

Use	these	settings	for	a	movie	file:	QuickTime/Raw	(to	keep	the	alpha	channel),
alpha	channel:	Straight	Unmated.	Make	 sure	 your	 frame	 rate	matches	 and
that	you	have	number	padding	on.	Click	Render.

FIGURE	5.22	Exporting	animation	from	Photoshop

Note:	it	is	important	to	double-check	how	your	alpha	channels	are	being	read	between	the
different	 file	 formats.	 You’ll	want	 to	 test	 that	 out	 before	 proceeding.	 You’ll	 find	 that	many
softwares,	depending	on	version,	may	not	 read	 .tif	or	 .mov	 files	and	 their	alpha	channels	as
expected.

Now	you	are	ready	to	import	your	image	sequence	into	Toon	Boom.

1.	 Open	a	new	project	 in	Toon	Boom	Animate	Pro;	make	 sure	 that	 the	 canvas	 size	 is
correct.

2.	 Select	File	>	Import	>	Images	…	(or	movie,	based	on	what	you	have	exported	from
Photoshop).

3.	 In	the	file	browser	window,	select	 the	tiff	 image	sequence	or	the	movie	 file.	Make
sure	the	alpha	channel	matches	what	you	used	to	render	in	Photoshop.

4.	 Chose	the	options	for	vectorize	the	images	in	color.	In	fact,	unlike	in	past	versions	of
Toon	Boom,	you	now	have	to	vectorize	if	you	wish	to	ink	and	paint	the	animation.	(If
you	read	the	first	edition	of	this	book,	vectorizing	is	now	very	good	in	Toon	Boom,



especially	in	color.)

The	 images	 are	 added	 to	 the	 exposure	 sheet	 and	 visible	 in	 the	 preview	 area.	Do	 not	 be
scared	by	 the	pixilated	 line.	This	 is	 a	 preview.	As	 a	note,	 graphics	 cards	may	 react	 oddly,	 I
have	 found.	On	a	MacBook	Pro,	only	selected	 layers	will	 show	the	black	 ink	 line.	Else	 they
show	in	white.	This	is	an	OpenGL	issue.	Creating	a	test	of	the	scene	will	show	the	actual	line
quality.	Also,	you	can	toggle	between	Open	GL	view	and	Render	view	with	the	buttons	at	the
bottom	of	the	canvas.	They	look	like	flowers.

FIGURE	5.23	Water	drawings	in	the	exposure	sheet

To	create	 the	same	 type	of	compositing	effect	 in	Toon	Boom	as	we	did	 in	Nuke,	we	will
explore	the	Toon	Boom	method	of	node	compositing.

Toon	Boom	Animate	Pro

1.	 Locate	 the	Timeline	 tab.	Right-click	 on	 the	 ink	 level	and	duplicate.	Name	 the	 top



level	 Ink,	 and	 the	 bottom	 level	 Paint.	 The	 Ink	 level	 will	 be	 the	 used	 as	 normal
unblurred	ink	level	and	will	have	a	version	of	it	that	will	be	blurred.	The	paint	level
will	be	on	the	bottom	of	the	image	stack.

2.	 In	Figure	5.24	you	see	the	paint	level.	The	paint	bucket	tool	was	used	to	fill	the	ink
with	paint.	The	ink	lines	were	self-painted	(though	garishly	for	this	example).

3.	 Temporarily	add	a	white	color	card	to	the	bottom	of	the	stack	of	images,	else	it	will
preview	over	black,	making	it	difficult	to	see	the	ink	lines.	To	get	a	color	card,	click
on	the	small	plus	icon	and	chose	Colour	Card.	Click	and	drag	 layers	 to	stack	them
correctly.

FIGURE	5.24	Ink	level	duplicated	and	painted

4.	 To	 blur	 the	 ink	 layer:	 locate	 the	Module	 Library	 (Windows	 >	Module	 Library).
Drag	it	into	the	node	window.	To	connect	it,	hold	down	the	option	key	and	drag	the
Blur-Radial	node	onto	the	line	between	the	ink	node	and	the	composite	node.	This
will	automatically	plug	it	in	between	the	two.	See	Figure	5.25.

5.	 Select	the	Blur-Radial	node	and	in	the	Layer	Properties	Window	(or	click	the	small
yellow	square	on	the	left	of	the	Blur-Radial	node)	change	the	Radius	settings	to	5.

6.	 Create	an	unblurred	version	of	the	ink	artwork	that	will	sit	on	top	of	the	composite
by	dragging	another	line	from	the	ink	node	to	the	composite	node.	This	line	should



be	 to	 the	 left	 of	 the	 blurred	 ink	 line.	 To	 see	 the	 results,	 locate	 the	Render	 View
button	(it	looks	like	a	little	flower	at	the	bottom	of	the	camera	window)	and	click	it
on.	This	will	show	all	of	the	levels	together.	See	Figure	5.25.

7.	 To	get	rid	of	the	blur	outside	of	the	clean	ink	line,	add	a	Cutter	node	to	the	Network
Window.	Next,	option	 drag	 the	Cutter	 node	 onto	 the	 line	 between	 the	Blur	 node
and	the	Composite	node.	This	will	automatically	plug	it	in.	To	create	the	mask,	drag
a	line	from	the	output	of	the	paint	node	and	hook	it	up	to	the	top	left	of	the	Cutter
node.

8.	 Lastly,	click	on	the	yellow	square	to	open	up	the	Cutter	node’s	properties,	and	select
inverted.	 The	 blurred	 inlines	 will	 only	 be	 visible	 on	 the	 inside	 of	 the	 water.	 See
Figure	5.26.

FIGURE	5.25	Blur	added	to	the	ink	layer.	(Paint	hidden	for	clarity.)



FIGURE	5.26	Blurred	ink	level	cut	to	only	show	on	the	inside	of	the	paint	areas

2D	Leading	Prop	in	Photoshop

Another	 area	 for	 the	 effects	 artist	 is	 that	 of	 putting	props	 into	 2D	 characters’	 hands.	The
prop	itself	can	be	in	2D	or	3D.	Many	times	it	is	in	3D.	The	hand	placing	of	3D	props	in	a	2D
character’s	hands	can	be	tedious	and	is	prone	to	having	jiggle	because	the	2D	animator	does
not	animate	her	or	his	2D	character	holding	a	spatially	perfect	prop.	The	easiest	method	is	to
bring	the	2D	animation	into	a	3D	software	package	as	an	image	plane	and	place	the	3D	prop
visually	so	that	it	seems	to	match	the	character’s	contact	point.	Another	method	that	is	now
becoming	 available	 is	 the	 limited	 ability	 to	 bring	 3D	 objects	 into	 Photoshop,	 After	 Effects,
Flash,	Toon	Boom,	and	other	2D	packages.

With	this	ability,	the	animator	does	not	have	to	leave	the	2D	package	to	animate	the	3D	to
follow	the	2D.	If	the	3D	is	to	have	any	larger	animation	ability	beyond	translate,	rotate,	and
scale,	 then	 the	 artist	will	 need	 to	use	 a	 3D	package	 to	 do	 that	 advanced	 animation.	 Simple
prop	following	animation	could	be	limited	to	translate,	rotate,	and	scale.	However,	this	limited
animation	 for	 the	 3D	 may	 make	 it	 stand	 out	 as	 3D	 if	 the	 2D	 character	 is	 squashing	 and
stretching	 in	a	cartoony	way.	 If	 that	 is	 the	case,	or	 if	 there	are	 large	perspective	cheats	 that
must	happen	to	match	the	3D	to	the	2D,	then	a	3D	package	will	need	to	be	used.

During	production,	prop	requirements	 for	a	 film	can	be	 large.	Hundreds	of	props	may	be
needed.	 If	 a	 team	 or	 student	 does	more	 than	 one	 film,	 sometimes	 props	 can	 be	 reused	 or
revamped	to	use	in	multiple	shows.	Having	a	good	system	to	store	and	reuse	props	can	help
speed	up	your	process.

We’ll	briefly	cover	using	3D	objects	in	Photoshop.	Photoshop	can	read	in	many	types	of	3D
objects	files.	Some	of	these	file	types	are	simple	to	write	out	and	have	been	around	for	ages;



others	are	relatively	new.	File	types	that	read	in	are	as	follows:

Export	Your	3D	Object

For	 this	 exercise	 we	 will	 work	 with	 a	 simple,	 blocky	 hat	 that	 has	 been	 created	 out	 of
polygons	in	Maya.	It	has	been	UVed	and	even	has	a	checkerboard	texture	on	it	just	to	show
the	UVs.	The	file	is	found	in	the	folder	named	2D_Leads_3DProp	and	is	called	Hat.	mb,	if	you
want	 to	 open	 it	 and	 look	 for	 yourself.	 The	 checkerboard	 texture	will	 actually	not	 be	 saved
with	the	OBJ	texture	because	that	is	procedural.	You	can	convert	a	procedural	texture	to	a	file,
and	then	it	would	be	exported.

To	export	an	object	out	of	Maya	as	an	OBJ	object,	you	will	first	have	to	turn	on	the	plug-in
objExport.mll:

1.	 Open	the	file	Hat.mb	in	Maya.
2.	 Click	Window	>	Settings/Preferences	>	Plug-in	Manager.
3.	 In	 the	 window	 that	 opens,	 turn	 on	 the	 Loaded	 and	Auto-Load	 checkbox	 for	 the

objExport.mll	or	objExport.bundle	(.mll	or	 .bundle	depending	on	which	version	of
Maya	you	are	using).

4.	 Select	the	hat	object.	It	will	highlight	in	green.
5.	 Click	on	the	Option	Box	next	to	File	>	Export	Selection.
6.	 Under	General	Options,	select	File	Type:	OBJexport.
7.	 Click	Export.

This	 has	 given	 us	 the	 exported	 files	hat.obj	 and	hat.mtl.	 You	 can	 find	 these	 files	 in	 the
folder	named	exportFromMaya.



Import	OBJ	File	into	Photoshop

In	Photoshop	CS4	or	later,	open	up	the	sample	file	that	we	will	use	by	clicking	File	>	Open,
and	 locate	 the	 file	 DanMurdock_Big-Gulp_Section.mov	 inside	 the	 2D_Leads_3DProp
folder.

FIGURE	5.27	DanMurdock_BigGulp_Section.mov	in	Photoshop,	by	Dan	Murdock,	2009,	digital	cel	I	course,	SCAD

Wavefront	is	one	of	the	original	3D	packages	that	was	ultimately	bought	and	incorporated
into	Maya,	 thus	you	have	the	 .OBJ	exporter	built	 in.	OBJ	is	a	universal	object	description.	 If
you	wanted,	you	could	open	the	obj	file	in	a	text	editor	and	look	it	over.	It	is	geek	readable.

Import	3D	OBJ	Object

In	Photoshop,	locate	the	3D	menu.	This	portion	of	Photoshop	will	not	work	with	older	Macs
or	graphics	cards.	To	bring	in	the	obj	object	from	Maya	into	Photoshop,	do	the	following:

1.	 Make	sure	that	the	movie	layer	is	not	selected.	Click	on	the	blank	area	in	the	layer



editor	 to	deselect	 the	video	 layer.	 If	you	don’t	do	 this,	 the	hat	will	not	 show	up	 in
some	versions	of	Photoshop!

2.	 Now	you	can	bring	in	the	hat:	3D	>	New	3D	Layer	from	file	…
3.	 Locate	the	hat.obj	file.	Select	the	file	and	click	Open.
4.	 Click	on	the	Move	tool	(“v”)	to	switch	to	move	3D	mode.	Use	these	tools	to	position

the	hat	so	that	it	looks	to	be	on	top	of	the	character’s	head.
5.	 If	you	click	directly	on	the	object	you	can	adjust	its	local	scale,	position,	and	translate

properties.
6.	 Create	a	position	keyframe	in	the	timeline	editor	so	that	the	hat	stays	in	position.

You’ll	note	that	new	3D	tools	show	up	at	the	top	of	the	screen.	These	are	similar	to	camera
attributes.

Rotate	the	3D	object	in	XYZ	space
Roll	the	object	in	front	of	the	camera	(using	all	axes)
Drag	the	3D	object	(in	X	and	Y,	up	and	down)
Slide	the	3D	object	(in	Z	and	up	and	down)
Scale	the	3D	object	(which	is	really	scaling	the	whole	universe	that	it	exists	in)

All	 right,	 3D	people,	 the	camera	controls	are	a	 little	different	 than	you	are	used	 to.	Note
that	 in	 the	 property	window	you	 can	 change	 to	 3D	 coordinate	 system	 to	 type	 numbers	 in.
Also,	Apple-click	in	a	field	to	get	a	virtual	slider.

In	Figure	5.28	you	see	arrows	indicating	the	3D	hat,	the	3D	layer,	and	in	the	timeline	editor
a	keyframe	that	has	been	added	to	the	3D	positioning	of	the	object.

FIGURE	5.28	OBJ	loaded	into	a	3D	layer

You	will	want	 to	 turn	 off	 the	 shadow	 that	 is	 happening	 on	 the	 universe’s	 ground	 plane.



Click	on	Infinite	Light	icon	(in	newer	versions	of	Photoshop)	and	turn	off	the	Shadow	option
found	in	the	Property	window.

You	can	even	paint	the	3D	object	in	Photoshop.	Figure	5.29	shows	the	hat	in	various	stages
of	 being	 painted.	 The	 normal	 paintbrush	was	 used.	 Remember	 that	 paint	 job;	we’ll	 see	 the
texture	that	was	created	in	just	a	moment.

FIGURE	5.29	Painting	a	texture	for	the	3D	object

To	set	keyframes,	turn	on	the	stopwatch	for	the	3D	Object	Position,	and	use	the	move	tool
(v)	 to	 position	 and	 rotate	 the	 hat	 for	 the	 keyframes	 needed.	 You	 can	 see	 an	 example	 of	 a
finished	animated	obj	in	the	Photoshop	file	DanMurdock_BigGulp_Section.psd.	Figure	5.30
shows	a	keyframes	set	for	the	hat	obj.



FIGURE	5.30	Keyframes	in	Photoshop

The	last	portion	we	will	cover	as	we	explore	the	3D	capabilities	in	Photoshop	is	exporting
the	object	file	and	the	texture	that	we	painted.	Feel	free	to	explore	the	3D	paint	capabilities	in
Photoshop.

To	export	 3D	objects	out	of	Photoshop,	 simply	 select	3D	>	Export	 3D	Layer….	 This	will
save	the	obj	file,	a	material	file	(mtl),	and	a	texture	(psd).

If	you	are	using	the	obj	 file	 in	Maya,	you	can	 load	 in	 the	psd	 texture	 that	was	created	 in
Photoshop.	Select	the	hat	object,	create	a	material	shader,	lambert,	for	example.	Then	create	a
PSD	file	node	 in	 the	color	channel.	Figure	5.31	shows	the	 texture	 loaded	 into	Maya.	This	 is
great	 news	 for	 Photoshop	 texture	 painters,	 because	 this	 shows	 a	 different	 workflow	 for
painting	the	textures	and	using	the	familiar	tools	of	Photoshop	painting.



FIGURE	5.31	A	psd	texture	loaded	into	the	Maya	scene

The	exported	files	are	in	the	companion	data	in	a	folder	titled	exportFromPhotoshop.	This
is	just	the	beginning	of	working	with	3D	in	Photoshop	and	the	beginning	of	Photoshop’s	3D
capabilities.	As	new	versions	of	Photoshop	are	created,	the	feature	set	will	continue	to	grow.

Import	OBJ	File	into	Toon	Boom	Harmony

If	you	have	access	 to	Toon	Boom	Harmony,	you	will	 find	that	you	can	bring	3D	obj	 files
into	 there	 as	 well.	 There	 is	 also	 a	Maya	 plugin	 for	 Harmony	 that	 can	 be	 used.	 To	 import
objects	 in	 Harmony,	 go	 to	 File	 >	 Import	 >	 3D	 Models….	 The	 model	 comes	 in	 with	 the
transformation	 handle	 corresponding	 to	 where	 the	 origin	 was	 in	Maya.	 The	model	 can	 be
moved,	 rotated,	 and	 scaled	 in	Harmony.	 It	 can	 even	 be	 animated	 in	 this	 fashion,	 just	 as	 in
Photoshop.	Remember	to	turn	the	Animate	button	on	for	keyframes	to	register.



FIGURE	5.31A	Importing	3D	models	into	Toon	Boom	Harmony

Tones	and	Shadows

These	two	terms	come	from	2D	animation.	Because	we	are	dealing	with	the	compositing	of
elements	to	make	a	final	 image	and	not	rendering	everything	in	3D	for	one	final	frame,	we
will	continue	to	use	these	2D	terms	for	our	2D/3D	pipeline.

The	term	“tones”	refers	to	the	area	on	a	character	that	the	light	does	not	fully	illuminate,
the	 area	 in	 shadow.	 This	 dark	 area	 can	 be	 caused	 by	 self-shadowing	 or	 cast	 shadows	 from
other	characters,	props,	and	 the	 like.	Although	 it	 is	 technically	a	 shadow,	when	 this	 shadow
area	is	on	top	of	a	character,	in	animation	it	is	referred	to	as	a	tone.	The	term	“shadows”	refers
to	the	shadow	cast	from	the	character	onto	the	background	elements.

In	3D	animation,	the	artist	must	only	think	about	setting	the	light	up	for	good	illumination
and	the	rendering	engine	takes	care	of	the	tone	and	shadow	portion	of	the	image	based	on	the
materials	applied	to	the	objects.	The	person	in	charge	of	lighting	looks	to	make	sure	that	the
tones	are	not	covering	the	character	in	a	distracting	way.



FIGURE	5.32	Example	of	3D	tone	and	shadow.	Model	and	rig	by	John	Vu,	2009,	3D	character	and	setup	animation	course,

SCAD

In	 2D	 animation,	 the	 artist	 must	 draw	 the	 areas	 where	 the	 light	 is	 not	 visible.	 This	 2D
representation	of	dark	areas—tones	and	shadows—is	used	in	the	compositing	stage	to	darken
the	character’s	painted	colors.



FIGURE	5.33	Example	of	2D	tone,	shadow,	and	highlight.	By	Dianna	Bedell,	2009,	Senior	Project	II,	SCAD

The	 difference	 in	 the	 representation	 of	 light	 can	 cause	 issues	 when	 putting	 2D	 and	 3D
images	 together.	 If	 the	 3D	 element	 is	 rendered	 with	 3D	 lighting	 and	 shadowing,	 the	 2D
imagery	cannot	match	because	it	will	be	flat	and	at	most	have	a	slight	shadowing	from	hand-
drawn	 tones	and	shadows.	We	have	examined	many	 films,	both	 in	 this	book	and	as	part	of
chapter	projects.	In	your	research,	you	have	seen	examples	of	extremely	rendered	3D	imagery
combined	with	very	flat	2D	imagery.	This	combination	can	be	somewhat	jarring.

What	do	you	do	with	light	and	shadow	if	the	media	look	at	them	differently?	How	do	we
make	them	match?	The	answer	is	to	choose	a	lighting/shading	model	to	use	for	both	media.
You	can	choose	to	light	and	shade	using	3D	methods	for	any	elements	that	are	in	contact	with
one	another	or	light	and	shade	using	2D	methods	for	touching	elements.

There’s	a	key	concept	in	this	approach.	It	is	only	when	characters	of	different	media	are	in
contact	with	 one	 another	 or	when	 a	 character	 itself	 is	made	up	 of	 different	media	 that	 the
lighting	models	must	match.	A	character	and	 the	character’s	background	can	have	different
lighting	models.



FIGURE	5.34	Example	of	a	2D	character	without	tones	and	a	highly	rendered	background.	Model	and	pose	by	John	Vu,

2009,	3D	character	setup	and	animation	class,	SCAD

3D	Tones	and	Shadows

In	the	previous	chapter	where	we	discussed	creating	a	3D	character	with	2D	parts,	we	set
ourselves	up	for	the	perfect	example	of	a	character	that	could	use	3D	tones	and	shadows,	even
on	top	of	the	2D.	Because	the	stand-in	3D	character	is	so	highly	modeled	and	basically	used	as
reference	for	the	2D,	we	can	pull	tones	and	shadow	mattes	from	the	render	and	use	that	in	our
composite.



FIGURE	5.35	3D	character	with	2D	parts	without	tones	or	shadows	(left);	using	a	3D	lighting	model	to	tie	the	elements

together	(right)

In	Chapter	3,	we	used	a	toon	shader	to	create	a	rim	light	matte	for	our	3D	arm.	We	will	use
the	same	technique	here,	but	we	will	apply	the	output	to	our	2D	and	3D	images	during	our
composite.

Tone	Matte

First	we’ll	create	our	3D	tone	matte	 for	both	 the	3D	portion	of	our	character	and	 the	3D
reference	geometry:	Jaguar	McGuire’s	body	and	head.

FIGURE	5.36	Using	interpolation	type	to	adjust	edge	of	black	and	white	tone

1.	 In	your	3D	package,	create	a	light	and	shine	it	at	your	3D	character.	A	spotlight	has
been	created	to	shine	on	Jaguar	McGuire	by	clicking	Create	>	Lights	>	Spot	Light.
In	Maya,	 to	 see	 lighting	 only,	 use	 the	 lighting	 display	mode	 (hot	 key:	 7)	 so	 that	 a
hardware	view	of	the	lighting	and	shading	can	be	seen.

2.	 Remember,	 for	 our	 mattes	 we	 want	 a	 completely	 black-and-white	 image	 to	 use
during	compositing.	Select	the	whole	object	and	apply	a	toon	fill	shader	in	the	Render
section	by	clicking	Toon	>	Assign	Fill	Shader	>	Light	Angle	Two	Tone.

3.	 The	default	color	of	the	shader	is	gray,	so	it	is	not	very	useful	to	us.
4.	 Change	the	first	chip	color	to	black.	This	produces	a	tone	that	is	too	hard	to	use.
5.	 Change	the	interpolation	type	to	spline.	This	produces	a	tone	that	is	too	soft	to	use.
6.	 Click	in	the	black	area	to	create	a	third	color	chip	of	black	and	move	it	toward	the



white	area	of	the	ramp	shader.	This	should	produce	a	smaller	threshold	between	the
black-and-white	color	change.

7.	 To	adjust	the	parameters	and	interactively	see	feedback,	you	can	use	the	Interactive
Photorealistic	 Rendering	 (IPR)	 window.	 Click	 on	 the	 IPR	 button	 in	 the	 render
window	and	follow	the	directions	 to	draw	a	box	around	the	render	region.	As	you
adjust	the	sliders	to	the	toon	shader,	it	will	interactively	update	in	your	window	until
you	get	the	shader	just	right.

FIGURE	5.37	Using	the	IPR	window	to	interactively	see	toon	shader	adjustments

Once	 you	 have	 the	 settings	 you	 think	 are	 correct,	 take	 a	moment	 and	 go	 through	 your
animation	to	check	for	any	unwanted	tone	effects.	A	quick	way	to	do	this	is	to	use	the	Keep
Image	feature	of	the	Render	View	window.

Render	the	first	image	in	your	animation	to	look	at	the	tones.	In	the	Render	View	window
you	can	save	images	by	clicking	the	Keep	Image	button	at	the	top	of	the	window.	Then	render
another	frame	later	in	your	animation	at	a	key	point	of	the	movement.	You	can	use	the	slider
at	the	bottom	of	the	Render	View	window	to	scrub	back	and	forth	between	the	images	and
check	 for	 unwanted	 popping	 in	 the	 tones	 or	 shapes	 that	 obscure	 important	 features	 of	 the
character.	 If	 such	 things	were	 to	 show	up,	 you	would	 need	 to	 readjust	 the	 lighting	 in	 your
scene.



FIGURE	5.38	Using	the	Keep	Image	feature	of	the	Render	View	window	to	check	the	tone	matte.	Shown	in	Maya	2014	(left)

and	Maya	2011	(right).	Even	though	the	version	changes,	the	buttons	stay	pretty	much	in	the	same	place

Once	 you	 are	 satisfied	 that	 your	 tones	will	 render	 correctly,	 you	 can	 render	 your	 tones.
Steps	 like	 these	 can	 help	 you	 catch	 errors	 before	 you	 kick	 off	 a	 render,	walk	 away	 to	 get
coffee,	and	come	back	 to	a	 surprise.	Of	course,	 this	 is	not	 to	 say	 that	after	you	 return	 from
getting	your	coffee	you	still	won’t	be	surprised.	That	is	the	nature	of	the	medium.	Those	who
have	been	around	the	digital	block	a	time	or	two,	feel	free	to	ignore	these	musings.	Students,
take	heed.

When	 rendering	 the	 tone	 matte,	 we	 can	 use	 .tifs	 because	 this	 is	 now	 going	 to	 final
compositing.	Remember	to	use	alpha	channels	and	frame	padding	(Figure	5.39).

FIGURE	5.39	Rendering	tone	matte



For	 the	 Jaguar	 McGuire	 shot,	 we	 rendered	 out	 the	 background	 element	 as	 one	 image,
because	 the	 elements	 are	 not	 being	 animated	 and	 the	 camera	 is	 locked	 (no	 camera
movement).	Maya	will	happily	let	you	render	110	frames	of	something	that	isn’t	moving.	Take
an	 extra	 moment	 before	 you	 hit	 the	 render	 button	 to	 contemplate:	 do	 you	 need	 all	 110
images?	Normally	you	will	not	need	an	alpha	channel	on	a	background.

FIGURE	5.40	Rendering	held	background	element

Next	we’ll	render	the	cast	layer	much	as	we	have	done	previously.	The	reference	head	has
been	hidden.	It	is	a	good	idea	to	do	a	quick	test	render	of	one	frame	and	make	sure	that	the
alpha	channel	is	there.	You	might	find	that	you	haven’t	hidden	everything.	This	was	the	case
during	 the	making	of	 the	 following	 image.	The	background	wall	was	 the	 same	gray	as	 the
perspective	window,	so	we	thought	it	was	hidden	when	it	was	not.	Only	after	the	render	was
completed	did	we	notice	that	the	alpha	channel	was	a	pure	blank	rectangle	of	white.	A	quick
render	test	would	have	shown	that	was	the	case	and	caused	the	animator	to	investigate	more
and	discover	that	the	wall	had	not	been	hidden.	Didn’t	we	just	say	that	students	were	to	heed
the	importance	of	test	renderings?	It	is	so	easy	to	click	that	render	button	without	thinking	to
check.	Remember!



FIGURE	5.41	Rendering	an	animated	cast	element	without	a	head

As	we	saw	in	Chapter	4,	the	head	has	already	been	drawn	in	Flash.	We	have	already	inked
and	painted	the	character	 in	Flash.	See	 the	additional	online	chapters	 for	more	about	 inking
and	painting	images.

To	have	a	 rendered	 frame	 for	every	 frame	 (which	can	be	easier	when	compositing	 if	 the
render	 time	 is	 not	 an	 issue),	 we	 will	 select	 all	 of	 the	 keyframes	 and	 right-click	 to	 select
Convert	to	Keyframes.

FIGURE	5.42	Prepping	2D	animation	to	export	for	final	composite

Once	this	is	done,	there	is	a	keyframe	for	every	frame	of	animation.
There	is	not	an	option	to	export	a	series	of	.tif	images	in	Flash.	Depending	on	the	software

that	you	are	using,	you	might	be	able	to	use	the	swf	file	itself.	If	that	format	does	not	work	for
your	compositing	software,	then	you	will	have	to	use	a	QuickTime	format.	Remember	to	use



animation	(no	compression)	export	settings.
To	export	a	swf	file,	there	are	not	many	file	settings	that	you	need	to	change.	We	turned	off

any	compression	settings.	 In	a	production	setting,	 I	would	 test	between	QuickTime	and	swf
files	to	see	if	there	was	any	loss	of	image	quality	before	proceeding.	We	tested	only	slightly
during	one	quarter’s	class	and	found	that	exporting	Quick-Time	out	of	Flash	created	a	slip	in
frame	rate!	Instead	of	exporting	out	at	24	frames	per	second,	it	was	exporting	at	24.9,	with	no
obvious	way	of	correcting	the	error.	The	slippage	showed	up	at	the	compositing	stage	when
we	were	running	a	frame	short	in	anything	that	came	out	of	Flash.	My	students	reported	that
they	were	using	the	animation	compression,	which	should	not	have	created	any	slippage,	yet
it	was	there.	We	chose	to	use	swf	instead.	Test.	Test.	Test!

You	can	use	any	compositing	software	 to	put	 these	 images	 together.	We’ll	use	both	After
Effects	 and	 Nuke	 so	 you	 can	 see	 the	 differences	 between	 the	 two	 types	 of	 compositing
systems:	time-line	and	node	based.

First	 we	 will	 use	 After	 Effects.	 Bring	 your	 elements	 (bg,	 cast	 [1–110].tif,	 head.swf,
J_tones[1–110].tif)	into	After	Effects	by	dragging	and	dropping	them	or	importing	them.	You
can	find	the	elements	 in	the	companion	data	TonesNShadows	>	Shot.	 In	newer	versions	of
After	Effects,	you	can	drag	and	drop	 the	 folder	of	 .tif	 images	and	 it	will	bring	 in	 the	whole
sequence.	 See	 Figure	 5.43	 for	 an	 example	 of	 elements	 brought	 into	 After	 Effects.	 In	 this
example	we	used	a	swf	file	for	the	head.

FIGURE	5.43	Animation	elements	brought	into	After	Effects



If	you	have	a	group	of	individual	images,	then	you	will	need	to	create	a	composite	for	each
element	 layer.	 In	our	example,	 that	 is	 the	cast	element	and	also	 the	 tone	matte.	To	create	a
composite:

1.	 Select	the	cast	images	1–110.
2.	 Drag	them	to	the	composition	icon.
3.	 Make	sure	the	settings	are	for	a	duration	of	one	and	that	the	sequence	layers	option

is	turned	on.
4.	 Repeat	steps	1–3	for	the	tone	element.

FIGURE	5.44	Creating	a	precomp	of	the	cast	element.	Each	.tif	is	treated	individually	as	in	older	versions	of	AE

You	will	only	need	to	do	those	three	steps	if	you	are	in	an	older	version	of	After	Effects	or
the	 images	 are	 being	 treated	 individually	 due	 to	 importing	 issues.	 If	 your	 images	 were
brought	in	as	a	sequence	(if	you	drag-and-dropped	the	folder)	they	should	already	be	in	24	fps
and	show	up	on	one	timeline.	You’ll	see	in	Figure	5.45	that	the	composition	is	indeed	made	at
24	frames	per	second.



FIGURE	5.45	Tif	image	sequence	of	the	cast	and	tone	are	treated	like	a	video	clip	if	you	drag-and-dropped	the	folder	of

images	into	AE

Now	we	 will	 affect	 the	 body	 with	 the	 3D	 tone	 that	 we	 created.	We	 will	 use	 the	 same
method	from	Chapter	3.	We	will	use	 the	 tone	matte	 to	adjust	 the	color	of	 the	head	and	the
cast	levels:

1.	 Create	another	composition,	and	drag	in	the	head	and	cast.	Label	this	head_cast.
2.	 Right-click	 in	 the	 timeline	 and	 add	 a	New	 >	Adjustment	 Layer	 above	 the	 head

level.
3.	 Drag	in	the	tone	composition	and	place	it	above	the	adjustment	layer.
4.	 Select	 the	Adjustment	Layer	and	 from	 the	 top	menu	click	Layer	>	Track	Matte	>

Luma	Inverted	Matte.
5.	 Right-click	 the	 Adjustment	 Layer	 and	 add	EFFECT	 >	 Color	 Correction	 >	 Color

Balance	(HLS).
6.	 Bring	lightness	down	to	the	desired	level.

You’ll	note	 the	 red	arrows	point	out	 the	 errors	 that	 can	 result	 from	 this	method.	The	2D
animation	 did	 not	 exactly	 follow	 the	 3D	head	 that	was	 used	 to	 generate	 the	 shadows.	 The
tones	can	still	be	used.	A	separate	cleanup	pass	will	need	to	happen	to	extend	the	mattes	to
better	match	the	2D	animation.	If	your	team	has	many	junior	effects	artists,	or	in	our	case	new
sophomore	students	helping	out	on	a	group	project,	using	3D	tones	can	help	the	artists	have
something	to	go	by	and	help	with	quality	control.	If	your	2D	animation	matches	very	well	to



your	3D	animation,	then	your	tones	will	match	correctly.	This	process	can	even	go	the	other
way.	 You	 could	 animate	 in	 2D,	 then	 roto	 match	 a	 3D	 stand-in	 just	 to	 cast	 tones	 on.	 Do
whatever	helps	you	to	attain	the	shot.

FIGURE	5.46	Adding	the	tone	element	in	After	Effects	(steps	1–6	listed	later)

Just	one	way	of	fixing	the	tone	mattes	is	to	bring	them	into	Photoshop	or	any	paint	package
and	 to	 simplify	 them	 there.	Remember,	do	not	hand-blur	 the	edges.	 If	you	hand-blur	edges
across	multiple	frames,	they	will	not	animate	very	well	and	they	will	cause	boiling	in	the	final
composite.	It	is	better	to	have	a	hard-edged	matte	and	blur	it	in	the	compositing	package	than
to	try	to	hand-blur	each	image.	In	Figure	5.47	the	matte	has	been	simplified.	All	of	the	areas
around	the	eye	facing	the	light	have	been	removed,	as	well	as	some	shadowing	on	the	jawline.
Note:	you	are	seeing	the	RGB	layer	of	the	matte.



FIGURE	5.47	Simplifying	the	tone	matte	in	a	paint	package

Shadows

We’ll	use	the	same	technique	of	creating	a	3D	shadow	in	Maya	and	compositing	it	in	After
Effects.

To	create	a	shadow	matte	in	your	3D	package,	you’ll	need	to	be	able	to	render	a	shadow
pass.	 In	 Maya	 2008	 or	 earlier	 versions,	 you	 can	 use	 render	 passes.	 In	 Maya	 2009	 +,	 the
company	changed	how	you	create	render	passes.	We’ll	show	both	methods.	The	concepts	are
the	same;	only	the	buttons	are	different.

We’ll	continue	using	our	Jaguar	McGuire	shot.	The	first	step	is	to	set	up	a	light	that	will	be
used	 to	 cast	 the	 shadow.	This	does	not	necessarily	have	 to	be	 exactly	 the	 same	as	 the	 light
used	in	the	main	render.	Remember,	your	goal	is	to	create	a	shadow	that	ties	the	2D	and	3D
elements	together.	In	this	shot	we	have	a	3D	head	that	will	cast	the	shadow	for	the	2D	head
layer.

FIGURE	5.48	Spotlight	added	to	the	room	to	cast	a	shadow

Before	kicking	off	a	full	render,	it	would	be	prudent	to	do	a	few	test	renders	just	to	make
sure	the	shadows	are	going	to	be	to	your	liking.	For	instance,	in	our	shot	the	character’s	right
ear	was	not	used	in	the	2D	animation,	so	it	needs	to	be	hidden.	Of	course,	you	won’t	see	that
in	 the	 following	 image	because	 the	 author	 did	not	 follow	her	 own	advice	 and	kicked	off	 a
render	without	checking,	resulting	in	the	need	to	re-render	the	images.	I	break	things	for	you.



You	are	welcome.

FIGURE	5.49	View	of	character	though	the	camera

To	create	a	shadow	layer,	you	should	isolate	only	the	objects	that	are	casting	or	receiving
the	 shadow	as	well	 as	 the	 light	 that	 is	 casting	 the	 shadows.	 Figures	5.50	 and	 5.51	 show	 the
room	before	a	render	layer	is	created.	Create	a	layer	by	selecting	Render	(layer)	>	Layers	>
Create	Layer	from	Selected.	Remember	that	when	a	render	layer	is	selected,	as	you	see	in
Figure	5.51,	only	those	objects	are	visible.

FIGURE	5.50	Creating	a	render	layer



FIGURE	5.51	Render	layer	shows	only	what	is	in	the	layer

Before	 you	 go	 on,	 is	 your	 light	 set	 to	 cast	 shadows?	Make	 sure	 the	 light	 that	 you	 have
included	in	your	render	layer	is	indeed	casting	shadows.	(Not	that	the	author	has	ever	made
that	mistake	before.	What	gave	you	that	idea?)

FIGURE	5.52	Spotlight	is	set	to	cast	depth	map	shadows

Creating	a	Shadow	Pass	in	Maya	before	Version	2009

To	 create	 a	 shadow	 render	 pass,	 right-click	 on	 the	 render	 layer	 and	 select	 Preset	 >
Shadow.	You	will	see	that	the	render	layer’s	second	button	turns	red	(Figure	5.53).	This	render
layer	does	not	include	parts	of	Jaguar	McGuire,	in	order	to	simplify	the	cast	shadow.



FIGURE	5.53	Render	layer	shadow	pass	created	in	older	versions	of	Maya

Render	as	normal.	For	a	shadow	pass	 the	render	 is	not	creating	an	RGB	image;	 it	 is	only
creating	an	alpha	channel.	This	is	different	than	what	we	have	done	before	where	we	actually
used	the	RGB	created	by	the	toon	shader	as	a	matte.	This	 time	we	are	using	a	true	shadow
matte.	It	can	be	slightly	disconcerting	the	first	time	an	artist	opens	the	shadow	matte	and	sees
nothing	in	the	RGB	channels.	Do	not	panic.	Look	in	the	alpha	channel.



FIGURE	5.54	Alpha	channel	of	a	shadow	pass

Creating	a	Shadow	Pass	in	Maya	2009	or	Newer

A	few	features	were	added	in	Maya	2009	to	add	more	functionality	to	render	passes.	At	first
testing,	I	couldn’t	figure	it	out	without	finally	giving	in	and	reading	the	documentation.	I	used
what	was	there	to	figure	out	how	it	really	worked.	Here’s	a	quickie	overview	of	using	render
passes	in	Maya	2009+.

The	previous	steps	will	work	if	you	have	Mental	Ray	selected	as	your	renderer.	You	must
select	Mental	Ray	as	your	renderer	in	order	for	the	list	of	passes	to	show	up.	I	was	unable	to
include	a	screen	grab	of	the	passes:	there	are	plenty	of	them	to	choose	from.

1.	 Select	your	object	and	in	the	Render	Pass	window	choose	Render	(layer)	>	Layers	>
Create	Layer	from	Selected,	as	we	did	previously.

2.	 Choose	Mental	Ray	as	your	renderer	in	the	Render	Settings	window.
3.	 Right-click	 on	 the	 render	 layer	 and	 click	Add	New	 Render	 Pass.	 Select	 Shadow

render	pass	from	the	large	list	presented.
4.	 If	 you	 look	 at	 the	 Passes	 tab	 in	 the	Render	 Settings	 window,	 you	 will	 see	 your

render	layer	listed	there.
5.	 Render	as	normal	and	wonder	where	your	render	layer	is.
6.	 In	 the	render	window,	select	File	>	Load	Render	Pass.	This	will	 open	your	 render



layer.	Remember,	 this	 is	an	alpha	channel,	 so	display	 the	alpha	channel	 to	 see	your
success.

Read	 the	documentation	 for	more	 information,	 including	movies	 on	how	 to	use	 the	new
implementation	of	render	passes.

FIGURE	5.55	Render	layers	in	Maya	versions	2009	or	newer

Compositing

We’ll	bring	the	shadows	into	our	After	Effects	composite.	Here	is	a	different	way	to	bring	in
images.	For	these	shadows,	we’ll	bring	all	of	them	in	as	one	piece	of	footage.	(The	rendered
shadow	and	other	assets	can	be	found	in	the	companion	data.)

1.	 Click	File	>	Import	>	File.
2.	 Select	the	first	image	in	the	shadow	sequence.
3.	 Make	 sure	 that	 Tiff	 Sequence	 is	 checked	 and	 Interpret	 as	 Footage	 is	 selected.	 (In

newer	versions	of	After	Effects,	you	can’t	adjust	the	footage	setting.)	Click	OK.
4.	 This	will	bring	all	of	the	images	in	as	a	footage	clip.	You	can	see	them	listed	as	one

piece	of	footage	in	the	project	tab.

Once	 the	 footage	 has	 been	 brought	 into	 After	 Effects,	 you	 can	 drag	 the	 shadow	 layer



between	the	head	and	the	bg	(background)	layers.	See	Figure	5.56	for	an	example.	It	doesn’t
matter	if	the	shadow	is	bigger	than	you	need	because	the	character	will	cover	it.	However,	if
there	 are	 any	 gaps	where	 the	 shadow	 does	 not	 quite	meet	 the	 character,	 you	will	 need	 to
extend	 the	 shadow	 in	 Photoshop	 or	 a	 painting	 package.	 In	 the	 image	 on	 the	 companion
website,	 the	 shadow	 area	 (the	 white	 area	 of	 the	 alpha	 channel)	 has	 been	 extended	 and
simplified.

FIGURE	5.56	A	shadow	image	placed	between	the	character	and	the	background

Depending	on	your	art	direction,	you	could	simply	adjust	the	opacity	of	the	shadow	layer
and	call	this	shot	finished.	However,	just	adding	a	black	shadow	does	not	give	you	a	rich	color
palette.	Instead,	we	will	use	the	same	method	that	we	used	previously	for	the	tone	to	use	the
shadow	as	a	matte	to	adjust	the	color	of	the	background	image(s):

1.	 Right-click	 in	 the	 timeline	 and	 add	 a	 New	 >	 Adjustment	 Layer	 above	 the
background	level.

2.	 Drag	the	shadow	layer	above	the	Adjustment	Layer.
3.	 Because	this	is	truly	an	alpha	channel	that	we	are	using,	select	the	Adjustment	Layer

and	from	the	top	menu	click	Layer	>	Track	Matte	>	Alpha	Matte.
4.	 Right-click	on	the	Adjustment	Layer	and	add	EFFECT	>	Color	Correction	>	Color

Balance	(HLS),	Brightness	and	Contrast	or	whatever	color	correction	method	you
desire.

5.	 Adjust	the	color	correction	settings	until	you	receive	the	correct	shadow	level.



FIGURE	5.57	Final	composite	in	After	Effects

3D	Tones	in	Nuke

To	carry	on	our	tradition	of	using	multiple	types	of	software	to	achieve	the	same	look,	let’s
take	a	look	at	how	to	achieve	this	composite	in	a	node-based	compositor.	We’ll	use	Nuke.	As
we	have	pointed	out,	node-based	compositors	are	somewhat	similar.	You’ll	be	able	to	apply
the	same	ideas	to	the	software	of	your	choice.

1.	Locate	the	Read	button	 in	 the	 Image	 tab	and	 load	 in	 the	assets.	 (Hot	key	R.)	 In	 this
example,	the	following	image	sequences	were	loaded:

a.	bg.tif Maya	Render
b.	shadow[1–81].tif Maya	Shadow	Pass
c.	J_tone[1–81].tif Maya	Two	Tone	Shader	(RGB)
d.	cast[1–81].tif Maya	Render
e.	head.mov Flash	swf	converted	to	mov	(Animation	settings)

You’ll	note	that	the	head.swf	file	we	used	in	After	Effects	does	not	read	into	Nuke.	Therefore,
the	 raw	movie	 file	or	an	 image	 sequence	needs	 to	be	used.	 In	Figure	5.58	 the	 images	were
loaded	and	show	up	in	the	node	view	tab.



FIGURE	5.58	Shot	assets	loaded	using	multiple	File	In	nodes

2.	First	we’ll	composite	the	head	overtop	of	the	cast.	Select	the	head,	then	the	cast,	and
select	the	Merge	>	Merge	icon	(Hot	key	M.)	It	should	automatically	plug	the	head	as	A
and	the	cast	as	B.	(A	over	B).

FIGURE	5.59	Compositing	the	head	over	the	cast

3.	Select	the	Merge1(over)	node	and	add	a	Color	>	Grade	node.	(Hot	key	G.)	This	will
automatically	hook	the	output	of	the	head/cast	merge	into	the	color	tool.	This	will	give
an	overall	color	correction	to	the	head/cast	merge.	Adjust	the	white-point	number	to



see	it	working.
4.	To	limit	the	composite	to	only	the	tone	area,	hook	the	mask	output	(found	on	the	right

of	the	Grade1	node)	to	the	Tones	node.	You’ll	know	if	you	have	the	correct	output—it
says	“mask.”	Can’t	miss	it.

5.	You’ll	note	in	Figure	5.60	that	the	tone	matte	is	working	but	it	 is	giving	the	opposite
effect.	Anyone	know	why?	Look	back	at	the	hint	located	in	the	listing	of	assets	(step
1).	Do	you	see	it?	The	tone	is	in	RGB,	which	means	its	alpha	is	actually	the	opposite	of
what	we	want	to	use.	Mattes	use	the	alpha	channel.

FIGURE	5.60	Tone	matte	used	to	brighten	the	head/cast.	This	tone	was	created	in	RGB.	The	alpha	is	what	the	matte

input	uses

6.	To	correct	the	issue,	double-click	on	the	Grade1	node	in	the	node	view	tab.	This	will
load	the	preview	image	into	the	preview	tab	(if	it	wasn’t	already	there)	and	load	the
adjustable	parameters	into	the	parameter	tab.

7.	 Locate	 the	Mask	 option.	 Click	 on	 the	 invert	 check	 box	 to	 turn	 it	 on.	 It	 will	 turn
orange.	As	you	can	see	 in	Figure	5.61,	 the	area	 that	 is	being	darkened	 is	 the	correct
area.



FIGURE	5.61	Inverting	the	tone	mask

8.	If	you	want	to	add	a	blur	(or	anything	else)	to	adjust	the	matte,	you	can	add	that	to	the
node	network	between	the	tone	and	the	Grade1	node.	In	Figure	5.62	you	can	see	the
addition	of	a	Blur	node.

FIGURE	5.62	Blur	node	added	to	the	matte	before	the	Grade1	node

9.	Continuing	to	the	background	area	of	this	composite,	select	the	background	node	and
add	another	Grade	node.	(Found	in	the	Color	tab,	hot	key	G.).	Hook	the	right	side	of
the	Grade2	node	 to	 the	bottom	of	 the	Shadow	node.	This	will	use	 the	 shadow	as	a



matte.	Because	the	shadow	pass	was	rendered	out	as	an	alpha	channel,	it	will	work	as
intended	 without	 any	 additional	 button	 clicks	 (Figure	 5.63).	 Adjust	 the	whitepoint
value	to	taste.

FIGURE	5.63	Shadow	matte	used	to	darken	the	background	image

10.	The	last	step	is	to	put	the	two	parts	together.	Select	Grade1	node	and	Grade2	node.
Add	 a	Merge	 >	Merge	 node	 (Hot	 key	M.).	 The	 output	 of	 this	 merge	 node,	 called
Merge2	(over),	should	automatically	connect	to	the	Viewer	node.	(Figure	5.64).

11.	To	export	your	 final	movie	 file,	you	add	a	Write	node	 to	 the	 last	node	 in	 the	 tree.
Actually	you	can	put	a	Write	node	anywhere	if	needed.	Select	the	Merge2	node.	In	the
Image	tab,	click	on	the	Write	node.

12.	In	the	Write	node’s	parameters,	add	the	path	and	file	name	of	your	final	output	(for
example,	JM_shot6_Final.mov).

13.	To	kick	off	the	final	render,	make	sure	that	the	Write	node	is	selected	(it	should	be
orange)	and	click	Render	>	Render	Selected	…



FIGURE	5.64	Final	Composite	Tree	in	Nuke

2D	Tones	and	Shadows

When	drawing	tones	in	2D,	the	artist	has	to	calculate	where	the	light	is	hitting	the	character
or	object	and	draw	this	2D	matte.	It	 is	essential	that	these	mattes	flow	along	the	character’s
surface	and	react	to	the	volumes	of	the	character	as	it	moves	in	the	light.	When	drawing	the
shadows,	 the	 artist	 draws	 a	 stylized	 representation	 of	 where	 the	 shadow	 falls	 on	 the
background.	 The	 mattes	 should	 not	 pop	 or	 wobble	 and	 draw	 attention	 to	 themselves;
however,	the	mattes	are	usually	blurred,	so	some	wobbles	will	be	minimized.

Shadows	and	tones	do	not	have	to	be	exact	representations	of	what	they	should	physically
be.	If	they	were,	they	would	become	too	distracting,	which	can	be	the	case	with	3D	tones	and
shadows.	The	mattes	should	be	simplified	ideas	of	the	shadowed	areas.

Figure	5.65	shows	a	coffee	cup	standing	in	the	light.	The	light	direction	has	been	drawn	in.
You	 can	 see	where	 the	 light	 rays	have	been	 extended	 through	 the	 coffee	 cup	 and	onto	 the
ground	plane.	This	is	the	shadow	area.	Where	the	light	hits	the	cup	creating	self-shadow	areas,
this	is	what	is	called	tones.	The	tones	follow	the	volume	of	the	cup.	Of	course,	this	is	a	simple
object.	If	your	character	has	lots	of	dangling	hair,	eyeglasses,	and	so	on,	the	tones	and	shadows
could	 be	 extravagant.	 When	 creating	 2D	 tones	 and	 shadows,	 you	 have	 the	 option	 of
simplifying	these	elements	so	that	they	do	not	detract	from	the	main	animation.



FIGURE	5.65	3D	coffee	cup	showing	tones	and	shadows

To	draw	2D	 tones	and	 shadows,	you	can	use	any	method	we	have	covered	 so	 far	 in	 this
book:	paper,	Photoshop,	Toon	Boom,	Corel,	and	the	like.	Paper	would	be	the	most	difficult	to
keep	registered	because	you	would	have	to	go	through	a	printing	process.	Figure	5.66	shows
four	 levels	 of	 images	 broken	 apart	 so	 you	 can	 see	 what	 each	 looks	 like.	 The	 cup	 and
background	level	are	3D	renders.	The	tone	and	shadow	are	drawn	in	Photoshop.



FIGURE	5.66	3D	cup	and	background	render	and	2D	tone	and	shadow	drawing

You	can	follow	the	same	processes	we	used	before	to	composite	the	2D	tone	and	shadows
into	your	scene.	A	tip	to	keep	in	mind	when	creating	tones	and	shadows,	especially	with	2D,	is
that	generally	tones	and	shadows	are	blurred.	2D	tones	and	shadows	tend	to	be	blurred	more
to	help	make	 them	 feel	 softer,	much	 like	you	would	get	with	 a	 3D	 tone	or	 shadow.	 If	 you
over-blur	 the	mattes,	 they	will	 pull	 away	 from	 the	 character	 (or	 coffee	 cup),	 as	 you	 see	 in
Figure	5.67.	When	drawing	2D	mattes,	 it	 is	best	 to	overdraw	them	so	 that	 they	overlap	 the
edges.	In	other	words,	draw	outside	the	lines.	Because	we	are	using	them	as	mattes	on	top	of
the	 character	 and	 tracking	 them	 as	 luma	 or	 alpha	 mattes,	 they	 will	 not	 be	 seen.	 So
overdrawing	the	mattes	will	not	cause	any	harm.

FIGURE	5.67	Overdraw	mattes	to	keep	them	from	pulling	away	from	the	edges	when	blurred	during	compositing

Further	Reading

Gilland,	 Joseph.	Elemental	Magic:	The	Art	of	Special	Effects	Animation.	Boston:	 Focal	Press,
2009.
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Camera

Flat,	Limited,	and	Deep	Space

FIGURE	6.1	Example	of	f lat	to	deep	space	by	John-Michael	Kirkconnell,	2009,	2D/3D	compositing	class,	SCAD

Lecture	Notes



You,	 dear	 reader/student,	 now	 have	 examined	 working	 with	 2D	 and	 3D	 art.	 When
combining	animation	media,	the	artist	must	create	a	world	that	houses	these	media.	The	next
topic	to	explore	is	how	to	look	at	the	world	where	these	images	come	together.

The	most	common	method	(not	that	we	are	saying	it	is	the	best)	is	to	put	everything	into	a
3D	world.	Surely	 this	has	been	the	case	as	3D	objects	and	environments	have	crept	 into	2D
animated	films.	In	fact,	the	history	of	animation	has	seen	a	steady	progression	from	the	use	of
flat,	to	the	use	of	limited,	to	the	use	of	deep	space	environments.	Mostly,	in	2D	animation	we
were	accustomed	to	flat-space	camera	work	until	the	multiplane	camera	was	invented	and	we
began	 to	 see	 limited	and	even	 the	beginnings	of	deep	space	usage.	Then	a	mismatch	of	 the
space	usages	began.	We	would	find	ourselves	watching	a	flat-space	film	with	some	usage	of
limited	space;	a	2D	character	would	be	happily	 telling	his	story	while	moving	 left	and	right
across	the	screen	and	sometimes	coming	toward	the	camera	for	added	depth;	and	then,	wham,
we	would	come	across	a	scene	where	the	camera	was	suddenly	liberated	and	moving	through
a	3D	environment	that	possibly	had	a	few	2D	characters	in	it.	Those	who	respond	to	titillation
would	exclaim,	“Wow!”	Those	who	respond	to	the	story,	would	retort,	“Oh,	Boy!	That	was	a
failure.”	Why?	We	made	the	audience	say,	“Wow,	look	at	the	shiny	thing,”	 instead	of	feeling
the	story	point	more.

An	example	of	such	an	incident	came	about	when	I	was	still	in	college	at	Ringling	School	of
Art	 and	 Design	 (now	 Ringling	 College	 of	 Art	 and	 Design).	 At	 the	 time,	 the	 head	 of	 the
training	department	at	Walt	Disney	Feature	Animation’s	Florida	studio	would	visit	the	college
every	year	looking	for	the	next	round	of	internship	candidates	for	Disney	feature	animation.
During	 the	 visits,	 Frank,	 the	 Disney	 representative,	 would	 treat	 us	 by	 giving	 a	 sneak
prescreening	of	that	year’s	animated	film.	At	that	time,	it	was	a	great	treat	in	the	lost	end	of
Florida	 to	 see	movies	before	 they	were	 released.	 Students	nowadays	 can	barely	understand
how	special	this	was,	given	their	current	ready	access	to	bootleg	videos.	(Oh,	and	if	you	think
you	can	enjoy	a	movie	on	your	iPhone,	please	skip	this	chapter.	It	is	not	for	you.)	Frank,	who
is	a	 lovely,	energetic	man,	screened	a	number	of	 films	during	my	stay	at	Ringling.	One	was
Beauty	and	the	Beast.	I	was	studying	computer	animation	at	the	time,	so	I	was	very	tuned	in
to	any	use	of	3D,	as	we	all	were.	In	the	center	of	the	film,	of	course,	there	is	the	great	ballroom
dance	 scene	where	 the	 characters	walk	 into	 a	 ballroom	 and	 the	 camera	 follows	 them.	 The
camera	then	swoops	up	and	around	the	ceiling	of	the	ballroom,	revealing	all	to	be	in	glorious
3D	and	textured,	and	then	it	comes	back	down	to	swoop	around	the	dancing	2D	characters.

Many	of	us	were	stunned.	What	a	lovely	example	of	3D	usage.	Wasn’t	that	beautiful?	Did
you	see	that?	They	were	really	pushing	the	envelope.	We	all	marveled	together.

It	wasn’t	until	years	later,	when	I	worked	at	Disney	and	was	more	educated	on	the	process
and	 art	 of	 animation,	 that	 I	 realized	 some	 considered	 the	 scene	 a	miserable	 failure.	 In	 one
swoop,	it	took	the	audience	out	of	the	moment	and	showed	off	the	technology.

The	 point	 to	 take	 away	 from	 this	 is	 that	 we	 shouldn’t	 show	 off	 our	 technology,	 our



pipelines.	There	should	be	reasons	 for	everything	we	do,	 including	the	world	we	create	and
how	we	move	our	camera	about.	It	shouldn’t	take	the	audience	away	from	the	story—which	is
why	we	started	this	book	with	the	question,	“How	do	you	know	if	it	is	successful?”

FIGURE	6.2	Bull’s-eye	to	keep	us	focused	on	why	we	set	up	shots

We	 have	 come	 full	 circle,	 then.	 (I’m	 sure	 there	 is	 a	 pun	 there.)	 In	 Chapter	 1’s	 online
companion	data	of	this	book,	we	discussed	Bruce	Block	and	the	outer	ring	of	the	bull’s-eye:
visual	storytelling	components.	If	you	haven’t	read	that	extra	chapter	or	are	not	familiar	with
Bruce	Block,	please	go	reference	that	online	chapter	now:	“Storybeats	and	Bull’s-eyes.”	Block,
in	his	teachings,	reminds	us	to	tie	the	intensity	of	our	visuals	tightly	with	our	story.	We	know
this;	 it	 is	 usually	 something	we	 do	 instinctively.	 However,	 you	might	 have	 noticed	 in	 your
research	that	there	is	a	fine	line	between	adding	visual	intensity	to	a	film	when	the	story	needs
it	 and	adding	visual	 intensity	 to	a	 film	at	 every	 chance.	The	problem	with	 the	 latter	 is	 that
ungoverned	 intensity	will	 become	 numbing	 and	 ultimately	 lower	 all	 intensity.	 If	 you	 have
ever	seen	a	visual	effects	film	where	one	unit	shot	all	of	the	exposition	and	talking	heads	and
another	unit	executed	all	of	the	whiz-bang	fight	sequences,	you	might	have	felt	this	problem



profusely.	 It	might	 have	 felt	 like	 this:	 talking	 heads	 =	 flat,	 flat,	 flat;	 fighting	 =	wow,	wow,
wow.	But	possibly	the	fighting	was	over-wowed	with	each	shot	so	that	by	the	end	you	were
thinking	to	yourself,	“Is	it	over	yet?”	So	to	help	us	govern	our	usage	of	visual	intensity,	Block
gave	us	the	tool	of	charting	the	storybeats	to	the	visual	intensity.

FIGURE	6.3	Block’s	intensity	chart

Block’s	book	covers	all	of	 the	actors	 that	can	be	used	 to	display	visual	 intensity.	You	will
want	 to	 read	 and	 understand	 his	 text.	We	 cannot	 cover	 all	 the	ways	 to	 apply	 the	 different
actors	 in	 this	 book.	We	 have	 room	 only	 to	 discuss	 the	 actor	 called	 space.	We	will	 only	 be
looking	at	 the	placement	and	movement	of	 the	 characters	and	cameras	 in	 this	 chapter.	You
will	 have	 to	 pursue	 the	 other	 subcomponents	 of	 space	 in	 your	 supplemental	 readings	 of
Block’s	book.

It	 has	 been	 rumored	 throughout	 the	 student	 body	 that	 any	 student	who	 takes	 a	 class	 of
mine	 should	not	move	 the	 camera.	 Students	give	 each	other	 the	advice	 to	 always	have	 the
camera	locked	down.	They	explain,	“Professor	O	hates	camera	moves.”	On	the	contrary,	I	love
them.	Yet	they	must	be	well	done	and	have	a	reason.

When	trying	to	understand	where	cameras	should	go	and	why,	I	found	myself	on	a	journey
of	 exploration	 into	 many	 ideas,	 methods,	 glossary	 terms,	 and	 ideologies.	 Many
cinematography	books	explained	how	certain	camera	positions	would	make	the	audience	feel.



However,	I	found	that	some	of	the	books	were	talking	about	single	shots	and	not	looking	at
the	 whole	 film	 and	 how	 the	 shots	 related	 to	 one	 another.	 If	 you	 want	 to	 gain	 a	 holistic
understanding	 of	 using	 the	 camera,	 I	 would	 suggest	 a	 reading	 list	 that	 includes	 the	 best
cinematography	book	you	can	find,	along	with	Bruce	Block’s	book,	plus	a	concise	book	about
camera	mechanics,	 and	 something	 on	 the	 placement	 and	movement	 of	 camera	 blocking.	 I
suggest	the	following:

1.	 Cinematography:	Image	Making	for	Cinematographers,	Directors,	and	Videographers
by	Blain	Brown,	for	better	appreciating	why	shots	are	set	up	the	way	they	are.

2.	 The	Visual	Story	by	Bruce	Block,	for	learning	more	about	how	to	focus	on	the	whole
structure	of	the	film	as	it	relates	to	the	story.

3.	 The	 Bare	 Bones	 Camera	 Course	 for	 Film	 and	 Video	 by	 Tom	 Schroeppel,	 for
understanding	what	a	camera	actually	is.

4.	 Hollywood	Camera	Work,	which	is	an	amazing	resource	of	tutorials	and	includes	an
exhaustive	set	of	tutorials	on	where	to	put	the	camera	and	how	to	actually	move	it.
See	the	companion	data	and	the	website	(www.hollywoodcamerawork.us)	 for	more
information.

Of	course,	reading	books	such	as	these	helps	to	float	glossary	terms,	rules,	things	to	avoid,
things	to	remember,	and	the	like	in	your	head	during	the	creation	process.	However,	you	then
need	to	have	hands-on	time	in	order	to	put	these	ideas	into	practice	and	develop	them	into	a
reality	and	not	just	an	abstract	idea.	So	before	we	continue	on	to	techniques	and	methods	that
are	being	taught	away	from	the	larger	context	of	a	full	story,	please	remember	to	utilize	the
Intensity	Chart	from	Figure	6.3	and	heed	Block’s	teachings	when	you	apply	these	methods	to
your	story.	Do	not	simply	apply	tutorial	knowledge	to	your	films	without	understanding	the
whole	of	it.	I	mean	it,	or	I’ll	have	to	start	lecturing	to	you	on	the	neuroscience	of	it	all.	Don’t
make	me	do	it.

Dig	Deeper

If	you	wish	to	understand	how	the	audience’s	brain	is	working	as	viewers	watch	your	film
and	how	to	use	that	information	to	your	advantage	when	trying	to	elicit	emotional	responses
out	 of	 the	 audience,	 read	 Synaptic	 Self:	 How	 Our	 Brains	 Become	 Who	 We	 Are	 by	 Joseph
LeDoux	and	view	the	numerous	videos	out	there	that	focus	on	this	topic,	even	those	shown	on
YouTube.

http://www.hollywoodcamerawork.us


Space	and	Camera	Moves

Four	types	of	spaces	can	be	created	in	your	film’s	world.

1.	 Flat	space
2.	 Limited	space
3.	 Deep	space
4.	 Ambiguous	space

We	create	 these	worlds	and	control	 them	by	our	placement	and	movement	of	 characters
and	cameras	in	relationship	to	one	another.	The	following	is	a	brief	overview	of	a	few	of	the
subcomponents	of	space.	Of	course,	refer	to	Bruce	Block’s	book	for	a	complete	understanding.

Any	 of	 these	 spaces	 can	 be	 created	 in	 any	medium.	 However,	 some	media	 traditionally
have	lent	themselves	to	certain	special	relationships.

Flat	Space

Character	placement.	On	the	same	vertical	plane,	similar	size,	move	parallel	to	the	camera.
Camera	movement.	Parallel	to	the	characters,	pan,	tilt,	zoom.
Parallax	between	levels.	None.

The	 visible	 symptoms	 or	 subcomponents	 of	 a	 flat-space	 shot	 can	 be	 seen	 in	 how	 the
characters	 are	 placed	 and	move,	 how	 the	 camera	moves,	 and	 how	 little	 parallax	 is	 shown
between	 the	 elements.	 Basically,	 all	 depth	 cues	 are	 removed	 from	 a	 flat-space	 scene.
Characters	can	be	placed	on	the	same	vertical	plane	and	be	shown	at	similar	sizes.	If	there	are
big	and	small	characters,	their	size	difference	can	be	minimized	by	seating	them	or	showing
close-ups	 of	 the	 characters	 and	 not	 showing	 them	 standing	 next	 to	 one	 another.	 If	 the
characters	move	at	all,	 they	should	move	 in	 front	of	 the	camera	and	never	 toward	 it.	 If	 the
camera	moves,	 it	 should	move	 parallel	 with	 the	 characters	 so	 that	 they	 stay	 a	 similar	 size
throughout	the	shot.

Think	about	Charlie	Brown	 for	a	moment,	as	he	walks	down	 the	 sidewalk	 into	 the	 front
door	of	his	house,	out	the	back	door	of	his	house,	and	approaches	the	doghouse	upon	which
Snoopy	sleeps.	If	you	have	seen	the	comics	or	the	television	cartoon	shows,	you	have	seen	an
example	of	absolute	flat	space.	The	characters,	in	addition,	are	all	just	about	the	same	size	just
to	add	to	the	flatness.	It	is	the	style	of	Peanuts.	This	style	is	allowed	to	be	broken	mostly	when
Snoopy	fights	the	Red	Baron.	Okay,	that’s	an	old	reference.	Let’s	look	at	something	that	is	in



the	same	realm	but	more	modern:	Calvin	and	Hobbes.	Yes,	that	series	probably	never	will	be
animated,	yet	a	similar	idea	can	be	found	in	those	comic	strips.

In	 fact,	 2D	 animation	 is	 easiest	 when	 created	 in	 a	 flat	 space.	 It	 is	 the	 perspective	 and
parallax	 of	movements	 that	make	 it	more	 difficult	 to	 draw.	On	 the	 other	 hand,	 it	 is	more
challenging,	yet	 rewarding,	 to	make	3D	worlds	 into	 flat	 space.	This	 can	be	done	by	paying
careful	attention	to	the	placement	of	characters	and	the	movement	of	the	camera	as	well	as
applying	a	mindful	usage	of	tonal	separation	and	textural	diffusion.	(You	know	where	to	go	to
read	more	about	that.)

Camera	movements	 for	a	 flat	 space	 shot	are	pans,	 tilts,	 and	zooms.	Basically,	 the	camera
does	not	move.	This	keeps	the	parallax	of	elements	down	to	a	minimum.	This	is	an	easy	space
to	achieve	by	locking	the	camera	and	characters	in	one	position	or,	if	they	move,	moving	them
together.	If	it	is	so	easy,	why	is	it	not	done	in	3D	very	often?	Because	it	is	also	just	as	easy	to
fly	 that	 camera	 around	 for	 no	 reason	 whatsoever.	 Remember,	 you	must	 have	 a	 reason	 to
move	the	camera	and	a	visual	rule	to	describe	why	you	are	choosing	to	pan	instead	of	track,
or	zoom	instead	of	dolly.

Pan

To	pan	a	camera	is	to	stand	in	one	place	and	basically	pivot	the	camera	on	its	stand	from
one	side	to	the	other,	usually	to	follow	a	character.	As	Figure	6.4	illustrates,	when	you	pan	the
foreground	elements	and	background	elements,	move	across	the	screen	at	the	same	rate.	How
far	 apart	 are	 the	 foreground	 and	 background	 levels?	You	 do	 not	 know,	 because	 the	 special
clues	have	been	 removed.	Note	 in	Figure	6.4	 that	 the	 distance	 between	 the	 branch	 and	 the
boy’s	head	never	changes.

FIGURE	6.4	Camera	pan

Tilt

Tilt	 is	 similar	 to	pan	 in	 that	 the	camera	 is	held	still	and	pivots	on	 its	 stand.	For	a	 tilt,	 the



camera	tilts	up	or	down	to	follow	an	object.	Usually	something	motivates	the	camera	to	move.
That	topic	is	beyond	the	context	of	this	book;	pity.	Tilting,	like	panning,	moves	foreground	and
background	elements	up	and	down	the	screen	at	the	same	rate.	Note	in	Figure	6.5,	as	was	the
case	in	Figure	6.4,	that	the	distance	between	the	branch	and	the	boy’s	head	never	changes.

FIGURE	6.5	Camera	tilt

Zoom

The	act	of	zooming	is	done	by	a	push	of	a	button	or	a	twist	of	a	 lens	to	change	the	focal
distance.	 (In	Maya,	 this	 is	 the	 focal	 length.)	This	action	 scales	all	 characters,	 foreground	and
background,	at	the	same	rate.

FIGURE	6.6	Camera	zoom

If	you	aren’t	quite	sure	about	what	a	3D	world	would	be	like	in	flat	space,	think	about	your
grandfather	 holding	 the	 video	 camera.	 Not	 all	 grandfathers,	 but	many,	 do	 not	move	much
when	they	hold	the	video	camera.	They	stand	in	one	place	watching	the	soccer	game.	They
pan	the	camera	from	left	to	right	across	the	field,	tilt	the	camera	up	to	watch	the	ball	as	it	flies
into	the	air,	and	use	the	zoom	to	gain	a	closer	look	at	their	prize	grandson	playing	defense.	As
long	as	the	soccer	players	run	across	the	field	and	do	not	run	toward	the	grandfather,	you	have
an	example	of	flat	space.

Before	 continuing,	 please	 note	 that	 flat	 space	 does	 not	mean	 that	 you	must	 use	 the	 2D
medium.	The	 same	space	can	be	created	 in	3D	or	 live	action.	Students	who	are	new	 to	 the
concept	of	defining	space	sometimes	confuse	medium	with	spatial	relationships.



In	 the	 hands-on	 section,	we	will	 take	 a	 3D	world	 and	 compress	 it	 to	 create	 a	 flat-space
scene	 that	has	been	 inspired	by	 the	Coen	brothers	being	 inspired	by	Busby	Berkeley	 in	The
Big	Lebowski.

Limited	Space

The	following	is	a	list	of	common	attributes	found	in	limited	space:

Character	placement.	On	distinctive	foreground,	midground,	background	planes
Camera	movement.	Track,	multiplane
Parallax	between	levels.	Parallel	parallax

The	visible	 symptoms	or	 subcomponents	 of	 limited	 space	 are	 seen	 in	how	 the	 characters
and	elements	are	placed	in	relationship	to	one	another	in	front	of	the	camera.	Their	placement
is	 typically	 in	 distinct	 levels	 that	 will	 show	 off	 the	 distance	 between	 them	 as	 seen	 by	 the
camera.	 You	 can	 think	 of	 these	 levels	 as	 a	 foreground,	midground,	 and	 background.	 There
may	be	more	 levels	 than	 this	 in	actuality,	but	 they	are	 still	usually	grouped	psychologically
into	 a	 foreground,	 midground,	 and	 background	 area.	 Character	 movements	 usually	 stay
within	their	given	level	with	limited	interaction	back	and	forth	around	other	elements	in	their
level.	In	the	purest	version	of	limited	space,	there	is	no	Z-depth	movement	of	the	characters	or
elements.	 The	 camera	 does	 not	 move	 toward	 the	 characters	 and	 elements,	 nor	 should	 the
characters	and	elements	come	toward	the	camera.	They	are	locked	into	their	horizontal	level.
Perspective	is	generally	still	squashed	as	much	as	possible	and	vanishing	points	are	hidden	in
this	linear-space	world.

Camera	movement	in	a	limited-space	world	is	tracking	the	camera	from	side	to	side	to	give
the	 depth	 cue	 of	 parallax	 between	 the	 levels.	 An	 example	 that	 you	 can	 look	 up	 on
watchthetitles.com	 is	 Teeth	 of	 the	 Night.	 These	 titles	 use	 limited	 space	 and	 multiplanes
throughout	the	sequence.

Track

To	track	is	to	pick	the	camera	up	and	move	it	horizontally	in	front	of	the	levels	or,	inversely,
to	pick	up	the	levels	of	artwork	and	move	them	underneath	the	camera,	depending	on	how
you	are	compositing	your	shot.	The	object	is	to	show	off	the	parallax	of	movement	between
the	characters.	To	do	that	you	must	understand	the	next	concept:	multiplane.	In	Figure	6.7	the
camera	 is	 moved	 left	 in	 front	 of	 the	 characters.	 The	 characters	 that	 are	 farther	 from	 the

http://watchthetitles.com


camera	move	across	the	screen	at	a	different	rate	than	the	character	closer	to	the	camera.

FIGURE	6.7	Track	shot

Multiplane

Multiplane	is	not	really	a	camera	move—it	 is	 the	name	of	a	camera	designed	in	the	early
1930s	and	perfected	by	the	Walt	Disney	Studio.	Now	the	term	is	used	as	a	verb,	meaning	to	set
artwork	 up	 in	 such	 a	 way	 as	 to	 show	 the	 parallax	 between	 levels.	 This	 was	 originally
accomplished	by	using	 the	multiplane	camera,	which	allowed	artists	 to	stack	up	glass	plates
and	move	them	at	varying	speeds	to	simulate	parallax	of	movement	from	left	to	right	under
the	 camera.	 The	main	 idea	 is	 that	 the	 artwork	 is	 set	 up	 at	 different	 depths	 away	 from	 the
camera	and	all	of	 the	elements	move	at	varying	ratios	 in	 relation	 to	one	another	 to	display
parallax.



FIGURE	6.8	Multiplanes	in	a	3D	space

You	are	probably	most	schooled	in	limited-space	setups.	This	is	the	traditional	setup	for	2D
animation.	 Foreground	 elements,	 background	 elements,	 and	 characters	 are	 set	 up	 into	 their
individual	planes.	To	break	away	from	the	flat	space	that	comes	with	basic	animation	setups,
tools	 such	 as	multiplane	 cameras	were	 created	 to	 help	move	 the	 planes	 in	 relation	 to	 one
another,	 causing	 parallax	 between	 levels.	 This	 was	 the	 case	 with	 many	 of	 the	 2D	 feature
animation	films.	Remember	that	just	because	something	is	in	3D	does	not	mean	that	it	has	to
be	in	deep	space.	You	can	set	up	a	limited-space	shot	in	3D	and	live	action	as	well.	Think	of	a
theater	stage	and	the	different	fly	areas	in	that	stage.	 (If	you’ve	ever	 looked	at	the	different
levels	of	curtains	on	a	larger	stage	and	seen	that	they	hide,	you	have	seen	the	fly	areas.)	Early
musicals	and	early	films	were	vaudeville	plays	that	had	a	camera	set	down	in	the	audience’s
seat.	Those	films	were	most	commonly	in	 limited	space.	This	can	still	be	seen	in	the	theater
today.	Why	use	it	in	3D?	As	Block	has	suggested,	it	is	a	good	way	to	emphasize	the	emotional
center	of	your	film.	If	you	keep	your	characters	jailed	in	limited	space	and	then	finally	release
them	 into	 deep	 space	 at	 a	 strategic	 point,	 the	 emotional	 impact	will	 be	 all	 the	 greater.	 To
emphasize	 this	 point,	 I	 like	 to	 show	my	 students	 Chapter	 16	 from	Little	Miss	 Sunshine,	 in
which	the	brother	character,	who	has	been	held	in	limited	space	for	a	very	long	time,	learns	he
is	color-blind	and	finally	escapes	into	deep	space.	Check	it	out—it	is	very	powerful.

In	the	hands-on	section,	we	will	create	a	traditional	multiplane	scene	using	some	wonderful
imagery	from	a	SCAD	student’s	puppet	theater.	Because	you	are	not	in	my	classroom,	I	won’t
be	able	to	play	a	song	from	my	favorite	musical	to	inspire	you.	It’s	a	shame.	“Little	shop,	little
shop	of	horrors.”

Deep	Space

The	following	is	a	list	of	common	attributes	found	in	deep	space:

Character	placement.	Exaggerate	size	difference,	move	toward	the	camera
Camera	 movement.	 Truck,	 dolly,	 boom,	 and	 other	 free	 movements	 of	 the	 camera

(Steadicam,	wire	track,	helicopter,	etc.)
Parallax	between	levels.	Showing	perspective,	has	vanishing	point

Deep	 space	 is	 the	 most	 modern	 of	 world	 spaces.	 Most	 advances	 in	 camera	 usage	 have
pushed	 this	 specific	 type	 of	 space.	 Even	 in	 animation,	 it	wasn’t	 long	 before	 the	 jump	 from
multiplane	limited-space	scene	setups	became	deep	space,	just	by	moving	the	camera	toward
the	artwork	and	adding	Z-depth.	Compositing	software	packages	were	created	that	allowed



for	 these	multiplane-type	 shots	 to	 have	 unlimited	 numbers	 of	 layers	 and	 to	move	 beyond
parallel	parallax,	and	they	added	the	ability	for	the	camera	to	move	in	Z-depth	through	the
flat	levels	easily.	Z-depth	camera	moves	are	the	definition	of	deep	space,	obviously.

Characters	in	a	deep-space	shot	are	placed	to	exaggerate	the	size	difference,	and	dynamic
compositions	can	be	created.	They	are	free	to	move	toward	the	camera	and	the	camera	is	free
to	move	toward	them.	When	using	3D,	it	is	easier	to	create	deep	space	than	any	other	type	of
space.

An	example	that	you	can	look	up	on	watchthetitles.com	is	Gruesome	School	Trip.	Though
the	titles	are	2D	flat	planes,	deep	space	is	applied	to	them.

Track

For	deep	space,	the	camera	can	track,	or	move	from	left	to	right.	The	difference	between	a
track	in	limited	space	and	one	in	deep	space	is	the	exploitation	of	perspective.	Limited-space
shots	do	not	have	vanishing	points	or	use	three-point	perspective,	whereas	deep	space	shots
do.

Dolly/Truck

To	 dolly	 is	 to	 pick	 the	 camera	 up	 and	 move	 it	 toward	 the	 characters.	 As	 a	 result,	 the
characters	visibly	scale	at	different	rates.	The	opposite	of	this	is	a	zoom	(see	the	section	on	flat
space),	in	which	the	characters	scale	at	the	same	rate.	In	Figure	6.9	the	boy	character	scales	up
at	a	slightly	different	rate	than	the	background	elements.

FIGURE	6.9	Dolly	camera	move

Boom

A	 boom	 is	 an	 interesting	 camera	 move.	 The	 camera	 is	 physically	 moved	 up	 or	 down.
Sometimes	it	is	combined	with	a	pan	or	pivot,	where	the	camera	pivots	on	its	moving	stand	to
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continually	 face	 the	 character.	 This	 changes	 the	 perspective	 planes	 of	 the	 character,	 and	 all
characters	in	view	move	at	different	rates	(parallax).	In	Figure	6.10	the	boy	moves	out	of	the
frame	more	quickly	than	the	background	elements	do.

FIGURE	6.10	Boom	camera	move

Multiplane	with	Perspective

If	 you	 take	 the	 concept	 of	multiplane	 and	 add	 forced	 perspective	 onto	 the	 actual	 planes
themselves,	you	create	a	world	with	deeper	space.	This	is	a	method	that	has	been	explored	in
2D/3D	 animation.	 It	 is	 achieved	 by	 taking	 what	 would	 normally	 be	 limited	 space,	 with
different	 levels	 placed	 in	 Z-depth,	 then	 adding	 dimension	 to	 the	 planes	 to	 augment	 the
parallax	in	the	images	themselves	as	the	camera	moves	through	the	planes.	Some	might	think
this	 is	 a	 concept	novel	 to	animation;	however,	 similar	 concepts	have	been	used	 for	years	 in
theater	stage	design,	live-action	set	design,	and	stop-motion	stage	design.

This	 type	 of	 deep-space	multiplane	with	perspective	was	used	 throughout	Mulan,	 Lilo	&
Stitch,	Prince	of	Egypt,	and	many	other	films.	Many	“making-of”	specials	found	on	DVDs	will
show	you	how	these	shots	were	put	together.	You	will	have	to	use	your	well-developed	eye	to
sort	out	more	modern	examples	of	2D/3D	multiplane	with	perspective	usages,	because	most
of	 these	are	 found	 in	 short	 films.	Some	 filmmakers,	however,	are	kind	enough	 to	post	 their
making-of	videos	on	their	websites.	For	example,	take	a	look	at	the	fabulous	2D/3D	film	titled
Le	Building	and	its	making-of	video	at	www.le-building.com.

http://www.le-building.com


FIGURE	6.11	Multiplane	with	added	perspective,	by	Jennifer	Chandler,	2008,	2D/3D	compositing	course,	SCAD

Fly-Through	and	Helicopter

We’ll	briefly	discuss	other	types	of	camera	moves	that	exploit	the	world	in	all	axes.	There
are	many	ways	to	move	the	camera	freely	about	the	gravity-less	world	of	a	compositor	or	3D
Cartesian	set.	A	fly-through	is	one	way	of	exploring	the	set	and	is	generally	what	 it	sounds
like.	The	camera	flies	through	the	set,	revealing	parts	of	the	environment.	A	great	example	of
a	2D/3D	fly-through	is	in	the	vine	skateboarding	sequences	of	Tarzan.	Here,	the	fleet-footed
Tarzan	 leads	 the	 camera	 as	 he	 barefoot-skates	 through	 the	 vines	 of	 the	 jungle.	 The	 camera
moves	all	throughout	the	environment	as	this	2D	character	moves	through	the	3D	vines.

A	 helicopter	 shot	 is	 one	 where	 the	 camera	 revolves	 around	 the	 character	 in	 a	 circle,
sometimes	for	the	whole	360	degrees.	The	focal	point	of	the	camera’s	movement	remains	the
character	for	most	or	all	of	the	scene.	You	have	seen	this	shot	in	hundreds	of	films.	In	Brother
Bear,	for	instance,	there	is	a	sequence	where	Koda	and	Kenai	are	sitting	on	a	rock	bluff.	Kenai
is	about	to	break	the	news	to	Koda	about	the	true	reason	for	his	mother’s	demise.	The	camera
starts	 behind	 the	 bears	 and	wheels	 around	 them.	They	 are	 drawn	 in	 2D	 and	 placed	 onto	 a
background,	which	in	my	memory	is	a	3D	rock.	You	can	also	see	a	great	helicopter/360-degree
shot	of	the	horse	in	Dreamworks’	Spirit,	Stallion	of	the	Cimarron,	and	even	a	good	showing	of



the	3D/2D	in	the	making-of	feature	on	the	DVD.	That	example	is	absolutely	seamless.

FIGURE	6.12	A	360-degree	shot	or	helicopter	camera	move

Moving	a	camera	around	in	a	3D	world	is	easy	and	easily	abused.	In	this	chapter	we	will
learn	how	 to	 push	 a	 deep-space	 shot	 using	multiple	media	 and	 adding	 perspective	 to	what
would	traditionally	be	a	flat	plane.

Ambiguous	Space

The	following	is	a	list	of	common	attributes	found	in	ambiguous	space:

Character	 placement.	 Anything	 to	 make	 the	 subject	 unidentifiable	 or	 to	 unsettle	 the
audience

Camera	 movement.	 Anything	 to	 unsteady	 the	 audience:	 upside-down	 shots,	 reverse
relationship	to	character	movement

Parallax	between	levels.	Anything	to	create	a	space	that	is	off	kilter	or	indefinable

Ambiguous	 space	 is	 often	 used	 or	 abused	 in	 horror	 films.	 It	 is	 hard	 to	 give	 it	 any	 other
emotional	 center	 than	 that	 of	 confusing	 the	 audience,	 as	 it	 is	mainly	 defined	 as	 a	 space	 in
which	the	viewers	do	not	know	what	they	are	looking	at	or	where	they	are.	Maintain	a	scene
like	 this	 for	 too	 long,	and	 the	audience	will	 lose	 interest.	Use	 it	 sparingly,	and	you	 instantly
increase	the	visual	intensity.



There	 are	 varying	 degrees	 of	 ambiguous	 space,	 however.	We’ll	 put	 the	 zolly	 shot	 in	 the
category	 of	 ambiguous	 space,	 because	 it	 is	meant	 to	 be	 off-putting	 to	 the	 audience.	 It	 is	 a
camera	move	that	has	a	reverse	relationship	to	the	character’s	movement.	A	zolly	is	a	zoom
and	a	dolly	combined.	You	have	seen	it	used,	surely.	Pop	quiz	with	extra	credit	for	those	who
can	name	the	person	who	first	created	the	zolly	camera	move	and	what	famous	shot	was	it
used	for.	To	push	the	shot,	you	can	also	move	the	character	away	from	the	camera	at	the	same
time	the	camera	moves	in	and	zooms	in.	You’ll	note	in	Figure	6.13	that	the	boy	scales	toward
the	camera	while	the	background	elements	stay	relatively	the	same	size.

FIGURE	6.13	Zolly	example

All	 of	 the	 normal	 things	 to	watch	 out	 for	 exist	 here:	 style	matching,	 frame	 rate,	 timing,
image	sizes,	and	registration.	Remember	what	we	learned	in	Chapter	2	?	Show	contact	points
judiciously,	 focus	on	 those	 that	 further	your	emotional	 focus,	 and	hide	everything	else.	Feet
contact	points	are	usually	not	highly	emotional,	 just	gravity	at	work,	 so	 they	can	be	hidden
most	of	the	time	to	avoid	giving	away	any	bad	compositing.	If	your	characters	are	sitting	and
the	camera	move	is	a	helicopter	shot,	hide	the	point	where	they	are	seated	on	the	ground.	Put
a	bush	in	front	of	them,	another	rock,	something.	That	type	of	contact	point	between	2D	and
3D	 is	 one	 of	 the	 hardest	 to	 keep	 from	 giving	 itself	 away.	 Again,	 where	 buttock	 contacts
ground	is	not	highly	emotional,	 just	weight.	Save	the	stress	of	getting	contact	points	perfect
for	 the	 moments	 that	 support	 the	 emotional	 center	 of	 your	 shot.	 Now,	 if	 the	 buttock
contacting	the	ground	is	amazingly	intricate	to	the	story	being	told,	because	the	character’s	life
was	just	saved	by	a	wedged	rock	and	the	camera	moves	around	in	a	sweeping	arc	to	show	the
gravity	of	the	situation,	then	yes,	show	that	contact	point.

Hands-On	Examples

Four	 examples	 will	 be	 used:	 example	 art	 will	 be	 used	 to	 walk	 you	 through	 using
compositing	packages	to	create	a	flat	space,	limited-space	shot,	deep-space	shot,	and	a	forced-
perspective	shot.



Flat	space.	In	the	hands-on	section,	we	will	take	a	3D	world	and	compress	it	to	create	a
flat-space	scene	that	has	been	inspired	by	the	Coen	brothers	being	inspired	by	Busby
Berkeley	in	The	Big	Lebowski.

Limited	space.	In	the	hands-on	section,	we	will	create	a	traditional	multiplane	scene	using
some	wonderful	imagery	from	a	SCAD	student’s	puppet	theater.

Deep	space.	We	will	take	a	look	in	this	chapter	at	how	to	push	a	deep-space	shot	using
multiple	media	and	adding	perspective	to	what	would	traditionally	be	a	flat	plane.

Occasionally,	 students	 in	my	 class	 confuse	 the	 idea	 of	medium	with	 camera	 space.	 They
think	that	flat	space	must	be	done	in	2D	and	deep	space	must	mean	3D.	Just	to	prove	the	point
that	it	is	camera	space	we	are	dealing	with	and	that	deep	space	can	be	created	with	2D	and
flat	space	can	be	created	with	3D,	we	will	do	just	that	in	our	hands-on	examples.

Flat	Space

The	 files	 for	 this	 hands-on	 project	 can	 be	 found	 in	 the	 companion	 data.	 The	 files	 are	 as
follows:

Maya_Files/FlatSpace_HatPinLadies.mb
Maya	file	with	animated	objects
Maya_Files/2	psd	textures
Image_Sequence/pinGirls.[1–80].tga

If	you	open	the	FlatSpace_HatPinLadies.mb	 file	 in	Maya,	you	will	see	that	two	cameras
are	set	up	for	the	scene.	The	persp	camera	is	set	up	for	the	flat-space	shot.	The	persp1	camera
is	set	up	for	a	deeper-space	shot.	Let’s	look	at	what	makes	this	scene	flat	space.



FIGURE	6.14	A	f lat-space	shot

The	 points	 to	 remember	 when	 creating	 a	 flat-space	 shot	 can	 be	 broken	 down	 into	 the
following	elements:

1.	 Camera:	placement,	lens,	and	movement
2.	 Lighting
3.	 Texture

In	this	project,	you	will	note	that	the	camera	has	been	placed	looking	down	directly	at	the
characters.	 There	 are	 no	 perspective	 lines,	 and	 horizon	 lines	 are	 hidden	 or	minimized.	 The
camera	 lens	 is	 an	 important	 aspect	 when	 planning	 a	 flat-space	 shot.	 In	 Maya,	 the	 focal
distance	is	what	you	would	adjust	to	get	a	narrow	or	wider	lens.	A	telephoto	lens	is	simulated
by	 having	 a	 large	 focal	 distance.	 A	 wide-angle	 lens	 is	 simulated	 by	 having	 a	 small	 focal
distance.	You	have	probably	learned	something	about	cameras	and	know	that	a	wider-angle
lens	exaggerates	your	perspective	and	basically	creates	a	deeper	space	in	your	shot,	whereas	a
telephoto	lens	compresses	space	and	minimizes	the	perspective	shift	in	your	shot.

In	 Figure	 6.15	 the	 original	 persp	 camera	 is	 looking	 down	 at	 the	 characters.	 The	 focal
distance	 is	 a	 very	 large	 197.	 In	 Figure	 6.16	 the	 second	 camera	 in	 the	 scene,	 persp1,	 is	 in	 a
similar	 position,	 looking	 down	 at	 the	 characters,	 but	 this	 camera	 has	 a	 focal	 distance	 of	 an
incredibly	 small	 9.	 You	 can	 see	 the	 difference	 in	 the	 exaggerated	 perspective	 lines	 of	 the



characters.

FIGURE	6.15	Camera	with	focal	length	of	197



FIGURE	6.16	Camera	with	focal	length	of	9

To	make	the	shot	as	flat	as	possible,	lighting	should	be	used	to	limit	the	tonal	range	seen.	In
other	words,	you	do	not	want	a	high	level	of	contrast	in	the	lighting.	You	do	not	want	tones
and	shadows,	or,	 if	 they	are	present,	 they	should	be	close	 in	tonal	range.	 I	once	saw	a	great
example	of	a	 live-action	 set	 that	 looked	 like	a	 Japanese	pen-and-ink	 illustration	except	 that
there	was	a	live	model	standing	amidst	the	stylized	set.	The	final	image	looked	completely	flat
and	lovely:	a	young	woman	in	a	kimono	stood	framed	in	pen-and-ink	(at	least	in	my	memory
they	were	pen-and-ink)	cherry	blossom	trees	and	flowering	bushes.	However,	a	picture	taken
from	the	side	of	 the	set	 showed	exactly	what	was	going	on	 to	accomplish	 this	amazing	 flat
image:	 the	 stage	 was	 tilted	 toward	 the	 camera,	 and	 there	 was	 indeed	 depth	 in	 the	 shot.
However,	there	were	dozens	of	lights	positioned	all	around	the	stage	to	illuminate	everything
and	absolutely	abolish	 shadows.	The	 result	was	a	 lovely	 flattened	space.	That	model	had	 to
have	been	extremely	hot	under	all	of	those	lights.

The	same	is	true	in	your	digital	3D	space.	You	will	need	to	light	to	get	rid	of	shadows	and
flatten	 the	 image	 out.	Welcome	your	 friend	 the	 ambient	 light.	 I	 know,	 I	 know.	 Students	 of
mine	have	just	raised	their	hands	to	state,	“But	you	said	never	to	use	ambient	lights.”	Yes,	this
is	true.	“But	you	said	they	just	washed	out	the	scene.”	Yes,	I	admit	it.	But	this	is	precisely	what
we	want	for	this	type	of	shot.	We	want	to	wash	out	all	darkness.	We	have	ultimate	control	and
do	not	get	 shadows	unless	we	ask	 for	 them;	 try	doing	 that	on	a	 live-action	 set.	Yet	we	still



need	to	make	sure	that	the	darker	areas	on	an	object’s	materials	are	minimized.	Ambient	light
will	help	with	this.

FIGURE	6.17	Ambient	light	added	to	the	scene	to	f latten	out	the	lighting

For	the	material	and	texture	aspect	of	flattening	your	scene,	the	first	idea	is	that	the	levels
of	texture	detail	should	be	the	same	throughout	the	image.	If	textures	lose	detail	as	they	fade
in	the	distance,	this	is	a	depth	cue	and	starts	to	deepen	the	space.	You	might	become	annoyed
with	any	darkness	in	the	material	color.	If	you	are	not	using	toon	shading	(which	we	realize
does	not	react	to	light	and	flattens	the	3D	character),	you	can	adjust	the	ambient	color	in	the
material.	Let’s	do	this	together:

1.	 Open	the	Maya	file	from	the	companion	data:	FlatSpace_HatPinLadies.mb.
2.	 Open	 the	Hypershade	 window	 either	 by	 clicking	 the	 button	 on	 the	 toolbar	 or	 by

going	to	Window	>	Rendering	Editors	>	Hypershade.
3.	 Locate	 the	 PinMaterial.	 Middle-mouse-drag	 it	 into	 the	 Work	 Area	 tab	 of	 the

Hypershade.	 With	 that	 node	 selected,	 click	 the	 Input	 and	 Output	 Connections
button.	 This	will	 display	 the	 textures	 that	 are	 connected	 to	 the	material	 node.	 You
will	 see	 that	 a	Photoshop	 file	 is	 being	 read	 into	 for	 the	 specular	 channel	 and	 color
channel.



FIGURE	6.18	Seeing	the	input	connections	to	the	material	node

4.	 In	 the	 fold-down	 tab	 menus	 on	 the	 left	 of	 the	 Hypershade	 window,	 locate	 the
Utilities	 fold-down	 tab.	Click	 the	Blend	Colors	node.	This	will	 add	a	blend	colors
node	to	your	hypershade	work	area.



FIGURE	6.19	Adding	a	blend	colors	node

We	want	to	add	the	color	texture	to	the	ambient	channel.	However,	if	we	add	it	straight	in,
it	will	completely	wash	out	any	3D	shading.	That	might	not	be	what	you	want.	Let’s	look	at
that	possibility	first	before	we	continue	with	how	we’ll	do	it	in	this	tutorial.

An	easy	way	to	hook	up	the	texture	directly	to	the	ambient	channel	is	to	double-click	on
the	PinMaterial	node.	This	should	open	the	Attribute	Editor	for	the	PinMaterial.

Then	 middle-mouse-drag	 the	 color	 texture	 on	 top	 of	 the	 Ambient	 color	 chip	 in	 the
Attribute	 Editor.	 You	 will	 see	 the	 connection	 is	 automatically	 made	 in	 the	 Hypershade
window’s	work	area.	Figure	6.20	presents	an	example	of	 this	connection.	The	 images	at	 the
top	 of	 the	 figure	 show	 what	 the	 material	 looked	 like	 before	 the	 addition	 of	 the	 ambient
texture	and	afterward.	You	can	see	that	the	shading	is	completely	flat,	maybe	too	flat	for	our
needs.



FIGURE	6.20	Adding	the	color	texture	directly	to	the	ambient	color

Instead	we	will	carry	on	with	our	method.	What	we	want	to	do	is	use	the	same	color	as	the
texture	but	knock	it	back	a	bit.	In	step	4	we	created	a	blend	colors	node.	We’ll	use	it	now.

5.	Click	the	Blend	Colors	node	so	that	it	opens	in	the	Attribute	Editor.	Middle-mouse-
drag	the	Color	texture	to	the	Blend	Colors	node’s	Color	1	color	chip.

6.	Add	a	gray	color	to	the	Blend	Colors	node’s	Color	2	color	chip.

FIGURE	6.21	Adding	color	texture	to	the	Blend	Colors	node

7.	Click	on	 the	PinMaterial	 so	 that	 it	 appears	 in	 the	Attribute	Editor.	Middle-mouse-
drag	 the	Blend	Colors	node	 to	 the	Ambient	 color	 chip	 in	 the	Attribute	Editor.	The
connection	will	update	in	the	Hypershade’s	Work	Area	tab.	The	image	preview	of	the
Attribute	Editor	shows	a	small	amount	of	shading	but	not	a	lot.



FIGURE	6.22	Connecting	the	Blend	Shape	node	to	the	ambient	color

8.	 Click	 on	 the	Blend	Colors	 node	 and	 adjust	 the	Blender	 attribute	 in	 the	 Attribute
Editor.	A	value	 of	 0	will	 give	 an	 ambient	 color	 of	 gray	 (or	whatever	Color	 2	 is).	A
value	of	1	will	give	the	texture	as	the	ambient	color.	Anything	in	between	is	a	mixture
of	the	two.

Figure	 6.23	 presents	 four	 material	 previews.	 The	 one	 in	 the	 top	 left	 is	 the	 original
anisotropic	material	 that	we	 started	with.	The	one	 in	 the	 top	 right	 is	with	 the	color	 texture
used	directly	as	 the	ambient	color;	 it	gave	a	completely	 flat	 look.	The	bottom	chips	use	 the
Blend	Colors	 node	 to	 blend	 between	 the	 color	 texture	 and	 a	 gray	 color.	 This	 allows	 some
shading	but	still	keeps	the	render	looking	flat.



FIGURE	6.23	Materials	with	and	without	ambient	color

The	final	project	for	this	tutorial	is	saved	in	a	file	named	FlatSpace_HatPinLadies_v2.mb.
In	this	file,	a	similar	Blend	Colors	node	technique	has	been	applied	to	the	ladies	as	well.



FIGURE	6.24	Flat	space	scene	with	f lat	lighting

Limited	Space

Limited	space	is	what	you	experience	in	theater	and	in	2D	animation.	Most	equate	this	type
of	 space	with	multiplane	 setups,	where	 the	 background	moves	 at	 a	 different	 rate	 from	 the
middle	 ground,	 which	 moves	 at	 a	 different	 rate	 than	 the	 foreground.	 The	 levels	 can	 have
parallax	of	movement,	but	to	maintain	limited	space	and	not	become	deep	space,	there	should
be	no	movement	toward	the	camera.

The	points	to	remember	when	creating	a	limited-space	shot	can	be	broken	down	into	the
following	elements:

Artwork	placement	in	relation	to	the	camera
Movement	of	the	artwork	parallel	to	the	camera
Movement	of	the	camera	parallel	to	the	artwork



The	files	for	these	hands-on	projects	can	be	found	in	the	companion	data.	The	files	are	as
follows:

FIGURE	6.25	The	main	under-the-sea	levels

FIGURE	6.26	Character	one	by	Yossaya	Aisiri,	2008,	SCAD



FIGURE	6.27	Character	two	by	Yossaya	Aisiri,	2008,	SCAD

FIGURE	6.28	Character	three	by	Yossaya	Aisiri,	2008,	SCAD



FIGURE	6.29	Character	four	by	Yossaya	Aisiri,	2008,	SCAD

FIGURE	6.30	Character	five	by	Yossaya	Aisiri,	2008,	SCAD

We	will	use	the	3D	camera	in	After	Effects	to	set	up	the	artwork	into	varying	depths,	then
we	will	move	 the	 camera	 to	 show	 parallax	 between	 the	 levels:	 a	 basic	multiplane	 camera
move.	You	can	accomplish	this	move	in	software	that	does	not	have	multiplaning	capabilities
by	moving	the	artwork	at	different	rates.	We	will	also	recreate	this	shot	in	Flash	to	show	that
technique.	Once	you	see	the	two	most	common	methods	for	accomplishing	this	type	of	shot,
you	 should	be	 able	 to	 re-create	 it	 in	 any	 software.	Oh,	we’ll	 go	 ahead	 and	 try	our	hand	at
Toon	Boom	too,	while	we’re	in	the	neighborhood.



Using	a	Compositing	System’s	3D	Camera

Nuke,	After	Effects,	 Toon	Boom,	 Smoke,	 and	many	proprietary	 software	 packages	 that	 I
have	worked	on	have	implemented	some	type	of	3D	camera	that	figures	out	the	depth	of	the
artwork	in	relationship	to	the	camera	when	either	is	moved.	Most	of	the	systems	I	have	seen
have	been	 extremely	 similar.	The	only	difference	 in	 the	 proprietary	 software	 packages	 that
does	 not	 show	 up	 in	 off-the-shelf	 software	 is	 the	 capability	 to	 set	 the	 artwork	 scale
relationship	so	that	when	a	piece	of	artwork	is	moved	back	in	depth,	it	automatically	scales	to
visibly	 stay	 in	 the	 same	 scale	 relationship	 to	 the	other	drawings.	 I’ll	 bet	we	 could	 come	up
with	an	After	Effects	expression	to	do	that.	Extra	credit,	anyone?

Our	first	example	uses	a	normal	3D	camera	for	multiplane	setups	in	After	Effects.	In	version
CS3	of	After	Effects	or	later,	you	are	able	to	bring	in	Photoshop	files	and	maintain	the	layers.
This	is	an	extremely	useful	feature.	Of	course,	if	your	production	pipeline	needs	.tif	files	or	tga,
you	can	still	use	those	individually.	Using	a	psd	file	allows	us	to	create	the	levels	in	Photoshop,
see	 the	relationship	of	 the	 layers	 in	 their	composition,	and	save	 them	all	 in	one	 file	 for	safe
transportation.	It	is	up	to	you	what	your	pipeline	needs.	For	this	example,	our	Photoshop	file	is
a	static	image.	There	is	no	animation	in	these	files.

As	an	aside,	this	is	only	one	method	for	working	on	projects	that	use	both	After	Effects	and
Photoshop,	 and	 as	 you	have	 noticed,	 this	 text	 is	 not	 the	 end-all/be-all	 text	 on	 how	 to	 click
every	 single	 button	 in	 these	 software	 packages.	 After	 Effects,	 Smoke,	 Nuke,	 Photoshop,
Illustrator,	Flash,	Corel	Draw,	Toon	Boom,	and	any	other	packages	we	might	have	touched	on
are	 huge	 software	 packages.	With	 hope,	 this	 text	 has	 been	 a	 great	 “getting	 your	 toes	wet”
opportunity,	and	you	will	be	fearless	in	picking	up	some	great	texts	that	explore	the	packages
in	depth.	There	are	even	some	great	concepts	in	the	help	documentation,	and	if	you	read	the
documentation	you	will	note	 that	Adobe	has	some	wonderful	online	video	tutorials	as	well.
How’s	that	for	information	when	you	need	it?	For	example,	here	is	a	great	video	to	watch	for
more	 information	 on	 using	 Photoshop	 and	 After	 Effects	 together:
www.adobe.com/go/vid0252.	 This	 link	 can	 be	 found	 in	 the	 help	 documentation	 along	with
many	others.

http://www.adobe.com/go/vid0252


FIGURE	6.31	Composition	that	was	automatically	created

Follow	these	steps	to	create	a	multiplane	shot	in	After	Effects:

1.	 Click	File	>	Import	File	(or	double-click	in	the	project	tab).
2.	 In	 the	 file	browser	window,	 select	 the	Photoshop	 file	sea_100dpi.psd,	 found	 in	 the

LimitedSpace	folder.
3.	 Select	 Import	 as:	 Composition	 (in	 older	 versions	 of	 After	 Effects,	 choose

Composition—Cropped	Layers.)	Leave	 the	default	 setting	of	Editable	Layer	Styles
on.

You	might	ask,	what	is	the	difference	between	the	different	“import	as”	options?
The	video	 link	mentioned	earlier	actually	explains	 it.	You	might	be	 familiar
with	 the	way	 footage	merges	 the	 layers	 together	 as	 one	 image	 or	 lets	 you
choose	which	layer	you	want	to	use.	We	want	to	use	all	of	the	layers,	so	our
choices	are	Composition	or	Composition	with	cropped	layers.	If	you	bring	in
the	Photoshop	 file	as	 composition,	 it	will	bring	 in	each	 layer	with	 the	 same
size	 as	 the	 document.	 The	 pivot	 point	 will	 be	 at	 the	 center	 of	 the	 whole
image.	If	you	bring	in	the	Photoshop	file	as	composition	with	cropped	layers—
you	guessed	it—the	layers	are	cropped	and	the	pivot	point	is	at	the	center	of
the	 layer	 itself.	All	 of	 the	 layers	 are	 still	 positioned	 as	 they	were	 originally
created,	only	their	cropped	size	and	pivot	point	are	different.

The	 layers	 are	 brought	 in	 and	 placed	 nicely	 in	 a	 folder,	 and	 a	 composition	 is



automatically	created.	That	saved	many	button	clicks,	didn’t	it?	Anything	that
saves	a	click	or	two	is	great!	Those	clicks	and	drags	add	up	to	precious	time
saved.

4.	 Double-click	on	the	composition	titled	sea_100dpi	to	see	the	layers	together.
5.	 To	help	 remember	what	 layer	 is	what,	 take	a	moment	 to	 rename	 the	 layers	 in	 the

composition.	Click	on	the	layer	so	that	it	highlights,	and	hit	Enter	on	the	keyboard
to	rename	the	layers.

6.	 To	place	these	layers	in	depth,	we	will	need	to	turn	on	the	3D	icon.	It	is	located	on	the
layer	itself	and	looks	like	a	cube.	Click	each	layer	on.

7.	 Right-click	 in	 the	 Composition	 tab	 and	 select	New	 >	Camera.	 For	 this	 hands-on
project,	we	will	use	the	default	camera.	Feel	free	to	experiment	on	your	own	for	the
chapter	assignment.	Click	OK	 in	the	camera	options	window.	You	will	notice	that	a
camera	 has	 been	 added	 to	 your	 composition.	 It	 doesn’t	 matter	 where	 it	 is	 in	 the
timeline.	I	prefer	to	have	the	camera	at	the	top	of	the	timeline	for	easy	access.

8.	 To	make	it	easier	to	see	what	your	camera	is	seeing	and	where	the	artwork	is	in	front
of	the	camera,	change	your	viewport	to	have	two	views.	Have	the	left	view	show	a
top	orthographic	view	by	clicking	once	in	the	left	port	and	making	it	the	active	port
(you	will	 see	yellow	triangles	at	each	corner).	Then	change	the	view	drop-down	to
top.	Have	the	right	view	show	what	the	camera	is	seeing	by	clicking	once	in	the	right
port,	making	 it	 the	active	port.	Then	change	 the	view	drop-down	to	be	Camera	 1.
See	Figure	6.32	for	an	example.



FIGURE	6.32	Setting	up	a	two-view	panel	with	top	and	Camera	1	views

You	can	 reposition	 the	 image	 in	 the	viewports	by	using	 the	space	bar	 and	 click	 (pan)	 or
zooming	in	and	out	with	the	mouse’s	middle	roller	ball	(should	you	have	one)	or	using	the	hot
key	z	(zoom	in)	alt	+	z	(zoom	out).

Next,	you	will	want	to	position	the	artwork	in	front	of	the	camera.
We	 have	 turned	 each	 layer	 into	 a	 3D	 layer.	 This	 has	 added	 another	 dimension	 to	 the

transform	attributes.	We	can	now	simply	move	them	back	in	Z-depth:

1.	 Select	each	layer,	and	locate	the	Position	attributes.	(You	can	show	just	the	position
attributes	with	the	hot	key	p.)	Start	by	moving	the	bg	layer	back	in	Z	away	from	the
camera.	You	can	drag	on	the	Z	attribute	with	your	mouse	button,	or	in	the	preview
window,	click	and	drag	on	the	Z	translate	manipulator.

You	will	 notice	 that	 the	background	 layer	 looks	 smaller	now	 that	 it	 is	moved
back	in	space.	Perhaps	on	the	website	we’ll	have	a	special	trick	on	how	to	put
in	 an	 expression	 to	hook	up	 scale	 to	 the	Z	position	 so	 that	 it	 automatically
scales.	For	now,	follow	this	step.

2.	 Scale	the	bg	layer	so	that	it	matches	visually	the	size	of	the	other	layers	when	viewed
through	Camera	1.	You	can	show	just	the	scaling	attributes	with	the	hot	key	s.	In	our
example,	 the	 bg	 image	 was	 moved	 back	 to	 about	 4000	 in	 Z,	 and	 the	 scale	 was
adjusted	to	200.

3.	 Repeat	for	the	next	layer.	The	reeds	layer,	for	example,	has	been	moved	in	Z	to	3500
and	scaled	to	190.	 In	the	companion	data,	you	can	see	an	image	in	which	the	reeds
layer	is	a	little	bit	in	front	of	the	background	layer	but	still	visibly	the	same	size	when
seen	 through	 the	 camera.	 You’ll	 note	 that	 the	 position	 and	 scale	 attributes	 are	 the
only	attributes	visible.	You	can	achieve	 this	 effect	by	using	 the	hot	key	p	 and	 then
holding	down	shift	and	then	the	hot	key	s	 to	show	the	position	attribute;	 then	add
the	scale	attribute.

4.	 Repeat	for	all	of	the	layers.	See	Figure	6.33	for	an	example.	You’ll	note	that	the	way
things	are	placed	 in	the	timeline	has	no	correlation	as	 to	what	 is	 in	front	or	behind
another	object	in	Z	position.	In	fact,	the	boat	and	TopWave	are	at	the	bottom	of	the
timeline	yet	closest	to	the	camera	in	Z.



FIGURE	6.33	All	levels	moved	in	Z.	The	boat	and	TopWave	are	the	closest	to	the	camera

5.	 Make	 sure	 that	 you	 are	 on	 the	 first	 frame	 of	 the	 timeline	 and	 adjust	 the	 camera’s
zoom	to	get	the	opening	view	of	the	underwater	stage.

After	all	of	that,	you	are	ready	to	set	two	keyframes	to	see	the	parallax	magic.	We’ll	move
the	camera	up	to	reveal	the	boat.	When	you	view	the	playback,	you	should	be	able	to	see	the
parallax	between	the	layers.	The	closer	the	layers	are	to	the	camera,	the	faster	they	will	move
across	 the	 screen.	 The	 farther	 away	 the	 backgrounds,	 the	more	 parallax	 (different	 rates	 of
movement)	you	will	have.

1.	 On	 frame	1,	 create	 a	keyframe	 for	 the	position	and	 the	point	 of	 interest	 for	 the
camera	by	clicking	on	the	stopwatch	icon.	If	you	only	set	a	keyframe	for	the	position,
the	 camera	will	move	 up	 but	 pivot	 down	 to	 continue	 to	 look	 at	 the	 center	 of	 the
images.

2.	 On	the	last	frame,	move	the	camera	position	and	point	of	interest	up	 in	Y	 so	 that
the	boat	is	visible.	A	keyframe	will	automatically	set.



FIGURE	6.34	Camera	with	keyframes	position	and	point	of	interest

Press	 play	 to	 play	 back	 a	 preview	 and	 notice	 the	 different	 rates	 of	 movement.	 Some
touchups	can	still	be	done.	You’ll	notice	that	the	background	layer	is	visible	when	you	don’t
want	 it	 to	 be.	 Do	 not	 be	 afraid	 to	 move	 the	 artwork	 to	 exaggerate	 the	 parallax	 and	 use
traveling	garbage	mattes	to	hide	unwanted	levels.

For	 the	 background	 and	 reed	 layers,	 we	will	 add	 a	mask	 to	 hide	 these	 levels	 when	 the
camera	moves	above	the	sea	level.	For	both	levels,	the	same	steps	will	go	as	follows:

1.	 Right-click	on	the	reed	or	bg	level	and	select	Mask	>	New	Mask.
2.	 Under	the	image	in	the	timeline	there	is	now	a	Mask	parameters	area.	Open	this	area,

change	the	setting	to	subtract,	and	click	on	the	stopwatch	icon	for	Mask	Path.	This
will	allow	us	to	animate	the	matte.

3.	 Make	 sure	you	have	 the	 selection	 tool	 active	 (or	use	 the	v	 hot	 key).	Go	 to	 frames
midway	through	the	camera	move	and	at	the	end.	It	might	be	best	to	start	at	the	end
and	work	 backward.	Adjust	 the	matte	 as	 needed	 to	 hide	 the	 reeds	 or	 background.
Keyframes	 will	 automatically	 be	 set.	 In	 Figure	 6.35	 three	 key-frames	 were	 set	 to
adjust	the	matte	during	the	camera	pan.

4.	 To	 further	 tweak	 the	 animation,	 you	 can	move/slide	 the	 image	 layers	 to	 get	more
parallax	or	a	better	composition.	In	Figure	6.36	a	few	keyframes	were	added	to	the
position	of	the	Front-Wave	and	TopWave	images.



FIGURE	6.35	Moving	the	mask	to	hide	the	reeds	and	background	levels	during	the	camera	movement

FIGURE	6.36	Keyframes	can	be	added	to	the	artwork	levels	themselves	to	increase	parallax	or	obtain	a	better	composition

Take	Note

You	 will	 note	 that	 the	 image	 size	 is	 very	 large.	 When	 exporting	 out	 movie	 files,	 it	 is
important	to	watch	your	file	size	so	that	you	maintain	a	good	playback	speed.	In	this	book	we
have	learned	that	the	compression	setting	animation	is	not	actually	a	compression	at	all.	It	is



all	of	the	frames	in	their	full	res	state	packed	into	one	movie	file.	You	will	not	receive	a	good
playback	rate	with	this.	As	an	example,	I	have	exported	a	movie	file	from	this	exercise.	You
will	 note	 that	with	 a	Sorenson	3	 compression,	 this	2400	 ×	2000	 pixel	movie	 is	 only	 3	MB.
There	 are	 other	 compression	 types.	 Sorenson	 is	 pretty	 old	 but	 serves	 me	 well	 for	 quick
compressions.	H.264	is	more	popular	now.

Multiplane	in	Flash

What	if	you	are	using	a	piece	of	software	that	does	not	have	a	3D	camera?	Well,	then	you
are	going	to	have	to	simulate	the	experience	the	old-fashioned	way:	by	moving	the	artwork
itself	at	different	ratios.	The	camera	itself	will	not	move,	because	there	is	no	camera	to	move.
Instead	we	will	move	the	artwork.	By	moving	the	artwork	at	different	rates,	we	can	establish
what	the	camera	is	focusing	on,	what	is	in	the	foreground	and	moves	faster	and	what	is	in	the
background	 and	moves	 slower.	 First,	 we’ll	 choose	 the	main	 100%	 level	 that	 stays	with	 the
camera.	Everything	else	either	moves	faster	than	that	level	or	slower.	For	example,	if	it	is	in
front	of	 the	 100%	 level,	 it	 can	move	150%	 faster,	 or	 if	 it	 is	 in	back	of	 the	main	 level,	 it	 can
move	80%	of	the	speed	of	the	main	level.

We	will	use	the	characters	and	some	of	the	images	we	have	already	used	in	our	hands-on
exercise.

Open	Flash	and	import	the	character	assets:

1.	 Click	File	>	Import	to	Library.	Select	sea01.psd;	click	on	open.
2.	 A	window	will	open	showing	each	layer	in	the	Photoshop	file.	The	character	layer	is

selected.	 That	 is	 correct.	 Click	OK.	 We	 do	 not	 need	 the	 composited	 layer	 of	 the
character	over	a	white	background.

3.	 This	will	create	a	folder	in	the	library	and	place	the	character	inside	of	it.
4.	 Do	the	same	for	the	other	characters	(sea02.psd—sea05.psd).	You	can	shift	select	all

of	 the	 character	 psd	 files	 and	 they	 will	 load	 in.	 Because	 they	 are	 unnamed	 in
Photoshop,	we	need	to	take	a	moment	and	name	them	appropriately	here.	Name	the
characters	and	organize	your	library.

5.	 Once	 again,	 click	 File	 >	 Import	 to	 Library	 and	 select	 the	 sea_100dpi.psd	 image.
We’ll	only	use	layers	2,	4,	5,	6,	and	7.	You	can	bring	them	all	in	to	experiment	with.

6.	 Once	the	layers	are	imported	to	the	stage,	organize	them	as	necessary.



FIGURE	6.37	Organized	library	with	all	assets	loaded

To	animate	these	assets,	we	will	have	to	turn	each	item	into	a	symbol.	While	we	are	doing
this,	we	will	go	ahead	and	load	them	into	layers	and	scale	them—they	are	huge	images:

1.	 Rename	the	first	level	in	the	Flash	timeline	to	bg.
2.	 Drag	the	blue	square	background	into	frame	1	of	that	layer.	It	will	fill	the	screen.
3.	 With	the	bg	selected,	click	Modify	>	Convert	to	Symbol	or	use	the	hot	key	F8.
4.	 Name	this	symbol,	and	make	sure	it	is	a	graphic.
5.	 Using	the	Free	Transform	Tool	(hot	key	Q),	scale	the	background	to	be	much	longer

than	the	Flash	canvas	is.	In	our	animation	we	could	move	it	slightly	and	need	room	to
pan	it	under	the	camera.	Please	view	the	companion	data	to	see	an	example.	In	our
example,	 the	background	 is	 shown	at	 the	 top	of	 the	 image,	and	at	 the	bottom	 it	 is
shown	in	wire	frame	so	that	you	can	see	its	size	in	relationship	to	the	canvas.

6.	 Repeat	these	steps	to	add	a	reed	level,	a	character,	and	a	wave.	See	Figure	6.38	for	an
example.



FIGURE	6.38	Symbols	added	to	their	own	layer	and	scaled	into	place

You	might	 find	 it	 useful	 to	 lock	 layers	when	you	 are	not	working	 on	 them—anything	 to
help	avoid	putting	the	symbols	on	the	wrong	layers.	It	is	very	important	that	each	symbol	be
on	its	own	layer.	We	are	going	to	add	motion	tweens	to	these.	If	you	have	worked	with	Flash
before,	you	may	know	that	you	can	only	have	one	pivot	point	per	motion	tween;	each	symbol
or	group	of	symbols	has	one	pivot	point.	If	you	have	any	more	than	that,	the	motion	tween
will	not	work.

Instead	of	pulling	out	the	mathematical	formula,	we	are	going	to	move	these	items	using
those	pivot	points	to	help	us.	First	we’ll	start	with	the	100%	layer,	because	this	layer	will	be	the
basis	by	which	all	of	the	other	layers	will	move.	Although	it	is	tempting	to	do	this	via	action
script	(I’ll	leave	that	explanation	to	those	who	are	bent	that	way	to	figure	out),	we’ll	do	it	by
hand:

1.	 Select	the	character	and	on	frame	1	place	the	character	on	the	right-hand	side	of	the
screen.

2.	 In	 the	 timeline,	 right-click	on	 the	keyframe	and	select	Create	Motion	Tween.	This
holds	 the	 exposure	 of	 the	 keyframe	 for	 a	 second	 on	 the	 timeline	 and	 moves	 the
current	time	to	the	end	of	that	exposure.



3.	 Move	the	character	to	the	left-hand	side	of	the	screen.	You’ll	see	a	line	extend	from
the	first	position	to	the	second	position	of	the	character.	In	the	timeline,	you	can	click
and	drag	the	last	frame	to	end	at	a	later	frame,	if	desired.

FIGURE	6.39	Characters’	animation	keyframes	set

Flash	(CS6	and	newer)	shows	a	line	indicating	the	path.	Older	versions	of	Flash	need	to	use
onion-skinning	(and	a	different	method	of	adding	motion	tweens).	The	wave	that	is	in	front	of
the	girl	should	move	faster	than	she	does—150%	faster.	If	we	click	and	move	the	wave	from
where	the	girl	was	in	frame	1	and	move	it	to	where	the	girl	moved	to	in	the	last	frame,	then
keep	 moving	 it	 farther	 (about	 half	 the	 amount	 we	 have	 already	 traveled),	 we	 have	 150%
movement.	It	is	easier	to	see	this	in	an	image.	See	Figure	6.40	for	an	example.	The	black	arrow
indicates	 the	 amount	 of	 the	 character’s	movement.	 The	 red	 arrow	 indicates	 the	 amount	 of
movement	for	the	front	wave.	In	the	accompanying	Flash	file,	this	is	labeled	as	an	OL.	Anyone
remember	why?	It	is	an	overlay,	meaning	the	front	wave	is	lying	overtop	of	the	character.

FIGURE	6.40	Move	the	front	layer	150%	faster	than	the	character

1.	 Select	the	first	frame	of	the	wave	element.	Create	a	motion	tween	as	you	did	with
the	character.	At	 the	end	of	 that	motion	tween	exposure	move	the	wave	farther	 to
the	 left	 than	 the	 character	 moved.	 Refer	 to	 Figure	 6.40	 for	 amount	 of	 movement
needed.



2.	 Next	animate	the	reeds	level.	Those	keeping	notes	may	remember	that	this	is	a	UL,
meaning	it	is	an	underlay.	This	level	lies	under	the	main	character.	It	has	a	“1”	next	to
it	in	case	we	were	to	add	another	underlay	that	would	have	a	“2”	behind	it.	The	same
can	be	done	for	overlays.	The	interesting	thing	about	this	naming	convention	is	that	it
indicates	the	order	of	levels	and	simplifies	the	constant	questioning	of	“What	was	in
front?	Was	it	the	waves	or	the	reeds?”	Imagine	if	this	were	100	levels	deep!	Create	a
motion	tween	on	the	first	frame	of	the	reeds	level.

3.	 At	the	end	of	the	motion	tween	exposure	select	the	reeds	element.	This	element	will
move	only	50%	of	the	character,	half	as	much.	Move	the	reeds	 level	halfway	to	the
left;	 see	 Figure	 6.41	 for	 an	 example.	 The	 black	 arrow	 indicates	 the	 amount	 of	 the
character’s	movement.	The	red	arrow	indicates	the	amount	of	movement	for	the	ul_1
reeds.

The	bg	does	not	have	to	move;	we	can	add	a	little	movement	of	5%	to	see	if	it
looks	okay.	Remember,	 if	 it	 looks	right,	 it	 is	right;	hang	the	math.	(Don’t	 let
my	high	school	geometry/programming	teacher,	Mr.	Erdly,	read	this.)

4.	 Animate	the	bg	using	motion	tweens	as	you	have	above.	Once	again,	measure	how
much	movement	 should	be	allotted	 to	 the	bg.	See	Figure	6.42	 for	an	example.	The
black	 arrow	 indicates	 the	 amount	 of	 the	 character’s	 movement.	 The	 red	 arrow
indicates	the	amount	of	movement	for	the	bg,	which	is	5%.

FIGURE	6.41	The	ul_1	movement	of	50%	of	the	character’s	movement



FIGURE	6.42	The	bg	movement:	5%	of	the	character’s	movement

Using	this	idea,	you	can	continue	assigning	amounts	of	movement	for	levels	that	are	farther
behind	the	character	or	closer	to	the	camera.	This	is	the	same	concept	as	if	you	were	traveling
down	a	road	in	a	car.	Imagine	that	the	cows	in	the	pasture	are	the	100%	level.	(I	grew	up	past
a	 dairy	 farm	 that	was	 also	 past	 the	 sausage	 factory.	 So	 you	 can	 also	 hold	 your	 nose	while
thinking	of	this	picture.	I	could	have	my	eyes	closed	as	a	kid	and	known	when	we	were	five
miles	from	home	by	the	smell.)	The	cows	are	the	100%	level.	The	barbed-wire	fence	in	front	of
them	is	moving	150%	faster	than	the	cows	across	your	field	of	vision.	The	telephone	poles	in
front	of	the	fence	are	moving	maybe	170%	faster.	The	bicyclist	on	the	road	is	the	closest	to	the
camera	 (your	 eye)	 and	might	 be	moving	 200%	 faster.	 The	 barn	 in	 the	 back	 of	 the	 field	 is
moving	50%	slower	 than	 the	cows	and	 the	mountain	even	 farther	back	 is	barely	moving	at
10%	 the	 rate	 of	 the	 cows.	 The	 sun	 never	 seems	 to	move.	 Thank	 heavens	 the	 stink	 is	 gone
before	we	get	to	my	house.

Go	back	to	the	last	frame	and	adjust	the	amounts	of	movement	until	the	parallax	feels	right.
The	 levels	 should	 all	 seem	 to	move	without	 any	one	 level	 seeming	 to	 stick	 slower	 or	 slide
faster	than	the	others.	Remember	to	show	your	friends	and	get	their	feedback.	Sometimes	you
work	on	your	shot	so	long	and	have	so	much	emotional	investment	into	it	that	you	cannot	see
the	errors.	Your	friends	have	no	such	emotional	investment	and	it	will	not	cost	them	any	time
to	fix	anything.	So	they	are	more	likely	to	see	the	errors	that	your	brain	simply	will	not	see
because	it	wants	the	shot	to	be	done.

An	example	of	this	exercise	is	presented	in	the	companion	data:	Multiplane.fla.

Multiplane	in	Toon	Boom



By	now	you	should	have	a	handle	on	importing	images	and	layering	things.	Toon	Boom	has
3D	capability,	much	like	you	have	seen	in	After	Effects.	You	can	bring	in	your	images,	place
them	into	the	timeline	and	then	in	3D	space,	move	them	apart	in	Z	depth.	Then	set	keyframes
as	 you	 are	 used	 to	 doing.	 But,	 there’s	 one	 very	 cool	 feature	 that	 is	 very	 much	 made	 for
animation:	Maintain	Size.	In	Toon	Boom	you	use	a	Perspective	window	to	move	the	layers
in	Z-depth.	(Or	any	direction,	X,	Y	or	Z,	for	that	matter.)	If	you	select	the	Maintain	Size	tool,
then	the	image	will	scale	up	or	down	as	you	drag	it	closer	to	or	away	from	the	camera.	That
means	that	in	the	compositing	camera,	the	image	will	look	like	it	is	always	the	same	size.	Yet,
you	are	moving	it	in	Z.	This	is	so	that	animators	can	draw	their	layout	compositions	and	you
can	adjust	the	Z-depth	without	bothering	that	original	composition.

FIGURE	6.42A	Toon	Boom	Animate	Pro—images	in	the	main	composite	window	and	timeline.	Composition	remains	the

same



FIGURE	6.42B	Toon	Boom	Animate	Pro—using	the	Maintain	Size	tool	to	move	images	in	Z	without	adjusting	the	size

Deep	Space

It	should	come	as	no	surprise	to	you	that	deep	space	allows	for	the	camera	to	move	toward
the	shot	elements	and	characters,	or	they	move	toward	the	camera.	Perspective	cues	are	used
to	 help	 deepen	 the	 space.	 These	 cues	 can	 include	 a	 one-,	 two-,	 or	 three-point	 perspective,
vanishing	points,	and	diffusion	of	textures	as	they	diminish	into	the	farthest	reaches	of	the	eye.
(Of	 course,	 there	 are	 other	 symptoms	 of	 a	 deep-space	 shot.	 You’ll	 have	 to	 read	The	 Visual
Story	to	learn	more.)

Deep-space	shots	are	“easy”	in	3D.	Pick	the	camera	up	and	move	it.	It	weighs	nothing.	You
do	not	have	to	build	a	track	for	it.	You	do	not	have	to	strap	it	to	you	or	others.	You	move	the
camera	around	the	world	and	shoot	what	comes	in	front	of	it.	Right?

My	students	know	better,	and	 they	know	a	 trick	question	when	 they	hear	one.	Although
you	have	a	virtual	3D	camera,	you	should	maintain	 the	 idea	 that	 the	camera	 is	expected	 to
behave	like	a	physical	camera.	It	can	do	fly-throughs	and	move	places	that	a	physical	camera
cannot.	However,	 the	 camera	 should	 always	move	with	 slow	 ins	 and	 slow	outs	 as	 if	 it	 had
weight	and	needed	to	take	effort	to	move	and	effort	to	stop.	You	have	likely	dug	deeper	by
reading	recommended	cinematography	books	to	understand	why	a	camera	would	be	placed
at	the	floor	versus	at	the	ceiling	or	closer	to	an	actor’s	field	of	view.	You	have	read	The	Visual
Story	to	understand	how	the	camera	setup	in	one	shot	relates	to	the	story	as	a	whole.	If	you
have	not,	 fear	not.	We	can	continue	with	 these	exercises	 to	 learn	what	buttons	 to	push	and
what	pipelines	to	use.	However,	make	sure	to	gain	more	exposure	to	reasons	for	moving	the
camera.	I’m	putting	the	soapbox	away	(apparently,	I	have	a	closet	full	of	them).

2D	Characters	in	a	3D	Camera	Move

So	far	in	this	chapter,	we	have	just	been	talking	about	3D	characters	in	a	3D	world	and	2D
characters	 in	 a	 2D	 world;	 for	 a	 few	 pages,	 we	 did	 not	 talk	 about	 2D/3D.	 Of	 course,	 any
medium	or	mixture	of	media	could	have	been	used	in	the	previous	exercises.	Now	we	return
to	our	originally	scheduled	program	of	2D	and	3D	media.

In	all	of	the	previous	chapters,	we	purposefully	held	the	camera	still.	What	happens	if	you
want	 to	 use	 2D	 characters	 in	 a	 3D	 camera	move?	When	 you	 have	 a	 2D	 character	 in	 a	 3D
world	and	have	a	3D	camera	move,	the	concept	of	registration	becomes	extremely	tricky.	You
can	use	the	pipelines	that	we	have	explored,	create	the	3D	first,	then	animate	the	2D	to	match.



Maintaining	good	contact	points	will	be	difficult,	yet	it	can	be	done.	Drawing	the	2D	to	match
the	 3D	 either	 digitally	 or	 using	 print	 and	 peg	 pipelines	 will	 require	 studious	 attention	 to
matching	 those	 contact	 points.	 To	 that	 idea,	 we	 have	 also	 explored	 the	 concept	 of	 always
hiding	the	contact	points	unless	they	are	absolutely	tied	into	the	key	emotion	and	storybeat	of
the	shot.	Keep	that	in	mind	as	we	go	through	this	next	exercise.

This	exercise	is	basically	a	multiplane	setup,	except	that	it	is	in	3D.	Also,	instead	of	having
flat	planes,	 they	will	be	 in	a	 sphere.	 In	class	 I	have	 lovingly	called	 this	a	multisphere	 setup.
This	type	of	a	camera	move	starts	to	edge	us	into	a	deep-space	world.

You	 have	 possibly	 seen	 something	 similar	 to	 this	 before.	 In	 Tarzan,	 when	 Jane,	 the
Professor,	and	Clayton	follow	Tarzan	to	the	gorillas	for	the	first	time,	there	is	a	realization	shot
where	the	characters	recognize	that	they	are	surrounded	by	gorillas.	 Jane	stands	up,	and	the
camera	shows	the	gorillas	in	the	trees	around	her.

If	you	watch	the	extra	content	on	the	DVD,	you	will	learn	about	Deep	Canvas,	a	software
program	 that	 allowed	 the	 background	 painters	 to	 paint	 their	 canvases	 in	 3D.	 Most	 might
confuse	this	with	typical	texture	painting	or	3D	paint	systems	like	ZBrush	or	Mudbox	(great
tools	to	learn,	by	the	way).	You	might	know	how	to	texture	paint	or	use	ZBrush	already.	Deep
Canvas	differed	from	3D	paint	packages.	It	held	each	paint	stroke	in	space,	layered	the	paint
strokes	 on	 top	 of	 each	 other	 (much	 like	 painting	 on	 glass,	 except	 in	 3D),	 and	 then	 allowed
those	paint	strokes	to	respond	to	the	scene’s	lighting.	It	was	a	wonderful	piece	of	engineering
that	was	truly	remarkable	and	different.	 I’ve	never	seen	anything	 like	 it	since.	The	software
was	originally	created	for	Tarzan,	 then	it	was	used	for	Treasure	Planet	and	even	on	Brother
Bear.

Besides	the	use	of	Deep	Canvas,	the	biggest	thing	to	note	is	that	the	gorilla	realization	shot
(among	others)	is	a	great	example	of	a	deep-space	shot	with	2D	characters	in	3D	worlds.	You
will	note	that	the	gorillas	in	the	trees	are	all	2D.	Of	course,	Jane	and	company	are	2D	as	well.
The	environment	 itself	 is	3D	painted	with	Deep	Canvas.	The	2D	gorillas	are	perched	 in	 the
tree	with	their	contact	points	hidden	as	the	camera	moves	in	3D	space	to	reveal	them.

When	faced	with	a	problem	such	as	this,	it	is	probably	best	to	bring	the	2D	artwork	into	the
3D	 system	 and	 composite	 it	 there.	We	will	 use	 the	mermaid	 characters	 from	 before	 as	 an
example	and	set	up	a	multisphere	shot.	This	is	a	quick	exercise;	feel	free	to	expand	on	it	for
the	project	portion	of	this	chapter.

Our	Assets

For	 this	 shot	we	will	 take	 the	output	of	our	Photoshop	characters	 that	have	been	quickly
animated	in	Flash	(as	an	example	of	using	animation,	not	as	an	example	of	animation),	create



image	sequences,	map	those	sequences	as	textures	inside	of	Maya,	and	do	our	camera	move
there.

We’ve	 already	 covered	 the	process	 of	 bringing	 the	 characters	 from	Photoshop	 into	Flash.
Just	as	a	review,	we’ll	make	a	.tif	sequence	with	alpha	channels.

In	Flash

1.	 Export	a	swf	file	by	selecting	File	>	Export	Movie.

FIGURE	6.43	Exporting	a	swf	of	the	characters

In	 the	 companion	 data	 you	 will	 find	 a	 swf	 for	 each	 of	 the	 characters.	 The	 animation	 is
minimal.	 These	 would	 be	 great	 candidates	 for	 taking	 into	 Flash	 and	 adding	 IK	 (inverse
kinematis)	to.	Extra	credit	goes	to	the	students	who	do	this	in	their	project.

You	 could	 export	 out	 a	 gif	 sequence	 directly	 from	 Flash;	 it	 would	 maintain	 the	 alpha
channel	that	you	need.	However,	compression	is	not	your	friend,	so	we	will	use	After	Effects
to	create	 the	 image	sequence.	There	are	other	ways	to	do	this.	You	can	have	scripts	 that	do
this	 automatically	 for	 you.	 Obviously,	 this	 is	 a	 step	 that	 is	 done	 often.	 Maintain	 a	 lossless
compression	and	keep	your	alpha	channels.	A	subject	we	have	not	even	discussed	in	this	book
is	that	of	lookup	tables	and	color	space.	That	topic	is	beyond	the	scope	of	this	book.

In	Older	Versions	of	After	Effects

1.	 Load	the	character	.swf	file	into	After	Effects
2.	 Select	File	>	Export	>	Image	Sequence	…
3.	 Choose	the	.tif	file	format	and	uncheck	“insert	space	before	number.”



4.	 When	you	 type	 in	 the	base	name	of	 the	 image	 sequence,	add	 in	 three	zeros:	 “000.”
This	will	add	zero	padding.	See	Figure	6.44	for	an	example.

FIGURE	6.44	Exporting	an	image	sequence	with	an	alpha	channel	from	After	Effects

In	After	Effects	CS6

1.	 Select	File	>	Export	>	Add	to	Render	Queue.
2.	 In	the	Render	Queue	tab,	click	on	Output	Module	Lossless.
3.	 Choose	the	.tif	file	format.
4.	 When	you	 type	 in	 the	base	name	of	 the	 image	 sequence,	add	 in	 three	zeros:	 “000.”

This	will	add	zero	padding.
5.	 Click	on	Render.

Now	we	are	going	to	want	to	bring	this	image	sequence	into	Maya	as	a	texture.	However,
Maya	will	not	read	anything	unless	it	has	a	Name.#.extension.	We	need	a	period	between	the
name	and	the	number.	Using	whatever	means	you	have,	you	will	want	to	change	the	name	of
the	sequence.

We	have	used	Adobe	Bridge	previously	in	this	book.	We’ll	use	it	again.	You	could	use	Shake
or	 even	 script	 shake	 to	 do	 this.	 (See	www.fundza.com	 for	 information	 on	 that	 process,	 and
thank	Professor	Kesson	for	his	selfless	contributions	to	better	the	lives	of	would-be	technical
directors	everywhere.)

In	Adobe	Bridge

1.	 Select	 all	 of	 the	 images	 (from	 1	 to	 19)	 by	 clicking	 on	 image	 1,	 holding	 shift,	 and

http://www.fundza.com


clicking	on	image	19.
2.	 Right-click	on	any	of	the	images	and	select	Batch	Rename.
3.	 Enter	in	the	text	to	get	a	basename	a	“.”	and	start	the	numbering	at	1.

I	 know—that	 was	 a	 lot,	 right?	 Imagine	 having	 to	 do	 that	 with	 thousands	 of	 layers	 and
images!	Go	hug	your	TD	(technical	director)	who	will	make	scripts	and	streamline	this	process
for	 you	 in	 production.	 If	 you	 are	 doing	 this	 on	 your	 own,	 this	 process	 of	 moving	 images
around,	keeping	 the	alpha,	keeping	 it	 lossless,	 and	making	 sure	 the	name	will	 read	 into	 the
next	software	package	is	tedious.	I’m	sure	you	can	come	up	with	your	own	methods	to	get	it
streamlined.

Now	we	are	ready	to	begin	putting	our	2D	animation	into	Maya.	A	note	to	mention	here	is
to	remember	resolution.	When	you	bring	images	into	Maya	and	are	going	to	render	them,	you
will	want	 to	keep	 in	mind	how	big	those	characters	are	going	to	be	on	screen	and	how	big
your	 final	 render	 is	going	 to	be.	 If	you	are	 rendering	a	high-definition	720	 image	and	 these
characters	are	going	to	fill	the	screen,	you	will	want	to	make	sure	they	are	at	a	high	enough
resolution	(have	enough	pixels)	to	be	viewed	well.

In	Maya

The	object	is	to	position	your	levels	inside	Maya,	move	the	camera	in	Maya	(as	well	as	the
artwork),	then	render	out	the	final	image.	You	can	also	render	out	multiple	passes	of	precomps
and	composite	them	together	in	your	compositing	package	of	choice.	It	doesn’t	have	to	be	one
final	render—whatever	makes	the	shot.

Let	 us	 remember	 alpha	 channels	 for	 a	 moment.	 In	 order	 to	 have	 anything	 seem	 see-
through,	you	must	have	an	alpha	channel.	By	this	chapter,	this	step	should	be	routine,	but	you
would	be	surprised	how	it	can	still	trip	you	up	if	you’re	not	reminded.	Figure	6.45	shows	that
the	wave	level	from	sea_100dpi.psd	has	been	saved	out	as	a	stand-alone	.tif	image.	The	actual
image	 itself	has	 transparency	around	 it	 in	Photoshop.	You	are	able	 to	see	 the	checkerboards
around	the	wave.	However,	Maya	will	not	know	this	is	supposed	to	be	an	alpha	channel	unless
an	alpha	channel	is	specifically	created.	In	many	cases	you	will	need	to	select	the	image	with
the	magic	wand	tool	(or	select	the	empty	space	then	go	to	select	>	invert	selection).	 In	 the
channels	tab,	you	can	see	that	an	alpha	channel	exists.	If	you	do	not	have	one,	you	can	create
one	from	the	selection	by	clicking	on	the	Save	Selection	as	Channel	button	at	the	bottom	of
the	tab.



FIGURE	6.45	Alpha	channel	in	Photoshop	for	the	Wave	element

At	first	it	was	hard	for	me	to	remember	which	was	the	alpha	channel	and	which	was	where
the	pixels	would	show	up.	Maybe	this	will	help:	the	color	black	has	a	value	of	0.	If	you	think
of	a	zero	value	as	nothing,	then	that	means	nothing	shows:	alpha.	The	color	white	has	a	value
of	1	(on);	everything	shows.	That	is	only	when	you	are	looking	at	the	alpha	itself.	Just	when
you	think	you	have	it,	remember	that	in	some	cases	in	this	book	we	have	created	mattes	in
the	RGB	channels.	When	using	RGB	mattes,	 it	 is	 just	 the	opposite—create	an	opposite	alpha
channel.	If	 in	doubt:	test.	The	image	in	Figure	6.46	shows	a	plain	white	canvas	 in	Photoshop
with	an	alpha	channel.	If	this	were	brought	into	Maya	and	placed	as	a	texture,	it	would	show
up	as	a	circle,	shown	in	the	insert.	As	a	note,	the	file	is	brought	into	the	color	attribute	and	the
transparency	attribute	of	the	material.	This	is	usually	done	automatically.	However,	sometimes
you	have	to	do	it	manually.

Take	Note

Make	sure	that	your	Photoshop	texture	is	saved	as	an	RGB	and	not	CMYK.	If	it	is	saved	as
CMYK,	the	fourth	channel	will	be	read	as	the	alpha	channel,	which	more	than	likely	will	lead



to	undesired	results.	(Not	that	the	author	did	that	by	accident.)

FIGURE	6.46	Alpha	channel	in	Photoshop	with	RGB	shown	as	plain	white

The	wave	texture	has	been	cropped	to	a	square	size.	Why	a	square?	This	is	now	going	to	be
used	as	a	texture.	Texture	space	is	defined	in	a	square	that	is	numbered	from	0	to	1	across	the
top	and	down	the	length	of	the	image.	This	is	how	textures	are	used	in	almost	all	packages.
While	on	the	subject	of	UVs,	because	this	is	now	using	our	2D	images	inside	of	a	3D	space,	you
will	need	to	become	familiar	with	UV	unwrapping.	We’ll	look	at	examples	together.

You	 can	 follow	 along	 in	 Maya	 with	 the	 file	 MultiSphere_setup.mb.	 Inside	 this	 file,	 a
sample	scene	has	been	created	that	has	a	few	textures	already	loaded	and	properly	uses	alpha
channels.	(If	the	textures	do	not	show,	Maya	doesn’t	know	where	they	are.	Reload	the	textures
in	the	Hypershade	window.)	We	will	create	geometry	to	hold	our	animated	character	textures
and	make	sure	that	those	texture	planes	face	the	camera	for	the	final	render.

First,	 let’s	 examine	 the	 spheres	 with	 textures	 already	 applied.	 The	 outer	 sphere,	 labeled
“OuterSphere,”	 is	 the	 background	 level	 and	 it	 has	 a	 background	 texture	 applied.	 The	 next
sphere	in	is	labeled	“MiddleSphere”	and	has	the	reeds	texture	applied	to	it.	You	can	see	that
the	alpha	channel	of	the	reeds	texture	is	being	read	in,	and	you	can	see	through	that	sphere	to
the	background	sphere—	hemispheres,	actually;	 to	better	show	what	 is	going	on	the	spheres
have	been	 reduced	 to	hemispheres.	Your	project	 can	have	 spheres	or	any	 type	of	geometry
that	wraps	around	the	camera.



FIGURE	6.47	MultiSphere_setup.mb

The	next	sphere	 in	 is	a	CharacterSphere	and	 it	has	been	hidden	for	 the	moment.	We	will
come	back	to	it.

The	 smallest	 sphere	 has	 been	 adjusted	 to	 hold	 the	 wave	 textures.	 It	 has	 been	 labeled
“WaveSphere.”	 You	 will	 note	 that	 the	WaveSphere	 has	 been	 broken	 up	 to	 hold	 the	 wave
texture	in	two	different	ways.	One	is	the	normal	use	of	UVing	in	the	hemisphere	to	apply	the
wave	texture	(Figure	6.48).



FIGURE	6.48	Wave	texture	applied	to	a	polygon	hemisphere	named	Wave2

The	 second	 way	 that	 the	 texture	 has	 been	 applied	 can	 be	 seen	 in	 Wave1.	 Wave1	 is	 a
separate	piece	of	geometry.	A	section	of	the	sphere	was	extruded.	That	extruded	section	was
extracted	and	then	separated	into	its	own	object.	 (History,	of	course,	was	deleted.)	This	way
the	 object	 itself	 can	 hold	 the	 texture	 but	 still	maintains	 the	 curvature	 of	 the	 sphere.	 It	was
important	in	the	UVing	process	to	make	sure	that	the	tops	and	sides	were	UVed	to	be	in	the
right	quadrant	of	the	UV	editor	so	that	they	received	the	alpha	channel	information	to	become
transparent.	 If	 the	UV	 gets	 to	 the	 edge	 or	 outside	 of	 the	 texture,	 gray	will	 show	up	 in	 the
rendered	 image.	You	might	 see	 a	 small	 bit	 of	 that	 in	 the	 example	 file.	To	 fix	 this	 problem,
open	the	UV	texture	editor	and	move	the	UVs	to	be	inside	the	quadrant.	If	we	had	U	and	V
wrap	turned	on	in	the	texture	placement	node,	it	would	not	be	an	issue.	However,	usually	in
cases	like	this	we	do	not	want	texture	wrap	on.

We	have	kept	everything	in	a	sphere	shape	so	that	it	wraps	around	the	camera	much	like	an
IMAX	screen	wraps	around	the	audience.	It	doesn’t	have	to	be	in	a	sphere,	but	in	this	case	we
will	keep	the	sphere	shape	in	order	to	push	the	fisheye	lens	appearance	of	the	levels.



FIGURE	6.49	Wave	texture	applied	to	an	extruded/separated	portion	of	the	polygon	hemisphere	named	Wave1

Take	Note

As	you	orbit	the	camera	around	to	look	at	the	spheres,	you	might	notice	that	the	wave	level
appears	to	go	behind	the	reed	level.	This	is	only	a	hardware	shading	(viewport	preview)	issue
and	 will	 not	 show	 up	 in	 the	 renders.	 However,	 to	 make	 the	 transparency	 sorting	 work
correctly,	in	the	viewport	select	Shading	>	Polygon	Transparency	Sorting	so	that	it	is	on.

To	create	geometry	planes	for	the	characters,	we	will	select	an	area	of	the	CharacterSphere
and	create	it	into	its	own	piece	of	geometry:

1.	 In	the	outliner,	select	CharacterSphere	and	turn	its	visibility	ON	in	the	channel	box.
2.	 Use	your	favorite	method	of	selection	to	select	a	rectangle	of	faces	behind	one	of	the

waves.
3.	 In	 the	 Polygons	 area,	 select	Option	 Box	 next	 to	Mesh	 >	 Extract.	 Make	 sure	 that

Separate	Extracted	Faces	is	turned	off.	(If	it	is	left	on,	every	face	you	selected	will
be	 divided	 from	 the	 others.)	 This	 has	 put	 the	 group	 of	 selected	 faces	 into	 its	 own
“list,”	 but	 it	 is	not	 separated	 from	 the	object	yet.	You	will	note	 that	 in	 the	outliner
there	is	still	only	one	object	named	CharacterSphere.

4.	 Next,	select	Mesh	>	Separate.	This	should	separate	the	extracted	polygons	into	their
own	named	object	in	the	outliner.	However,	there	is	still	history	attaching	them	to	the
main	CharacterSphere.

Note:	depending	on	your	version	of	Maya,	you	may	receive	an	error:	Separate
works	on	selected	objects	or	on	faces	from	one	single	object.	This	message	may



appear	even	if	you	do	have	faces	selected,	just	not	exactly	what	Maya	wants.
To	 get	 to	 the	 faces	 that	Maya	wants	 selected,	 right-click	 in	 the	 view-port
window	 and	 hold	 down	 the	CTRL	 key.	 This	 will	 open	 a	 hot	 box	window.
Select	 from	 the	 bottom	 hot	 box:	 To	 Face	 Path.	 This	 will	 select	 the	 faces
correctly	and	you	can	continue	with	step	5.

5.	 Make	sure	 to	delete	 the	history	by	clicking	Edit	>	Delete	by	Type	>	History.	 You
will	know	you	were	successful	when	that	pesky	Transform	node	is	gone	from	your
outliner.

Now	that	the	plane	for	the	character	is	ready,	apply	a	material	and	the	texture	by	doing	the
following:

1.	 Select	the	newly	extracted	plane.	In	the	figure	ours	is	renamed	to	CrabKid.	Apply	a
lambert	material	to	the	plane.	One	way	is	to	right-click	on	the	plane	and	select	from
the	hot	box	menu	Assign	New	Material	>	Lambert.

2.	 In	 the	Attribute	Editor,	 select	 the	checkerboard	 button	next	 to	 the	color	 chip	 and
add	a	file	node.

3.	 For	that	file	node,	 in	the	Attribute	Editor	click	the	browse	button	and	find	the	first
frame	of	the	crabkid	image	sequence,	crabKid.0001.tif,	and	click	open.

4.	 In	the	Attribute	Editor,	make	sure	to	click	on	the	use	image	sequence	button.	This
will	automatically	read	in	an	image	to	match	the	frame	that	the	timeline	is	on.	(Why,
back	in	my	day	we	had	to	write	an	expression	for	that.)

If	you	look	back	at	the	material	node,	you	will	note	that	the	transparency	has	automatically
been	 loaded	 from	 the	 alpha	 channel	 for	 you.	 If	 not,	 you’ll	 have	 to	 do	 that	manually	 in	 the
hypershade.

Some	things	can	go	wrong	when	you	do	this	on	your	own:

If	you	use	a	CMYK	image	instead	of	an	RGB	image,	alpha	reads	it	incorrectly.
If	 you	 use	 a	 naming	 convention	 that	 Maya	 cannot	 understand,	 like	 crab0001.tif	 or
crab_0001.tif,	you	will	get	a	purple	message	about	a	node	not	existing.
You	will	have	problems	if	you	forgot	to	have	an	alpha	channel.
You	will	have	problems	if	you	saved	the	image	as	a	.jpg	or	in	a	format	that	does	not
hold	alpha	channels.

Now,	 as	 you	 look	 at	 your	 CharacterSphere	 you	 will	 think	 something	 has	 gone	 terribly
wrong	and	you	might	start	thinking	of	the	items	in	the	preceding	list	as	possible	candidates.
There	is	nothing	wrong,	only	something	that	has	not	been	done:	UV	mapping.	If	you	open	the



UV	Editor	by	selecting	Window	>	UV	Texture	Editor,	the	problem	should	become	apparent.
The	UVs	are	nowhere	near	the	image	of	the	crabkid’s	smiling	face.

FIGURE	6.50	UVs	are	not	correctly	mapped	to	show	character	texture

If	you	are	unused	to	UVing,	it	is	small	tasks	like	these	that	will	help	you	gain	confidence	in
the	fine	art.	In	an	example	on	the	companion	website,	the	UVs	have	been	moved	around	(by
selecting	 them	 and	 using	 the	 move	 and	 scale	 tool)	 until	 they	 fit	 within	 the	 upper	 right
quadrant	and	display	the	character.	Also,	the	U	wrapping	and	V	wrapping	have	been	turned
off	 inside	 the	 file	2D	texture	placement	node.	You	can	 locate	 these	nodes	 in	 the	hypershade
window.

Repeat	 these	 steps	 to	 create	 texture	planes	 for	 the	other	 animated	 textures.	My	 students,
remember	 to	name	as	you	go.	 In	Figure	6.51	 the	merman	 image	 sequence	has	been	 loaded
onto	a	small	polygon	area	behind	the	other	wave	element.



FIGURE	6.51	Two	characters	loaded	as	textures

Take	Note

Take	note:	you	want	to	make	sure	that	you	have	enough	2D	images	to	match	the	time	in
your	Maya	 timeline.	 If	 you	 advance	 past	 frame	 15	 in	 our	 example	 file,	 the	 crabkid	 texture
does	not	have	any	more	images.	It	either	will	go	blank	or,	oddly	enough,	load	in	a	different
texture!	Oops.	That	is	going	to	be	a	gotcha	at	render	time	if	you	don’t	plan	for	it	now!

The	last	step	is	to	place	a	camera	in	the	scene	by	clicking	Create	>	Cameras	>	Camera	or
whatever	 type	 of	 camera	 you	 prefer.	 Then	 animate	 the	 camera	 as	 desired.	 Please	 see	 the
companion	data	for	an	example	in	which	a	camera	has	been	placed	at	the	base	of	the	spheres
looking	up	at	these	god-like	merfolk.

Very	 important:	 you	 will	 notice	 that	 the	 lighting	 in	 this	 scene	 is	 ambient	 to	 make
everything	appear	flat	and	the	materials	are	lambert	so	that	there	is	no	specular	highlight.
Of	course,	you	could	add	in	3D	objects	that	have	their	own	type	of	lighting.	You’ll	want	to	use
light	linking	to	make	sure	that	the	3D	lighting	does	not	affect	the	2D	imagery	and	vice	versa.
Extra	 effort	 points	 to	 the	 students	who	 include	 that	 step	 in	 their	 final	 project.	You	 can	 find
more	information	on	light	linking	in	the	Maya	help	documentation.

Forced	Perspective

What	if	you	want	to	add	a	little	more	dimension	to	your	scene?	There	are	two	things	you



can	do.	One	is	to	have	the	character’s	plane	follow	the	camera.	Doing	this	will	enable	you	to
move	 the	 camera	 without	 giving	 away	 the	 secret:	 that	 the	 character	 is	 only	 a	 pixel	 deep.
Another	thing	you	can	do	is	much	like	the	idea	we	explored	by	creating	spheres.	You	can	add
dimension	to	your	texture	planes,	push	perspective,	and	force	more	parallax	to	happen.

First,	having	your	character	planes	face	the	camera	is	a	useful	technique	to	know.	Because
we	 created	 these	 characters	 as	 spheres,	 it	may	not	 be	necessary.	But	 if	 the	 camera	were	 to
move	or	if	the	character	were,	say,	a	driver	in	a	UFO	that	moved	past	the	camera,	you	would
want	the	character	to	always	face	the	camera.	To	accomplish	this,	do	the	following:

1.	 Select	the	Camera	and	then	the	character’s	plane.	This	is	a	driver/driven	relationship,
so	it	is	important	that	the	camera	is	selected	first.

2.	 Under	Animation,	select	the	option	box	for	Constraint	>	Aim.
3.	 You	want	the	aim	vector	to	match	the	axis	you	want	to	point	toward	the	camera.	In

our	example	on	the	companion	website,	the	X	axis	is	pointing	away	from	the	camera.
Therefore,	the	aim	vector	is	set	to	−1	in	the	x	box.	(You	might	have	assumed	that	the
three	unmarked	boxes	stand	for	X,	Y,	and	Z.)	Then	click	Add.

4.	 If	 you	 want	 to	 adjust	 the	 offsets	 in	 any	 way,	 select	 the	 object,	 locate	 the	 aim
constraint	 in	 the	 inputs	 area	 of	 the	 channel	 box,	 and	 adjust	 the	 offsets	 to	 get	 the
positioning	 you	 desire.	 In	 Figure	 6.52	 the	 clouds	 are	 being	 adjusted	 to	 be	 framed
better	in	the	camera	view.

FIGURE	6.52	Adjusting	the	Aim	constraint	offset	as	needed

Things	to	watch	out	for	when	using	Aim	constraints:



Make	sure	that	the	constraint	is	added	correctly.	The	camera	should	not	whiz	away.	If
it	does,	you	have	constrained	the	camera	to	the	character.	Oops.
Make	sure	that	your	planes	are	getting	enough	ambient	lighting.	They	may	turn	from
the	 light	 and	 become	 dark	 in	 your	 render.	 You	 may	 want	 to	 parent	 constrain	 an
ambient	light	to	follow	along	with	your	camera	to	always	illuminate	the	characters.
Remember,	if	it	looks	good	in	the	final	render	camera,	that	is	all	you	care	about.	Move
things,	 scale	 things;	 it	 is	 okay.	 If	 you	 are	 working	 for	 an	 art	 director,	 though,	 that
person	might	 change	his	 or	her	mind	about	 the	 camera	move.	 If	 that	happens,	 then
you	have	some	extra	work	to	do.

To	push	the	idea	of	adjusting	these	levels	even	more,	look	for	opportunities	to	create	more
parallax	by	adding	dimension	to	the	texture	planes	themselves.	Many	packages	now	allow	for
pushing	of	simple	textured	polygon	planes.	Toon	Boom	is	one	we	will	look	at	next.

Using	 our	 current	 example,	we	 added	 a	 slight	 extrusion	 to	 the	MiddleSphere	 so	 that	 the
bottom	portion	of	 the	 texture	would	have	parallax	with	 itself	during	 the	camera	move.	For
this	process,	you	would	do	the	following:

1.	 Select	Edit	Mesh	 >	 Split	 Polygon	Tool	 or,	 in	 newer	Maya	 versions,	Edit	Mesh	 >
Interactive	 Split	 Tool	 in	 the	 Polygon	 area	 and	 click	 on	 the	 edges	 of	 the
MiddleSphere	to	cut	a	line	running	along	the	bottom	blue	area	of	the	texture.

2.	 Use	your	favorite	selection	method	to	select	the	bottom	area	of	the	texture	plane	that
corresponds	with	the	blue	ocean	floor.

3.	 Select	Edit	Mesh	>	Extrude,	 and	 extrude	 the	 features	 so	 that	 the	 element	 juts	 out
from	the	rest	of	the	texture.

4.	 Place	 your	 camera	 and	move	 it.	 You	 should	 see	 parallax	 of	 the	 texture	 plane	with
itself	and	other	elements.

FIGURE	6.53	Adding	dimension	to	the	texture	plane	by	extruding	areas

This	 technique	was	actually	used	 in	Mulan	and	Atlantis,	 among	others.	You	 can	 see	 it	 in
Mulan’s	opening	shot	of	the	Great	Wall	of	China,	after	the	wonderful	painting	with	animated
mattes	and	compositing	 tricks	 fades	 into	 the	actual	animated	shot	of	 the	Great	Wall.	As	 the



camera	pulls	back	to	show	the	wall,	you	might	notice	parallax	going	on	between	the	segments
of	the	wall	itself.	A	technique	of	forced	perspective	and	a	lot	of	creative	compositing	was	used
to	 create	 that	 shot.	 I	 believe	 that	was	when	Maya	was	 available	 as	 a	 beta.	 This	method	 of
creating	deep	space	with	2D	artwork	was	used	throughout	the	film	with	varying	degrees	of
deep	space.	A	more	notable	shot	would	be	from	sequence	19	shot	24,	where	Mulan	runs	into
the	crowd	and	the	camera	booms	up	to	show	fireworks	bursting	in	the	sky.	That	is	a	3D	shot
full	of	2D	imagery	with	forced	perspective	on	many	of	the	palace	elements,	and	don’t	forget
crowds	and	particle	fireworks.

Further	Reading

Ashman,	Howard,	et	al.	DVD.	Little	Shop	of	Horrors.	Burbank,	CA:	Warner	Home	Video,	2000.
Block,	Bruce.	The	Visual	Story.	Boston:	Focal	Press,	2007.
Brinkmann,	Ron.	The	Art	and	Science	of	Digital	Compositing.	Amsterdam:	Morgan	Kaufmann

Publishers/Elsevier,	2008.
Brown,	 Blain.	 Cinematography:	 Image	 Making	 for	 Cinematographers,	 Directors,	 and

Videographers.	Directors	and	Videographers.	Oxford:	Focal,	2002.
Hollywood	Camera	Work.www.hollywoodcamerawork.us.
LeDoux,	Joseph.	Synaptic	Self:	How	Our	Brains	Become	Who	We	Are.	London:	Penguin	Books,

2003.
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Completed	Works

We’ve	 covered	 how	 to	 get	 the	 shots	 done,	 which	 types	 of	 pipelines	 and	 software
combinations	might	be	used,	and	how	the	use	of	camera	might	be	addressed	in	each	shot.	We
need	 to	 take	 a	 step	 back	 and	 spend	 this	 chapter	 going	 over	 some	 completed	 works	 and
looking	at	the	overall	methods	used.

Disney’s	Paperman

This	is	a	lovely	story	with	a	refreshing	animation	style	that	combines	many	of	the	methods
you	 have	 learned	 in	 this	 book.	 There	 are	 SIGGRAPH	 papers	 presented	 about	 how	 they
achieved	 the	 film	and	 the	 tools	created	 (http://siggraphencore.myshopify.com/products/2012-
tk141).	 You	 can	 also	 read	 an	 article	 written	 by	 the	 director,	 John	 Kahrs:
http://www.cgmeetup.net/home/the-making-of-paperman/.

http://siggraphencore.myshopify.com/products/2012-tk141
http://www.cgmeetup.net/home/the-making-of-paperman/


FIGURE	7.1	Making	of	Paperman	from	http://www.disneyanimation.com/projects/paperman

What	was	 the	 process?	 First	 everything	was	 animated	 in	 3D.	Then	 they	 created	 2D	 lines
overtop	of	 the	3D	 imagery.	The	3D	was	shaded	very	 flatly.	The	aesthetic	was	very	stylized.
This	method	 is	used	quite	 frequently,	mostly.	You	can	almost	re-create	 it	with	 the	 tools	you
have	read	about	in	this	book.	The	difference	comes	in	how	the	2D	line	was	created.	There	is
some	 magic	 here	 that	 you	 won’t	 be	 able	 to	 re-create	 completely.	 It	 is	 worth	 studying.
“Computer-Assisted	Animation	of	Line	and	Paint”	is	the	name	Disney	gave	to	the	process	in
their	SIGGRAPH	2013	presentation.	Here	are	the	basic	steps	they	did	to	create	Paperman:

The	3D	Animation

1.	Created	the	normal	3D	character	and	animated	it.

So	far,	so	good—you	know	how	to	do	that.	The	next	part	may	be	new	and	you’ll	need	to	do
some	research.

http://www.disneyanimation.com/projects/paperman


Create	a	2D	Texture	that	will	Move	in	3D

2.	Ran	a	process	over	the	Z-depth	information	of	the	image	and	created	a	motion	vector.
3.	Used	that	motion	vector	to	create	a	paper	texture	for	the	line	and	paint	that	respects

the	3D	space	and	movement	of	the	character.

You	can	create	motion	vectors	with	Mental	Ray.	Motion	vectors	are	images	that	look	at	the
previous	image	and	the	current	image,	then	create	an	image	in	between	that	only	represents
the	movement	vector	of	each	component	of	 the	 image.	You	can	get	a	crash	course	 in	 them
here:	 http://www.youtube.com/watch?v=F9rW17naKUQ.	 The	 tips	 in	 that	 video	 for	 creating
motion	vectors	are	to	make	sure	to	change	the	shutter	angle	to	360	for	easier	offset	ability	and
add	 a	 render	 layer	 override	 that	 renders	 frame	 1.5	 instead	 of	 1,	 and	 so	 on.	 Then	 when
compositing	you	can	offset	the	motion	vector.

Create	2D	Lines	that	Move	in	3D

4.	Did	a	motion	vector	pass	for	all	the	vertices	of	the	character,	render	it	as	an	image,	and
extend	it	for	compositing	needs	later	on.

You	can	do	all	of	this	with	the	toon	line	and	paint	effects	engine.	It	does	steps	number	4	and
5	for	you.	But	now	things	are	starting	to	get	tricky.	You	may	have	watched	the	Motion	Vector
101	video	listed	above.	Step	6	is	something	that	you	need	to	do	with	vectors	to	extend	beyond
the	character	or	you’ll	get	hard	edges.	This	 is	 to	texture	the	 lines	eventually	 in	compositing.
But	beware,	you	cannot	create	motion	vectors	of	toon	lines	or	paint	effects	in	Maya	unless	you
convert	them	to	polygons	first,	or	do	a	post-compositing	trick.

5.	Created	the	2D	keyframes.

Ah,	here	we	are	at	the	real	difference.	We	can	achieve	animated	2D	line	results,	but	not	as
elegantly	 as	 the	 proprietary	 tool	 that	 Disney	 created	 and	 not	 as	 beautifully,	 given	 that	we
cannot	do	some	of	the	processing	on	the	toon	line.	Thank	heavens	Disney	shares	the	processes
at	SIGGRAPH	so	that	creative	programmers	out	there	can	help	make	tools	available	to	other
artists.	So	what	can	we	do?

We	can	attach	paint	effects	brushes	to	curves,	and	we	can	animate	curves.	Well,	it	isn’t	easy
to	animate	cvs.	You	want	to	draw	the	lines	like	an	animator—that’s	where	the	proprietary	tool
excelled.	We	can:

http://www.youtube.com/watch?v=F9rW17naKUQ


1.	 Create	 >	 CV	 Curve	 or	Pencil	 tool	 and	 draw	 the	 ink	 lines.	Watch	 out	 if	 you	 are
drawing	in	the	perspective	camera;	who	knows	where	the	line	will	go.	This	is	reason
number	one	why	this	method	will	be	a	pain	to	control.

2.	 Select	the	surface	and	the	curve;	click	on	Surfaces	>	Edit	NURBS	>	Project	Curve
on	Surface.	This	positions	the	curve	on	the	surface	based	on	the	camera	view.	Note:
the	surface	needs	to	be	a	NURBS	surface	for	this	to	work.

3.	 Select	an	appropriate	paintbrush;	make	sure	the	curve	is	still	selected:	Paint	Effects	>
Curve	Utilities	>	Attach	Brush	to	Curves.

4.	 Go	back	to	the	curve	itself,	select	cvs	and	animate	them.

FIGURE	7.2	Animating	curves	with	paint	effects	applied	to	them.	(We	had	to	see	Robby	one	more	time	before	the	end	of	this

book.)

Well,	that	wasn’t	elegant,	was	it?	Now	we	know	why	the	proprietary	system	was	needed.
Of	course,	there	are	other	ways	to	manually	draw	in	2D	over	the	character,	and	that	is	what
we	can	do.

“Package	Whispers”	by	Monira	Kamal



FIGURE	7.3	Monira	Kamal	working	on	a	scene	of	“Package	Whispers,”	2012

Production:	Konrad	Wolf	University	of	Film	and	Television	in	collaboration	with	UPS,	“We	Love	Logistics”

Let’s	 take	a	 look	at	 the	animated	short	 “Package	Whispers,”	 created	by	Monira	Kamal	of
Germany.	This	film	was	created	for	the	UPS	challenge	“We	Love	Logistics.”	The	art	direction
was	 clearly	 indicated	 by	 style	 frames	 inspired	 by	 artist	 Stina	Persson.	You	 can	 see	how	 the
style	 frame	 pushed	 the	 animation	 to	 have	 a	 clear	 aesthetic	 in	 Figure	 7.4.	 (Read	 further	 in
Chapter	 2’s	 online	 material	 about	 “Iteration	 for	 Developing	 a	 Pipeline	 and	 Nailing	 the
Moment.”)



FIGURE	7.4	Style	frame	of	“Package	Whispers”

FIGURE	7.5	Digital	2D	animation	in	“Package	Whispers”	using	a	Cintiq	monitor

The	animators	worked	in	3D	to	animate	the	characters	in	their	scenes.	The	characters	only
had	three	different	body	types,	but	look	to	be	good	models	and	rigs	to	work	with.	These	shots
are	not	mixing	different	characters	of	different	mediums	like	we	did	in	Chapter	3.	Instead	they
are	 starting	with	 3D	 (see	 Figure	 7.6)	 characters	 and	 then	 flattening	 out	 the	 characters	 and
adding	 toon	 shading.	You’ll	note	 in	 the	 style	 frames	 that	 the	 characters	 are	designed	 to	not
have	skin	tone,	so	the	flat	shading	adds	to	the	story	of	this	piece.	(See	Figure	7.7.)



FIGURE	7.6	3D	animation	in	“Package	Whispers”



FIGURE	7.7	3D	animation	with	toon	shading	in	“Package	Whispers”

The	next	set	of	images	shows	the	process	of	the	character	broken	apart.	The	characters	are
animated	in	3D	with	toon	lines	(Figure	7.8),	then	digital	2D	animated	cloth	and	accessories	are
added	on	 top.	Oh,	 isn’t	 that	 3D	 leads	 2D?	You	know	 that	 already.	Then	 the	 features	 of	 the
character	are	added	as	well.	Finally	the	animation	is	composited	over	watercolor	backgrounds.
Note:	 the	 backgrounds	 themselves	 are	 composites	 of	 different	 water-color	 elements.	 (See
Figure	7.9.)



FIGURE	7.8	3D	model	with	toon	lines,	Digital	2D	animated	cloth,	and	animated	features	in	“Package	Whispers”

FIGURE	7.9	Character	composited	over	watercolor	background	in	“Package	Whispers”

Please	go	here	to	view	the	completed	short	film:

http://www.hff-potsdam.de/de/filmeprojekte/hff-filme/detail/package-whispers.html.
The	 making-of	 video	 can	 be	 found	 here:	 https://www.youtube.com/watch?

v=kHDdxQcdc0Q.

These	grad	students	did	a	great	job	pulling	off	a	great	short	animated	film.	Congratulations!

http://www.hff-potsdam.de/de/filmeprojekte/hff-filme/detail/package-whispers.html
http://https://www.youtube.com/watch?v=kHDdxQcdc0Q
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What	Next?

Well,	everyone,	we	have	reached	the	end	of	our	printed	journey.	Surely,	as	you	have	read
this	book	you	have	thought	of	different	ways	to	approach	the	problems	we	have	faced.	Maybe
there	are	different	methods	you	have	used	or	want	 to	 test	out.	There	will	be	new	software,
new	versions,	scripts,	and	methods	to	be	explored.	On	top	of	it	all,	there	will	be	examples	of
animation	that	we	all	want	to	look	at	to	learn	from	or	be	inspired	by.

What	other	things	can	you	work	with?	IK	bones	in	Toon	Boom	or	Flash?	What	happens	if
you	 bring	 live	 elements	 into	 your	 animation?	 I	 wonder	 where	 Photoshop	 and	 its	 3D
capabilities	is	going	to	go?	How	can	this	apply	to	sprite	animation	and	game	engines?	(Oh	my
—that’s	a	whole	’nother	world.)

What	a	lovely	journey	this	has	been.	My	only	wish	is	that	you	will	not	get	bogged	down	in
one	method,	one	medium,	one	aesthetic.	Instead,	while	making	beautiful	art,	I	hope	you	keep
fearlessly	asking,	“What	does	this	button	do?”	and	“Will	it	help	tell	my	story?”

Warmly,
…	tina
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perspective	and	185–6;	tracking	with	camera	and	182,	184

deep-space	shot	211–12

digital	animation	4,	49,	63,	133

Disney’s	Paperman	225–8

dolly	camera	move	185

dope	sheets.	See	x-sheets

drawing:	in	Flash	49,	107–10;	frame	by	frame	42–3

Dukal’s	artistic	brushes	79–80

duplicate	layers	133

EFX	animation	121,	124

EFX	elements	120–1,	125,	127,	128,	134

EFX	team	119–20

Elemental	Magic:	The	Art	of	Special	Effects	Animation	(Gilland)	120

emotion:	in	animation	17–18;	moment	scene	with	22

environment:	light	and	124;	using	3D	for	127

exporting:	 image	 sequences	 214;	 levels	 of	 animation	 37–9;	 movie	 files	 205;	 from	 Photoshop	 140–1,	 149;	 rough	 animation

108–9;	swf	files	157,	213;	3D	objects	145–6

Fantasia	2000	95,	117

file	types	39–40,	145

fill	shader	30–3,	74,	153

Flash:	animation	in	100–2,	106;	drawing	in	49,	107–10;	image	sequences	in	213–14;	importing	video	and	106–7;	keyframes	in

63,	107;	multiplane	in	205–10;	saving	images	in	65–6;	timing	in	63

flat	space:	attributes	of	179;	camera	movements	for	180;	hands-on	examples	188–96;	introduction	to	175–6

flat-space	shot	179,	189,	190



f lip	images	133–4

flower	animation	131,	132

f ly-through	186,	211

frame	animation	43,	81

frame	padding	130,	155

frame	rate:	for	combining	mediums	10–11;	setting	25,	40,	50–1

frame	stack	window	46,	47

graph	editor	27,	29,	70–3

heffalump	element	118

helicopter	shot	186–8

Hercules	94,	125

highlights	74,	94,	124

Hunchback	of	Notre	Dame	6,	117

hybrid	animation:	defined	1;	examples	of	14;	mediums	and	5–13

hybrid	character:	challenges	related	to	58–9;	forming	cohesive	56–7;	2D/3D	integration	and	13

image	format	10–11,	105

image	plane:	attaching	to	camera	in	Maya	67;	hiding	74;	resolution	gate	and	68

images:	 bringing	 into	After	 Effects	 157–9,	 165–6;	 creating	 digitally	 3;	 exporting	 109–10;	 f lipping	 133–4;	 importing	 of	 51,

113–16,	141–2;	rendering	of	38–9;	saving	65–6

image	sequences	67–8,	83,	214–15

image	sizes	12,	52,	108,	188

importing:	character	assets	205–6;	of	images	51,	113–16,	141–2,	210;	in	Maya	67–8;	OBJ	file	146,	149–50;	2D’s	3D	stand-in	25;

of	video	106–7

ink	level	142,	143,	144

ink	lines	135–6,	138

intensity	chart	177,	178

Interactive	Photorealistic	Rendering	(IPR)	window	31,	32,	154

Iron	Giant,	The	1,	2,	17

Jaguar	McGuire:	body	cast	56;	cape	on	fire	sequence	96;	character	design	96–100;	neck	brace	100–4;	tone	matte	153–60

keyframes:	 adding	 to	 aid	 animator	 27;	 of	 animation	 99;	 camera	 and	 203–4;	 from	 final	 composite	 53;	 in	 Flash	 63,	 107;	 in

Maya	69;	onion-skinning	and	42,	64–5;	in	Photoshop	148;	timing	of	11,	64

keyitis,	avoiding	73



layers:	cropped	200;	duplicating	132–3;	editable	30,	31;	putting	symbols	on	206–7;	reed	202,	203;	renaming	200

levels:	in	After	Effects	85;	assigning	amounts	of	movement	for	210;	breaking	things	in	92;	compositing	82–3

light/lighting:	for	animation	151;	drawing	in	2D	EFX	124;	f lat-space	shot	and	191;	forming	hybrid	character	and	56;	media

issues	152;	tones	and	150

Lilo	and	Stitch	6,	10,	186

limited	space:	attributes	of	181–2;	camera	movements	in	182;	hands-on	examples	189,	196–9;	multiplanes	and	182–4;	tracking

with	camera	and	182

limited-space	shot	183,	184,	196

line	look	18,	55,	61,	62

line	mileage	5–6,	17,	58,	92

line	quality	76,	142

lossless	compression	52,	214

masking	out	body	87–9

matte:	adjusting	color	of	the	object	and	86;	masking	out	body	and	87–9;	over-blurring	173;	using	to	adjust	lighting	85–6

Maya:	 animation	 in	 6,	 22–8,	 102,	 103;	 breakdowns	 set	 in	 70,	 71;	 Corel	 Painter	 and	 45–8;	 image	 sequences	 in	 215–16;

inbetweens	71;	 installing	script	28;	keyframes	 in	69;	 other	 software	and	48–9;	 Photoshop	 and	 40–3;	 psd	 texture	 loaded

into	149;	rendering	in	37–40;	re-rendering	in	45;	shadow	pass	in	163–5;	3D	arm	in	66

mediums:	cost	issues	7–8;	determining	preferred	5–8;	lighting	issues	152;	making	to	look	like	each	other	55–6;	problems	with

combining	8–13;	tweaking	between	22

MiddleSphere	217,	223

motion	tweens	207–9

movement:	forming	hybrid	character	and	57;	organic	objects	122

movie	files	44–5,	47–8,	141,	205

Mulan:	crowd	element	in	117;	Hun	charge	in	6;	large	amount	of	3D	in	126

multiplane	camera	117,	198

multiplanes:	 in	3D	space	183;	 in	After	Effects	 200–1;	 in	Flash	205–10;	 limited	 space	and	182–4;	with	 perspective	 185–6;	 in

Toon	Boom	210–11

node-based	compositors	82,	115,	137–9

Nuke	system	137–9,	167–71

objects:	constraining	26;	moving	organic	122;	using	3D	and	2D	together	90

OBJ	file,	importing	146,	149–50

onion-skinning	42–3,	46,	58,	64–5

opening	shot	96,	224

organic	objects,	moving	122



“Package	Whispers”	228–30

paint	effects	brush	112,	113

paint	fills,	creating	137

paint	level	82,	143

palace	crowd	element	117

panning	a	camera	180

Paperman	225–8

parallax	between	levels	179,	181–4,	187

Pearce	Sisters,	The	(Cook)	55

pegging	process	10,	20,	57,	126

Pencil	Check	Pro	64–6

perspective:	animation	in	24;	forced	222–4;	multiplane	with	185–6

Photoshop:	alpha	channels	in	43,	215–17;	animation	in	40–4,	130–4,	144–5;	cleanup	in	76,	110–11,	132–3;	drawing	frame	by

frame	in	42–3;	exporting	from	140–1;	image	sequences	in	40–4;	 importing	OBJ	file	 into	146;	keyframes	 in	148;	 painting

technique	136;	rendering	in	40,	43–4;	video	layers	in	130–2

Photoshop	brushes:	built-in	76–8;	custom	78;	downloading	79–81;	preset	77

physical	assets,	budget	for	7–8

pipeline:	for	animation	57–8;	contact	points	and	125;	for	proper	registration	10,	13

pipeline	test:	for	image	formats	11;	of	2D	character	8;	of	3D	arm	59

pivot	points	200,	207

Pooh’s	Hunny	Hut	attraction	117–18

Pose	test	66

pose-to-pose	animation	42,	58,	132

props:	with	contact	points	122;	leading	2D	animation	126,	128–30;	using	3D	for	127

QuickTime	file	48,	52,	107–8,	110–11

QuickTime	movie	44,	105–6

reference	images:	for	animation	58;	rendering	of	104–5

registration:	animation	and	57;	description	of	9–10;	pipeline	for	ensuring	10,	13

rendering:	of	animation	72–3;	cast	layer	156;	 in	Corel	Painter	47–8;	final	movie	52;	 in	Maya	37–40;	 in	Photoshop	43–4;	 of

reference	images	104–5;	tone	mattes	155–7

render	layers:	creating	37–9,	162,	163;	in	Maya	165;	setting	up	37

resolution	gate	68

RGB	image	75,	82,	164,	220

rigging	26,	98,	103

rim	light	74–5,	82,	84–7

rim	light	matte	86,	153



roll	images	133–4

rough	animation	100,	106–11,	134

scene:	adding	dimensions	to	222–3;	f lat	space	196;	material	and	texture	aspect	of	f lattening	192–4

script:	on	character	sets	28–9;	installing	28

sequence	layers	84,	158

shadow	layer	162,	166

shadow	matte	152,	161,	170

shadow	pass	163–5

shadows:	description	of	124,	150;	higher-res	head	and	99;	tones	and	123,	150–3,	171–3;	See	also	light/lighting

Simpsons	Movie,	The	6,	8

software	packages:	for	animation	4;	using	multiple	40,	58

solid	shapes	121–2

space:	ambiguous	187–8;	deep	184–7;	f lat	179–81;	limited	181–4;	mismatch	of	usages	175;	types	of	179

spotlight,	adding	to	cast	shadow	161,	163

stand-in	character	22,	37,	38,	99

stop-motion	animation	4,	7,	13,	73

style	matching	9,	188

subject	matter	5,	93

swf	files	157,	158,	213

symbols	added	to	layers	206–7

Synaptic	Self:	How	Our	Brains	Become	Who	We	Are	(Ledoux)	178

3D	animation:	assets	of	4;	complex	elements	7;	converting	to	be	on	twos	27–8;	Disney’s	Paperman	226;	in	Flash	101–2;	in	f lat

space	181;	handling	off	to	2D	29;	“Package	Whispers”	229–30;	redrawn	in	2D	55;	2D	animation	on	top	of	40–5;	twos	script

and	72

3D	antlers	7,	61

3D	appendage	2,	57

3D	arm:	in	Maya	66;	pipeline	test	of	59;	with	rim	light	85–7;	setting	keyframes	69–70

3D	camera	199–205

3D	 character:	 animating	 22–8;	 applying	 toon	 shading	 to	 29–30;	 creating	 tone	matte	 for	 153–4;	 industry	 examples	 16–17;

printing	on	paper	19–20;	2D	character	and	10,	21–2

3D	characters	with	2D	parts:	animation	and	94,	102–4,	106;	Flash	and	106–10;	hands-on	examples	95–6;	 importing	 images

and	113–16;	industry	examples	94–5;	introduction	to	92–3;	Jaguar	McGuire	and	96–102;	line	look	and	93;	Photoshop	and

110–11;	reference	images	and	104–5;	toon	lines	and	111–13

3D	elements	2,	10,	94,	151

3D	layer	147,	201



3D	objects	10,	145–9,	175

3D	package:	creating	light	in	153;	setting	up	camera	in	129;	shadow	matte	in	161

3D	props:	leading	2D	128–30;	placing	visually	145;	as	popular	125,	127;	putting	in	2D	character’s	hand	144–5

3D	tones:	in	Nuke	system	167–71;	shadows	and	152–3

tif	images	51,	105–7,	141,	157–9

tilting	camera	180

timeline	editor	115,	137,	147

timeline	keyframes	43,	107

timeline	window	40,	42

timing:	for	animation	29,	62–3;	for	combining	mediums	11–12;	in	Flash	63;	in	Toon	Boom’s	Pencil	Check	Pro	64–5

timing	charts	11,	12,	69,	70,	71

tone	mattes:	adjusting	color	of	the	head	and	159;	creating	3D	153–4;	fixing	and	simplifying	160;	giving	opposite	effect	169;

Jaguar	McGuire	153–60;	rendering	155–7

tones:	animation	and	159–60;	character	without	152;	description	of	124,	150;	shadows	and	123,	150–3,	171–3

Toon	Boom:	assortment	of	software	139–40;	cleanup	in	81–2;	drawing	in	49;	exporting	from	Photoshop	to	140–1;	importing

image	sequence	into	141–2;	multiplane	in	210–11

Toon	Boom	Animate	Pro	116,	139–44

Toon	Boom	Harmony	149–50

Toon	Boom	Pencil	Check	Pro	64–6

toon	fill	shading	29–30

toon	lines:	features	of	111–13;	matching	2D	character’s	cleaned-up	lines	33–5

toon	line	shader	34–5

TopWave	images	202,	204

touch	between	characters	18,	54

tracking	with	camera	182,	184

Treasure	Planet	17,	59,	213

Triplets	of	Belleville,	The:	bicyclists	in	2,	61;	2D/3D	integration	and	59;	2D/3D	portions	in	60

24	frames	per	second	11,	50,	159

2D	animation:	 assets	of	 4;	 complex	 elements	 7;	 in	 Flash	 100,	106;	 in	 f lat	 space	 180;	 introduction	 to	 2;	 lighting	 issues	 151;

“Package	Whispers”	229;	in	Photoshop	130–4;	pipeline	for	57–8;	tones	and	159–60;	on	top	of	3D	animation	40–5

2D	character:	animation	of	61–2;	pipeline	test	of	8;	putting	3D	props	in	144–5;	without	tones	152;	3D	body	cast	with	56;	in	3D

camera	move	212–13;	3D	character	and	1,	10,	19–22;	with	3D	parts	2

2D	characters	with	3D	parts:	animation	of	61–2;	composition	set	up	and	83–5;	hybrid	character	and	56–9;	industry	examples

59–61;	 introduction	 to	 54–5;	in	Maya	 66–8;	media	 and	 55–6;	 registration	 issues	 57;	 rim	 light	 and	 74–5,	 85–7;	 saving

images	and	65–6;	timing	issues	62–5;	See	also	animation;	Photoshop

2D	EFX	94,	124,	126,	127,	128

2D	elements	10,	11,	94,	136

2D	head	97,	101,	112,	161



2D	images	3,	66–8,	217

2D	lines	226–7

2D	texture	221,	226

2D	tones	171–3

2D/3D	combinations	2,	13,	90

2D/3D	films	128,	186

2D/3D	integration	13,	59

twos.mel	script	28,	72,	100,	104

UV	editor	218,	220

UVing	process	218,	221

video	layers:	blank	42–3;	in	layer	palette	40;	opening	QuickTime	file	into	110–11;	in	Photoshop	130–2

Visual	Story,	The	(Block)	178,	211–12

visual	style	5,	9,	13,	127

visual	target	58,	97,	98

Wacom	tablets	10,	19

wave	textures	217,	218,	219

x-sheets:	combining	2D	and	3D	57;	maintaining	12;	in	Toon	Boom	81

Z-depth	182,	184,	201,	210,	226

zero	padding	51,	214

zolly	shot	99,	188

zooming	camera	181
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